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Preface

Welcome to the Oracle Marketing User Guide, Release 11i.

This guide assumes you have a working knowledge of the following;:
»  The principles and customary practices of your business area.

s Oracle Marketing.

If you have never used Oracle Marketing, Oracle suggests you attend one or
more of the Oracle Marketing training classes available through Oracle
University.

»  Oracle Self-Service Web Applications.

To learn more about Oracle Self-Service Web Applications, read the Oracle
Self-Service Web Applications Implementation Manual.

s The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications
product information.

How To Use This Guide

The Oracle Marketing User Guide contains the information you need to understand
and use Oracle Marketing. This guide contains seventeen chapters:

»  Chapter 1 provides an overview of Oracle Marketing.
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Chapter 2 discusses topics related to working in Oracle Marketing. It also
contains information about user profiles.

Chapter 3 contains business user flows based on specified scenarios, and will
help you understand some of the major functions available in Oracle
Marketing.

Chapter 4 describes the functions relating to creating and managing audience in
Oracle Marketing.

Chapter 5 describes what programs are, and how to create and use them in
Oracle Marketing.

Chapter 6 discusses campaigns, which are planning objects in Oracle
Marketing, and campaign schedules, which are the execution objects in Oracle
Marketing.

Chapter 7 describes what events and event schedules are, and how to create
and manage them.

Chapter 8 introduces the new Campaign Workbench in Oracle Marketing, and
describes how to create, manage, and track campaign schedules from the
Campaign Workbench.

Chapter 9 describes how to manage products and their price lists, track
competitor products, and maintain trade deals.

Chapter 10 discusses what Offers are and how they can be created and
associated with products that are promoted through campaign or event
schedules.

Chapter 11 describes how the Budgets functionality of Oracle Marketing can be
used to create budgets and to use them to fund marketing activities.

Chapter 12 discusses how you can control access to and initiate approvals for
your marketing objects.

Chapter 13 describes how marketing collateral and messages can be created and
associated with marketing activities.

Chapter 14 discusses how to create and use the common components available
across Oracle Marketing objects, such as Notes, Tasks, Attachments, and
Contact Points.

Chapter 15 discusses the data mining functionality in Oracle Marketing.

Chapter 16 discusses the different bins, reports, and charts on Oracle
Marketing’s home page and describes how to personalize them.



s Chapter 17 describes the procedures for the operations that are common to
many objects in Oracle Marketing.

= Appendix A is a reference that lists and describes the Home page bins, reports,
and charts.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For additional information, visit the Oracle
Accessibility Program Web site at http:/ /www.oracle.com/accessibility /

Accessibility of Code Examples in Documentation

JAWS, a Windows screen reader, may not always correctly read the code examples
in this document. The conventions for writing code require that closing braces
should appear on an otherwise empty line; however, JAWS may not always read a
line of text that consists solely of a bracket or brace.

Other Information Sources

You can choose from many sources of information, including documentation,
training, and support services, to increase your knowledge and understanding of
Oracle Marketing.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDEF).

s PDF Documentation- See the Documentation CD provided with each release
for current PDF documentation for your product. This Documentation CD is
also available on OracleMetaLink and is updated frequently.

= Online Help - You can refer to Oracle iHelp for current HTML online help for
your product. Oracle provides patchable online help, which you can apply to
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your system for updated implementation and end user documentation. No
system downtime is required to apply online help.

m 11i Release Content Document - Refer to the Release Content Document for
new features listed release. The Release Content Document is available on
OracleMetaLink.

= About document - Refer to the About document for patches that you have
installed to learn about new documentation or documentation patches that you
can download. The new About document is available on OracleMetaLink.

Related Guides

Oracle Marketing shares business and setup information with other Oracle
Applications products. Therefore, you may want to refer to other guides when you
set up and use Oracle Marketing.

You can read the guides online by choosing Library from the expandable menu on
your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at
http:/ /oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI). This guide also includes information on setting user
profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle
Applications” from any Oracle Applications help file.

Guides Related to This Product
Oracle Marketing Implementation Guide
This guide provides detailed functional and integration setup information for

technical consultants, application administrators, and implementation team
members.
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Oracle Advanced Pricing User Guide

This document provides information required to set up pricing features of Oracle
Marketing.

Oracle Business Intelligence System Implementation Guide

This guide outlines the steps required to create the End User Layer (EUL) and
import EUL Export File (EEX) for Oracle Discoverer.

Oracle Discoverer Administration Guide

This document provides general information on the set up and administration of
Oracle Discoverer. Includes features, terms, and information on how to use Oracle
Discoverer with Oracle Applications.

SQL* Plus User’s Guide and Reference

This guide provides information and guidelines for SQL *Plus commands that can
be used for list generation and segment creation.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle Applications. This guide
also introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle
Applications products. In Release 11i, much of the installation process is handled
using Oracle Rapid Install, which minimizes the time to install Oracle Applications,
the Oracle8 technology stack, and the Oracle8i Server technology stack by
automating many of the required steps. This guide contains instructions for using
Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product
user’s guides and implementation guides.
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Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the
CRM products. The steps should be done immediately following the tasks given in
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i.
You cannot upgrade to Release 117 directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade,
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information that you need to
run the AD utilities. This guide also provides information on maintaining the
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide

This guide explains how to define periodic and event alerts to monitor the status of
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products

This guide contains the user interface (UI) standards followed by the Oracle
Applications development staff. It describes the UI for the Oracle Applications
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products and how to apply this Ul to the design of an application built by using
Oracle Forms.

Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more
than one currency, use this manual before implementing Oracle Marketing. This
manual details additional steps and setup considerations for implementing Oracle
Marketing with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle Marketing with Oracle
Applications' Multiple Organization support feature, so you can define and support
different organization structures when running a single installation of Oracle
Marketing.

Oracle Workflow Administrator's Guide

This guide explains how to complete the setup steps necessary for any Oracle
Applications product that includes workflow-enabled processes, as well as how to
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide

This guide explains how to define new workflow business processes and customize
existing Oracle Applications-embedded workflow processes. It also describes how
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide

This guide describes how Oracle Applications users can view and respond to
workflow notifications and monitor the progress of their workflow processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the
Oracle Marketing implementation team, as well as for users responsible for the
ongoing maintenance of Oracle Applications product data. This manual also
provides information on creating custom reports on flexfields data.
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Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific
Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
e€TRM is available on Metalink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual

This manual describes Oracle Applications messages. This manual is available in
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide

Many CRM products use components from CRM Application Foundation. Use this
guide to correctly implement CRM Application Foundation.

Training and Support

Training

Oracle offers a complete set of training courses to help you and your staff master
Oracle Marketing and reach full productivity quickly. These courses are organized
into functional learning paths, so you take only those courses appropriate to your
job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by
Oracle University at any one of our many education centers, you can arrange for
our trainers to teach at your facility, or you can use Oracle Learning Network
(OLN), Oracle University's online education utility. In addition, Oracle training
professionals can tailor standard courses or develop custom courses to meet your
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needs. For example, you may want to use your organization structure, terminology,
and data as examples in a customized training session delivered at your own
facility.

Support

From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Marketing working for
you. This team includes your technical representative, account manager, and
Oracle’s large staff of consultants and support specialists with expertise in your
business area, managing an Oracle server, and your hardware and software
environment.

OracleMetaLink

OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain
information and advice from technical libraries and forums, download patches,
download the latest documentation, look at bug details, and create or update TARs.
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
Technical Libraries/ERP Applications/Applications Installation and
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
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Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle
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Oracle develops and markets an integrated line of software products for database
management, applications development, decision support, and office automation,
as well as Oracle Applications, an integrated suite of more than 160 software
modules for financial management, supply chain management, manufacturing,
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.



1

Introduction to Oracle Marketing

This chapter describes the features and functions, benefits, enhancements, and
integration points of the 117.10 release of Oracle Marketing.

Topics in the chapter include:

s Section 1.1, "Product Overview"

= Section 1.2, "Key Features and Functions"
= Section 1.3, "Key Benefits"

s Section 1.4, "Enhancements”

»  Section 1.5, "Oracle E-Business Suite Integration Points"
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Product Overview

1.1 Product Overview

Oracle Marketing drives profit, not just responses, by intelligently marketing to the
total customer/prospect base. By leveraging a single repository of customer
information, marketing professionals can better target and personalize their
campaigns, and refine them in real-time with powerful analytical tools.

Oracle Marketing automates the entire marketing process from campaign planning,
budget management, and list creation to execution and analysis. It enables
marketers to:

= Go to market faster with complete campaign management
= Be more cost-effective with complete marketing control

=  Execute targeted marketing with complete marketing analysis

Complete Campaign Management

Campaign management in Oracle Marketing focuses on planning, coordinating,
and executing multi-channel marketing campaigns (via e-mail, direct mail, Web
sites, telemarketing, or any indirect marketing media). Oracle Marketing offers
real-time personalization and product recommendations as part of Web campaigns
in conjunction with a Web store such as Oracle iStore. The Campaign Dashboard,
the home page of the Campaign Workbench, enables simple campaign planning,
tracking, and analysis. The Campaign Workbench itself enables quick campaign
execution.

Oracle Marketing also offers a sophisticated capability to generate target lists, create
strategic or tactical marketing segments, and manage imports from other data
sources. In addition, Oracle Marketing helps manage marketing event logistics such
as setting up agendas, venues, and registration rules for seminars, trade shows, and
other marketing-related events.

Complete Marketing Control

Oracle Marketing helps provide the right level of control by automating processes
and workflows. Not only can workflows and approvals be easily configured for
various marketing models and different marketing events, but Oracle Marketing is
also very flexible in terms of changing the control elements of the application (for
example, which fields are locked or mandatory).

Budget and cost management are essential to the success of a marketing operation.
Oracle Marketing offers comprehensive budget and cost management functionality
to help organizations keep costs under control. With its seamless integration with
the Oracle E-Business Suite, Oracle Marketing provides the ability to create and
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Key Features and Functions

modify product and pricing information, enabling further control over the more
strategic aspects of marketing.

Complete Marketing Analysis

Analysis is often the first stage in a marketing cycle. The Oracle Marketing solution
provides out-of-the-box marketing reports as well as flexible metrics that can be
configured to measure performance based on any data within the Oracle E-Business
Suite. The Oracle E-Business Intelligence (Daily Business Intelligence) reports and
charts and Oracle Marketing’s Home page marketing intelligence reports and charts
can be personalized to provide a centralized view of key marketing data. The
Audience and Campaign Dashboard reports provide real-time information for
quick pre-campaign analysis and planning.

1.2 Key Features and Functions

The Oracle Marketing application is composed of several functional areas. The
implementation and use of each functional area depends on your business
requirements. Functional areas include:

Campaign Planning and Execution

Oracle Marketing enables you to create, execute, track, and analyze marketing
campaigns. Using intuitive interfaces such as the Campaign Workbench, you can
quickly define campaign attributes and sophisticated performance metrics to
evaluate effectiveness. Oracle Marketing's configurable triggers allow you to
automate complex multistage campaigns (based on any condition or time period) to
execute scheduled activities. Oracle Marketing can also help you execute campaigns
across multiple customer interaction channels such as Web, e-mail, direct mail, and
telemarketing. You can also set up schedules that will repeat based on customer
event triggers. To prevent excessive customer contact through one or many
channels, you can set up fatigue rules to define contact limits by time period and by
channel.

Segmentation and List Management

The Audience Workbench of Oracle Marketing supports sophisticated segmentation
strategies, complex segment hierarchies, and powerful yet easy to use list
management. It provides functionality to import, deduplicate, profile, and analyze
customer and prospect data. You can use the intuitive natural language query
methodology to generate campaign specific target lists from multiple data sources.
You can also quickly create lists based on user-defined criteria within Oracle
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Key Features and Functions

Discoverer or by splitting or merging existing lists. External customer and prospect
lists (in CSV or XML format) can be imported and refined with user-defined rules to
purge duplicate records.

Predictive Modeling and Scoring

Oracle Marketing is seamlessly integrated with Oracle Data Mining to provide a
closed-loop process for predicting customer behavior. With this integration,
non-technical marketers can use automated templates to build predictive models
for common marketing scenarios, including campaign response probability,
customer retention risk, and product affinity. Custom predictive models can also be
leveraged to predict user-defined customer behaviors.

After building a predictive model, you can evaluate the model's effectiveness and
accuracy. By intelligently targeting only those prospects with a high propensity to
exhibit a desired behavior (for example, respond to a marketing campaign), you can
increase marketing ROI by decreasing the number of contacts and increasing the
response rate. If you must operate within a budget or other constraints, you can
perform an optimal targeting analysis to identify the ideal audience to target in a
campaign.

E-Merchandising and Web Campaigns

Oracle Marketing supports the targeting of online visitors with personalized Web
advertisements, Web offers, or product recommendations. The extensible
E-Merchandising rule-based engine dynamically selects the content to display to
online customers based on their profile, their purchase history, or their shopping
context. This personalization module has a tight, out-of-the-box integration with
Oracle iStore and can easily be used on other Web sites.

Budget and Cost Management

The budgeting feature enables you to create, associate, and manage budgets and
checkbooks. The Budget and Cost Management functionality supports a budget
hierarchy to define unlimited sub-budgets. You can transfer funds between different
campaign budgets, and the marketing checkbook helps you track the budget
amount allocated to a campaign.

Promotion Management

You can use Oracle Marketing to create discounts and offers that can be fulfilled
across all channels such as Web stores and Oracle TeleSales. You can create a variety
of offers, such as off-invoice discounts, tiered discounts, free shipping terms, and
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buy-one- get-one-free offers. Moreover, offers can have a unique coupon code and a
maximum number of usages tied to specific budgets, thereby limiting liability.

Product Creation and Maintenance

Marketers can manage products and services through Oracle Marketing. The
powerful integration between the Products module of Oracle Marketing and Oracle
Inventory allows marketers to easily manage product relationships, competitor
products, product bundles, and product revisions.

Pricing Management

In Oracle Marketing, a marketer can create a price list and apply it across the Oracle
E-Business Suite. This enables users to respond rapidly to market conditions.

Deliverable and Message Management

Oracle Marketing provides a complete solution to create and maintain
marketing-related deliverables and collateral. It also enables the bundling of
multiple collateral kits. These collateral and collateral kits can be actual inventory
items, and fulfilled by telesales agents like any other inventory item.

Event Logistics Management

As an event coordinator, you can plan, create, and execute events, incorporating
relevant information such as invite list, agendas, registration start and end dates,
budgets, and resources. You can also define registration rules, "invite only" events,
and campaign associations and track both campaign and event costs and results.
The registration rules can be enforced when a telesales agent or marketer registers a
customer to an event. Web-based event registration is enabled through Oracle
Marketing integrating with Oracle Scripting. Event invitations can be sent out
through event schedules and automatic e-mail notifications can be sent to event
registrants about changes in event logistics. Marketers can also select event
registrants and attendees to generate leads.

Response Management

To initiate and manage customer responses, click-through destinations allow you to
easily insert complex, structured URLs in the content of an e-mail or Web campaign.
These trackable URLs are used to track customer responses to the campaigns as well
as to direct the customers to the appropriate next step. The next step may be to send
customers to a specific Oracle iStore page, or to start a Web script. Web scripts are
created with Oracle Scripting and are used to establish an interactive, personalized
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conversation with customers. Out-of-the-box scripts for lead creation, event
registration, and data acquisition are provided with Oracle Marketing.

Analysis and Reporting

Oracle E-Business Intelligence (Daily Business Intelligence) and Oracle Marketing’s
Home page provide comprehensive out-of-the-box reports and charts for analyzing
the following aspects of the marketing process: budgets, campaigns, events,
channels, leads, and return on investment. The reports provide a complete view of
the Campaign to Order business flow by leveraging data from across the Oracle
E-Business Suite. Each user can configure the Marketing Home Page to include the
most relevant reports for their responsibility. Using these reports, you can quickly
see your top and bottom performing activities and take proactive steps to increase
marketing effectiveness.

Leads Management

Oracle Leads Management provides a central engine for capturing, cleaning, and
deduplicating all sales leads across the business enterprise. The engine then
distributes and monitors leads for follow up across Oracle Marketing, Sales, and
Partner solutions. The Leads Management Engine encapsulates lead qualification,
and distribution logic using flexible, business-specific rules appropriate to different
campaign strategies, regions, products, and customers for each stage of the lead life
cycle. All rules are tracked and reported against actual lead lifecycle, enabling
optimization of lead quality. Businesses can customize the rules to optimize lead
quality and predictability. Refer the Oracle Leads Management Implementation and
Administration Guide for more information.

Marketing to Partners

Marketers can use Oracle Marketing to provide offers and promotions to their
channel partners or a select group of partners for new product launches and
inventory clearances. Based on contact preferences, customers can notify the
partners about these offers and promotions.

Security

Oracle Marketing has a robust security model for marketing objects that enables a
central office to manage all high level programs, but that also enables departments
or branches to manage their specific campaigns and schedules. Marketers can
choose to limit access to one or more marketing initiatives to only those resources
who are within a given marketing team by setting a program, campaign, or event to
be confidential. However, marketers can choose to give limited access to people
outside their teams by setting a marketing initiative to be non-confidential. Security
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for campaign and event schedules is derived from their parent objects. Home page
reports also adhere to the team access security model.

1.3 Key Benefits

Oracle Marketing is part of the Oracle E-Business Suite; because of this you can
easily add additional applications and functionality as needed. For example, if your
business requirements mandate that your marketing campaign results be translated
into leads, then you can implement Oracle Leads along with Oracle Marketing. This
combined implementation enables you to analyze and track leads as a follow up to
your marketing initiatives.

Oracle Marketing (along with the entire Oracle eBusiness suite) leverages the Oracle
Trading Community Architecture (TCA), which stores all customer, partner, and
prospect information in a single repository. This enables the marketing team to
deliver consistent messages and offers across various channels.

Oracle Marketing offers the following benefits:

= Automated Processes: With centralized processing and approval management,
Oracle Marketing enables an organization to focus more on marketing and less
on logistics.

= Quick and Simple Schedule Deployment: Using the Campaign Workbench,
marketers can analyze, plan, create, and execute campaign schedules easily and
quickly.

= Multi-Channel Execution: Oracle Marketing’s seamless integration with other
products in the Oracle E-Business Suite enables a marketer to plan and execute
campaigns across e-mail, direct mail, fax, Web, sales, and telemarketing
channels.

= Increased Velocity: Improved personal productivity, team collaboration, and
information sharing enables marketers to plan and execute campaigns in an
accelerated time frame to gain a competitive advantage.

» Improved Profitability: Campaign and offer tracking across the Oracle
E-Business Suite enables marketers to pinpoint the revenue generated by each
marketing effort.

= Maximize the Effectiveness of Marketing Dollars: Cost and revenue tracking
functions help marketers adjust campaigns to manage and monitor the
effectiveness of marketing dollars.
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1.4 Enhancements

Oracle Marketing and its component modules include numerous new features and
enhancements in this release.

Note: This document describes functionality to be delivered in the
Oracle E-Business Suite 11i.10 release. If you are implementing this
product prior to the release, using product minipacks or family
packs, some new functionality may be dependent on integration
with other Oracle products. Please consult MetaLink for relevant
product patches and documentation.

The following sections describe new features and enhancements that have been
made in release 11:.10:

Campaign Management Enhancements

The following new functions are provided via the Campaign Workbench, to provide
users the ability to plan, create, execute, and track marketing initiatives quickly and
easily:

Schedule Dashboard - This new dashboard enables marketing users to identify
high and low performing schedules within and across campaigns.

Schedule Gantt Chart - This function enables marketing users to visualize the
layout of promotional activities across time. In addition to simple time lines,
users can enter single dimensions for the Gantt including purpose and audience
information, and product and channel information, to help plan and identify
conflict or overlap in propositions.

Sales Schedules - This function enables sales as well as marketing users to create
activities that cross sell and up sell customers in sales territories. When a sales
initiative is launched, leads are generated for sales follow up. Sales campaigns
will also be able to link to proposals. This way when the leads are created, sales
representatives will be able to easily reference the collateral and proposals
associated with a lead.

Web Marketing Schedule - Marketing users can easily and simply run a
campaign on the Web by creating a Web campaign schedule.

Email Schedule - E-Mail schedules now fully leverage Oracle Content Manager
(OCM) such that e-mail templates can guide the format for the different types of
e-mail.
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s Direct Mail Schedule - Marketing users now have the option of printing PDF
documents with merge fields to a network printer.

= Schedule Operational Reports - For supported channels (Web, direct marketing,
sales), workbench schedules support schedule-level reports for execution
tracking.

= Repeating Schedules - Marketers can set up repeating schedules easily.

s Streamlined lead maturation - Campaign schedules can be easily set up to
mature low value, low grade, and unaccepted leads from one or more
campaigns via the new target audience natural language query builder.

Integration with Oracle Personalization enables marketers to create personalized
product recommendations on the Web, based on a customer’s past buying patterns,
navigation behavior, and product ratings.

Integration with Oracle Content Manager enables marketers to store collateral
content that will be sent to a customer and collaboration content that will be used
internally for team collaboration purposes in a central repository. This will ensure
the content is controlled centrally and is shared across objects. Marketers can also
print, fax, and generate .csv files for labels to be used for marketing schedules using
the print channel.

Audience Management Enhancements

The new Audience Workbench provides marketers with an intuitive interface to
create and manage lists, and provides administrators with a logical interface to set
up data sources and list templates used by marketers to create lists. Marketers can
also analyze list effectiveness, examine list trends, split and merge lists, and directly
create a campaign schedule from an existing list.

Marketers can use the natural language query interface within the Audience
Workbench to enter list filter criteria using easily understood marketing terms. For
example, you can now say "Select customers in the US who have purchased
Laptops prior to 01-June-2004". This method makes the filter criteria easy to read,
simple to use, and hides the complexity of the underlying data schema.

List generation based on user-defined data sources is enhanced to include robust
match, merge, and deduplicate logic. The list generation engine creates unique
records that associate the customer records in the user-defined data source and the
Oracle customer model (TCA). This ensures data integrity between the user-defined
data source and the TCA.

The list splitting functionality enables you to easily split a list to create new lists,
which can be associated with different marketing activities. For example, you can
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split a B2B customer list based on industry types or job roles. You can also combine
lists to create a merged list that can be associated with a specific marketing activity.

The List Attribute chart is a new charting interface designed to help you better
understand the distribution of customer profile attributes within a list, such as the
customer distribution by industry within a list. This capability empowers you to
visually analyze your customer data and tailor appropriate marketing activities.
Out-of-the-box charts are provided for common attributes in B2B and B2C
scenarios. Additional charts can also be defined based on any desired customer
attributes within a data source.

Lead Linking Enhancements

In Oracle Marketing, customer responses are generated as click-throughs, e-mail
responders, script/survey responders, event attendees, event registrants, Web visits,
and so on. Oracle Marketing integrates with Oracle Leads Management to evaluate
these marketing interactions and generate sales leads or to enhance the quality of
existing leads.

Data Mining Enhancements

Two new out-of-the-box predictive model templates are added to provide marketers
with a richer set of customer behavior predictions: Product Affinity and Customer
Profitability. The Product Affinity model predicts the likelihood of customers
purchasing a particular product. You can also use this model to predict propensity
to buy within a given product category based on an analysis of all products in that
category. The Customer Profitability model predicts the likelihood that the
relationship with a customer will be profitable. With the addition of the new
predictive model types, you can better profile and understand customer behavior,
offer customers the right products, and maintain profitable customer relationships.

Oracle Marketing's predictive modeling and scoring functionality is enhanced to
provide guidance on the optimal customers/prospects to target in a campaign. This
analysis is based on customer propensity scores and expected costs and revenues
per customer for a campaign activity. You can immediately use the results of a
scoring run from either a Campaign Response Model or a Product Affinity Model to
determine the optimal customers to contact.

Additionally, for Lift Charts, the number targeted and the number of positive
responses information is displayed. Lift Chart and Performance Matrix tables can
also be downloaded to CSV files for offline analysis.
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Web Marketing Enhancements

With this release, you can create and execute Web Marketing campaign schedules
from the Campaign Workbench. The screens have been simplified and the process
streamlined so that manual intervention and dependence on the Website manager is
minimized.

Integration of Oracle Marketing with Oracle Content Manager (OCM) enables Web
content (text or image) to be stored and managed in a central repository. OCM
content types determine what and how content will be rendered on a Web site.

Integration of Oracle Marketing with Oracle Personalization provides the added
ability to make product recommendations based on demographic customer
information, a customer’s current or past browsing patterns, or products in the
shopping cart, resulting in a better shopping experience for visitors and more
purchases for the Web store.

Metrics and Tracking Enhancements

Oracle Marketing provides out-of-the-box calculations for key measures of
campaign and event performance. These scalable calculations enable marketers to
evaluate critical marketing performance indicators without customizing any setup
information. The additional performance metrics calculations in this release include:

s Return on Investment

= Total Revenue based on Booked Orders or Invoiced Orders
»  Target Group, Contact Group, and Control Group Size

= Response Rates

»  Cost per Response, Cost per Lead, Cost per Order

The new Formula metric type helps marketers define formulas within an intuitive
interface to accurately determine the performance of marketing activities. The
metrics setup and administration function is streamlined by allowing each metric
template to be associated with only one marketing activity type (e-mail,
telemarketing, or direct mail) or one marketing object type (campaign, campaign
schedule, event, or event schedule).

The metric creation page now provides administrators with information that is
relevant for each metric calculation type: manual, function, formula, rollup, and
summary. In addition, some key metric attributes, such as metric category, used
with, display type, and calculation type are automatically locked to prevent metric
definitions from becoming invalid.
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Security Enhancements

Oracle Marketing’s enhanced security model enables a central office to manage all
high level programs, but enables departments or branches to manage their specific
campaigns and schedules. You can choose to limit access to your marketing
initiatives to only those resources who are members of your team (or group of users,
for example, franchise, organization, or branch) by setting a program, campaign, or
event to be confidential. However, you can choose to give limited access to people
outside your team by setting a marketing initiative to be non-confidential.

1.5 Oracle E-Business Suite Integration Points
Oracle Marketing integrates with the following products:

Oracle Leads Management

Oracle Leads Management enables users to capture, evaluate, and distribute the
leads generated by marketing activities for sales follow up. It provides solutions to
automate and optimize prospect-to-sales conversion across the enterprise. It
provides a staging area for all prospective leads.

Oracle Content Manager

Oracle Marketing leverages Oracle Content Manager’s functionality as a central
repository of electronic content to be shared across the E-Business Suite of
applications. You can create and store content in Oracle Content Manager. This
includes internal content used for team collaboration purposes, supporting content
for sales and other enterprise users, and external schedule content (such as cover
letters, attachments, e-mail deliverables, and so on) that will be fulfilled and sent to
the customer.

Oracle iStore

Oracle Marketing integrates with Oracle iStore to enable you to use the Web as a
marketing channel and deploy Web Ads, Offers, or personalized product
recommendations on the Oracle iStore Web site.

Oracle One-to-One Fulfillment

Oracle One-to-One Fulfillment provides E-Business Suite business applications with
a centralized mechanism for managing fulfillment. Fulfillment is the process of
compiling and distributing information to customers. Oracle One-to-One
Fulfillment consists of an application programming interface (API) and a server.
The Oracle One-to-One Fulfillment API is used by Oracle Marketing to initiate a
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request for fulfillment processing. The fulfillment request identifies the content and
the server and the Oracle One-to-One Fulfillment server processes the request. It
compiles and sends content, such as product literature, proposal templates,
welcome letters, and other electronically stored documents to an output device.
Output devices include e-mail, fax, and print servers.

Oracle Product Life Cycle Management

Oracle Marketing integrates with Oracle Product Life Cycle Management (PLM)
helps marketers define products, product bundles, and product relationships in
Oracle Marketing. This information is automatically populated in the product
catalog and is available across the E-Business Suite of applications.

By integrating with PLM, Oracle Marketing leverages on PLM’s product cataloging
and management system. Product cataloging uses the concept of hierarchy, which
provides an efficient and re-usable catalog and product management system. The
same hierarchy is used across marketing, sales, and reporting to achieve cohesive
product-based reporting.

Oracle Field Sales

Oracle Field Sales is an application designed for field sales representatives, sales
managers, and executives. The application provides a complete set of tools that
enables sales teams to manage the sales cycle from beginning to end. It supports the
key functions of the sales cycle, with features such as comprehensive customer
management, lead and opportunity management, forecasting, quote generation,
order placement, and sales methodologies.

When Oracle Marketing integrates with Oracle Field Sales, the critical link in the
Campaign to Cash business flow is fulfilled, providing the information to analyze
the success of company campaigns. The integration also enables sales managers to
generate and track leads by deploying sales campaign schedules from the
Campaign Workbench.

Oracle Scripting

The integration between Oracle Marketing and Oracle Scripting provides marketing
managers with the ability to follow-up on the campaigns they design with a
scripted flow of interactions (either through the Web or a call center). Customers
will be able to register for an event online via scripting integration. There are also
seeded Oracle Scripting scripts that marketers can use to invite customers to
participate in surveys (using the Survey components of Scripting) by linking from
an e-mail or a Web campaign. The return data from surveys can be used to evaluate
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customer satisfaction, improve product lines, target new or improved services, or
otherwise improve responsiveness.

Scripting is integrated in Oracle Marketing through the use of click-through
destinations (CTDs) that can be enabled behind a banner on iStore, via an e-mail, or
even associated in direct marketing collateral.

Oracle Proposals

Proposal templates are used by marketing schedules (in the new Campaign
Workbench) as collaboration content. This content is used in the downstream flow
of lead management. Sales representatives who are processing the leads use a
standard proposal template for a specific schedule.

Oracle Data Mining

Data Mining is a process used to discover strong, meaningful patterns and
relationships in large amounts of data. Oracle Marketing is integrated
out-of-the-box with Oracle Data Mining to build predictive models of customer
behavior. Marketers can build models to predict campaign response likelihood,
determine product affinity, or predict any user-defined "target behavior” within a
data source. Marketers can then leverage each model's predictions to determine
which customers/prospects are most likely to display a particular behavior. This
closed-loop process does not require any technical data mining or programming
knowledge and can produce dramatic increases in marketing ROL

Oracle Personalization

Oracle Personalization (OP) is a real time data analytics engine and it integrates
with Oracle Marketing to make Web product recommendations based on aggregate
customer information and a specific customer's past buying patterns, navigation
behavior, and product ratings.

Oracle TeleSales

Oracle TeleSales (OTS) is an application designed for inside sales professionals,
inbound telesales agents, or outbound telemarketing agents. OTS offers a
multi-channel selling solution that manages leads, opportunities, and forecasts. It
provides a set of tools to help the sales team manage the sales cycle - from
prospecting for customers to booking the order. When Oracle Marketing and Oracle
TeleSales integrate, you can use the Oracle Marketing List Import feature to assign
lists to Oracle TeleSales Agents. The agents can then use the Universal Work Queue
to access the list of customers assigned to them by the marketing team.
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Oracle Student Services

Oracle Marketing integrates with Oracle Student Services to provide features for the
entire recruiting process, from campaign planning, budget management, and list
creation to execution, reporting, and analysis. By using a centralized and integrated
approach, Oracle Marketing ensures that recruiting activities are on budget and
executed in real time through the most effective communication channels.
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Working in Oracle Marketing

This chapter discusses topics related to working in Oracle Marketing. Sections
include:

»  Section 2.1, "Users and Responsibilities"
s Section 2.2, "About Calendar"

= Section 2.3, "Understanding User Profiles"
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2.1 Users and Responsibilities

You can create different users and assign them responsibilities based on their role in
Oracle Marketing. Table 2-1 lists these details as well as the functionality available
to a particular user responsibility in the application.

Table 2-1 Users, Responsibilities, Roles, and Accessible Tabs in Oracle Marketing

Responsibility | Role Accessible Tabs

Campaign »  Performs administrative and The Campaign Dashboard is the

Workbench setup activities to support home page.

Super User Schedule Creation . .
Shortcuts available are:

s Creates and maintains Schedule
Templates that are used to create
Campaign Schedules, Web s Create Schedule
Placements used for Web e Schedules List
Schedules, and Approval Rules

= Campaign Hierarchy

Schedule Details

s Creates, maintains and follows
up the Campaign Schedules for | s  Schedules Gantt Chart

marketing s Create Schedule
= Associates appropriate Target

Groups with the Campaign

Schedules for execution s Audience Workbench

= Reports Dashboard

Administration
= Schedule Templates
= Approval Rules

s Web Placements

Audience Super |w  Establishes and manages the The Audience Administration
User internal list selection process for | Dashboard is the home page.
marketing Shortcuts available are:

= Manages all lists from affiliates | =  Create Query Template

and vendors s All Query Templates

= Develops and manages

processes for data quality of lists | Create Data Source

s Ensures data enrichment and =  All Data Sources
data integrity of list data = Fatigue Rules Setup

s Audience Workbench

= All Suppression Lists

n Contact Preferences
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Table 2-1 Users, Responsibilities, Roles, and Accessible Tabs in Oracle Marketing

Responsibility | Role Accessible Tabs
List Manager Creates and manages lists for The Audience Dashboard is the
marketing campaigns and events home page. Shortcuts available
are:
»  Create List
= My Lists

= Search Lists

= Segments

= Imports

»  Discoverer

= Organizations

n  Persons

= AllLists

= Campaign Workbench

Oracle = Creates setup templates for All tabs and functions are
Marketing Super marketing objects available.
User

»  Creates and manages marketing
activities such as Programs,
Campaigns, Campaign
Schedules, Events, and Event

Schedules
Oracle = Creates and manages profiles Oracle Forms Application
Marketing d look opens. The following Setups are
Administrator = Creates and manages lookups available:
n Runs concurrent requests . Profile
= Lookups

n Concurrent Requests

2.2 About Calendar

The Oracle Marketing Calendar provides administrative users of a marketing
organization with the ability to publish execution objects and their details to all
marketing users through the calendar functionality. These objects can be selected
for display based on a selection criteria or by manually selecting individual objects
to be displayed.
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The marketing calendar is set up by the administrator. The administrator decides on
the set of objects that will be displayed on the calendars of every user within the
organization. However, if you do not wish to view any of the marketing objects set
up by the administrator, you can use the user profiles functionality to turn off the
views.

For information on setting up the marketing calendar, refer Oracle Marketing
Implementation Guide.

2.3 Understanding User Profiles

Oracle Marketing has some attributes that you can modify based on your individual
preferences. Clicking the Profile link available on most pages displays a profile page
where you can set preferences for the various tabs in the application.

Apart from setting preferences for the tabs, you can change your password and
specify navigation, display, and calendar preferences. See the Oracle CRM
Application Foundation User Guide for more information.

Access to many of the tabs is controlled by a responsibility. Each user is given a
responsibility which determines what tabs are displayed and what rights a user
may have. See Section 2.1, "Users and Responsibilities" for information on
marketing responsibilities.

2.3.1 Setting General Preferences

Use the following procedure to set General Preferences in Oracle Marketing.

Prerequisites
None

Steps
1. Log in to Oracle Marketing, and click the Profile link.

2. Click General from the Marketing Online side navigation link.
3. Modify the settings for country, timezone, and other details, as required.
4. From the Side Navigation Look drop-down, select an appropriate option.

Based on what you select, the side navigation links for the objects in Oracle
Marketing are grouped under specific headings.
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= Essential and Optional: Links for mandatory tasks are grouped under
Essential, and those that are optional are grouped under Optional.

= Business Process View: If this option is selected, links are grouped under
headings that reflect your business processes. These headings are Planning,
Execution, Track, and Collaboration. The Execution and Track headings
appear only for the relevant objects such as Events, Campaigns, and so on.

5. Click Update.

These settings are saved and are applicable immediately.

2.3.2 Setting Preferences for the Tabs

You can select the Saved Search to display as the default summary for the
individual tabs in Oracle Marketing. The following procedure sets preferences for
the Campaigns tab. You can use the same procedure to set preferences for all the
other tabs. The navigation varies based on the tab that you choose.

Prerequisites
None

Steps
1. Log in to Oracle Marketing, and click the Profile link.

2. Click Campaigns from the Marketing Online side navigation link.

3. From the Campaign Searches region, select the search to be used as default by
clicking the option in the Use as Summary Page Default column.

4. Do the same from the Program Searches region.

5. Click Update.
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Oracle Marketing Business User Flows

This chapter describes the common business user flows for Oracle Marketing based
on typical marketing scenarios. Sections include:

= Section 3.1, "Sending Monthly Newsletters to a Set of Customers"
= Section 3.2, "Sending Mailers to a Set of Customers to Promote a Product"
= Section 3.3, "Advertising on the Web to Promote a Product"

= Section 3.4, "Following Up to Responders to an Earlier Schedule with a
Telemarketing Campaign Schedule"

= Section 3.5, "Generating Leads Using a Sales Campaign Schedule"

= Section 3.6, "Improving Campaign Results Using Predictive Analytics"

3.1 Sending Monthly Newsletters to a Set of Customers

This business user flow describes how you can use the repeating e-mail campaign
schedule functionality of Oracle Marketing to create, execute, and track the activity
of sending a monthly newsletter to a specific set of customers.

3.1.1 Scenario

Vision Enterprises, a manufacturer of computers and computer accessories, sends
out a monthly newsletter to selected customers to keep them informed about the
latest product information and troubleshooting tips. Each e-mail communication
must contain a link to Vision Enterprise’s Web site address that customers can click
for more detailed information.
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3.1.2 Process Flow Diagram

Figure 3-1 displays the process flow for the monthly newsletter e-mail campaign

schedule.

Figure 3—-1 Repeating Campaign Schedule Flow
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Create ‘Repeating Schedule'
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date

!

Execute ‘Repeating Schedule’
on next scheduled execution
date

3.1.3 Dependencies and Prerequisites

s Oracle Marketing must be fully implemented
» Integrations with the following must be set up:
s Oracle Content Manager
s One-to-One Fulfillment

= A campaign must exist
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3.1.4 Steps

= Optionally, for metrics to roll up and be reported at a program level, a program
must exist

Use the steps in this section to complete this flow.

Step 1: Create a Repeating E-mail Campaign Schedule

You will create a campaign schedule, choosing E-mail as the channel of execution.
You must associate this campaign schedule to an existing campaign to which it will
roll up. For the campaign to roll up to a program, a program must exist and the
campaign must be associated with it.

For information on campaigns and programs, see:
= Section 6.1, "Campaigns Overview"

m  Section 6.2, "Creating a Campaign"

= Section 5.1, "Programs Overview"

s Section 5.2, "Creating a Program"

The steps involved in creating a repeating e-mail schedule are as follows:

Step 1.1: Complete the Mandatory Data for the Campaign Schedule

Choose an e-mail campaign schedule template to create this campaign schedule.
Selection of this template enables a set of attributes which must be completed.

For information on entering mandatory data, see Section 8.2.1, "Entering Basic
Campaign Schedule Details".

Step 1.2: Set the Frequency at Which the Schedule Must Repeat

For the newsletter to be sent to customers every month, you must set frequency at
which the e-mail campaign schedule repeats.

For information on how to set up the repeating option, see Section 8.2.1, "Entering
Basic Campaign Schedule Details".

Step 1.3: Complete the Optional Setup for the Schedule

You can optionally associate products or offers, collaboration material, notes,
tracking metrics, and other additional information to the campaign schedule.

For information on how to include optional setup data, see:
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= Section 8.2.2, "Associating a Product or Offer"

= Section 8.2.6, "Creating and Associating Collaboration Content"

= Section 8.2.7, "Associating Costs, Revenues, and Metrics for Tracking"
»  Section 8.2.8, "Creating a Note"

= Section 8.2.9, "Entering Additional Information"

Step 1.4: Create Newsletter Content and Corresponding Cover Letter and
Associate them to the Schedule

The e-mail cover letter is the newsletter that will go to the target customers. You can
(optionally) include a click-through destination (CTD) in the cover letter that the
customers can click to navigate to Vision Enterprise’s Web site.

See Section 8.2.3, "Creating and Associating Cover Letters to Direct Marketing
Schedules" for information on how to create a cover letter and include a CTD in it.

Step 1.5: Prepare a List of Customers to Send the Newsletter to

You can specify the audience to whom to send the newsletter. You do so by creating
a target group using list templates or based on existing lists, segments, workbooks,
or custom SQL. Note that the schedule repeats to this list each time it executes.

Optionally, you can choose to apply fatigue rules for the schedule. You can view
fatigue reports to know how many customers are fatigued and how many available
to target.

For information on how to create and associate a target group, see Section 8.2.4,
"Creating and Associating Target Groups"

For information on fatigue rules, see:
= Section 8.1.9, "Understanding and Using Fatigue Rules"
= Section 8.1.15.1, "Viewing a Schedule or Channel Specific Fatigue Report"

Refer Oracle Marketing Implementation Guide to know how to create fatigue rules.

Step 2: Submit the Campaign Schedule for Approval

When you have completed the various details for the campaign schedule, you can
submit it for approval. The approval goes through the Workflow process, and when
a campaign schedule is approved it moves to the Active status.
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Even for objects not needing approvals, you must request approval and manually
change the status of the object to Active. To know more about Approvals, see
Section 12.3, "Approvals Overview".

When the campaign schedule is automatically activated by the Repeating Trigger,
e-mail will be sent to all the customers in the target group using the live version of
the cover letter.

The target group is evaluated for suppressed and fatigued customers before the
e-mail is sent out.

Step 3: Update the Cover Letter in Oracle Content Manager

You can update the cover letter (the newsletter that was sent by the e-mail schedule)
in Oracle Content Manager and keep the next version ready for circulation the
following month. When the campaign schedule executes the following month, the
latest live version of the newsletter is picked up and sent to the target group.

Refer Oracle Content Manager User Guide for information on updating cover letters.

3.2 Sending Mailers to a Set of Customers to Promote a Product

This business user flow describes how to use the direct mail print campaign
schedule functionality of Oracle Marketing to create, execute, and track an activity
to send mailers to a set of customers to promote a new product.

3.2.1 Dependencies and Prerequisites
s Oracle Marketing must be fully implemented

= Integrations with the following must be set up:
s Oracle Content Manager
= One-to-One Fulfillment

= A campaign must exist

= Optionally, for metrics to rollup and be reported at the program level, a
program must exist

3.2.2 Scenario

Vision Enterprises, a manufacturer of computers and computer accessories, wants
to send a direct print mail communication to its customers who purchased its
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computers in the last year. Its marketing manager also wishes to view the fatigue
reports to know the number of customers fatigued.

3.2.3 Process Flow Diagram
Figure 3-2 depicts the process flow for a direct mail print campaign schedule.

Figure 3-2 Process Flow for a Direct Mail Print Campaign Schedule
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3.2.4 Steps

Use the steps in this section to complete this flow.
Step 1: Create a Direct Mail Print Campaign Schedule

You will create a campaign schedule, choosing Print as the channel of execution.
You must associate this campaign schedule to an existing campaign to which it can
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roll up to. Additionally, for the campaign to roll up to a program, ensure that the
program exists and the campaign is associated with it.

For information on campaigns and programs, see:
= Section 6.1, "Campaigns Overview"

= Section 6.2, "Creating a Campaign"

= Section 5.1, "Programs Overview"

= Section 5.2, "Creating a Program”

The steps involved in creating a print campaign schedule are as follows:

Step 1.1: Complete the Mandatory Data for the Campaign Schedule

Choose the Direct Mail - Print campaign schedule template to create this campaign
schedule. Selection of this template enables a set of attributes which must be
completed.

For information on entering mandatory data, see Section 8.2.1, "Entering Basic
Campaign Schedule Details".

Step 1.2: Complete the Optional Setup For the Campaign Schedule

You can optionally associate products or offers, collaboration material, notes,
tracking metrics, and other additional information to the campaign schedule.

For information on how to include optional setup data, see:

= Section 8.2.2, "Associating a Product or Offer"

= Section 8.2.6, "Creating and Associating Collaboration Content"

»  Section 8.2.7, "Associating Costs, Revenues, and Metrics for Tracking"
= Section 8.2.8, "Creating a Note"

= Section 8.2.9, "Entering Additional Information"

Step 1.3: Create Mailer Content and Corresponding Cover Letter and
Associate them to the Schedule

The print cover letter is the mailer that will go to the target customers. You can
select the mailer from Oracle Content Manager (OCM) repository or create it and
submit it for approval. When approved, it is available to be used by the campaign
schedule. You must have the necessary folder permissions to create and store
content in OCM. Refer Oracle Content Manager User Guide for information on folder
permissions.
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You may also generate the recipient information for the members of the target
group, and download and use the resulting .csv file to print labels using external
programs.

See Section 8.2.3, "Creating and Associating Cover Letters to Direct Marketing
Schedules" for information on how to create a cover letter and generate recipient
information for labels.

Step 1.4: Prepare a List of Customers to Send the Mailer to

You can specify the audience to whom to send the mailer. You do so by creating a
target group using list templates or based on existing lists, segments, workbooks, or
custom SQL. Optionally, you can choose to apply fatigue rules for the schedule. You
can view fatigue reports to know how many customers are fatigued and how many
available to target.

For information on how to create and associate a target group, see Section 8.2.4,
"Creating and Associating Target Groups"

For information on fatigue rules, see:
= Section 8.1.9, "Understanding and Using Fatigue Rules"
= Section 8.1.15.1, "Viewing a Schedule or Channel Specific Fatigue Report"

Refer Oracle Marketing Implementation Guide to know how to create fatigue rules.

Step 2: Submit the Schedule for Approval

When you have completed the various details for the campaign schedule, you can
submit it for approval. The approval goes through the Workflow process, and when
a campaign schedule is approved it moves to the Active status.

Even for objects not needing approvals, you must request approval and manually
change the status of the object to Active. To know more about Approvals, see
Section 12.3, "Approvals Overview".

When the campaign schedule is approved and active, mailers are printed and sent
to all the customers in the target group.

The target group is evaluated for suppressed and fatigued customers before the
mailers are sent out.

3.3 Advertising on the Web to Promote a Product

This business user flow describes how you can use the Web marketing functionality
of Oracle Marketing to create and execute a Web Ad.
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3.3.1 Dependencies and Prerequisites

s Oracle Marketing must be fully implemented

s Integration with Oracle iStore and Oracle Content Manager must be set up

s The Product page for the product you are promoting must be set up in iStore
= A campaign must exist

= Optionally, for metrics to rollup and be reported at the program level, a
program must exist

3.3.2 Scenario

Vision Enterprises, a manufacturer of computers and computer accessories, wants
to promote its new sleek monitors on Vision iStore's Home page. When Web visitors
click on the Ad, they will be brought to the product page for the monitors.

3.3.3 Process Flow Diagram

Figure 3-3 depicts the process flow for creating and executing a Web ad.
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Figure 3-3 Process Flow for Creating and Executing a Web Ad
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3.3.4 Steps

Use the steps in this section to complete this flow.

Step 1: Specify the Location on the Web Site Where the Ad Must be

Displayed

As the Web site manager (who could well be the marketer, too), you will define and
activate the location where the Web Ad will be rendered when the Web Advertising
Schedule becomes active and executes. You can select the content types, the display

method, and the default content for a placement.

For information on placements and how to create them, see Section 8.3.2, "Creating

and Using Placements".

Step 2: Create a Web Ad Campaign Schedule

As a marketer, you will create a campaign schedule using the Web channel. You
must associate this campaign schedule to an existing campaign to which it can roll
up to. Additionally, for the campaign to roll up to a program, ensure that the
program exists and the campaign is associated with it.
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For information on campaigns and programs, see:
= Section 6.1, "Campaigns Overview"

= Section 6.2, "Creating a Campaign"

= Section 5.1, "Programs Overview"

= Section 5.2, "Creating a Program”

The steps involved in creating a Web Ad campaign schedule are as follows:

Step 2.1: Complete the Mandatory Data for the Campaign Schedule

Choose the Web Advertising campaign schedule template to create this campaign
schedule. Selection of this template enables a set of attributes which must be
completed.

For information on entering mandatory data, see Section 8.3.4.1, "Entering Basic
Details".

Step 2.2: Complete the Optional Setup For the Schedule

You can optionally associate a specific audience, notes, metrics that you want to
track, and other additional information to the campaign schedule.

For information on how to include optional setup data, see:

= Section 8.2.4, "Creating and Associating Target Groups"

»  Section 8.2.7, "Associating Costs, Revenues, and Metrics for Tracking"
= Section 8.2.8, "Creating a Note"

= Section 8.2.9, "Entering Additional Information"

Step 2.3: Select the Product that you Want to Promote in the Web Ad

In this step you will associate the sleek monitors (Offering) that you wish to
promote through the Web Ad. Only products that have been associated to the
parent campaign are available to be associated with the Web Ad campaign
schedule.

See Section 8.3.4.2, "Associating a Product or Offer" for information on how to
associate a product.
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Step 2.4: Specify the Web Site Location Where the Ad Will be Displayed and
Select Content to Display

In this step, you will specify the placement to which this schedule must render
content and the content item that must be displayed. Because Oracle Marketing
integrates with Oracle Content Manager (OCM), OCM content types determine
what and how content will be rendered in a placement. Content types have one or
more stylesheets associated with them, which define how the content type is
actually displayed in a Placement.

If you have the necessary access permissions to OCM folders, you can create the
content item and submit it for approval. Content must be approved before it can be
rendered. Refer Oracle Content Manager User Guide for information on folder
permissions.

See Section 8.3.4.3, "Associating a Web Ad or Web Offer to a Placement” for
information on associating a Web schedule to a placement.

Step 2.5: Specify the Action for the Click-Through Destination

In this step, you will enable the visitor to go to the product page directly and get
more details for the monitors. Alternatively, you could have enabled the visitor to
add the product immediately to the shopping cart. You do so by defining a CTD for
the content item and selecting an action for the CTD. Actions available include:

= GotoURL
s Go to Content Item
= Go to Web Script

For information on creating click-through destinations, see Section 8.3.4.3,
"Associating a Web Ad or Web Offer to a Placement".

Step 3: Submit the Schedule for Approval

When the Web Ad Schedule is approved and active, it can be executed and its
content rendered in the selected Placements. Note that this does not mean that this
schedule will actually run. It only means that this schedule is eligible to run.
Whether it actually runs or not will depend on other conditions like what the
selection method is for the Placements associated with the Schedule, if there are
other higher priority schedules using the same Placement, and so on. See section
Section 8.3, "Understanding and Creating Web Schedules" for more details.

In this scenario, it is assumed that the Web Ad schedule that was just created is the
only Web Ad schedule using the associated Placement.
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To know more about Approvals, see Section 12.3, "Approvals Overview".

Step 4: Verify if the Web Ad is Displayed on the Web Site

If you log into the iStore Web site, you should see the advertisement in the specified
location.

3.4 Following Up to Responders to an Earlier Schedule with a
Telemarketing Campaign Schedule

This business user flow describes how to use Oracle Marketing to create and
execute a telemarketing campaign. You will use the Campaign Workbench to
complete the flow.

3.4.1 Dependencies and Prerequisites
s Oracle Marketing must be fully implemented

= Integrations with Oracle Content Manager and Oracle TeleSales must be set up
= A campaign must exist

= Optionally, for metrics to rollup and be reported at the program level, a
program must exist

3.4.2 Setup Needed for this Scenario

» Integration with Oracle Scripting must be set up

»  The data sheet for the product being promoted must be available

3.4.3 Scenario

Vision Enterprises wants to execute a Telemarketing follow up schedule for
customers who responded to an earlier e-mail schedule to promote their new sleek
monitors. The product data sheet that must go out to the telesales agents must be
included.

3.4.4 Process Flow Diagram

Figure 3—4 depicts the process flow for creating and executing a telemarketing
campaign schedule.
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Figure 3—-4 Process Flow for Creating and Executing a Telemarketing Campaign
Schedule
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3.4.5 Steps

Use the steps in this section to complete this flow.

Step 1: Create a Telemarketing Campaign Schedule

You will create a campaign schedule, choosing Telemarketing as the channel of
execution. You must associate this campaign schedule to an existing campaign to
which it can roll up to. Additionally, for the campaign to roll up to a program,
ensure that the program exists and the campaign is associated with it.

For information on campaigns and programs, see:
= Section 6.1, "Campaigns Overview"

ms  Section 6.2, "Creating a Campaign"

= Section 5.1, "Programs Overview"

= Section 5.2, "Creating a Program"
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The steps involved in creating a print campaign schedule are as follows:

Step 1.1: Complete the Mandatory Data for the Campaign Schedule

Choose the Telemarketing campaign schedule template to create this campaign
schedule. Selection of this template enables a set of attributes which must be
completed.

For information on entering mandatory data, see Section 8.2.1, "Entering Basic
Campaign Schedule Details".

Step 1.2: Complete the Optional Setup For the Schedule

You can optionally associate products or offers, notes, tracking metrics, and other
additional information to the campaign schedule.

For information on how to include optional setup data, see:

= Section 8.2.2, "Associating a Product or Offer"

»  Section 8.2.7, "Associating Costs, Revenues, and Metrics for Tracking"
= Section 8.2.8, "Creating a Note"

= Section 8.2.9, "Entering Additional Information"

Step 1.3: Prepare a List of Customers who Responded to an Earlier Schedule

You can specify the audience which the telemarketing agents must contact. You do
so by creating a target group using list templates or based on existing lists,
segments, workbooks, or custom SQL. Optionally, you can choose to apply fatigue
rules for the schedule. You can view fatigue reports to know how many customers
are fatigued and how many available to target.

In this scenario, you will create the target group of respondents to an earlier e-mail
campaign schedule by using seeded list templates (Interaction Follow Up - B2B or
Interaction Follow Up - B2C).

For information on how to create and associate a target group using seeded list
templates, see Section 8.2.4, "Creating and Associating Target Groups"

For information on fatigue rules, see:
= Section 8.1.9, "Understanding and Using Fatigue Rules"
= Section 8.1.15.1, "Viewing a Schedule or Channel Specific Fatigue Report"

Refer Oracle Marketing Implementation Guide to know how to create fatigue rules.

Oracle Marketing Business User Flows 3-15



Generating Leads Using a Sales Campaign Schedule

Step 1.4: Associate the Data Sheet for the Product as Collaboration Content

In this step, you will associate the product data sheet as an outbound script that
must reach the telemarketing agents.

Scripts are usually used to guide agents in their interactions with customers or
prospects. This reduces agent training time and ensures that consistent corporate
messages are communicated to customers and prospects. Scripts are also used to
poll target audiences, receive and analyze responses, and take action based on the
compiled survey data. Scripts are created in Oracle Scripting.

See Section 8.2.6, "Creating and Associating Collaboration Content" for information
on associating scripts to a campaign schedule.

Step 2: Submit the Campaign Schedule for Approval

When you have completed the various details for the campaign schedule, you can
submit it for approval. The approval goes through the Workflow process, and when
a campaign schedule is approved it moves to the Active status.

Even for objects not needing approvals, you must request approval and manually
change the status of the object to Active.

When the campaign schedule is approved and active, the proposal template and the
list of customers is sent out to the telemarketing agents.

The target group is evaluated for suppressed and fatigued customers before the
schedule executes.

To know more about Approvals, see Section 12.3, "Approvals Overview".

3.5 Generating Leads Using a Sales Campaign Schedule

This business user flow describes how sales managers can use the Sales Campaign
Schedule functionality of Oracle Marketing to generate leads from their install base.

3.5.1 Dependencies and Prerequisites
s Oracle Marketing must be fully implemented

» Integration with Oracle Content Manager must be set up
s A campaign must exist

= Optionally, for metrics to rollup and be reported at the program level, a
program must exist
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3.5.2 Setup Needed for this Scenario

s Integration with Oracle Proposals must be set up

= A proposal template must be available

3.5.3 Scenario

The sales manager of Vision Enterprises plans to generate top quality leads from
Vision’s install base. The sales team will receive the proposals and sales material it
needs to aid training and to follow up the leads generated.

3.5.4 Process Flow Diagram

Figure 3-5 depicts the process flow for creating and executing a sales campaign.
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Figure 3-5 Process Flow for Creating and Executing a Sales Campaign
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3.5.5 Steps

Use the steps in this section to complete this flow.
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Step 1: Review the Sales Dashboard

Using the Sales Funnel, Latest Forecast, Top Customers, Top Opportunities, and the
Cross Sell /Up Sell Sales Campaigns regions of the Sales Dashboard, you can make
decisions for the what, why, and when of a new sales blitz.

Refer the Oracle Field Sales User Guide for more details on the dashboard.

Step 2: Create a Sales Campaign Schedule

You will create a campaign schedule, choosing Sales as the channel of execution.
You must associate this campaign schedule to an existing campaign to which it can
roll up to. This allows Oracle Marketing to track the overall success of this effort as
part of larger enterprise marketing activities.

Additionally, for the campaign to roll up to a program, ensure that the program
exists and the campaign is associated with it.

For information on campaigns and programs, see:
s Section 6.1, "Campaigns Overview"

= Section 6.2, "Creating a Campaign"

= Section 5.1, "Programs Overview"

= Section 5.2, "Creating a Program”

The steps involved in creating a Sales campaign schedule are as follows:

Step 2.1: Complete the Mandatory Data for the Campaign Schedule

Choose the Sales campaign schedule template to create this campaign schedule.
Selection of this template enables a set of attributes which must be completed. You
will define the launch date, the methodology, and the objective for the sales
campaign.

For information on entering mandatory data, see Section 8.2.1, "Entering Basic
Campaign Schedule Details".

Step 2.2: Select the Selling Product for the Schedule

You will define the target product being cross sold or up sold for the sales effort.
this product will be the product used to generate the sales leads. The product
selected also drives the content for the sales training.

For information on how to select a product, see Section 8.2.2, "Associating a Product
or Offer".
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Step 2.3: Complete the Optional Setup for the Schedule

You can optionally associate notes, tracking metrics, and other additional
information to the sales campaign schedule.

For information on how to include optional setup data, see:

= Section 8.2.7, "Associating Costs, Revenues, and Metrics for Tracking"

= Section 8.2.8, "Creating a Note"

= Section 8.2.9, "Entering Additional Information"

Step 2.4: Prepare the List of Customers that the Schedule Must Target

You can define the set of accounts against which leads will be generated for sales
follow up. You can do so by creating a target group using list templates or based on
existing lists, segments, workbooks, or custom SQL. List templates are based on the
sales effort purpose - for example, to cross sell to the install base for the selected
sales group. This functionality is leveraged from Oracle Marketing’s Audience
Workbench.

After defining the target group, you can generate the target list and view its entries.

For information on how to create and associate a target group, see Section 8.2.4,
"Creating and Associating Target Groups"

Step 2.5: Select and Associate a Proposal Template

In this step, you will associate the proposal template for the leads for this campaign.
Sales representatives can use templates to generate and fulfill proposals for the sales
campaign schedule leads. The proposal template is created in Oracle Proposals and
is associated as collaboration content.

See Section 8.2.6, "Creating and Associating Collaboration Content" for information
on associating proposals to a campaign schedule.

Step 2.5: Select and Associate Content to aid Sales Training/Collaboration

Here you define the content for the sales effort. This content will be made available
to the sales representatives as read-only content to help train on the product
strategy and cross sell opportunity while working on the leads.

Content items can be selected from the Oracle Content Manager (OCM) repository.
You may also create the content if you have the necessary access permissions for
OCM folders.

Refer Oracle Content Manager User Guide for information on folder permissions.
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See Section 8.2.6, "Creating and Associating Collaboration Content" for information
on associating content items to a campaign schedule.

Step 4: Submit the Campaign Schedule for Approval and Return to the
Sales Dashboard

When you have completed the various details for the campaign schedule, you can
submit it for approval. The approval goes through the Workflow process, and when
the campaign schedule is approved, it moves to the Active status.

Read only access is provided to the sales representatives for content associated with
leads assigned to them. The read-only page also provides information about the
target product, install base criteria for the leads, and objective information provided
by the manager.

To know more about Approvals, see Section 12.3, "Approvals Overview".

Step 5: Review the Leads Generated from the Sales Campaign

Leads for the sales campaign are set to be scored as 'A' leads to ensure they are
prioritized in the workload for the sales representative queue. All leads are
channeled to Direct to call Territory Manager to be assigned to sales representatives.

Refer the Oracle Field Sales User Guide for more details.

3.6 Improving Campaign Results Using Predictive Analytics

This business user flow describes how to use Oracle Marketing to build and
evaluate a predictive model and use the model's results to generate a target list for a
campaign schedule.

3.6.1 Dependencies and Prerequisites
s Oracle Marketing must be fully implemented

s Oracle 9i Data Mining version 9.2.0.5 or higher must be installed

3.6.2 Scenario

Vision Enterprise plans to launch a new product, Vision Wireless Laptop, into the
market. The Vision marketing group expects that existing laptop customers are
good candidates for a campaign to promote the new product. However, Vision
would like to cut its marketing costs for this campaign. Instead of targeting all
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laptop customers, Vision plans to intelligently target only those customers who are
most likely to respond to the marketing campaign. This will help Vision ensure a
better return on investment.

3.6.3 Process Flow Diagram

Figure 3-6 depicts the process flow for a predictive response model.

Figure 3—-6 Process Flow for Predictive Campaign Response Model
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3.6.4 Steps

Use the steps in this section to complete this flow.

Step 1: Identify Target Customers

In this step, you will create a list of all existing laptop customers and split this list
into the following two lists:

= A’test list’ based on a random subset, for example 5%, of the original list
= A’scoring run list” with the rest of the customers

For the procedures on creating a list of target customers, see:
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Section 4.3, "Creating and Managing Lists"

Step 2: Create and Execute a Test Campaign Schedule
In this step, you will perform the following:

»  Create a parent campaign with two child campaign schedules - “test campaign
schedule’ and "primary campaign schedule’

= Attach the "test list’ to the "test campaign schedule’

= Execute the "test campaign schedule’” and collect the responses (captured within
Interaction History)

For the procedures on creating a campaign and campaign schedules, see:
ms  Section 6.2, "Creating a Campaign"

= Section 8.2, "Creating a Campaign Schedule"

Step 3: Create and Build a Campaign Response Model

A predictive model is a set of rules that can be used to determine the value of a
specific customer attribute (for example, response to a campaign) based on the
known values of other attributes.

In this step, you will:

»  Create a campaign response model

= Use the "test campaign schedule’ as training data for this model
»  Preview the data used for this response model

= Build the model

For the procedures on creating and building a model, see:

= Section 15.5.1, "Creating the Model"

= Section 15.5.2, "Selecting Training Data For Response Models Using Seeded
Data Sources"

= Section 15.5.7, "Scheduling a Build for a Model"

Step 4: Evaluate the Model Results
When a predictive model is built, the model's results are available as:

»  Lift Chart - that shows how well the model is expected to perform, that is, the
benefit of Intelligent Targeting Vs. Random Targeting
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s Performance Matrix - that provides statistical insight into the accuracy of the
Model

= Attribute Importance Report - that shows the customer attributes that have the
greatest impact on response probability

By evaluating this information, you can determine the accuracy of the model and
make adjustments to the training data to enhance the performance and predictive
power of the model.

For more information on model build results and how to evaluate the build, see
s Section 15.3, "Evaluating Model Build Results"

= Section 15.5.8, "Viewing Build Results"

= Section 15.4, "Improving Model Results"

Step 5: Create and Score a Target Population

Scoring is the process of using a predictive model to determine the future behavior
of a target population. During the scoring run, each customer record in the target
population is assigned a probability score. This score indicates the likelihood that
the customer will exhibit the target behavior. For example, respond to a marketing
campaign.

In this step, you will:

s Create a scoring run

» Identify the ’scoring run list’ for the scoring run selection

= Generate the scoring run

See Section 15.6.2, "Generating a Scoring Run" for the procedures to complete the
generation of a scoring run and generate a list.

Step 6: View Scoring Run Results

The scoring run result is divided into ten continuous deciles. Each decile has an
associated percentage range (for example 80-90%) that indicates the likelihood that
the customers within this range will exhibit the target behavior.

For the procedure to view scoring run results, see Section 15.6.2.5, "Viewing Scoring
Run Results".
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Step 7: Generate a List and Associate it to a Campaign Schedule

The scoring run results helps you narrow your target population by selecting only
those customers with a high likelihood to exhibit the "target behavior"

= Select the top customer deciles to be included in the list
= Generate this list of customers
= Associate this list to the ‘primary campaign schedule’

By intelligently targeting only those customers with a high propensity to exhibit the
target behavior, you can increase Marketing ROI by decreasing the number of
contacts and increasing the response rate.

For the procedure on generating a list and associating it to a campaign schedule, see
Section 15.6.2.7, "Generating a List Based on Decile Scores".
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4

Creating and Managing Audiences

Functions relating to creating and managing audience in Oracle Marketing can be
performed from the Audience tab.

Sections in this chapter include:

= Section 4.1, "Managing Audiences"

m  Section 4.2, "Overview of the Audience Dashboard"
= Section 4.3, "Creating and Managing Lists"

= Section 4.4, "Creating and Managing Segments"

»  Section 4.5, "Creating and Managing List Imports"

»  Section 4.6, "Viewing Organization and Person Information"
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4.1 Managing Audiences

An audience, in marketing terms, is a group of people who can be targeted for a
campaign or an event. They meet a common criteria, and can be addressed for a
specific purpose such as customer retention, cross-sell, or the launch of a new
product.

In Oracle Marketing, you will use the Audience Workbench to work with and
manage lists for your marketing activities. From the Audience Workbench, tasks for
audience management (commonly known as list management), includes:

»  Working with Lists, Segments, Workbooks, SQL queries, and List Imports using
the Audience Workbench.

s Creating and managing Person (B2C) and Organization (B2B) records using the
Person and Organization tabs.

4.1.1 Working with Audience Objects

There are several objects that you will use when you work with audiences in the
Audience Workbench. This section gives you a brief overview on each of them.

Lists

A list is a group of customers or prospects who meet specific user-defined criteria.
A list is always static. For example, from a given database, a list is created on
12-December-2003 consisting of high income customers with kids living in San
Francisco. The list contains 1000 records. On 13-December-2003, there are 50
additions to the high income category of customers in the database. However the
list, being static, continues to hold only the original 1000 entries.

List Templates

A list template is a set of conditions that has been defined by the administrator for
the purpose of creating a list. Two types of list templates are available: the Natural
Language Query (NLQ) template and the Parameterized SQL template. The NLQ
template allows you to specify the query conditions in a format that is similar to the
way you speak or converse. The Parameterized SQL template displays query
conditions as a list of parameters whose values you can enter directly.

Segments

Segments are groupings of customers satisfying strategic or tactical business rules
or criteria. A segment is dynamic. For example, if a segment is associated with a
target group in a campaign schedule, those customers meeting the segment criteria
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will be included in the list at the time of generation. Therefore, a segment always
reflects the latest data in the database. For example, from a given database, a
Segment is created on 12-December-2003 consisting of high income customers with
kids living in San Francisco. The Segment contains 1000 records. On
13-December-2003, there are 50 additions to the high income category of customers
in the database. The Segment now contains 1050 records.

Workbooks

Workbooks are created within Oracle Discoverer and contain user-defined selection
criteria for customers/prospects. A workbook can have a single or multiple
worksheets. A worksheet can be used as criteria for the generation of a list.

SQL

You can use Structured Query Language (SQL) as another method to store specific
criteria that you can dynamically use to create a list.

List Import

This is the process used to import external data, such as a purchased or rented
prospect list, into the Oracle Customer Model (TCA).

Target Groups

A Target Group is associated with campaign schedules to specify the customers or
prospects to target. You can define a target group based on list templates, lists,
segments, workbooks, or SQL.

Person
A person is an individual consumer that your business interacts directly with.

Organization:
An organization is a business or company.

Organization Contact:

An organization contact is a person who acts on behalf of or in the context of an
organization.

Creating and Managing Audiences 4-3



Overview of the Audience Dashboard

4.2 Overview of the Audience Dashboard

The Audience Dashboard is the home page of the Audience Workbench for users
with a List Manager responsibility. On the dashboard, you can monitor the
performance and metric trends of your lists, view the distribution of lists across the
various purposes, and quickly navigate to other functionalities such as creating or
updating a list. The functional flow for the tasks that a marketer can perform from
the Audience Dashboard is as follows:

»  Search for lists. See Section 17.2, "Personalizing Views in the Audience and
Campaign Workbenches" for details on the Search functionality provided in
Oracle Marketing.

= Monitor the effectiveness of your lists such as top or bottom performing lists
= Examine metric trends for your lists
= View your list distribution by purpose and most recently updated lists

= Use shortcuts to navigate to the Campaign Workbench (depending on your
responsibility)

»  Create or modify lists

The Audience Dashboard contains five main bins: List Effectiveness Report, List
Metric Trend Chart, Active Lists by Purpose, My Recent Lists, and Shortcuts.

Topics in this section include:

= Section 4.2.1, "List Effectiveness Report"
s Section 4.2.2, "List Metric Trend Chart"
= Section 4.2.3, "Active Lists by Purpose"
= Section 4.2.4, "My Recent Lists"

m  Section 4.2.5, "Shortcuts"

4.2.1 List Effectiveness Report

The information displayed within this bin is based on the view selected. The lists
appearing are associated with the target groups of active campaign schedules. The
Top and Bottom Performing Lists are out-of-the-box views. These two views are
based on the number of leads the list has generated over the period of time
specified in the view. The top performing lists will be displayed by default.

The list effectiveness is measured based upon the following metrics:
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= Responses

s Leads

= Opportunities

= Booked Order Count

= Booked Order Amount
= Invoiced Revenue

You can personalize your view to display the appropriate metrics, but additional
metrics cannot be added to the list effectiveness bin.

4.2.1.1 Personalizing the List Effectiveness Views

You can modify what is displayed in the summary, and how the information is
displayed by personalizing the view. The Personalize feature provides the
following options:

= General Properties: You can change the name of the view, specify the number
of rows to be displayed in a tabular summary, and provide a description for the
view.

s Column Properties: You can choose the columns to display in the tabular
summary, and the order in which they should appear.

= Sort Settings: You can choose three columns to sort on, and specify the sort
order.

= Search Query: You can specify the query based on which the summary is
displayed. Note, you can determine which list trend chart to show by selecting
a value for the List Metric Trend Chart here.

See Section 17.2, "Personalizing Views in the Audience and Campaign
Workbenches" for the procedure.

4.2.2 List Metric Trend Chart

The information displayed by the List Metric Trend Chart is based on the view
selected in the List Effectiveness bin. The lists appearing are associated with the
target groups of active campaign schedules. The metric trends chart bin displays a
graphical view of the trends for lists corresponding to specific metrics. You can
evaluate the effectiveness of your lists over a time period.

You can personalize your view to display the appropriate metrics, but additional
metrics cannot be added.
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Note: If the profile value for the application is set for ADA
compliance, a table with the corresponding information is
displayed above the metric trend chart.

4.2.2.1 Personalizing the List Metric Trend Chart

You can select the metrics and the time lines to be used for the display in the
Personalize definitions of the List Effectiveness bin. For example, if you wish to
view the Leads Trend chart for the last 5 days, you must select the metric value as
Leads and the Time Period as 5 Days in the personalize page of the List
Effectiveness bin.

The metric values that you can select from include:
s Leads

= Contact Group Size

= Responses

= Opportunities

= Booked Orders

= Booked Revenue

= Invoiced Revenue.

The Time Periods you can select from include Last 5 Days, Last Month, Last 3
Months, Last 6 Months, Last Year, Last 2 Years, and Last 5 Years.

See Section 17.2, "Personalizing Views in the Audience and Campaign
Workbenches" for the procedure.

4.2.3 Active Lists by Purpose

The Active Lists by Purpose bin displays a pie chart that depicts the distribution of
the active lists by purpose. Some seeded purposes are Cross Sell, Up Sell, Customer
Acquisition, Customer Retention, or any other purposes defined by your
administrator. If you are the logged in user, only your lists that are in the Available
status are considered for display. Each purpose is displayed in a different color and
the lists available for each purpose are displayed as a percentage. For example, if
you own ten lists and four of them are for the Cross Sell purpose, then Cross Sell
purpose is indicated as 40% in the pie chart.
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4.2.4 My Recent Lists

The My Recent Lists bin at the bottom of the Audience Dashboard displays details
of your recent lists in descending order based on the last date of update. You can
change the sort order to ascending by clicking the Last Updated Date column
heading. By default, five lists are displayed.

The information displayed includes List Name, Audience, Purpose, Status, and Last
Updated Date and provides you with summary data of your recent lists. You can do
the following from the My Recent Lists summary if the list is in Available status:

s Click the list name hyperlink to view the list details.
s Click the View Entries icon to view the members of a list

s Click the Create Schedule icon to navigate to the Create Campaign Schedule
page of the Campaign Dashboard where you can create and launch a marketing
activity with the list as the Target Group. The Create Campaign Schedule icon is
enabled only if the list entries are available. See Section 8.2, "Creating a
Campaign Schedule" for more information on creating a campaign schedule.

4.2.5 Shortcuts

The Shortcuts bin is displayed on the top right corner of the Audience Dashboard
and contains a list of links that you can click to perform specific tasks or navigate to
other audience functionality. The links available may vary as per the responsibility
with which you log in to Oracle Marketing. The links are:

m  Create List - Click to create a list.

= My Lists - Click to navigate to the My Lists saved search. The Lists Overview
page is displayed and you can view your lists that are not in the Archived
status.

= Search Lists - Click to display Search Lists page of the Audience tab. You can
enter the First Name, Last Name, and so on to search for a specific member, and
view the lists that the member is part of.

= Segment - Click to display the Segments page of the Audience tab where you
can define and modify the criteria for generating segments of customers for
whom specific marketing activities can be initiated.

»  Discoverer - Click to launch the Oracle Discoverer tool in a separate window.
You can define the conditions of your list in Oracle Discoverer and include
them while generating lists.

Creating and Managing Audiences 4-7



Creating and Managing Lists

Imports - Click to display the List Imports page of the Audience tab. You can
use the import process wizard to import a purchased or rented list or any other
list from an external data source. You can then use the imported customer data
to generate a list.

Campaign Workbench - Click to navigate to the Campaign Dashboard page
where you can create and launch a campaign schedule for specific target
groups. This shortcut is displayed only if your current responsibility has access
to it.

Audience Administration - Click to navigate to the Audience Administration
Dashboard. This link is displayed only if you are logged in with an Audience
Super User responsibility. As an administrator, you can create and manage list
templates and data sources from the Administration Dashboard.

4.3 Creating and Managing Lists

Working with lists is the process of analyzing, building, and managing lists of
customers or prospective customers. Lists are created for specific purposes and are
based on predefined templates or other lists, segments, workbooks, or custom SQL.
For example, for a product launch campaign, you would specifically target
customers who have earlier purchased a related product from you. To do so, you
can use seeded cross sell list templates to build an effective cross sell list of
candidates based on past orders.

Topics in this section include:

4.3.1 Overview

Use the following sections to understand the various concepts of working with lists
in the Audience Workbench.

4-8

Section 4.3.1, "Overview"

Section 4.3.2, "Creating a List Using List Templates"
Section 4.3.3, "Creating Lists Using Advanced Methods"
Section 4.3.4, "Generating Lists"

Section 4.3.5, "Managing Lists"

Topics in this section include:

Section 4.3.1.1, "Understanding Purposes"
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= Section 4.3.1.2, "Understanding List Templates"

= Section 4.3.1.3, "Understanding List Types"

= Section 4.3.1.4, "Understanding List Options"

»  Section 4.3.1.5, "Viewing the SQL Statement for a List"
s Section 4.3.1.6, "List Statuses"

4.3.1.1 Understanding Purposes

Each marketing activity is organized for a specific purpose, and hence the target
audience for it is generated according to that purpose. You can choose from the
following seeded purposes:

= General Purpose - This is a generic purpose.

s Cross Sell - When you want to sell additional products related to products the
customers have already bought.

= Up Sell - When you want to sell products to replace products already bought.

s Customer Acquisition - When you want to acquire additional customers and
expand your customer base.

s Customer Retention - When you want to build customer loyalty

s Lead Maturation - This is for sales users who want to initiate schedules to
improve lead quality

You can add more purposes in addition to the seeded ones. Based on the purpose
chosen, the corresponding list templates are available for selection at the time of
creating a list.

4.3.1.2 Understanding List Templates

A list template is a set of predetermined criteria that marketers can use to create
lists. List templates are derived from data sources, and are designed for specific
purposes.

There are two kinds of list templates - Natural Language Query and Parameterized
SQL. Benefits in using templates to generate your list are:

= Ease of use
s Knowledge of database query languages not required

= Reusability
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Created for a specific purpose that addresses marketing requirements

Restricts the criteria used to create lists based on organization requirements

4.3.1.3 Understanding List Types

Various types of lists can be used to generate the audience for a marketing activity.
These include lists, segments, and target groups.

Lists: A list is a group of customers or prospects who meet specific user-defined
criteria. A list is always static.

Segments: Unlike lists, segment are dynamic. Segments are saved queries,
which when executed, generate a list of customers based on the latest records in
the database.

Target groups: A target group is a mixture of lists, segments, workbooks, or
SQL. A target group is the audience for a campaign schedule.

4.3.1.4 Understanding List Options

As part of the list creation process, you can choose to apply list options on the final
list. In Oracle Marketing, list generation options include choosing the deduplication
rules and limit the size of the generated list.

Deduplication Rules: Deduplication rules are rules that your administrator can
set up to help you remove duplicate entries from within a list. These rules can
be set up to check for duplicates based on a combination of e-mail address, first
and last name, and so on. For information on setting up deduplication rules,
refer the Oracle Marketing Implementation Guide.

Size Restrictions: You can choose to include all the records in a list or you can
set criteria to reduce the size of the generated list. The size of a generated list
may need to be restricted because of budget or resource constraints. You can
specify that a random x% of records be included in the list, where x is a number.
For example, you may want to include only 50% of the records that match your
selection criteria in the list.

Along with the percentage, you can also specify a maximum size for the
generated list. If you have specified a maximum size for the list and if the
specified x% records results in a greater number, the maximum size takes
precedence. For example, assume a list size of 1000 entries and the maximum
size specified as 500. If you specify that 60% of the records must be included,
which is 600 records, when the list is generated it will contain only 500 records,
which is the maximum number specified in this example.
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4.3.1.5 Viewing the SQL Statement for a List

After you have defined your selections, you can view the corresponding SQL

statement generated by the system. When you modify the selections, the SQL

statement is automatically updated to reflect the changes. If you are unable to
generate the desired list, the SQL statement can be reviewed to investigate the
reasons for the inaccuracies.

4.3.1.6 List Statuses

A list can transition through the following statuses:

Draft: This status is set by the system when you are in the process of specifying
conditions for a list. It indicates that the list is not ready for use. As long as the
list is in the Draft status, you can change or add conditions, as needed.

Scheduled: This status is assigned by the system automatically when you
schedule the list for generation at a later time. At this point, the list conditions
cannot be modified unless the generation process is cancelled first.

The list can also be in the Scheduled status even if you have explicitly stated to
generate the list immediately. This is because list generation is a workflow
process and it is dependent upon when the request is picked up by the
Workflow Manager.

Generating: This status is assigned by the system automatically when the list is
being generated.

Migrating: This status is assigned by the system automatically when the list is
being migrated.

This status is particularly applicable for list generation using remote data
sources. When you generate a list using remote data sources, the list physically
resides in the remote data source after it is generated. The AMS Migrate Remote
List concurrent program can be scheduled to migrate the list to the local
instance. However, if you are generating a target group using remote data
sources, the migration will happen immediately after the generation in the
remote instance is completed. During the migration, the list has the status of
Migrating.

Available: This status is assigned by the system automatically when the list has
been generated or migrated successfully. When the list is in the Available
status, you can view the entries or update the conditions.
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= Failed: This status is assigned by the system automatically when the list
generation or migration has not been successful or when the you cancel the
generation process.

= Locked: This status is assigned by you when you do not want any changes to be
made to a list.

= Archived: This status is assigned by you when you do not want this list to be
used any longer. An archived list is not available for selection.

4.3.2 Creating a List Using List Templates

To create a list, you can use either the Standard or Advanced methods. For the
Standard method, you will be using list templates. Depending on your audience
and purpose, you can select a template set up by your administrator.

The two types of list templates that can be configured by an administrator are:
= Natural Language Query
s Parameterized SQL

4.3.2.1 Creating a List Using Natural Language Query

Using the Natural Language Query (NLQ) template, conditions can be specified just
as you would naturally think of them. You can define your selection criteria by
selecting the operator and the corresponding value for each condition. Following is
a sample query to generate a list of customers who may be interested in buying
high-end electronic toys in the state of California for their children. This is what the
query template will look like:

Customers whose state of residence is name of state

And whose annual income is greater than amount

And have children is yesno

In the above example:
= is, is greater than are the operators you can enter by clicking on the link

= name_of_state, amount, and yes/no are the values of the condition that you can
enter by clicking on the link

s The words and phrases not underlined are the pre and post text included in the
selection to make it readable.
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The word "and" is supplied by the system.

The following is an example with values selected for the above template selection. If
necessary, operators can be changed. In the example, the "is greater than" operator
has been changed to "is between".

Customers whose state of residence is California

And whose annual income isbetween 50000 and 95000

And have children is Yes

Prerequisites
None

Steps

1.

@ o » w N

Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

Click the Create List link from the Shortcuts bin.

Enter a name for your list, select an audience, and a purpose.

From the List Creation Method region, select Standard.

Using the search icon, select a Standard template to base your query on.
Click Continue.

Any mandatory and/or default conditions defined for the template that you
have chosen is displayed. Mandatory conditions cannot be removed.

Click the hyperlink on the operator and condition value to modify it.
Repeat this step until all conditions are filled. You must fill in all the conditions.
To add or modify the selection conditions, click Modify Selections.

You can add more conditions. However, the selections displayed is restricted to
your template definition.

To view a sample of the entries that will be selected when the list is generated,
click Preview Entries.

Note: This may take some time. Please wait till the process is complete.

10. To view the project running total when the list is generated, click Recalculate.
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This number gives you an idea of how many records will finally be selected
when the list is generated.

Note: This may take some time. Please wait till the process is complete.

11. To define what to include in or exclude from the list, click List Options.
For more information on List Options, see Section 4.3.1.4, "Understanding List
Options".

12. To view the SQL statement for this query, click SQL Statement.

13. To save the selections, click Finish.

The Generation subtab appears. At this point, you have only defined the list
selection criteria. The list must be generated before proceeding to step 14 and
15. For more details on generating a list, see Section 4.3.4, "Generating Lists".

14. To view the entries in the list, click the Entries subtab.

The list entries can be viewed only if it is generated successfully and is in the
Available status. For information on other options in this subtab, see
Section 4.3.5, "Managing Lists".

15. To view charts of how the entries are distributed based on the selected
conditions, click the Charts subtab.

The charts can be viewed only if the list is generated successfully and is in the
Available status. For more information, see Section 4.3.5.3, "Viewing Customer
Attribute Charts for a List".

16. To create or view notes, click the Notes subtab.

4.3.2.2 Creating a List Using Parameterized SQL

The Paramaterized SQL List template is based on a SQL statement with parameters
provided by your administrator. The selection parameters are presented, and you
must enter the values for the parameters while creating the list.

In the Parameterized SQL template, the selections are displayed as a list of
parameters whose values you can enter directly. For example, if the purpose for the
list is Cross Sell and the selected list template is Cross Sell Based on Orders, the
parameters to be specified can be Product, Cross Sell Product, Date of Purchase,
Order Amount Greater Than, and Contact Job Title.

Note: The condition between the parameters will always be AND
when using the parameterized SQL.

4-14 Oracle Marketing User Guide



Creating and Managing Lists

Prerequisites
None

Steps

1.

a & w0 Db

10.

11.

12.

Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

Click the Create List link from the Shortcuts bin.
Enter a name for your list, select an audience, and a purpose.
From the List Creation Method region, select Standard.

Using the search icon, select a Parameterized SQL template to base your query
on.

Click Continue.
The Selections region displays the parameters defined for this template.

Enter values for the parameters, or select them from a drop-down list or a list of
values.

To define what to include in or exclude from the list, click List Options.

For more information on List Options, see Section 4.3.1.4, "Understanding List
Options".

To view the SQL statement for this query, click SQL Statement.
Click Finish.

The page refreshes, and the Generation subtab appears. At this point, you have
only defined the list selection criteria. The list must be generated before
proceeding. For more details on generating a list, see Section 4.3.4, "Generating
Lists".

Optionally, to view the list generated based on your query, click Preview
Entries from the Selections tab.

Note: The result for this action may take some time. Please wait till the process
is complete.

Optionally, to view the number of entries in the list, click Preview Count from
the Selections tab.

Note: The result for this action may take some time. Please wait till the process
is complete.
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13.

14.

15.

To view the entries in the list, click the Entries subtab.

The list entries can be viewed only if it is generated successfully and is in the
Available status. For information on other options in this subtab, see
Section 4.3.5, "Managing Lists".

To view charts of how the entries are distributed based on the selected
conditions, click the Charts subtab.

The charts can be viewed only if the list is generated successfully and is in the
Available status. For more information, see Section 4.3.5.3, "Viewing Customer
Attribute Charts for a List".

To create or view notes, click the Notes subtab.

4.3.3 Creating Lists Using Advanced Methods

Advanced list creation offers unlimited flexibility to create lists. You can create a list
based on different Source Types. The source type can be a list, segment, Oracle
Discoverer workbook, custom SQL, or an imported list. For each source type, you
can select an instance of the source type and base the new list on it.

When using advance methods, it is possible to include a combination of source
types to arrive at a complete list. If you are a knowledgeable SQL user, you can also
formulate your own SQL query to create a list.

When a source type is selected, it is displayed in the Selections area. You can select
multiple lists with a combination of source types. The selected source types are
displayed in a tabular format. The columns of this table are described below:

Action: You have a choice of three- Exclude, Include, and Intersect.

s Choose Include when you want to add the entries to the final list you are
creating.

s Choose Exclude when you want to remove the entries from the final list
you are creating.

s Choose Intersect when you want to include only the common entries with
other include entries to the final list.

When there are multiple source types selected, some prospects may be
members of more than one list. In such a case, you can decide which list the
common members must be included or excluded from. Sometimes, you can
choose to intersect with another list. As a result, only common members will be
selected as part of the resultant list.
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Note: Only the Include action is available for the source type in
the first row.

Name: Displays the name of the source type that you selected. The name is a
hyperlink that you can use to navigate to the details page.

Type: Displays the source type of the object selected. It could be List, Segment,
Workbook, Import, or Custom SQL.

Size: Displays the size of the list, segment, or import selected. The size
information will help you decide how many records you actually want in your
list. Because a segment is dynamic, the size will only be as current as the last
time the segment was refreshed. The size column will only display values for a
list, an import list, and a segment.

% Requested: You can enter a value to indicate what percentage of the selected
object must be included when your list is generated. Based on the percentage, a
random selection of records is included in the list. This option is applicable only
for the Include and Intersect actions.

Dedupe Rank: When multiple objects are selected for list creation, and you
have selected Include as the Action, you can enter a number to indicate from
which object a record must be included, in case duplicates of the record exist in
more than one location. For example, if Listl and List2 are two lists you have
included for your list generation and you specify Dedupe Rank as 1 for List1
and Dedupe Rank as 2 for List2, if a record is found to exist in both lists, the
record from List1 will be included in the final list because List1 has higher rank
than List2.

# of Duplicates: Displays the number of duplicates that were identified in the
selected object during list generation. Duplicates are identified based on the
deduplication rule.

Running Total: Displays the number of records included. After each Include
operation, the deduplication rule is applied and the resulting number of records
are cumulated. For example, if you select two lists and both are Include
operations, the Running Total for row one will the number of unique records
from the first list and the Running Total for row two will be the cumulation of
the unique records of row one and unique records of row two. To display the
Running Total, click the Recalculate button. The running total does not take
into account the deduplication rule when the Recalculate button is clicked.
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= Delta: Displays the difference between the Running Totals of the current row
and the previous row.

4.3.3.1 Creating a List using the Advanced Method

Use the following procedure to create a list using an existing list, segment,
workbook, imported list, or SQL.

Prerequisites
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

Click the Create List link from the Shortcuts bin.
Enter a name for your list, select an audience, and a purpose.
From the List Creation Method region, select Advanced.

Click Continue.

@ o » w N

In the Selections region, from the Add drop-down list, select the source type for
your list. Only sources of the same audience are displayed when you click the
Go button for the steps below.

a. To create a list from an imported list, select Import List, and click Go. To
import a list, see Section 4.5.2, "Importing a List".

b. To create a list from an existing list, select List, and click Go.

c. To create a list from an existing segment, select Segment, and click Go. To
create a segment, see Section 4.4.2, "Creating a Segment".

d. To create a list from a Discoverer workbook, select Workbook, and click Go.
For more information on workbooks and how to create them, see the Oracle
Discoverer User Guide.

e. To create a list using a SQL query, select SQL, and click Go. See
Section 4.3.3.2, "Creating a Custom SQL" to create a custom SQL statement.

One or more of the above sources can be used to create a list.

7. To Include, Exclude, or Intersect entries in a list source, select the appropriate
option from the Action column.
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10.
11.

12.

13.

14.

15.

16.

This first action must always be Include.
To calculate the number of entries from each source, click Recalculate.

A concurrent request is submitted to calculate the number, and the request ID is
displayed. You must return to this list at a later time to view the result.

To change the order of the sources, click Reorder. Using the up and down
arrows, reorder your selections and click Apply.

To delete a list source from the selection, click the icon from the Delete column.
To define the list deduplication or limit the size of the list, click List Options.

For more information on List Options, see Section 4.3.1.4, "Understanding List
Options".

Click Finish.
The page refreshes, and the Generation subtab appears.

Use the Generation subtab to generate the list. See Section 4.3.4, "Generating
Lists" for more information.

Click the Entries subtab to view the entries in the list.

The list entries can be viewed only if it is generated successfully and is in the
Available status. For information on other options in this subtab, see
Section 4.3.5, "Managing Lists".

Click the Charts subtab to view how the entries in the list are distributed based
on selected attributes.

The charts can be viewed only if the list is generated successfully and is in the
Available status. For more information, see Section 4.3.5.3, "Viewing Customer
Attribute Charts for a List".

Click the Notes subtab to create or view notes.

4.3.3.2 Creating a Custom SQL

While creating a list using the Advanced method, you can create a custom SQL
statement. If you are a knowledgeable SQL user, you have the flexibility to create
your own query. Unlike a template, you do not have any restrictions, and can
generate any kind of lists.

Use the following procedure to define the SQL statement.
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Prerequisites
Knowledge of SQL

Steps
1. Follow the steps to create a list using the advanced method. See Section 4.3.3.1,
"Creating a List using the Advanced Method" for the procedure.

2. Choose SQL as the source type to create your list.
3. Click Create Custom SQL.

4. Enter a name for the SQL statement, select the table or view name, and the
unique identifier for the query.

5. Enter the SQL statement for the query.

This must be a valid SQL statement and at least one master type data source
key should exist in your select statement. A sample statement is given below:

Select 'PERSON_LIST’, AMS_PERSON_DETAILS_
V.party_id from AMS_PERSON_DETAILS_V where
rownum < 100

Note: The SQL statement cannot contain “Order By” or “Group By” clauses
within it.

6. Click Validate SQL.

7. Click Apply.

This SQL query can now be used as a source type to create a list.

4.3.4 Generating Lists

When a list is generated, customer records satisfying the list conditions are
populated in the list. A list can only be generated after all the conditions have been
specified. The amount of time it takes to generate a list depends on several factors
such as the size of the database and the system environment condition at the time a
list is being generated.

Generation Types
You can also choose from three Generation Type options:
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s Full Refresh: Choosing this option will result in a new list, if the list is
generated for the first time, or remove all previous entries and replace with new
entries if the list has previously been generated.

= Append New Records: In this mode of list generation, all the list entries and
information about those entries from the previous generation will be retained.
New entries that meet the specified selection criteria will be added to the
existing list. Using this generation type could result in the list entries and
information about those entries not matching the selection criteria completely.

= Update Attributes Only: In this mode of list generation, if any modifications
are made to the customer attributes in the corresponding data source or
Audience, those changes are updated within the list entry records. For example,
if the Audience is Organization Contacts and changes are made to the customer
attributes in the Oracle Customer Model (TCA), the latest information about the
entries will also be updated in the list. Using this generation type could result in
the list entries and information about those entries not matching the selection
criteria completely.

Schedule a List Generation

When you are satisfied with the conditions specified for the list, you can choose to
schedule it for generation. A list can be generated immediately or at a future time.
For generating at a future time, the system defaults to 12am the next day. For
example, if the system date is 07/17/03, list generation is scheduled for 07/18/03 at
12:00 a.m. You can choose to change the default date and time for list generation.

List Generation Log

As a list is being generated, the system logs messages in a log that you can view to
track the progress of list generation. Additionally, when the status of a list changes,
the system logs the change in the log. Log messages are stored in descending order
of date, that is, the latest log message is at the top of the list; you can reorder the log
to display it in ascending order of date.

4.3.4.1 Generating a List
Use the following procedure to specify the generation type and time to generate a

list.

Prerequisites
You must have specified the conditions for the list.
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Steps

1.

a0 DN

7.

Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

Click the My Lists link from the Shortcuts bin.
Click the hyperlink of the name of the list that you want to generate.
Click the Generations subtab.

To define how you want to generate the list, select from the Generation Type
drop-down list.

To specify when you wish to generate the list:

a. To generate the list at a future time, specify a date.
By default, the time is set to 24 hours from now.

b. To generate the list, click Generate List.

If you wish to view the status of the list generation, refresh this page by
clicking the Refresh button on the browser. The list status does not change
on its own. This is particularly useful if you have chosen to generate the list
immediately.

Optionally, click Log to view the log created during list generation.

4.3.5 Managing Lists

After a list is generated, you can view the entries it retrieved, modify its conditions,
split a list into two or more lists, merge two lists, and so on. You can manage lists
from the List Summary and detail pages.

Sections include:

Section 4.3.5.1, "Modifying List Conditions"

Section 4.3.5.2, "Exporting a List"

Section 4.3.5.3, "Viewing Customer Attribute Charts for a List"
Section 4.3.5.4, "Splitting a List"

Section 4.3.5.5, "Merging Lists"

Section 4.3.5.6, "Deleting a List"

Section 4.3.5.7, "Creating Campaign Schedules from a List"
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4.3.5.1 Modifying List Conditions

You can modify the conditions specified for a list. Based on the new conditions, you
can recalculate the number of entries in the list.

Use the following procedure to modify the conditions for a list. Depending on how
the list was created initially, the procedure for modifying a list can vary slightly. See
the appropriate list creation procedure for more information.

Prerequisites
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

Click the My Lists link from the Shortcuts bin.

To modify a list, click the hyperlink of the name of the list.

Make the necessary modifications to the selection criteria of the list.
Click Apply.

Optionally, to generate the list, click the Generation subtab.

N o g & 0 Db

Optionally, to view the entries, click the Entries subtab.

4.3.5.2 Exporting a List

You can export a list to:
= share it with external parties who may not have access to the application
= modify it offline and import it back into the application

A list is exported in the form of a single .csv file. The columns in the file include the
currently displayed columns for the list and all Enabled columns, whether they are
displayed or not.

Use the following procedure to export a list.

Prerequisites
The list must be generated, and must have entries in it.
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Steps

1. Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

Click the My Lists link from the Shortcuts bin.

Click the hyperlink of the name of the list you want to export.
Click the Entries subtab.

Click Export List.

a0 DN

A message appears asking you whether you wish to open the file or save it.
6. Select the required option.

The list is exported as a .csv file, and opens in Microsoft Excel.

4.3.5.3 Viewing Customer Attribute Charts for a List

The Charts page helps you to understand and quickly analyze grouping of the
customer within your list. You can decide based on the chart analysis if adjustment
to the selection criteria is required. Four charts can be displayed at one time. The
chart can be of Pie, Column, or Bar format.

Your administrator can specify which attributes to chart as well as define the
default chart format to display. You can select different attributes and different
chart types for display and analysis if the default does not suit your need. For
example, in a B2B scenario, you may want to analyze the customer distribution by
industry in a list and in a B2C scenario, you may wish to understand customer
distribution by household incomes.

The administrator can also define chart ranges for the attributes. For example, for
the chartable attribute Household Income, the administrator can define chart ranges
as follows - Less than 50000, Between 50000 and 100000, Between 100000 and
250000, and Greater than 250000. When you view the chart, list entries are grouped
on these ranges.

Use the following procedure to modify chart options.

Prerequisites
The list attributes must be defined as Chartable by the administrator.

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.
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Click the My Lists link from the Shortcuts bin.
Click the hyperlink of the name of the list you want to view the chart for.
Click the Charts subtab.

o © Db

To change the attribute for the chart, select an attribute from the Attributes
drop-down list.

The page refreshes to display the chart based on the new attribute.

6. To change the format of the chart, select the format from the Chart Format
drop-down list.

7. Optionally, to split the list based on a selected attribute, click Split.

4.3.5.4 Splitting a List

Lists may need to be split into smaller lists for campaigns that have multiple phases,
each designed to target customers with slightly different profiles. Splitting a list
results in significant time saving as compared to generating them separately. For
example, for an electronic toys product launch campaign, a list containing high
income customers in California may need to be split to generate a list of high
income customers with children and without children.

When you split a list, multiple lists are created from it. You can split a list using one
of the following three methods. The entries for the new lists are chosen randomly.

= Split by Percentage: You must enter the percentages based on which the split
lists will be created. For example, if the original list contains 1000 entries, and
you indicate that it must be split into two lists, with the first list containing 75%
of entries and the second 25%, it results in the first list containing 750 entries
and the second list 250 entries.

= Split by Number: You must enter the actual sizes of the resulting lists as
numbers. For example, for a list containing 1000 entries, you can indicate that
the first list will contain 750 and the second will contain 250 entries.

= Split by Attribute: You can select the attribute based on which the list will be
split. For example, you can choose to split the original list based on the Industry
attribute resulting in a set of lists, each containing the entries for a particular
industry.

Only those attributes that are defined as Use for Split by the administrator
during data source definition are available for splitting a list. A list can be split
based upon the attribute LOV or chart definition.
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For example, for the Industry attribute, the list of values may be Automotive,
Health Care, and IT. The split lists will be one for each industry.

For the Attribute Household Incomes, a chart range may be defined. The chart
ranges defined may be Less than 50000, Between 50000 and 100000, Between
100000 and 250000, and Greater than 250000. The original list will be split into
four lists, with each chart range being the condition for the split for the
respective list.

For more information on data source definition, see the Oracle Marketing
Implementation Guide.

Use the following procedure to split a list.

Prerequisites
The list must be generated, and must have entries in it.

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

Click the My Lists link from the Shortcuts bin.

You can also split lists from the Entries subtab as well as the Charts subtab.
From the Split column, click the icon for the list you want to split.

Select the method to split, and click Continue.

If you have chosen to split by percentage:

a. In the Split List Name column, change the name of the list, if required.
b. In the Percentage column, enter the percentage number for each sublist.

For example, for the list to be split into two with 50% in each, enter 50 for
two sublists.

c. Toadd arow, click Add Another Row.

Add more rows if you are splitting the list into more than five.
d. Click Apply.

The sublists are created as individual lists.
If you have chosen to split by number:

a. In the Split List Name column, change the name of the list, if required.
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b.

In the Number column, enter the number for each sublist.

For example, for the list (that has 100 entries) to be split into two, enter 50
for two sublists.

To add a row, click Add Another Row.
Add more rows if you are splitting the list into more than five.
Click Apply.

The sublists are created as individual lists.

If you have chosen to split by attribute:

a.

From the Split By Attribute drop-down list, select the attribute to split the
list by.

Only those attributes that are defined as Use for Split by the administrator
during data source definition are available for splitting a list.

Click Continue.
In the Split List Name column, change the name of the list, if required.
Select the condition for the attribute.

For example, if you are splitting by the City attribute, you can select Equal
To.

Enter a value for the attribute in the Values column.
For example, New York.
To add a row, click Add Another Row.

You may need to add more rows if you are splitting the list into more than
five.

Click Apply.

The sublists are created as individual lists.

4.3.5.5 Merging Lists

When two or more lists are merged, a single list is created. Only lists that are
already generated, have the same audience, and are in the Available status can be
merged.

The final merged list may not contain the sum of the individual lists. This is because
the records with the same Party Id are automatically deduped. This is in addition to
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using the dedupe rule. In this case the whole is not always equal the sum of the
parts.

Use the following procedure to merge lists.

Prerequisites
The list must be generated, and must have entries in it.

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

2. Click the My Lists link from the Shortcuts bin.
3. Select two or more lists to merge, and click Merge.

The lists selected to be merged are displayed in the Merge page.
4. Enter a name and description for the new list.

5. For some entries from each list to be merged, enter a number in the %
Requested column for each list.

6. Click Apply.

See Section 4.3.3.1, "Creating a List using the Advanced Method" for steps to
complete creating the list.

4.3.5.6 Deleting a List

You can choose to delete one or more lists. If a list is used in a Campaign or Event
schedule, and the schedule is still active, the list, as an independent object cannot be
deleted. However, the list can be removed from the schedule.

Prerequisites
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

2. Click the My Lists link from the Shortcuts bin.
3. To delete a list, select the list, and click Delete.

4-28 Oracle Marketing User Guide



Creating and Managing Segments

4. If you do not want a list to be deleted, clear the selection in the Delete column.

5. Click Apply.

4.3.5.7 Creating Campaign Schedules from a List

When you choose to create a campaign schedule from the Lists page, the creation of
a new campaign schedule is launched, and the entries in the selected list become
candidates of the target group. When the target group is generated, the entries may
be a smaller set after suppression criteria and fatigue rules are applied.

When you create a campaign schedule from a list, the list’s Purpose will
automatically become Campaign Schedule. You can create a campaign schedule
from a list only if the list contains at least one entry.

To create a campaign schedule from a list, click the icon from the Create Campaign
Schedule column in the Lists page.

For information on how to create a campaign schedule, see Section 8.2, "Creating a
Campaign Schedule".

4.4 Creating and Managing Segments

Market segmentation is a methodology for identifying groups of customers, or
prospects that satisfy business-defined strategic or tactical criteria. For example, a
car manufacturer may need to identify different types of consumers based on
lifestyle preferences to segment their car buying market accordingly. Once
segments are identified, marketers may develop specific marketing programs that
will uniquely target each segment.

Topics in this section include:
m  Section 4.4.1, "Segments Overview"

= Section 4.4.2, "Creating a Segment"

4.41 Segments Overview

Segmentation criteria can be saved and used as the basis for list, or target group
generation. For example, a segment could be defined for Credit Card dormancy,
based on the date of the last customer purchase transaction.

Segments can be created using either a Oracle Discover workbook, or a SQL
statement. Unlike a list, which has a fixed set of entries, the entries within a segment
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may differ over time as customers and prospects migrate in and out of the segment
as they satisfy/dissatisfy the business criteria on which the segment is based.

The segment summary page displays all the segments that you have created within
Oracle Marketing. You can personalize the attributes on this page by clicking the
Personalize button.

Segment Hierarchies

Segments can be organized into a segment hierarchy, in which each child segment
contains a subset of the entries in their parent segment.

Consider the following example:
Segment A: All customers in the organization’s customer database
Segment B: High income families
Segment C: High income families with kids

Segment B is defined as a child segment of Segment A, and Segment C is a child
segment of Segment B.

The segment hierarchy for the above example is depicted in Table 4-1.

Table 4-1 Segment Hierarchy Example

Segment Segment Segment Segment Segment

Name Criteria Count Hierarchy Condition

Segment A All Customers 100,000 N/A N/A

Segment B High income 25,000 Child Segment of | Intersection of
families Segment A Segment B and

Segment A

Segment C High income 10,000 Child Segment of | Intersection of
families with Segment B Segment C and
kids Segment B

4.4.2 Creating a Segment

When you create a segment, you can either choose to base it on an Oracle
Discoverer Workbook or write your own SQL statement. If you choose Workbook,
the associated SQL statement for the Workbook is displayed in the SQL section.
This SQL statement is not editable. If you choose SQL, you must enter the SQL
statement in the SQL text field.
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Valid Segment Queries

A valid SQL query (from Oracle Discoverer Workbook or directly typed in Oracle
Marketing) must meet the following conditions.

»  The query statement must be formatted correctly.
»  The setups that map the results of the segment to a list must be complete.

= The query must contain a data source code for mapping. The code for a data
source is entered by the administrator while creating it.

s The query must contain a unique identifier for the data source.

s The query must contain Country if Address 1 is included.

s The query must not contain Order By or Group By clauses within it.
A minimal SQL statement for creating a list will be:

Select '<data source code>', <unique identifier> from <data
source object>

In the above example, if the data source’s code is 'EXAMPLE_DS', the correct
segment query will be:

select 'EXAMPLE_DS', party name, party_id from hz_parties

Note: Do not enter ; at the end of the SQL statement.

When a segment query is not valid for list generation, the following error message
is displayed:

"Error: Cannot create list based on this segment. Please
recheck the sgl segment'

For the query to execute correctly and create a list with entries in it, a data source is
required.

Data Sources

A data source provides a mapping of an underlying data table or view to the
marketing list entries table. This mapping provides the AMS: List Generation
concurrent program with instructions on how to insert results from the query into
the AMS_LIST_ENTRIES table. Many data sources are pre-defined, and can be used
as templates. You can also create new data sources.
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Use the following procedure to create a segment using a Discoverer Workbook or
SQL.

Prerequisites
None

Steps

1.

a & 0N

10.

11.

Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

Click the Segments link from the Shortcuts bin.

Click Create.

Enter a Segment Name and a Segment Code.

To create a segment hierarchy, select a parent segment.

The current segment definition will be a child of this parent segment.
The initial status will be Draft.

The Available status implies that the segment is available for lists and target
groups. The Cancelled status implies that the segment is not available for lists
and target groups.

Select the Type.
If the Type is Workbook, click the Search icon to select a Workbook.

If the Type is SQL, enter a data source name, and then enter a SQL statement in
the SQL field.

Enter a Description.
Click Create.
The segment is created and is in the Draft status.

Optionally, to view the number of entries for this segment, click Preview
Count.

The Segment Size appears.
Optionally, from the Segments summary page:

a. To view the hierarchy for a segment, click the icon from the View Hierarchy
column.
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b. To create a list using a segment, click the icon from the Create List column.

¢. To modify the selections for a segment, click the hyperlink of the name of
the segment.

4.5 Creating and Managing List Imports

This is the process used to import external data, such as a purchased or rented
prospect list, into the TCA

Oracle Marketing offers a list import process, enabling marketers to map an external
data source, such as a purchased or rented list, or an existing customer database, to
destination target fields either within the Oracle Customer Model or a staging area
within Oracle Marketing (for rented lists).

Topics in this section include:
Section 4.5.1, "Overview of List Imports"

Section 4.5.2, "Importing a List"

4.5.1 Overview of List Imports

The List Import feature enables you to enrich your customer data with purchased
lists and also consolidate the customer data from legacy systems. This feature
facilitates the importing of:

= Prospects for marketing campaigns

»  Customers into the Oracle Customer Model (TCA)

= Leads for following up by Oracle TeleSales

= Event registrants for processing in Oracle Marketing’s event module

The list import process imports records (in .csv or .xml format) from a client
desktop, server or an ftp site. For additional details of importing from a server or
ftp site, refer the Oracle Marketing Implementation Guide.

The list import process is in the form of a wizard that guides you through the
process of importing a rented or purchased list of prospects. The steps in the wizard
include:

1. Selecting the Import Type (Persons, Organization Contacts, Leads, Event
Registrants)

2. Specifying the location of the file
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3. Mapping the fields between the source file and the destination columns (for a
list of fields that can be imported, refer the Oracle Marketing Implementation

Guide)

4. Importing the list import table with the source data

Once the records have been imported, they can be used for campaign or event

target group generation.

Rented vs. Purchased Lists

During the import process, you can specify if the source for the import data is from
a Rented or Purchased list. Table 4-2 highlights the difference in processing for

these two sources.

Table 4-2 Rented vs. Purchased Lists

Rented List

Purchased List

Data stored within a staging area (AMS_
LIST_ENTRIES) in Oracle Marketing

Data stored within the staging area and are
added to the Oracle Customer Model (TCA)

Dummy, inactive records created in Oracle
Customer Model (TCA) for the
corresponding records

Corresponding customer information is
inserted into the Oracle Customer Model
(TCA)

Rented records are purged based on usage
or expiry date

Purchased records are not purged and are
maintained within the Oracle Customer
Model (TCA)

4.5.2 Importing a List

Procedures in this section include:

Section 4.5.2.1, "Importing Using the List Import Wizard"

Section 4.5.2.2, "Viewing List Import Results"

Section 4.5.2.3, "Handling List Import Errors"

4.5.2.1 Importing Using the List Import Wizard

The list import wizard walks you through the process of importing a rented,

purchased, or other lists.
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Prerequisites

A flat file (.csv format) or an .xml file, located in your computer, a server, or an ftp

site. The .xml file format applies only to Organization Contacts (B2B) and Persons
(B2C).

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

Click the Imports link from the Shortcuts bin.

Click Create to start the Import Wizard.

Select the Import Data Type.

By default the Organizations, Contacts, Addresses option is checked.

You can either click Next to continue the import process or you can click Setup
to configure the default import mapping and the fields that are to be exposed
during Import Preview.

s If you click Next, then proceed to step 6 of this procedure.
»  If you click Setup:

a. Specify the default import mapping for .csv or .xml files. By specifying this
default mapping for an import type, you do not have to configure the
mapping during the list import wizard process. The default import
mapping for an import data type will be automatically applied to the
import process.

b. From the Preview Selection region, select the fields that are to be exposed
during the import preview, by selecting the Available Fields to the Exposed
Fields section.

c. Click Apply to apply the changes.
d. Click Return to return to the import wizard.

On clicking Next to continue the import process, the Import Step 1a: Definition
page appears.
a. Enter a unique name and description for the Import.

b. In the Source File region, select the location for the source file.

*  Choose Client if the source file is located on your computer, and click

Go to browse for the location of the source file.
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*  Choose Server if the source file is located on a server.

It must be located in the directory specified by your System Adminis-
trator. Refer to the Oracle Marketing Implementation Guide for additional
information for server side imports.

*  Choose FIP to specify an FITP address for your source file.

Also provide your user name, password (to access the file) and the file
name.

Select the Character Set for your import source file.

By default this is set to “Western ISO-8859-1". You can also choose from
European (ISO-8859-2), Japanese (SHIFI-]IS), and so on.

Specity the column delimiter for your source file.
By default this is set to “Comma”. For a .csv file, choose Comma.
Select the Field Enclosed By for your source file.

By default this is set to “Double Quotation”. For a .csv file, choose Double
Quotation.

Select the File Header Exists check box, if the file has a header row.

When you check this, make sure that the first line of your file has the
column headings (field names).

Select a deduplication rule that needs to be applied while generating this
import.
The deduplication rule will directly be applied only on the source file that is

being imported. The deduplication rules can be configured by your System
Administrator.

Check the Use Word Standardization check box to apply Word
Standardization Rules on the import data.

Word Standardization is used in the deduplication process. For example,
when the Word Standardization is checked, the words ‘Street” and “St.” are
treated the same. The Word Standardization rules can be configured by
your System Administrator.

Click Next to proceed to the next step of the import wizard.

7. Enter Additional Details for the import:

a.

Select the source for your import.
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Enter a Vendor and Cost. These are optional entries.

If you choose a Rented List as your source, you must enter either an
expiration date or the number of uses.

*  Number of Uses: The number of uses for a rented list is based on the
number of campaign schedules that are made Active using a particular
rented list.

*  Expiration Date: You need to run the AMS: Purge Imported List
concurrent program to purge the entries of the Rented List after the
expiration date. If the source chosen is other than a rented list, this is an
optional entry.

Click Next to save and continue the import process.

The Import Mapping page appears. If a default mapping has been specified
through the Import Setup, then this page will not be displayed.

In the Import Mapping section, you can specify the mapping between the
source fields to target fields.

You can load an existing mapping to map the source and target fields. This is
beneficial if the source file has to be imported regularly.

You can also manually map the source and target fields and enter a unique
mapping name in the Save New Mapping field. This will create a reusable
mapping that can be loaded using the “Load Existing Mapping” field.

a.

To do the mapping, select an item from the Source Fields column and the
corresponding item from the Target Fields column, and click > to move the
field mapping to the Mapping: Source => Target column.

Continue until all desired fields are mapped.

To remove an existing field mapping, highlight the item mapping in the
Mapping: Source => Target column and click the <.

This removes the field mapping. For a complete listing of the Target Fields
that are available, refer to the Oracle Marketing Implementation Guide.

See the Preview field for the data from the import file.

Click Next to save the changes on this page and move to the next step of the
import process. If a name for the new mapping is provided, then the new
mapping will be saved.

The Import Step 3: Review page appears.
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9. Review the import information.

a. Inthe General region, you can specify the error threshold number for this
import.

The Error Threshold identifies the maximum number of errors that can
occur during list import. For example, if Error Threshold = 100, it implies
that there can be a maximum of 100 errors before the list import stops
processing additional import records. Records prior to the error threshold
being reached will be imported using the regular import logic.

b. To update existing records, select the Record Update box.

The list import process uses the existence checking rules to match the
records in the import source file to the Oracle Customer Model (TCA). If a
match is found, then the customer record in the Oracle Customer Model
(TCA) is updated with additional information from the source file. If this
field is cleared, then the import source file records are inserted into the
Oracle Customer Model (TCA) even if a match exists between the Oracle
Customer Model (TCA) record and the import source file.

c. Tovalidate the data, select the Validate Data box in the Validate region.

For example, date fields can accept data only in the date format, data for a
field with a list of values should contain one of the values specified, and so
on.

d. To automatically generate a list upon import, select the Generate a List
upon Import box.

By default, this field is cleared. If you select this field, you must provide the
List Name. By default, the List Name has the same name as the Import
name. You can overwrite the default List Name.

e. To preview the data being imported, click the Preview button.

The fields that are displayed in the Preview page are based on the “Exposed
Fields” that are set up in the Import Setup page. By default, the mandatory
fields are always displayed as part of the Preview page

f. After reviewing the details on this page, click Import to begin the import
process.

A confirmation page appears.

g. Click Finish to return to the Import Summary Page where the import
results can be viewed.
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h. Optionally, click New Import to import data from a new source file.

4.5.2.2 Viewing List Import Results

The Imports summary page displays all imports with their Type, Status, ID,
Creator, Import Date, Number of Records and Log.

Prerequisites
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

Click the Imports link from the Shortcuts bin.
To view details of an import, click the hyperlink of the list import name.

To view the log for an import, click the Log icon.

a & 0N

See the Status column for the result of your import.

4.5.2.3 Handling List Import Errors

If there is an error during list import, then the status of this import will be “Error”
(if no import records were successfully imported) or “Incomplete-Errors” (if some
of the import records were successfully imported). You can drill down into the
import results to obtain additional information about the errors (for example
number of error records, number of duplicate records).

Additionally, within the context of a list import error results, the Search feature
enables you to query results based on certain key attributes like first name, last
name and so on.

Prerequisites
= Animport error while importing data from a source file to Oracle Marketing

»  The status of the import is “Error” or “Incomplete-Errors”

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and access the
Audience Dashboard.

2. Click the Imports link from the Shortcuts bin.
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3. Click the hyperlink of the list import name.

The Import Details page summarizes the details of the import and the import
error results.

4. To obtain additional information about the error, in the Results region, click the
Number of Error Records link.

The error records page has hyperlinks to the individual error records, the row
number of the error record in the source file, the status of the error record and a
brief description of the respective error.

a. Click on the corresponding error record hyperlink to view the error details
for the respective error record.

The incorrect values for the import fields are highlighted with reason for its
failure. Errors can arise due to mismatches in data type, no import data for
a mandatory field in the system, or if the import value does not match the
lookup values for the corresponding data field.

b. Correct the identified errors and click Update to directly update the error
record.

This record is now ready to be imported again.

c. In the Import Details page, click the Reload button to import the updated
records into the Oracle Customer Model (TCA).

5. To identify the duplicate records during list import, in the Results region, click
the Number of Duplicate Records link.

The duplicate records page has hyperlinks to the individual duplicate records.
Click on the corresponding duplicate record to view the details.

a. Modify the data to make this record unique and click Update to directly
update the record.

b. In the Import Details page, click the Reload button to import the updated
records into the Oracle Customer Model (TCA).

6. To query the import results, click Search.

You can search based on Load Status (Error, Active, Duplicate, Reload,
Success), Load Date, First Name, Last Name, and so on.
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4.6 Viewing Organization and Person Information

You have a selling relationship with a person or organization, regardless of whether
anything has been purchased or serviced. A selling relationship can be established
simply by negotiation terms that will be used if you later sell products. You create
lists, segments, and target groups from a data source of Persons in a B2C scenario
and a data source of Organizations in a B2B scenario.

Refer the Oracle Field Sales User Guide for information on working with the Person
and Organization tabs.
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Planning and Using Programs

A program is an umbrella object used to combine different marketing objects into
one entity.

Topics in this chapter include:
= Section 5.1, "Programs Overview"
= Section 5.2, "Creating a Program"

= Section 5.3, "Adding Components to a Program"
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5.1 Programs Overview

Programs are an umbrella object used to combine different Campaigns, Events,
Deals, Promotions and other objects into one entity. In this way, a new product
launch may have events, campaigns, promotions, advertising, trade management
deals and more, all coordinated from one point in Oracle Marketing.

Figure 5-1 depicts that in a hierarchy of marketing objects, a program is at the top.
All other objects, such as campaigns, events, or even other programs can be a part
of a program.

Figure 5-1 Hierarchy of Marketing Objects

Program

| I I

Program Program Program

| }

e

Campaign Campaign Event Event
Schedule Schedule Schedule Schedule

Parent Program

A program can be or have a parent program. For example, you want to launch a
marketing activity for a product launch in America, Europe, and Asia Pacific.
Accordingly, programs with a customized set of campaigns and events addressing
specific interests based on geography are created. All these programs can be
grouped under a single program called GlobalLaunch. In this example, program
GlobalLaunch is a parent program.
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Figure 5-2 Parent and Child Programs
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5.2 Creating a Program

Use the following procedure to create a program.

Messages in a Program

A message can be defined as the overall theme or communication that is being
pushed through the execution channels and is a high level communication
paradigm. An example would be "Know More, Do More, Spend Less With Oracle
Applications".

Costs, Revenues, and Metrics

A program’s costs, revenues, and metrics are based on the costs, revenues, and
metrics associated with the individual components of the program, such as
campaigns, campaign schedules, events or event schedules. These are rolled up to
display the program’s costs, revenues, and metrics.

Prereq
None

uisites
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Steps

1.

o o &~ w N

10.

11.
12.

13.

Log into Oracle Marketing with the appropriate responsibility and navigate to
Campaigns > Programs.

Click Create.

Enter the program name.

Optionally, select a parent for the program using the search icon.
Enter a short name, a business unit, and a purpose for the program.
Select a owner using the search icon.

The Owner field defaults to the person who is currently logged into the
application.

Select the start and end periods, start and end dates, and a currency.

If the start and end period is chosen from a LOV, the start and end dates are
entered automatically.

Select a country for the program.
Click the Global check box if this is a program across geographies.

Click the Confidential check box to restrict access to this program to members
within your team till the program is in the Active status.

Note: Using the Team side navigation link, you can select the individual
members or teams to grant access to.

Enter a description for the program.
Click Create.
The program is created. Next, you must select the components for this program.

To view the hierarchy of the objects associated with a program, click its View
Hierarchy icon in the Programs page. The hierarchy is displayed in the Program
Tree page. You can click the object name to drill down and view its details.

5.3 Adding Components to a Program

Use this procedure to add various marketing objects to a Program. Components
include campaigns, events, and one-off events.
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Prerequisites
An existing Program and a campaign, event, or one-off event

Steps

1.

o a & 0 N

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaigns > Programs.

Click the hyperlink of the program name to add components to.
Click the Components side navigation link.

From the Type column, select a marketing object type.

Select an object using the search icon.

Click Update.

The marketing object is added to the program, and other details of the new
components are displayed.
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Creating and Using Campaigns

A campaign is an object used for planning, managing, and budgeting marketing
activities, and is a set of campaign schedules in Oracle Marketing.

Sections in this chapter include:

= Section 6.1, "Campaigns Overview"

= Section 6.2, "Creating a Campaign"

= Section 6.3, "Understanding Campaign Execution"

»  Section 6.4, "Creating a Campaign Schedule"

= Section 6.5, "Using Collaboration with Campaign Schedules"
= Section 6.6, "Understanding Web Marketing"

= Section 6.7, "Creating and Managing Web Marketing Content"
= Section 6.8, "Troubleshooting Web Marketing"
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6.1 Campaigns Overview

One of the biggest challenges for business managers is to envision and develop
marketing programs for their products and services. To meet such a challenge, you
can create and execute marketing activities with specific themes and goals.

In Oracle Marketing, a campaign is a collection of marketing activities designed to
support a goal. A campaign is the vehicle for putting information about an
organization’s products, services, offers, and messages to existing and potential
customers.

Marketing campaigns consist of the campaign and its schedules. A schedule
determines when, where, and how a campaign activity is executed. A particular
campaign may have multiple schedules that execute through different marketing
channels.

For example, Vision Mobile wants to promote their new wireless instant messaging.
They create a campaign called “Wireless IM Promotion” and under that campaign
they add schedules. They might add an outbound telemarketing component in
which telemarketing representatives call a list of people to see if they want the new
service. They might have a banner ad that promotes the service and brings people
to a web registration page. They might also have an e-mail blast that goes out to a
list of contacts, who can then click on a link to move to a Web registration page.

Because all campaigns are not created alike, Oracle Marketing allows for custom
setups to easily configure campaigns for different activities and marketing channels.
Campaigns are often a hierarchical structure and can be divided by geography, by
product, or by marketing channel.

Oracle Marketing also provides out-of-the-box calculations for key metrics such as
leads and opportunities generated, event registrations, and planned and approved
budgets. These scalable calculations enable you to evaluate critical marketing
performance indicators and the effectiveness of their campaign spending and also
determine which channel is most effective.

Through its life cycle, a campaign goes through a number of status transitions: New,
Pending Theme Approval, Planned, Pending Budget Approval, Active, and so on.
For more details, refer Oracle Marketing Implementation Guide.

Some of the attributes that you can set for a campaign include:

s Classify it on the basis of a business unit. This is particularly useful for tracking
marketing activities in a multi-unit organization.
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s Classify it to the basis of an objective to enable focussed marketing. For
example, you can create a campaign with improving brand awareness as its
objective.

= Indicate it is for global execution. The global source code can be used for
reporting purposes.

= Set the Confidential flag to ensure that associated users and teams can view it.
= Associate teams or users to whom you wish to assign access rights.

= Set it to be a template. You can then use this campaign as a template to easily
create other campaigns.

= Version it for easy tracking. Only one version of a campaign can be active at a
time.

= Associate it to a program (an umbrella object) so that costs, revenues, and other
metric details can roll up to allow effective business tracking.

= Set a priority for it. Priority is used to define approval rules for the campaign.
Based on the priority, approvals are routed to appropriate approvers. The
priority may appear on Workflow notifications to approvers to convey any
urgency for approvals.

= Associate it to a budget. The budget must then be approved by an assigned
approver.

= Associate products that you want to promote.
= Associate relevant costs, revenues, and metrics that you want to track.

Associate deliverables and messages that must reach the customers. For example,
you may want to include product punch lines or a product data sheet for the
marketing activities associated with the campaign.

6.1.1 Campaign Processes

Campaigns are constructed using a wide variety of marketing objects. The basic
components of campaigns are its theme, funding (budgets), execution (schedules),
target audience (lists and marketing mediums), cost (costs), and effectiveness
measuring devices (metrics).

A campaign in Oracle Marketing is a planning tool and to execute it, you can create
campaign schedules. A basic marketing campaign can be divided into several
processes as depicted in Figure 6-1.
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Figure 6—-1 Campaign Planning and Execution
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The logical process flow for a campaign is as follows:

1.

Planning a Campaign, which includes:

s Creating the campaign

s Defining the geography

= Associating products, offers, and deliverables
s Determining the budget

= Obtaining theme and budget approvals

= Associating costs, revenues, and other metrics
Executing a campaign, which includes:

s Creating a campaign schedule by selecting channels and setting dates
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s Creating a target list
»  Associating triggers
= Arranging collateral
3. Tracking a campaign, which includes

= Viewing costs, revenues, and other metrics

6.1.2 Understanding Triggers

The triggers functionality enables you to improve marketing communications by
automatically executing campaign schedules when specific customer or business
situations arise. They are used to activate a campaign schedule when a specified
threshold or criteria is reached. For example, a trigger may test the responses to an
in-state campaign. If the level of responses reaches a specified level, a regional
campaign is activated. Likewise, triggers can be used to create campaign waves. An
initial campaign may offer a particular product. A second wave campaign, triggered
to execute a month after the initial campaign may offer accessories only to
customers who purchased the product during the initial campaign.

You can use Triggers to execute multi-channel campaign schedules too. For
example, after the number of responses to a campaign reach a specified threshold,
an e-mail blast and a telemarketing schedule may be triggered.

Figure 6-2 depicts a typical trigger function flow. You create a campaign and its
associated campaign schedules. You also create a trigger, and if the campaign
schedule is triggerable, associate the trigger to the campaign schedule. When the
trigger condition is met, the action associated with it executes.

Figure 6-2 Trigger Functional Flow
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The business benefits from using the trigger functionality include:

Monitor response information continuously and automatically execute specified
action when responses reach a specific threshold. For example, if the number of
responses for a Oracle 9i campaign reaches 100,000, initiate a telemarketing
campaign schedule.

Automatically execute the same schedule again over the defined time line, as
and when the trigger condition is satisfied. For example, check weekly if new
people have signed up for online banking, if they have, send a welcome letter to
them.

In addition to the actions defined for a trigger during trigger definition,
marketers can assign custom action to the trigger to meet specific needs. An
example of a custom program:

For schedule A, if the number of registrations > 5000, send notification and
activate schedule B; Generate a list of all registrants and send a thank you
e-mail to them.

Terminate a trigger process. For example, a product is withdrawn from the
market, and you want to stop the trigger that was monitoring response of the
campaign that was promoting it.

Create date-based triggers that are based only on the time line, with no check
condition. For example, send out a "Happy Birthday" e-mail every day to
people whose birthday is today.

Table 6-1 defines the terms and concepts associated with triggers.

Table 6—1 Trigger Terms and Definitions

Term Definition

Trigger A mechanism that enables an action to be performed on a

specific Marketing object. This mechanism is either date based
or date and condition based. If the condition defined for the
trigger is satisfied then an action is invoked.
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Table 6—1 Trigger Terms and Definitions

Term Definition

Trigger Action Once a condition is met, the trigger kicks off an action. The
trigger action determines what happens next.

The following actions are supported:

Seeded Marketing Actions:

= Sends notification to a specified resource
= Executes associated campaign schedules
Custom Marketing Actions:

= Using custom logic, a non-seeded action can be created.

Trigger A condition specifies what the trigger will monitor. Trigger
Condition conditions use metrics to measure and compare the
performance of Marketing objects.

Supported Trigger Conditions:
»  Metric to Metric Comparison
= Metric to Value Comparison

= Metric to Workbook Comparison

Metrics Oracle Marketing uses metrics to measure the performance of
Marketing objects. Many metrics are seeded with the
application - if not seeded, a metric can be created manually.
For more information, see Oracle Marketing Implementation
Guide.

The trigger functionality uses metrics to compare Marketing
object values; the result of this comparison becomes the trigger
condition.

When the defined trigger condition is met an action is
invoked. In other words, metrics (by being compared to
another metric, value, or workbook) cause a trigger action to
invoke.

Metric to Metric | Compares a Marketing object’s metric value to another
Trigger Marketing object’s metric value.

Condition For example, campaign forecasted responses (metric) can be

compared to campaign actual responses (metric). If the
specified condition is met (forecasted responses is equal to
actual responses) an action is invoked (send a notification to
the campaign owner).
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Table 6—1 Trigger Terms and Definitions

Term

Definition

Metric to Value
Trigger
Condition

Compares a Marketing object’s metric value to another value.

For example, campaign responses (metric) can be compared to
20,000 (value). If the operator (=) is selected, once the
campaign responses = 20,000 a trigger initiates an action (for
example, execute a follow up telemarketing campaign
schedule).

Metric to
Workbook
Trigger
Condition

Compares a Marketing object's metric value to a single value
returned by a Discoverer Workbook.

For example, if the Responses (metric) for a campaign
schedule is greater than the value returned by a Discoverer
Workbook, then activate the associated campaign schedule. In
this case, the Discoverer Workbook should return a single
value. For example, the Workbook may have a SQL condition
like 'select count (customer_identifier) from ams_person_
details_v'. This returns the count of customer records in 'ams_
person_details_v' as a single value.

Date Based
Trigger

This type of trigger is based on a predetermined date and
time, it does not monitor a condition. In this case, the date
criteria replaces the trigger condition. When the
predetermined start date is met the trigger action begins.

Repeating date based triggers can be created enabling a
schedule to automatically re-run on an hourly, daily, monthly,
quarterly, or yearly basis.

Repeating
Schedules

Repeating schedules can re-run based on a date or single
condition criteria.

When a repeating schedule re-executes, a new copy of the
schedule is made - the original schedule is preserved. When
the condition is met, the trigger picks up the new schedule; the
schedule runs based on its defined criteria.

The new schedules executes and the old schedule is preserved.
In other words, each execution is a new instance of the
schedule, therefore a marketer is able to separately track
campaign responses for each schedule.

For example, a trigger activates schedule A and it runs for a
specific period of time. When schedule A is ready to repeat
(based on the repeat unit), a copy of schedule A’s information
is made and becomes schedule B. Schedule A’s information is
preserved, schedule B becomes the active schedule. This cycle
repeats until the trigger end date is reached. All schedule
information is separately preserved - therefore, it can be
individually viewed for tracking purposes.
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Table 6—1 Trigger Terms and Definitions

Term Definition

Trigger Monitor | Defines the frequency in which conditions are checked for
Frequency satisfaction. A trigger runs for a set period of time and
conditions are verified only for that period.

Trigger Monitor Frequency Determinants:
= Start and End Date
s Time Zone

= Repeat Every (for example, every 1 hour, 2 days, 1 week,
and so on.)

Triggers Repeat Units:
s Hour

= Day

= Week

= Month

s Quarter

s Year

Trigger A Workflow notification sent to a specified resource. Once a
Notification trigger condition is met, if the action is setup to send a
notification, one will be sent to the specified resource.

Trigger The major functionality behind triggers is provided by Oracle
Workflow Workflow.

6.2 Creating a Campaign

There are four groups of Campaign components, not all of which will be available
for use with every campaign: Planning, Execution, Track and Collaboration. The
Campaign components are determined by the Custom Setups in the Administration
Tab.

Use the following procedures to create a campaign:

= Section 6.2.1, "Entering Basic Campaign Details"

= Section 6.2.2, "Identifying Geographies for a Campaign"
= Section 6.2.3, "Adding Products to a Campaign"

= Section 6.2.4, "Creating a Trigger and Associating it to a Campaign"
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Section 6.2.5, "Associating Deliverables to a Campaign"
Section 6.2.6, "Associating Costs, Revenues, and Metrics to a Campaign"

Section 6.2.7, "Sourcing Budgets for a Campaign"

6.2.1 Entering Basic Campaign Details

Complete the following procedure to create a campaign.

Prerequisites
Required Custom Setups

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click Create.
Select the type of campaign to create using the Setup Type drop-down list.

Selecting a type determines the attributes to be displayed. Setup types are
created by your administrator.

Enter a name for the campaign according to naming conventions for your
organization, if any.

Select a program to associate this campaign with.

This enables costs, revenues, and other metric details to roll up to a program, an
umbrella object, and allows effective business tracking.

Enter a unique source code. Optionally, you can leave the source code field
blank and the system will generate a unique code upon campaign creation.

Select a business unit if yours is a multi-unit organization.
Enter a number to indicate the campaign version.

If multiple versions for a campaign exist, only one version can be active at any
given time.

Select the purpose for the campaign from the drop-down list.

The purpose can be used for custom reporting.

10. Select a start period and end period for the campaign.
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11.
12.
13.

14.
15.
16.

17.

18.

19.

Select the start and end dates for the campaign.
Select a currency, priority, owner, country, and language for the campaign.
Select applicable check boxes:

= Global - indicates that the campaign will be executed globally and the
global source code will be used for reporting

= Confidential - restricts access and view to this campaign to the team
associated with the campaign till the campaign is in the Active status. Other
teams will not be able to view the campaign

s Template - indicates that the campaign can be used as a template to base
other campaigns on. If this is selected, the campaign cannot be made Active

Enter a description for your campaign.
Click Create.

To modify a campaign’s details, click the campaign’s Name link in the
Campaigns page, enter or modify the necessary details in the Campaign Details
page, and click Update.

To copy a campaign, click Copy in the Campaigns page, enter the necessary
details in the Copy Campaign page, and click Copy.

To create a campaign that is similar to an existing campaign, you can copy the
existing one and modify it rather than create a new one.

To save the list as a .csv file, click the Download to CSV File icon on the
campaigns page, and save the file in the required directory.

To request approval for a campaign, click Request Approval in the Campaign
Details page.

6.2.2 Identifying Geographies for a Campaign

You can use the Geography side navigation link to specify the geographic location
where the campaign will be executed.

Prerequisites
An existing campaign
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Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the campaign’s Name link and navigate to Planning > Geography.
Select a Level from the drop-down list.

Click the Name search icon to display a list of geographies at the selected Level
and select a geography.

Click Update.

The Location column will display the physical location the named Geography is
contained in. This is an information field only and does not have any functional
impact. You can use the information for reporting purposes.

To disassociate a geographic location from a campaign, click its Remove check
box and click Update.

6.2.3 Adding Products to a Campaign

The Products link is used to create inventory items and product families.
Associating a product to a campaign can be used for reporting.

Prerequisites
An existing campaign

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the campaign’s Name link and navigate to Planning > Products.

To associate a product family, click the Search icon in the Product Family region
and select a product category from the list of values.

If this product family is to be excluded for the campaign, select its Exclude
check box.

If this product family is to be considered as the primary category for the
campaign, select its Primary Category check box.

This is useful for reporting purposes when multiple product families are
associated with a campaign.
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To associate a product to the campaign, click the Search icon in the Product
region and select a product number from the list.

Only products that are associated to a campaign can be associated to its
campaign schedules. This information is used in reporting to generate
information such as "how many campaigns were executed to promote Product
X"

If this product is to be excluded for the campaign, select its Exclude check box.
Click Update.

To remove a product family or product from a campaign, click its Remove check
box and click Update.

6.2.4 Creating a Trigger and Associating it to a Campaign

You can use triggers to activate associated campaign schedules when a specified
threshold or criteria is reached. You can also choose to send notification to a specific
resource when a trigger action executes.

Use the following procedure to create and associate a trigger to a campaign.

Prerequisites
A campaign must exist

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Name link for the campaign and navigate to the Trigger side
navigation link.

Click Create.
In the Triggers page, enter a name and select its type.
Enter the details in the Monitor Setup, Conditions, and Actions regions.

The details you enter in the "Every’ field of the Monitor Setup region determine
the frequency at which the trigger is monitored. For example, if the monitor
frequency for a date-based trigger associated to a campaign is '3 Months’, then
between the start and end dates specified for the trigger, an associated
campaign schedule will repeat every 3 months.

Click Create.
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An Associated Schedules region appears, which will display a list of triggerable
campaign schedules that you associated with this trigger.

To update a trigger, click the trigger name to navigate to the Trigger Details
page, make the necessary changes in the Actions regions, and click Update.

To stop a trigger from executing, click the trigger name to navigate to the
Trigger Details page, and click Stop Trigger.

To disassociate a trigger from a campaign, select its Remove check box in the
Trigger page, and click Update.

6.2.5 Associating Deliverables to a Campaign

Use the following procedure to associate deliverables to a campaign.

Prerequisites
A campaign must exist

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Name link for the campaign and navigate to the Deliverable side
navigation link.

Select a Type and Name for the deliverable.

Enter the Quantity, Need By, and Fulfill On details.

Click Update.

Similarly, you can add more deliverables to the campaign.

To disassociate a deliverable, select its Remove check box and click Update.

6.2.6 Associating Costs, Revenues, and Metrics to a Campaign

Costs and Revenues are special types of metrics with features specific to accounting
for costs and revenues and calculating the return on investment (ROI). Use the
Costs and Revenues side navigation to track forecasted and actual values for each
Cost or Revenue metric associated with a campaign.

6-14 Oracle Marketing User Guide



Creating a Campaign

Apart from costs and revenues, relevant seeded metrics are automatically available
for tracking a campaign. Additionally, you may need to associate metrics that are
specific for a campaign.

6.2.6.1 Associating Campaign Metrics
Use the following procedure to associate an existing metric with a campaign.

Prerequisites
= A campaign must exist

s The required metric must be set up by the system administrator

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Click the Name link for the campaign and click the Metrics side navigation link.

All the metrics associated with the campaign are displayed. The metrics
template functionality allows the setup of metrics at an object or custom setup
level.

3. Within the Create New region of the Metrics Details page, click the Search icon
to display a list of available Metrics and select a metric from the list.

4. Enter the Forecast and Actual values in their respective columns. Optionally,
select a Transaction Date and enter a Description.

The Transaction Date is a reference for you. It is not used within the metrics
logic.

5. Click Create.

The selected Metrics is now associated with the campaign and will appear in
the Metrics region.

6. Click Refresh.

The newly associated metric values are displayed as the Summary or Rollup
metrics for the campaign.

7. To disassociate a metric from a campaign, select its Remove check box and click
Update.
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6.2.6.2 Viewing Associated Campaign Metrics
Use the following procedure to view the metrics associated with a campaign.

Prerequisites
An existing marketing campaign with associated Metrics

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Click the Name link for the campaign and click the Metrics side navigation link.

All the metrics associated with the campaign are displayed. The metrics
template functionality allows the setup of metrics at an object or custom setup
level.

3. Select a View Option and click Go. The following table describes the available
view options. Details is the default view option.

Table 6-2 Campaign Metrics View Options

View Option Description

Details View all Metrics associated with the Campaign. Summary
Metrics are represented hierarchically and have Rollup,
Manual and/or Function Metrics that define a summarization
as leaf nodes of the Summary Hierarchy.

Formula Only View metrics that are based on the Formula calculation type.
You can also add new formula metrics in this view and enter
the forecast and actual values.

Input Only View metrics that are of Manual calculation type, that is they
have been entered manually. You can also add new metrics in
this view and enter the forecast and actual values.

Function Only View only metrics based on PL/SQL procedures and
functions. You can only input forecast values in this view.

Rollup Only View only Metrics that are rolled-up from lower levels in the
marketing object hierarchy. You cannot input any data in this
view.

4. Summary metrics are displayed with the option to expand the summary
hierarchy. Select the plus sign (+) to view the next level of detail in the
hierarchy.
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5. Based on the Metrics type, you can enter the Actual and/or Forecast Values for
the metrics.

For Manual, Function, and Formula metric types, you can enter the Actual
Values and the Forecast Values until a campaign becomes active.

6. Click Update to save your changes.

7. Click Refresh to view the newly entered metric values calculated for the
Summary or Rollup Metrics for this campaign.

6.2.6.3 Viewing Campaign Metric Charts

Use the following procedure to view metric charts for a campaign.

Prerequisite
An existing marketing campaign with associated Metrics

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Click the Name link for the campaign and click the Metrics side navigation link.

All the metrics associated with the campaign are displayed. The metrics
template functionality allows the setup of metrics at an object or custom setup
level.

3. Select a Chart Option and click Go.

The options available are Pie and Bar with Pie being the default. Only summary
metrics will have the chart icon displayed. The chart displays the distribution of
the sub-components that make up the summary metrics. For each component,
the Actual and Forecast values are displayed.

6.2.6.4 Viewing Campaign Metrics History

You can view the trends of the actual and forecasted values for a metric by viewing
its history. The Metric Background Processes concurrent program records the actual
and forecasted values for metrics and populates the history tables for the
corresponding marketing objects. The values in the metrics history tables are then
used to display the metrics history. Refer Oracle Marketing Implementation Guide for
more information on the background processes.

Use the following procedure to view metrics history.
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Prerequisite
As existing marketing campaign with associated Metrics

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Name link for the campaign and click the Metrics side navigation link.

All the metrics associated with the campaign are displayed. The metrics
template functionality allows the setup of metrics at an object or custom setup
level.

In the Metrics History region, click the Search icon and select a metric whose
history you want to view from the list of values.

Enter the From Date and To Date.
Enter a number and select the Data Interval from the drop-down list.

The data interval options include Day, Week, Month, and Year. Example: if you
enter the number 1 and the data interval as Week, the x-axis coordinates display
1-week intervals.

Select the Value Type.

If you choose Cumulative, then the values are added up for each display
co-ordinate within the x-axis. If you choose Incremental, then the value of the
metric at a given interval is displayed directly.

Click View History.

The trend for the metrics is displayed for the specified time range.

6.2.6.5 Entering Values for Campaign Metrics

Use the following procedure to enter values for campaign metrics.

Prerequisites
An existing marketing campaign with associated Metrics

Steps

1.

2.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Name link for the campaign and click the Metrics side navigation link.
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All the metrics associated with the campaign are displayed. The metrics
template functionality allows the setup of metrics at an object or custom setup
level.

Select the Input Only view option and click Go.
This is the best option for entering forecast and actual values for a metric.

Summary and Rollup Metrics are displayed with the option to expand the
metrics hierarchy. Select the plus sign (+) to expand the metrics hierarchy and
view the next level of detail.

Enter values for Forecast and Actual where applicable.

You cannot update the Forecast Value for an active campaign. The Actual Value
for Function metrics is automatically calculated and displayed.

Click Refresh to view the updated metric values in the Summary or Rollup
Metrics for this campaign.

6.2.6.6 Associating Campaign Costs and Revenues

Use the following procedure to associate existing costs and revenues metrics with a
campaign.

Prerequisites
A campaign must exist

The required Cost or Revenue metric should be set up by your System
Administrator

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Name link for the campaign and navigate to Planning > Costs and
Revenues.

All the costs and revenues metrics associated with the campaign are displayed.
The metrics template functionality allows the setup of metrics at an object or
custom setup level.

Click the search icon within the Create New region of the Costs and Revenues
Details page and select a Cost or Revenue Metric from the list.
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Select the currency and enter the forecast and actual values for the cost or
revenue.

Select a transaction date and enter a description. The transaction date is a
reference for you. It is not used within the metrics logic.

Click Create. The selected cost or revenue metric is now associated with the
campaign and will be displayed in the relevant Costs or Revenues region.

Click Refresh to view the Summary or Rollup metrics of the newly associated
cost or revenue.

To disassociate a cost or revenue metric from a campaign, click its Remove
check box and click Update.

6.2.6.7 Viewing Associated Campaign Costs and Revenues

Use the following procedure to view the costs and revenue metrics associated with
a campaign.

Prerequisite
As existing marketing campaign with an associated Cost or Revenue metric.

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Name link for the campaign and navigate to Planning > Costs and
Revenues.

All the costs and revenues metrics associated with the campaign are displayed.
The metrics template functionality allows the setup of metrics at an object or
custom setup level.

Select a View Option. Detail is the default view option.

Table 6-3 contains the description of the different view options available.

Table 6-3 Campaign Cost and Revenue Metrics View Options

View Option Description

Detail View all Cost and Revenue metrics associated with the

Campaign. Summary Metrics are represented hierarchically
with Rollup, Manual, and/or Function Metrics that define a
summarization as leaf nodes of the Summary Hierarchy.
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Table 6-3 Campaign Cost and Revenue Metrics View Options

View Option Description

Formula Only View only composite values of Cost and Revenue metrics
based on formulas set up for the campaign. Formula metrics
are calculated only for the values at the current level. Rollup
and summaries are not valid for formula metrics.

Function Only View only Cost and Revenue metrics based on PL/SQL
procedures and functions. You can only input forecast values
with this option.

Input Only View only the manually entered Cost and Revenue metrics.

This option allows you to enter forecast and actual metric
values. You cannot modify the forecasted values when the
campaign is active.

Rollup Only View only Cost and Revenue metrics that are rolled-up from
lower levels in the marketing object hierarchy. You cannot
input any data in this view.

4, Summary Cost and Revenue metrics are displayed with the option to expand
the summary hierarchy. Click the plus sign (+) to view the next level of detail in
the hierarchy. New row(s) appear displaying the individual cost or revenue
metrics that are part of the hierarchy.
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6.2.6.8 Viewing Campaign Costs or Revenues Charts
Use the following procedure to view cost or revenue charts for campaigns.

Prerequisite
As existing marketing campaign with an associated Cost or Revenue metric.

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Click the Name link for the campaign and navigate to Planning > Costs and
Revenues.

All the costs and revenues metrics associated with the campaign are displayed.
The metrics template functionality allows the setup of metrics at an object or
custom setup level.

3. Select a Chart Option and click Go.
Chart options include Pie and Bar, with Pie being the default option.

4. To view the chart displaying summarized cost or revenue information, select
the Chart icon above the Cost or Revenue region. To view the chart for a single
cost or revenue component, select the chart icon in the corresponding row.

The chart displays the distribution of the sub-components that make up the
summary Costs or Revenues. For each sub-component, forecasted and actual
values are displayed.

Note that the chart icon is displayed only for the summary Costs or Revenues
metrics.

6.2.6.9 Viewing Campaign Costs and Revenues History

You can view the trends of the actual and forecasted values for Cost or Revenue
metrics by viewing their history.

Prerequisite
As existing marketing campaign with associated Costs or Revenues metrics defined

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.
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Click the Name link for the campaign and navigate to Planning > Costs and
Revenues.

All the costs and revenues metrics associated with the campaign are displayed.
The metrics template functionality allows the setup of metrics at an object or
custom setup level.

Click the Search icon in the History region of the Costs and Revenues Details
page and select the Cost or Revenue metric whose history you want to view.

Enter the From Date and To Date to indicate the duration for which you want
the history.

Enter a number and select the Data Interval from the drop-down list.

The data interval options include Day, Week, Month, and Year. Example: if you
enter the number 1 and the data interval as Week, the x-axis coordinates display
1-week intervals.

Select a the Value Type, which can be Cumulative or Incremental.

If you choose Cumulative, then the values are added up for each display
co-ordinate within the x-axis. If you choose Incremental, then the value of the
metric at a given interval is displayed directly.

Click View History.

The trends for the selected Cost or Revenue metrics are displayed both as a
table and a chart.

6.2.6.10 Entering Values for Campaign Costs and Revenue Metrics
Use the following procedure to enter values for campaign costs and revenues.

Prerequisite
As existing marketing campaign with associated Costs or Revenues Metrics defined

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Name link for the campaign and navigate to Planning > Costs and
Revenues.
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All the costs and revenues metrics associated with the campaign are displayed.
The metrics template functionality allows the setup of metrics at an object or
custom setup level.

3. Select Input Only from the View Options drop-down list and click Go.

All the details of the cost and revenue components for the campaign are
displayed.

4. Enter or modify values for Forecast and Actual where applicable.
You cannot update the forecast value when a campaign is Active.

5. Check the Post to Budgets check box to enable posting of the actual costs to the
associated budget.

This will lock the Actual cost column and you will not be able to make
modifications to it.

6. Click Update to save your changes.
7. Click Refresh to view the updated summary of the cost and revenue values.

8. To disassociate a cost or revenue metric from a campaign, click its Remove
check box and click Update.

6.2.7 Sourcing Budgets for a Campaign

To source funds for a campaign, you can associate a campaign to a budget. Using
this information, the initial estimate can be communicated to the approvers during
the approval process.

You must have access to the budget that you want to associate to the campaign.

Use the following procedure to associate a campaign to a budget and to create a
budget request.

Prerequisite
As existing marketing campaign

An existing budget that is Active and has a valid period of overlap between the
campaign dates and the budget dates

Access to the budget
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Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Name link for the campaign and navigate to Planning > Budget.

For a new campaign, enter the Initial Estimated Budget in the currency
indicated and click Update.

To create a budget request, click Create Request.
Enter the necessary details in the Budget Source and Request Details regions.
Information about the object receiving the budget allocation is displayed.

Click Create to save the request details.

6.3 Understanding Campaign Execution

Campaign schedules are the vehicles used to execute marketing campaigns. Topics
in this section include:

Section 6.3.1, "Schedules Overview"

Section 6.3.2, "Understanding Schedule Types"

Section 6.3.3, "Understanding Costs, Revenues, and Metrics"
Section 6.3.4, "Sourcing Budgets and Transferring Funds"

Section 6.3.5, "Understanding Target, Control, and Contact Groups"
Section 6.3.6, "Understanding Fatigue Rules"

Section 6.3.7, "Understanding Advanced Outbound"

Section 6.3.8, "Understanding Teams"

6.3.1 Schedules Overview

Schedules set up the actual delivery of the marketing campaign. They determine
when a specific marketing activity is going to take place, what the methodology of
that activity is, and how the responses will be captured. They also determine how
any mailing or calling lists, cover letters, or other content are used and what
deliverables, if any, are involved.

If you set a schedule’s Triggerable attribute to Yes, it can be triggered. That is, some
threshold must be reached before a schedule will be activated. For example, if the
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response rate in a particular test market reaches a given threshold, then the
campaign schedule for a larger test market is activated. See Section 6.1.2,
"Understanding Triggers" for more details.

6.3.2 Understanding Schedule Types

Schedules are categorized based on the outbound channel of execution. In Oracle
Marketing, you can create a specific type of schedule by choosing a Setup Type. By
selecting a Setup Types you are defining an Activity Type and an Activity for the
schedule. For example, if you select Direct Marketing - Email as the Setup Type, the
Activity Type is Direct Marketing and the Activity is Email.

For some marketing schedules you have a choice of activities. For example, for an
indirect marketing activity, such as Advertisement, you can select from a list of
activities, such as TV, Radio, Billboards, and so on.

In addition to the seeded Setup Types, your administrator can define custom Setup
Types for your specific business needs. For example, to create a schedule for
recruiting students from campuses, the administrator may define activities such as
Magazine Inserts, Group Discussions, Interviews, and so on.

6.3.3 Understanding Costs, Revenues, and Metrics

Metrics are measurements for forecasting and tracking the effectiveness of
marketing activities. You can associate cost, revenue, or other metrics with many
marketing objects, such as programs, campaigns, campaign schedules, events, and
so on. Metrics can be generated automatically by the system or entered manually.
For a given marketing object, you can choose to associate seeded, out-of-the-box
metrics or your administrator can define new metrics specific to your needs.

You can view metrics summarized at a marketing object level or at its parent level to
get a perspective of the effectiveness of marketing activities. Your administrator can
define the level up to which you want the metrics to be summarized. For example,
you may want campaign schedule metrics to be summarized to the parent
campaign level only and not to the program level (a program is an umbrella object
to which other programs, campaigns, and events can be attached).

You may enter the forecasted and actual costs and revenue values in the currency
that you have chosen as your default. However, when the costs and revenues
associated with marketing objects are summarized to the parent levels, the
forecasted and actual values are converted and displayed in the currency defined
for the campaign.
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See Section 8.1.13, "Associating Costs, Revenues, and Metrics" for more details on
Metrics.

Metrics and Campaign Triggers

Metrics can be used to initiate campaign triggers when the specified condition is
met. Within a trigger, a condition is defined in which a metric value is compared to
a user-defined value, to another metric value, or to an Oracle Discoverer workbook
that generates a single value. The campaign trigger can then be associated with a
campaign schedule. When the specified trigger condition is met, the campaign
schedule is activated.

The process flow is as follows:

1. Create the Campaign Schedule.

Define attributes for the Campaign Schedule.
Define the Campaign Trigger.

Associate the Trigger to Campaign Schedule.

The system monitors the Trigger condition.

@ o » w N

The system activates the Campaign Schedule if and when the Trigger condition
is met.

See Section 6.1.2, "Understanding Triggers" for more information on triggers.

6.3.4 Sourcing Budgets and Transferring Funds

Budgets are a source of funds for marketing activities. You can request funds for a
campaign schedule from a budget you have access to, a person who owns budgets,
or from the parent campaign. Budget requests must be approved before you can use
budget amounts. The administrator configures Approval Rules that will route
budget approval requests to authorized approvers.

Funds transfer is moving money from one budget to another. For example, if a
campaign schedule to launch a new product is not being effective, funds allocated
to it may not be required. You may then transfer the unused funds to other budgets
from where funds can be released for other marketing activities. See Section 11.1,
"Overview of Budgets" for more information on budgets.
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6.3.5 Understanding Target, Control, and Contact Groups

A target group for a campaign schedule specifies the list or lists associated with the
campaign schedule. You can generate a target group using any combination of the
following:

s List - a group of customers who match a set of conditions. A list is static, that is,
once generated, a list has an unchanged number of entries.

= Segment - a set of conditions that will be executed dynamically when a target
group is created. For example, a segment could be defined as residents living in
the state of California. If this segment is associated with a target group, then the
number of records satisfying the segment criteria at the time of generating the
target group will be considered as part of the target list.

= Employee List - a group of employees who match a set of conditions. Like lists,
an employee list is also static.

A Control Group is a set of list entries who do not receive campaign information.
While generating a Target Group, you can specify the number of records to be
included in the Control Group. For example, based on your marketing criteria, you
could have 5000 prospects being targeted for a direct marketing activity. You could
then create a Control Group of 250 (5%) prospects who will not be contacted for this
direct marketing activity. The responses from the Control Group can be compared
with the responses from target records that receive the campaign information to
determine the benefits of marketing to customers and prospects who meet the list
criteria.

A Contact Group is a group of list entries who are actually contacted through a
marketing activity. The Contact Group is obtained by taking the count of the
associated lists (or segments) for the Target Group, subtracting the Control Group
records, and adjusting for any suppression and duplicate records. For example,
based on your marketing criteria, you could have 5000 prospects being targeted for
a direct marketing activity. You could then create a Control Group of 250 (5%)
prospects who will not be contacted for this direct marketing activity. You will then
have 4750 prospects who will automatically become part of the Contact Group
(assuming no suppression and duplicate records). The responses from the Contact
Group can be compared with the Control Group responses to measure the
effectiveness of the marketing campaign.

Within Oracle Marketing, generating a target group will automatically apply
suppressions and deduplicates amongst the list sources that were selected to make
up the target group. You can also view the record counts and the record entries for
each of the sources (list, segment, employee list) and for the target group per se
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(control group records are flagged). Once generated, the list of target group entries
will be available for outbound execution (direct mail, e-mail, and so on).

6.3.6 Understanding Fatigue Rules

Fatigue rules prevent marketing teams from over contacting their
customer/prospect base. These rules enable them to carefully target customers so
that they have a receptive group of customers even as they work towards meeting
their marketing goals. For example, a fatigue rule could be created so that a
customer is contacted 4 times (or less) per month. Fatigue rules are specified for a
time period - weekly, monthly, quarterly, or yearly and are applied during
campaign schedule execution. See Section 8.1.9, "Understanding and Using Fatigue
Rules" for more information.

6.3.7 Understanding Advanced Outbound

When Oracle Marketing integrates with Oracle Advanced Outbound, it serves to
maximize both outbound list penetration and agent productivity. Campaigns and
lists are created in Oracle Marketing, and Oracle Advanced Outbound is used as the
execution arm for these lists when telesales agents contact customers on the list via
the telephone.

6.3.8 Understanding Teams

You can choose to limit all access to one or more marketing campaigns to only those
resources who are within your team (or group of users such as a franchise,
organization, or branch). You can do so by setting the Confidential flag for a
campaign. When you create a campaign, you can define it to be confidential. Only
its owner and associated team members can then access it. However, when the
status of a confidential campaign changes to Active, access to it is the same as for
any non-confidential campaign.

An administrator has full access to all the campaigns, immaterial of the status of the
Confidential flag.

If you have not set the Confidential flag, you can give read-only access to other
users and teams by adding them to a campaign. This also enables rollup access to a
parent program.

Campaign schedules associated with a campaign inherit the confidentiality
associated with the campaign.
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6.4 Creating a Campaign Schedule
The procedures explained in this section include:
= Section 6.4.1, "Entering Basic Campaign Schedule Details"
= Section 6.4.2, "Creating Cover Letters for Campaign Schedules"
m  Section 6.4.3, "Creating a Target Group"
= Section 6.4.4, "Associating Metrics with a Campaign Schedule"
= Section 6.4.5, "Associating Costs and Revenues with a Campaign Schedule"
= Section 6.4.6, "Sourcing Budgets for a Campaign Schedule"
= Section 6.4.7, "Transferring Funds from a Campaign Schedule to a Budget"

= Section 6.4.8, "Associating Offers to a Campaign Schedule"

6.4.1 Entering Basic Campaign Schedule Details

Campaign Schedules may have many different components as determined by the
Activity Type and Activity and defined in Custom Setup on the Administration tab.
Your Campaign Schedule may not have all the side navigation links listed.

Campaigns Schedules are created to execute Campaign activities.

Note: Campaign Schedules can be created in one of two ways -
using the Campaign Workbench or by using the Campaign tab of
the application. Campaign schedules created using the Campaign
tab will also be seen in the different views and reports available on
the Campaign Workbench. However, you cannot access these
schedules from the Campaign Workbench. Similarly, campaign
schedules created from the Campaign Workbench will be seen in
the different views and reports available in the Campaign tab
pages, but cannot be accessed from there. Refer Oracle Marketing
Implementation Guide for details on implementing the two different
campaign schedule creation functionality.

Use the following procedures to create a campaign schedule.

Prerequisites
An existing campaign
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Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Names link of the campaign for which you want to create a schedule
and navigate to execution > Campaign Schedule.

Click Create.

In the Create Campaign Schedule page, select the type of campaign schedule to
create using the Setup Type drop-down list.

Selecting a type determines which fields are displayed. These types are set up
by your administrator. The Create Campaign Schedule page will refresh and the
corresponding Activity Type and Activity fields are displayed. If the schedule is
triggerable (defined in the activity type by the administrator), a Trigger Details
region is added to the Create Campaign Schedule page.

Enter a name for the campaign schedule and select a language and country for
the campaign schedule.

Select the Use Parent Source Code check box, for the Source Code of the parent
campaign to be used to identify the campaign schedule too.

The source code is used for tracking and reporting. If individual schedule based
reporting is required, use unique source codes.

If necessary, change the coordinator and leave the Source Code field blank and
the system will generate and insert a unique source code for the campaign
schedule.

Select a Marketing Medium, if necessary. Certain execution channels, such as
Oracle Advanced Outbound, require particular Marketing Mediums to be
selected for a campaign schedule.

Select a currency, time zone, start and end dates, start and end times, objective,
and priority for the campaign schedule and enter a Description.

10. If necessary, associate a trigger and complete the Trigger Details region.

a. Select Do Not Use Trigger to execute the schedule manually at the Start
Date and Start Time specified.

b. Select Use Trigger to have the schedule activated when the trigger condition
is met and select a Trigger Condition.

c. If necessary, select the Repeat and Exclude previous entries from Target
Group check boxes.
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11.

12.
13.
14.

15.

16.

d. Select the Execute After Approval by check box if this use of a trigger must
be approved, and select the approver.

e. Select the Send Notification to check box and select the person to be notified
when the use of the trigger is approved.

In the Mail Preference region, enter a Subject and select a Template.
These are specific for e-mail, fax, or print schedules.

Click Create.

Click Request Approval to initiate the approval process for the schedule.

Click Preview in the Campaign Schedule Details page, select a style sheet, and
click Go to preview the cover letter.

To modify a campaign schedule’s details, click the campaign schedule’s Name
link in the Campaigns page, enter or modify the necessary details in the
Campaign Schedule Details page, and click Update.

To copy a campaign schedule, click Copy in the Campaign Schedule Details
page, enter the necessary details in the Copy Campaign Schedule page, and
click Copy.

To create a campaign schedule that is similar to an existing campaign schedule,
you can copy the existing one and modity it rather than create a new one.

6.4.2 Creating Cover Letters for Campaign Schedules

You can associate a collateral or cover letter content item to a campaign schedule.
Based on the content type you choose, different attributes are available for the
content item.

Use the following procedure to create and associate cover letters to e-mail, fax, or
print campaign schedules.

6.4.2.1 Creating Cover Letters for E-mail or Fax Campaign Schedules

Use the following procedure to create a cover letter for e-mail or fax campaign
schedules.

Prerequisites
A campaign schedule must exist
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Steps

1.

10.
11.

12.

13.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Names link of the campaign to which the schedule belongs and
navigate to Execution > Campaign Schedule.

Click the name link of the campaign schedule for which you want to create the
cover letter.

In the Mail Preference region, enter the Subject.

To select a cover letter from the library, use the Search icon and select a cover
letter from the list of values.

To create a cover letter, select a content type and click the Create icon.
Enter or modify the required details in the General region.

In the Email Details region, enter the Sender, Reply-to, and Subject fields. You
can select an attribute from the drop-down list and click < to include the merge
field in the Subject.

Search and select the Content Block and Image information in the Header
region. The content depends on how the header has been setup.

In the Body region, enter the text for the e-mail or fax body.

You can enter the content for the e-mail in an HTML format. If the e-mail is for

non-html clients, you can choose to display the e-mail content in text format by
clicking Edit Text Version. The content created for Fax groups will display the

content in HTML format.

If the content type has any query associated with it, you can embed the query
tags into the e-mail body individually by selecting it and clicking <, or all at
once by clicking <<.

To insert a Click-through Destination (CTD):

1. Enter the text for the link in the Body region, select it, and click the Click
Thru Destination URL icon in the toolbar.

2. In the Define Click Through Destination page, select the Action and its
associated parameters. For example, if you choose the action "Go to URL,
enter a URL in the URL field.

3. Click Apply.
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14.

15.

16.

17.

18.

19.

20.
21.
22,

Search and select the Content Block and Image information in the Footer
region. To add another content block, click Add Another Row and select a
content block from the list of values.

To add an attachment from the Oracle Content Manager (OCM) repository, click
the Search icon in the Attachments region and select the attachment. To add
another attachment, click Add Another Row and select another attachment.

To upload an attachment from your desktop, browse a location, select the
attachment, and click Add Attachment in the Upload Attachments region.
Similarly, add more attachments, if necessary.

Click Apply.

You can now preview the cover letter and send a test mail or fax. Click the Edit
icon.

In the Cover Letter Details page, enter the mailing address in the Send Test field
and click Send Test.

Click Submit For Approval to submit the cover letter for approval.
Click Apply.

To edit the cover letter details, click the Edit icon in the Mail Preference region,
make the necessary changes and click Apply.

6.4.2.2 Creating Cover Letters for Print Campaign Schedules
Use the following procedure to create a cover letter for a Direct Mail Print schedule.

Prerequisites
A campaign schedule must exist

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Names link of the campaign to which the schedule belongs and
navigate to Execution > Campaign Schedule.

Click the name link of the campaign schedule for which you want to create the
cover letter.

In the Mail Preference region, select a printer.

6-34 Oracle Marketing User Guide



Creating a Campaign Schedule

5. To select a cover letter from the library, use the Search icon and select a cover
letter from the list of values.

To create a cover letter, select a content type and click the Create icon.
Enter or modify the required details in the General region.

In the Print Details region, browse and select a .pdf or .rtf file and click Apply.

© ®» N o

To print a test mail, click the Edit icon in the Mail Preferences region again,
select a printer from the Sent Test To list, and click Send.

10. Click Submit For Approval to submit the cover letter for approval.
11. Click Apply.

12. To disassociate a file, click its Delete icon in the Print Details region, and click
Apply.

6.4.3 Creating a Target Group

A Target Group for a campaign schedule specifies the list or lists associated with the
campaign schedule. Certain activity types require a generated list in order to make
the campaign active. For example, any direct marketing activity type (direct mail,
e-mail, fax or telemarketing) requires a generated list. You can generate a target
group using any combination of the following:

s List
= Segment
= Employee List

A segment is a dynamic criteria that will be executed when the target group is
generated. For example, a segment could be defined as a condition to obtain
residents living in the state of California. Now, if this segment is associated with a
target group, then the number of records satisfying the segment criteria at the time
of generating the target group will be considered as part of the target list entries.

However, for a List or Employee List, the number of entries is static. This implies
that if a list or employee list is associated with a target group, then the static
number of entries in these lists when the lists were generated will become part of
the target group list entries.

Use the following procedure to create a target group.
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Prerequisites

A generated list or segment

An existing campaign with a campaign schedule

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Names link of the campaign to which the schedule belongs and
navigate to Execution > Campaign Schedule.

Click the name link of the campaign schedule for which you want to create a
target group.

From the side navigation, click the Target Group link.

Enter the name for the target group and select its Source Type.

Select a Generation Type.

If you choose:

= Full Refresh - when the list is regenerated all the entries from the list are
removed and it will be generated afresh as if being generated for the first
time.

= Append New Records - all the list entries from the previous list generation
activity will be retained. New entries that meet the specified selection
criteria will be added to the existing list. However, if list criteria is
modified, then the entries from the previous list generation will not be
satisfying the list criteria.

= Update Attributes Only - if any modifications are made to the customer
attributes in the corresponding data source or Audience, those changes are
updated within the list entry records.

Select No Control Group or Using Control Group as appropriate. If you choose
to use a control group, enter the percentage of the target group or the count of
records for the control group.

A Control Group is a list of customers or prospects who will not receive the
campaign information.

Click Purge List Entries After Grace Period.

If this is selected, then the entries of the Target Group are purged based on the
concurrent program AMS - Purge Target Group and the profile option AMS:
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10.

11.
12.

13.
14.

15.

Grace Period in Days. Refer Oracle Marketing Implementation Guide for additional
information.

In the Selection region, select the lists, segments, and employee lists that you
would like to associate with this target group.

Only the lists and segments with the Available status will be listed.

For a target group associated with a telemarketing campaign schedule, you can
optionally enter a Group Code for each of the target group selections.

The Group Code is used to logically group selections within a Target Group and
assigned to telemarketing agents using Oracle Advanced Outbound.

Click Create.
Click Generate Target Group.

Suppression rules (based on suppression list entries with the "Available” status),
control group entries, and deduplication rules (based on activity type) will be
applied when the Target Group is generated. After the Target Group is
generated, the suppression, deduplication, control group, and contact group
information is displayed in the Summary region.

Click the View Entries icon to view the members in a list.

To view and modify the Control Group entries, click the List name in the
Selections region. Click Personalize, add Control Group to the Displayed
column, enter a name for the search, and click Save and Apply.

To modify the details for a target group generation, make the necessary changes
in the Target Group page and click Update. Remember to click Generate Target
Group to regenerate the target group.

6.4.4 Associating Metrics with a Campaign Schedule

Use the following procedure to associate an existing metric with a campaign
schedule.

Prerequisites

A campaign with an associated campaign schedule

The required metric must be set up by the system administrator
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Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Select the relevant campaign, click the Name link of the required campaign
schedule and navigate to Track > Metrics.

All the metrics associated with the campaign schedule are displayed. The
metrics template functionality allows the setup of metrics at an object or custom
setup level.

3. Within the Create New region of the Metrics page, click the Search icon to
display a list of available Metrics and select a metric from the list.

4. Enter the Forecast and Actual values in their respective columns. Optionally,
select a Transaction Date and enter a Description.

The Transaction Date is a reference for you. It is not used within the metrics
logic.

5. Click Create.

The selected Metrics is now associated with the campaign schedule and will
appear in the Metrics region.

6. Click Refresh.

The newly associated metric values are displayed as metrics for the campaign
schedule.

7. To disassociate a metric from a campaign, select its Remove check box and click
Update.

6.4.4.1 Viewing Associated Campaign Schedule Metrics

Use the following procedure to view the metrics associated with a campaign
schedule.

Prerequisites
An existing marketing campaign with an associated campaign schedule

Metrics associated with the campaign schedule
Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.
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2. Select the relevant campaign, click the Name link of the required campaign
schedule and navigate to Track > Metrics.

All the metrics associated with the campaign schedule are displayed. The
metrics template functionality allows the setup of metrics at an object or custom
setup level.

3. Select a View Option and click Go. The following table describes the available
view options. Details is the default view option.

Table 6—4 Campaign Schedule Metrics View Options

View Option Description

Details View all Metrics associated with the Campaign. Summary
Metrics are represented hierarchically and have Rollup,
Manual and/or Function Metrics that define a summarization
as leaf nodes of the Summary Hierarchy.

Formula Only View metrics that are based on the Formula calculation type.
You can also add new formula metrics in this view and enter
the forecast and actual values.

Input Only View metrics that are of Manual calculation type, that is they
have been entered manually. You can also add new metrics in
this view and enter the forecast and actual values.

Function Only View only metrics based on PL/SQL procedures and
functions. You can only input forecast values in this view.

Rollup Only This view is not applicable to campaign schedules as they are
the lowest level objects in the objects hierarchy.

4. Summary metrics are displayed with the option to expand the summary
hierarchy. Select the plus sign (+) to view the next level of detail in the
hierarchy.

5. Based on the Metrics type, you can enter the Actual and Forecast Values for the
metrics.

For Manual, Function, and Formula metric types, you can enter the Actual
Values and the Forecast Values until a campaign schedule becomes active.

6. Click Update to save your changes.

7. Click Refresh to view the newly entered metric values calculated for the
Summary or Rollup Metrics for this campaign schedule.

Creating and Using Campaigns 6-39



Creating a Campaign Schedule

6.4.4.2 Viewing Campaign Schedule Metric Charts

Use the following procedure to view metric charts for a campaign schedule.

Prerequisites
= An existing marketing campaign with an associated campaign schedule

= Metrics associated with the campaign schedule

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Select the relevant campaign, click the Name link of the required campaign
schedule and navigate to Track > Metrics.

All the metrics associated with the campaign schedule are displayed. The
metrics template functionality allows the setup of metrics at an object or custom
setup level.

3. Select a Chart Option and click Go.

The options available are Pie and Bar with Pie being the default. Only summary
metrics will have the chart icon displayed. The chart displays the distribution of
the components that make up the summary metrics. For each component, the
Actual and Forecast values are displayed.

6.4.4.3 Viewing Campaign Schedule Metrics History

You can view the trends of the actual and forecasted values for a metric by viewing
its history. The Metric Background Processes concurrent program records the actual
and forecasted values for metrics and populates the history tables for the
corresponding marketing objects. The values in the metrics history tables are then
used to display the metrics history. Refer Oracle Marketing Implementation Guide for
more information on the background processes.

Use the following procedure to view metrics history.

Prerequisites
= An existing marketing campaign with an associated campaign schedule

»  Metrics associated with the campaign schedule
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Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Select the relevant campaign, click the Name link of the required campaign
schedule and navigate to Track > Metrics.

All the metrics associated with the campaign schedule are displayed. The
metrics template functionality allows the setup of metrics at an object or custom
setup level.

In the Metrics History region, click the Search icon and select a metric whose
history you want to view from the list of values.

Enter the From Date and To Date.
Enter a number and select the Data Interval from the drop-down list.

The data interval options include Day, Week, Month, and Year. Example: if you
enter the number 1 and the data interval as Week, the x-axis coordinates display
1-week intervals.

Select the Value Type.

If you choose Cumulative, then the values are added up for each display
co-ordinate within the x-axis. If you choose Incremental, then the value of the
metric at a given interval is displayed directly.

Click View History.

The trend for the metrics is displayed for the specified time range.

6.4.4.4 Entering Values for Campaign Schedule Metrics

Use the following procedure to enter values for campaign metrics.

Prerequisites

An existing marketing campaign with an associated campaign schedule

Metrics associated with the campaign schedule

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.
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Select the relevant campaign, click the Name link of the required campaign
schedule and navigate to Track > Metrics.

All the metrics associated with the campaign schedule are displayed. The
metrics template functionality allows the setup of metrics at an object or custom
setup level.

Select the Input Only view option and click Go.
This is the best option for entering forecast and actual values for a metric.

Summary and Rollup Metrics are displayed with the option to expand the
metrics hierarchy. Select the plus sign (+) to expand the metrics hierarchy and
view the next level of detail.

Enter values for Forecast and Actual where applicable.

You cannot update the Forecast Value for an active campaign schedule. The
Actual Value for Function metrics is automatically calculated and displayed.

Click Refresh to view the updated metric values in the Summary or Rollup
Metrics for this campaign schedule.

6.4.5 Associating Costs and Revenues with a Campaign Schedule

Use the following procedure to associate existing costs and revenues metrics with a
campaign schedule.

Prerequisites

A campaign must exist with an associated campaign schedule

The required Cost or Revenue metric should be set up by your System
Administrator

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Select the relevant campaign, click the Name link of the required campaign
schedule and navigate to Track > Costs and Revenues.

All the costs and revenues metrics associated with the campaign schedule are
displayed. The metrics template functionality allows the setup of metrics at an
object or custom setup level.
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Click the Search icon within the Create New region of the Costs and Revenues
Details page and select a Cost or Revenue Metric from the list.

Select the currency and enter the forecast and actual values for the cost or
revenue.

Select a transaction date and enter a description. The transaction date is a
reference for you. It is not used within the metrics logic.

Click Create. The selected cost or revenue metric is now associated with the
campaign and will be displayed in the relevant Costs or Revenues region.

Click Refresh to view the Summary or Rollup metrics of the newly associated
cost or revenue metric.

To disassociate a cost or revenue metric from a campaign schedule, click its
Remove check box and click Update.

6.4.5.1 Viewing Associated Campaign Schedule Costs and Revenues

Use the following procedure to view the costs and revenue metrics associated with
a campaign schedule.

Prerequisites

A campaign must exist with an associated campaign schedule

Cost or Revenue metrics should have been associated with the campaign
schedule

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Select the relevant campaign, click the Name link of the required campaign
schedule and navigate to Track > Costs and Revenues.

All the costs and revenues metrics associated with the campaign schedule are
displayed. The metrics template functionality allows the setup of metrics at an
object or custom setup level.

Select a View Option. Detail is the default view option.

Table 6-3 contains the description of the different view options available.
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Table 6-5 Campaign Schedule Cost and Revenue Metrics View Options

View Option Description

Detail View all Cost and Revenue metrics associated with the
campaign schedule. Summary Metrics are represented
hierarchically with Rollup, Manual, and/or Function Metrics
that define a summarization as leaf nodes of the Summary
Hierarchy.

Formula Only View only composite values of Cost and Revenue metrics
based on formulas set up for the campaign schedule. Formula
metrics are calculated only for the values at the current level.
Rollup and summaries are not valid for formula metrics.

Function Only View only Cost and Revenue metrics based on PL/SQL
procedures and functions. You can only input forecast values
with this option.

Input Only View only the manually entered Cost and Revenue metrics.
This option allows you to enter forecast and actual metric
values. You cannot modify the forecasted values when the
campaign schedule is active.

Rollup Only This view is not applicable to campaign schedules as they are
the lowest level objects in the objects hierarchy.

4. Summary Cost and Revenue metrics are displayed with the option to expand
the summary hierarchy. Click the plus sign (+) to view the next level of detail in
the hierarchy. New row(s) appear displaying the individual cost or revenue
metrics that are part of the hierarchy.
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6.4.5.2 Viewing Campaign Costs or Revenues Charts

Use the following procedure to view cost or revenue charts for a campaign
schedule.

Prerequisites

A campaign must exist with an associated campaign schedule

Cost or Revenue metrics should have been associated with the campaign
schedule

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Select the relevant campaign, click the Name link of the required campaign
schedule and navigate to Track > Costs and Revenues.

All the costs and revenues metrics associated with the campaign schedule are
displayed. The metrics template functionality allows the setup of metrics at an
object or custom setup level.

Select a Chart Option and click Go.
Chart options include Pie and Bar, with Pie being the default option.

To view the chart displaying summarized cost or revenue information, select
the Chart icon above the Cost or Revenue region. To view the chart for a single
cost or revenue component, select the chart icon in the corresponding row.

The chart displays the distribution of the components that make up the
summary Costs or Revenues. For each component, forecasted and actual values
are displayed.

Note that the chart icon is displayed only for the summary Costs or Revenues
metrics.

6.4.5.3 Viewing Campaign Costs and Revenues History

You can view the trends of the actual and forecasted values for Cost or Revenue
metrics by viewing their history.

Prerequisites

A campaign must exist with an associated campaign schedule
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s Cost or Revenue metrics should have been associated with the campaign
schedule

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Select the relevant campaign, click the Name link of the required campaign
schedule and navigate to Track > Costs and Revenues.

All the costs and revenues metrics associated with the campaign schedule are
displayed. The metrics template functionality allows the setup of metrics at an
object or custom setup level.

3. Click the Search icon in the History region of the Costs and Revenues page and
select the Cost or Revenue metric whose history you want to view.

4. Enter the From Date and To Date to indicate the duration for which you want
the history.

5. Enter a number and select the Data Interval from the drop-down list.

The data interval options include Day, Week, Month, and Year. Example: if you
enter the number 1 and the data interval as Week, the x-axis coordinates display
1-week intervals.

6. Select a the Value Type, which can be Cumulative or Incremental.

If you choose Cumulative, then the values are added up for each display
co-ordinate within the x-axis. If you choose Incremental, then the value of the
metric at a given interval is displayed directly.

7. Click View History.

The trends for the selected Cost or Revenue metrics are displayed both as a
table and a chart.

6.4.5.4 Entering Values for Campaign Costs and Revenue Metrics

Use the following procedure to enter values for campaign schedule costs and
revenues.

Prerequisites
= A campaign must exist with an associated campaign schedule
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s Cost or Revenue metrics should have been associated with the campaign
schedule

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Select the relevant campaign, click the Name link of the required campaign
schedule and navigate to the Costs and Revenues side navigation link.

All the costs and revenues metrics associated with the campaign schedule are
displayed. The metrics template functionality allows the setup of metrics at an
object or custom setup level.

3. Select Input Only from the View Options drop-down list and click Go.

All the details of the cost and revenue components for the campaign schedule
are displayed.

4. Enter or modify values for Forecast and Actual where applicable.

You cannot update the forecast value when a campaign schedule is Active.
5. Click Update to save your changes.
6. Click Refresh to view the updated summary of the cost and revenue values.

7. To disassociate a cost or revenue metric from a campaign schedule, click its
Remove check box in the Cost or Revenue region and click Update.

6.4.6 Sourcing Budgets for a Campaign Schedule

To source funds for a campaign schedule, you can associate a campaign schedule to
a budget.

Use the following procedure to associate a campaign to a budget and to create a
budget request.

Prerequisite
As existing marketing campaign with an associated campaign schedule

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.
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Select the relevant campaign, click the Name link for the appropriate campaign
schedule, and click the side navigation Budget link.

For a new campaign schedule, enter the Initial Estimated Budget in the
currency indicated and click Update. To update the initial estimated budget for
a campaign, enter the changed amount and click Update.

Select Source from Parent for the budget for the campaign schedule to be
sourced from the parent campaign’s budget.

To create a budget request, click Create Request.
Enter the necessary details in the Budget Source and Request Details regions.

Information about the object for which the budget request is made is displayed
in the Budget Recipient region.

Click Create to save the request details.

6.4.7 Transferring Funds from a Campaign Schedule to a Budget

Creating a Transfer returns budget funds to a budget. This is generally used to
return a partial amount back to a budget.

Prerequisites
An existing Campaign with a Campaign Schedule

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Select the relevant campaign, click the Name link for the appropriate campaign
schedule, and click the Budget side navigation link.

To request a transfer of funds from the campaign schedule to a budget, click
Create Transfer.

Enter the necessary details and click Create.

Enter a Holding Owner only if the funding source is derived from a partner or a
vendor.

Click Update in the Sourcing Details region and click the Details icon to view
the latest summarized information of the budget request and budget transfer.
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6.4.8 Associating Offers to a Campaign Schedule

Use this procedure to associate offers to a campaign schedule.

Prerequisites
An existing Campaign with a Campaign Schedule

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Select the relevant campaign, click the Name link for the appropriate campaign
schedule, and click the Offers side navigation link.

3. Using the Search icon, select the offers that you want to add to the schedule.
4. Click Update.

6.5 Using Collaboration with Campaign Schedules

Oracle Scripting integrates with Oracle Marketing to help you interact with
customers and track such interactions. Topics in this section include:

= Section 6.5.1, "Scripting Overview"

= Section 6.5.2, "Associating Scripts to a Campaign Schedule"

6.5.1 Scripting Overview

The goal of the integration between Oracle Marketing and Oracle Scripting is to
provide marketing managers with the ability to follow-up on the campaigns they
design with a scripted flow of interactions (either through the Web or a call-center).

One of the resulting benefits is to enable marketers to automate and streamline
some marketing-specific activities like event registration or lead creation.

As another benefit, the branching functionality of Oracle Scripting enables
marketing organizations to react differently to the input of different customers
based on their profile or on the answers they provide to questions, and thus to
develop a personalized relationship with customers.

Scripting is integrated in Marketing through the use of click-through destinations
(CTDs) that can be enabled behind a banner on store, via an e-mail, or even
associated in direct marketing collateral. You can invite a list of customers to
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participate in a survey campaign or direct them to specific Web sites by visiting a
defined URL. The return data from surveys can be used to evaluate customer
satisfaction, improve product lines, target new or improved services, or otherwise
improve responsiveness.

6.5.1.1 Scripting Integration Process Flow

The following diagram illustrates the Oracle Marketing/Oracle Scripting
integration flow.

Scripting Author : Marketing Manager : Customer
| |
| |
Adapt Seeded Script or I |
Author Mew One | |
1 | |
N | |
eploy Script | |
| | Link Campaign |
I Schedule to Script |
| | |
| Execute Campaign |
I Schedule |
| | | Respond to Campaign
I | Schedule
| | !
: : Interact with Script
| |
Check Reports
I
I I
I End |
| I

The high-level process flow is as follows:
1. A script is created in Oracle Scripting.

2. The Script is deployed in Oracle Scripting.
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3. The marketer links a campaign schedule to the script (using click-through
destinations for Web scripts).

4. Customers responding to the schedule are taken through the script, the
customers' answers are collected, and the potential action (event registration,
lead creation) is executed.

5. Marketer can check the schedule dashboard for a report on the results of the
schedule.

6.5.1.2 Seeded Scripts

Oracle Marketing comes with seeded scripts for the following marketing-specific
activities:

s User Authentication

= Event Registration

= Event Registration Cancellation

s Lead Creation

s Customer Data Acquisition

These seeded scripts are intended to be usable with minimum configuration and to
be deployed as either call center scripts or Web scripts. Some components or
building blocks are also seeded to allow customer identification and customer
authentication. Refer Oracle Marketing Implementation Guide for more information.

Based on how a script is used, it can be an Inbound script or an Outbound script.
For example, when a customer calls a vendor to purchase a product or to ask for
product details, the telesales agent opens a script (that can be a questionnaire) and
uses it to interact with the customer. As it is used for an inbound call, this script is
an Inbound script. Whereas, when a telesales or telemarketing agent initiates calls
to customers or prospects, and if the prospect chooses to talk to the agent, the agent
will open a script and use it to interact with the customer. As it is used for an
outbound call, this script is an Outbound script.

6.5.2 Associating Scripts to a Campaign Schedule

Use the following procedure to associate Inbound or Outbound scripts with a
campaign schedule.

Prerequisites
An existing campaign with a campaign schedule

Creating and Using Campaigns 6-51



Understanding Web Marketing

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Select the relevant campaign, click the Name link for the appropriate campaign
schedule, and click the Contact Point side navigation link.

Based on your requirement, select Inbound Script or Outbound Script as the
Type.

Click the Search icon and select a script from the list of values.
Click Update.

To disassociate a script from a campaign schedule, select its Remove check box
in the Contact Points page and click Update.

To view the responses to the deployed scripts, select the campaign schedule and
navigate to the Dashboard side navigation link.

6.6 Understanding Web Marketing

There are two ways to do Web Marketing in the 11.5.10 release of Oracle Marketing,
one using the Execution tab and the other from the Campaign Workbench. It is
recommended that Campaign Workbench be used in most cases, unless there are
custom conditions needed, in which case Web Marketing from the Execution tab
will need to be used. The following sections pertain only to Web Marketing from the
Execution tab. See Section 8.3, "Understanding and Creating Web Schedules" to
know how Web Marketing works from the Campaign Workbench.

Topics in this section include:

Section 6.6.1, "Web Marketing Concepts"

Section 6.6.2, "Web Marketing Content"

Section 6.6.3, "Personalizing Web Marketing Content"
Section 6.6.4, "Using Style Sheets to Display Content"
Section 6.6.5, "Understanding Web Postings"

Section 6.6.6, "Web Marketing Strategy"

Section 6.6.7, "Display Priority"

Section 6.6.8, "Understanding Web Placements"

Section 6.6.9, "Associating a Posting to Placements"
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Section 6.6.10, "Runtime Actions for Postings"

Section 6.6.11, "Extending Web Marketing"

6.6.1 Web Marketing Concepts

To leverage the capabilities of the Internet, you can use the Web Marketing
(formerly called eMerchandising) functionality of Oracle Marketing to display
personalized content, such as ads, offers, and product recommendations in web
sites. Sites can be from Oracle iStore, Oracle iSupport, or Oracle Partner Portal. Most
Web Marketing capabilities can also be used with custom web sites.

The business benefits from Web Marketing include:

Targeting the right customers at the right time by displaying specific ads only to
specific customer segments

Maximizing shopping cart value by making product recommendations based
on a customer’s browsing behavior, purchase behavior, and shopping cart
contents

The Web Marketing Process

Figure 6-3 depicts the flow of tasks when you create an ad, offer, or product
recommendation for a Web site. You would:

Create a posting

Specify the content type for the posting

Define the schedule selection strategy for the posting
Specify content display priority for the posting

Create a placement to select the physical location on a Web site where the
content will be displayed

Select a Placement Style

Associate the posting to a placement
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Figure 6-3 Web Marketing Process Flow
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6.6.2 Web Marketing Content

In Web Marketing, the content type specifies the type of Web posting. The three
categories of content types are:

s Section 6.6.2.1, "Product Recommendation"
s Section 6.6.2.2, "Web Advertisements"
s Section 6.6.2.3, "Web Offers"

6.6.2.1 Product Recommendation

These are Inventory products published on Oracle iStore as Product Details. This
content type makes product recommendations to the visitor by picking the products
from the inventory. In Oracle iStore, images (media objects) are assigned to products
and these images are displayed to customers.

At runtime, the recommended products are automatically filtered by the following
criteria:

s Published flag: all the recommended products must be published in Oracle
iStore

s Customer’s specialty store: the visitor has the ability to buy all recommended
products

6.6.2.2 Web Advertisements

Web ads refer to Oracle Marketing campaign schedule objects of type Internet
Advertisement. You can use Web ads to improve product brand or company
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awareness or to alert a customer of new and upcoming products, deals, or other
information.

Important: The selected campaign schedules are automatically filtered by the
visitor’s target group, if any. In Oracle Marketing, a schedule can be associated with
a target group, consisting of a combination of lists, segments and workbooks. It is
important for the marketer that only the customers pertaining to the schedule’s
target group be exposed to the campaign. Therefore, with this ability at runtime,
eMerchandising selects only the campaigns for which the visitor is eligible.

A Web advertisement can have campaign schedule of content type Web Image or
Web Text.

For details on stylesheet, see Section 6.6.4, "Using Style Sheets to Display Content".
Web Image

A Web advertisement of content type Web image, can be an existing image on your
server or a new image uploaded from your client. You can specify the width and
height (in pixels) of the image, or accept the defaults based on the image file
selected. The image can have alternate text, which will be displayed when the
cursor is placed over the image. You can specify a specific language for the image or
accept the default or All Languages. Click-through destination of the image, which,
as the name indicates, is the destination to which the Web visitor is directed upon
clicking on the image. The content types and subtypes determine the style, or look
and feel, that is applied to the Web image.

Web Text

A Web advertisement of content type Web text contains a display text that is
displayed in Oracle iStore or any Web site. You can select a specific language for the
text or accept the default, or All Languages.

As with Web images, the subtypes are used in conjunction with Styles to display the
text with the associated style.

6.6.2.3 Web Offers

Web Offers are marketing offers that are associated with a campaign schedule of
type Internet Promotion. At runtime, eMerchandising renders the content (Web
image or Web text) associated with an offer.

6.6.3 Personalizing Web Marketing Content

You can personalize the content in the following way:
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= Select segments and lists to target. These can be defined in the Audience tab of
Oracle Marketing. Lists are a combination of segments, workbooks, and other
lists. At runtime, the eMerchandising engine checks if the visitor is part of at
least one of the selected segments or lists. This allows you to define rules, such
as, “If the visitor is part of the 18-25 year-old or 26-35 year-old segment, then
recommend the following list of products.”

= Compare the total amount of the active shopping cart to a value specified in the
default currency (as defined in the Administration page). This allows you to
define rules, such as, “If a visitor’s shopping cart amount is greater than $1,000
display the high-end product line advertisements.”

s Create your own custom conditions - your administrator can do it for you in the
Administration tab.

6.6.4 Using Style Sheets to Display Content

A style sheet is used to display content of types Web Image or Web Text. Web
images are rendered on the Web site with a short description. A style sheet can be of
type universal, half banner, full banner, and so on. Style sheets are applied to the
XML content returned by the eMerchandising engine at runtime.

A stylesheet is used to display content of different type, Web Image or Web Text.
You can create new styles by copying and modifying the style sheets provided out
of the box. For information on customizing stylesheets and samples, see the Oracle
Marketing Implementation Guide.

6.6.5 Understanding Web Postings

A posting is an object that holds the content type, content selection, and display
strategy in Web Marketing. There are two types of postings:

Universal Posting

A universal posting applies the same merchandising strategy to all the online
visitors; however, the strategy may return different personalized content to different
visitors.

Rule-Based Posting

For a rule-based posting, you can define a set of one or more rules that will define
the content to be displayed. Using rule-based postings, you can apply different
merchandising strategies to different visitors. Rules are based on visitors’ status
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(anonymous or registered), their shopping cart value, their last quote, their
browsing behavior, their belonging to a marketing list, and so on.

The content types, strategy types, and associated placements are the same for
universal and rule-based posting.

For a rule-based posting, you must specify:

s Content type - if you are creating a Product Recommendation, Web
Advertisement, or Web Offer.

s Maximum number of items to be displayed - if the strategy you have specified
returns many content items for a posting, you can specify the maximum
number that must be used for display. For example, you can specify that you
want a maximum of three product recommendations to be displayed on the
home page, even if different rules together return five recommendations. These
can be displayed randomly or based on the display priority that you have set.
The default value of this maximum number is 1.

= Rules - for each rule, you must specify a merchandising strategy, a display
priority (to indicate the order in which the content returned by the rule will be
displayed), a list of targeting rules, a list of conditions, and the default content
that must be displayed if no content is returned by the rule. If you define
multiple conditions, they are all joined by the logical AND and the options for
each condition are joined by the logical OR. For example, you can specify the
condition as Anonymous Visitor OR Registered without Purchase History AND
has Shopping Cart Total greater than or equal to $100 AND belongs to the Gold
Customers segment OR belongs to the Platinum Customers segment.

»  Status - Its default value is Active. You may want to change its status to Inactive
if you no longer want to use the posting.

Note: Because the priority value helps the eMerchandising engine
decide which rule to implement at run time, you cannot assign the
same priority to more than one rule.

6.6.6 Web Marketing Strategy

A merchandising strategy is an algorithm used to select the personalized content
items to be returned by a posting. The Web Marketing strategy types are:

= Section 6.6.6.1, "Manual Selection (Specific List of Content Items)"
= Section 6.6.6.2, "Predefined Relationships"
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s  Section 6.6.6.3, "Oracle Personalization"

= Section 6.6.6.4, "Custom Strategies"

6.6.6.1 Manual Selection (Specific List of Content ltems)

Based on the content type selected at the posting level, the Web Marketing
administrator has access to a list of relevant content items and picks from those to
create the list. Example: select a campaign to display from amongst a given list.

6.6.6.2 Predefined Relationships

This type of merchandising strategy leverages the association between content
items and inventory products, as well as the item relationships amongst the
inventory products as defined in Oracle iStore or Inventory. The Web site and
marketing administrator would have defined the product relationships in
Inventory, Oracle iStore (on the Merchant page), or Oracle Marketing (in the
Product tab). For example, you may want to display an ad to cross sell a product
related to a product in the customer’s shopping cart.

You may choose to have the merchandising strategy return:

a. Content which is directly associated to a product context. For Example,
“Select the Web Ads that are directly associated with the products on page.”

b. Content which is associated to products that are linked to a product context
by an item relationship. For example, “Select the Web Ads for products up
selling the products in the cart.”

When you choose to display products based on their relationship, you must specify
the product context - products being viewed on the page or products in the active
shopping cart.

The association between a content item and an inventory product can be of a
different nature based on the content type. For a Web Ad, you may make the
association when you create a campaign schedule and for a Web Offer, when you
create an offer.

6.6.6.3 Oracle Personalization

In order to remain highly effective in the fast-paced Web marketing field and to
keep the best customers coming back to their Web sites, you must deploy
personalized and just-in-time messages to your customers. You need to capture
customers’ real-time interactions, analyze those interactions, and provide real-time
recommendations based on current and past browse behavior.
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In the Oracle E-Business Suite, customer data is captured and tracked by the Oracle
Personalization module. To create product recommendations based on this data,
you need to select Oracle Personalization as the Recommendation Type when you
are creating a Product Recommendation Web schedule.

The following are the parameters that you can define settings for and a brief
explanation of each:

Filter

Include Product Previously Bought (Unchecked by default) - When
checked, products that have been previously bought by the visitor can still
get recommended by OP

Context

Best Context Available (Default) - Context used for recommendation will be
products in shopping cart if available. If none, then product on page
browsed. If none, then only the customer identity will be used. Note that
customer identity is also used as part of context for ‘products on page
browsed' or 'products in shopping cart'

Products in shopping cart - Context used for recommendation will be
products currently in the shopping cart and the customer identity

Products on page browsed - Context used for recommendation will be
products on page being browsed and the customer identity

Customer identity only - Context used for recommendation will be the
visitor himself, without regard for what product he is looking at or put in
his shopping cart

Base Data - The recommendation model is generated using all historical orders
and select historical navigational data. What the selections for 'Base Data'
determine is if the visitor's particular session information and/or historical
information should be a factor in making the recommendation.

Both Current Session and History (Default) - Basically use all the data
available

Current session only - Only current session data will be used with the
recommendation model

History only - Only the customer's historical data will be used with the
recommendation model; current session data is ignored
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Sample Use Cases for Changing OP Parameters

While the default settings will be sufficient for most scenarios, the user may want to
modify some of these settings based on their marketing objectives. Some sample use
cases where settings are modified follow:

Products Sold are Consumable

Products can be one-time purchases (usually durable goods, CDs, software with
specific versions) or consumable with repeat purchases. If products tend to be
repeat purchases, then the following should be set:

»  Filter - Check the 'Include Product Previously Bought' check box

This does not mean that previously bought products "WILL" be recommended -
it just means that they are not out of contention.

‘Impulse’' Buy

Analogous to check-out counters at the supermarket, additional products can be
displayed that have a high possibility of being bought, regardless of what the
person is buying right now. The following should be set:

s Placement is a location in the Shopping Cart page
s Context - Customer Identity Only
= Base Data - History Only

Cross-sell and Up-sell Based on Products Being Browsed

The intent here is that whatever it is that the visitor is browsing, always cross-sell or
up-sell him the things that he is most likely to buy together with the product
browsed. In this case, the following should be set:

»  Placement is either a location in the Product Detail page or in the Shopping Cart
page
= Context - Products on Page Browsed or Products in Shopping Cart

= Base Data - Both Current Session and History or History Only

6.6.6.4 Custom Strategies

You can create your own strategies beyond Manual, Product Relationship, and
Oracle Personalization. You can incorporate business priorities and their order
(ascending or descending) based on:

s Product list price for the product recommendations
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s Campaign priority or campaign schedule start date and end date for Web
Advertisements

m  Offer start and end date for Web offers

For information on creating custom strategies, refer Oracle Marketing Implementation
Guide.

Note: Sample custom strategy classes for all the three content
types are shipped with Oracle Marketing. See the Oracle Marketing
Implementation Guide for details.

6.6.7 Display Priority

Aside from showing the highest affinity content to a customer, you may want to
push content based on specific business reasons. For example, you may want to
display high-priced products for a high-end customer and not just display products
in the order of retrieval. You can achieve this trade-off of affinity-based pull versus
business driver-based push by defining display priority for the content items
returned by the merchandising strategy.

You have different options to set the display priorities for different strategies and
different content types. For example, for Web Ads and Web Offers, you may want
the display to be based on their start dates; for a Product recommendation, you may
want to display products on descending order of their prices.

6.6.8 Understanding Web Placements

A Web placement is a logical representation for a physical space on an application
page, where some content (returned by a posting) is displayed. It is identified by a
site, a page, a location, and eventually some page parameters. You can activate a
placement once you assign a posting and style to display.

Site
A site is an Oracle e-Business suite application or any other HTML site which is
using Web Marketing to display personalized content.

Web Marketing is shipped with seeded sites out-of-the-box (Oracle iStore and
Partners Online) and a screen will be available to register new sites.
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Page

A page in Web Marketing may represent a unique page in an application or a
template, based on how you want to classify their placements. In the case of Oracle
iStore, pages are logical templates as defined in the “Templates’ tab of the Oracle
iStore Merchant Ul. Oracle iStore pages are treated as default, and come seeded
(Section, Product Details, and Shopping Cart pages) with the application.

Location

A location is the place in a page where the placement is situated. You can use
out-of-the-box, seeded values for specifying the location. Your administrator can
also register new locations. Refer to the Oracle Marketing Implementation Guide for
information on registering a new location.

6.6.8.1 Oracle iStore Placements
The following are the main Oracle iStore concepts applicable to Web Marketing:

s Product Details - The Product Details page is displayed to the visitor on clicking
the product. It refers to the detailed description of a particular product and can
include a text description and an image of the product.

»  Specialty Stores - These are different stores within a single instance for serving
different customer segments. Each store can have its own product selection,
user interface and process flows, while all stores can leverage a unified, central
merchant administration and product and content repository.

= Multimedia Components - These are used to enhance the presentation of
products to Oracle iStore visitors. Examples of multimedia files could be a
picture of a certain size, audio of a certain length, animation sequence or text.
Oracle iStore supports logical groupings of several multimedia components that
can be rendered based on the selected specialty store and language
combination.

m Bins - These are content containers within Oracle iStore.

In Web Marketing, you can create placements that are associated to the Oracle iStore
bins that are enabled. Placements can be created for each specialty store and each
tab.

The following example explains the rules for Oracle iStore placements for Specialty
store and Tab; where, Page is Product Details and Location is Left Bin 3:
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Table 66 Example for Specialty Store and Tab

Specialty Store Tab Posting Priority
Vision.com Home P1 1
Vision.com Any P2 2
Any Home P3 3
Any Any P4 4

Note: Defined values have priority over Any and Specialty store
have priority over Tab.

s If visitors are on the Vision.com Specialty Store and the Home tab, they get the
P1 posting.

= If visitors are on the Vision.com Specialty Store and any tab other than Home,
they get the P2 posting.

= If visitors are on any Specialty Store and the Home tab, they get the P3 posting.

= If visitors are any Specialty Store and any tab, they get the P4 posting.

6.6.8.2 Partner Portal Placements

With Web Marketing, you can display personalized Web ads and offers on the home
page of Oracle Partner Portal. The two seeded placements for the Oracle Partner
Portal are the top and bottom of the Home page.

The profile PV: Enable Web Marketing globally controls the use of Web Marketing
on Oracle Partners. Set profile option to Yes at Site, Application and Responsibility.
For details, see the Oracle Marketing Implementation Guide.

6.6.8.3 Other Placements

A placement can be used on other corporate sites to personalize content based on
legacy customer data that is not stored in Oracle Applications.

Sites that implement Oracle Marketing (not a third-party company) can create
segments in Oracle Marketing. The segments can be re-used in a rule-based posting
to personalize Web advertisements on corporate web sites or an employee portal
built with Oracle Portal.
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6.6.9 Associating a Posting to Placements

The associated placements page of a posting displays all the locations that will
display a posting. You can drill down to view the details of the placement. You can
specify the style to be applied to the posting/placement combination and indicate if
this posting/placement combination is active or inactive, or you can remove the
association altogether.

6.6.10 Runtime Actions for Postings

Table 6-7 lists the runtime actions for a Universal Posting.

Table 6—-7 Universal Postings at Runtime

Content Type Strategy Type Runtime Actions
Product Manual Selection = Displays iStore product details and
Recommendation description

= Selects the product list from manually
specified list from Inventory

= Filters the list by maximum number
of items to display and the display

priority
Provided the product:

= Belongs to the visitor’s iStore
Specialty Store (also called Site)

= Is published in /Store

Product Product Relationship |« Displays iStore product details and
Recommendation description

= Selects products based on their
relationship to the products currently
on the page or in shopping cart

s Filters based on maximum number of
items to display and the display
priority

Provided the product:
»  Is published in iStore

= Belongs to the visitor’s iStore
Specialty Store (also called Site)
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Table 6—-7 Universal Postings at Runtime

Content Type Strategy Type Runtime Actions
Product Oracle = Displays iStore product details and
Recommendation Personalization description
»  Selects products based on Oracle
Personalization’s determination on
what products a visitor is most likely
to buy
s Filters based on maximum number of
items to display and the display
priority
= Caninclude or exclude products
currently on page
Provided the product:
»  Is published in iStore
= Belongs to the visitor’s iStore
Specialty Store (also called Site)
Note: For more information on Oracle
Personalization and its parameters, see
Section 8.3.3.1, "Understanding Oracle
Personalization".
Product Custom s User defined
Recommendation = Sample custom condition retrieves all
the products that are created within
the last 30 days
Web Ad Manual Selection = Selects from the manually specified

list of active Web Ad campaign
schedules

= filter the list by maximum number of
items to display and the display
priority

Provided that:

= Visitor belongs to a segment or target

group associated with the Web Ad
campaign schedule

»  Current date is within campaign
schedule start/end dates
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Table 6—-7 Universal Postings at Runtime

Content Type Strategy Type Runtime Actions
Web Ad Product Relationship | = Selects Web Ad campaign schedules
associated to products with a
relationship to the products currently
on the page or in shopping cart
= Caninclude/exclude products
currently on page
= Subject to maximum number of items
to display and the display priority
Provided that:
= The visitor belongs to a segment or
target group associated with the Web
Ad campaign schedule
»  Current date is within campaign
schedule start/end dates
Web Ad Oracle = Selects Web Ad campaign schedules
Personalization associated to products that Oracle
Personalization has determined as
products a visitor is most likely to
buy
= Caninclude/exclude products
currently on page
= Subject to maximum number of items
to display and the display priority
Provided that:
= the visitor belongs to a segment or
target group associated with the Web
Ad campaign schedule
= current date is within campaign
schedule start/end dates
Note: For more information on Oracle
Personalization and its parameters, see
Section 8.3.3.1, "Understanding Oracle
Personalization".
Web Ad Custom s User defined
= Sample custom condition retrieves all
the products that are created within
the last 30 days
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Table 6—-7 Universal Postings at Runtime

Content Type

Strategy Type

Runtime Actions

Web Offer

Manual Selection

Displays the content defined for the
offer in iStore

Selects from the manually specified
list of active Web Offer campaign
schedules

Filter the list by maximum number of
items to display and the display

priority

Provided that:

The visitor belongs to a segment or
target group associated with the Web
Offer campaign schedule

Visitor is eligible for the offer

Current date is within campaign
schedule start/end dates

Web Offer

Product Relationship

Displays the content defined for the
offer in iStore

Selects products based on their
relationship to the products currently
on the page or in shopping cart

Subject to maximum number of items
to display and the display priority

Can include/exclude products
currently on page

provided that:

The visitor belongs to a segment or
target group associated with the Web
Offer campaign schedule

Visitor is eligible for the offer

Current date is within campaign
schedule start/end dates
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Table 6—-7 Universal Postings at Runtime

Content Type Strategy Type Runtime Actions
Web Offer Oracle Displays the content defined for the offer
Personalization in iStore

Selects products based on Oracle
Personalization’s determination on what
products visitor is most likely to buy

Subject to maximum number of items to
display and the display priority

Can include/exclude products currently
on page

provided that:
The visitor belongs to a segment or target

group associated with the Web Offer
campaign schedule

Visitor is eligible for the offer

Current date is within campaign schedule
start/end dates

Note: For more information on Oracle
Personalization and its parameters, see
Section 8.3.3.1, "Understanding Oracle
Personalization".

Web Offer Custom User defined

Sample custom condition retrieves all the
products that are created within the last 30
days

As a rule-based posting consists of a set of one or more rules, first the rules’
conditions or criteria are to be met. Once the conditions are met, the strategy type
determines what content is displayed. The strategy types are the same as those used
in a universal posting. The following runtime actions takes place before applying
the strategy:

»  Evaluate conditions for highest priority rule
= If the conditions are false, it picks the next rule in the order of priority
= If the conditions are true, then apply the strategy

s If the number of items returned is less than the maximum number, evaluate the
next rule in order of priority
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Associate products and segments of the Web ad campaign schedule is used as part
of the strategy for displaying content to visitors. The associated products will be
used in the strategy type product relationship to determine what Web ads to display
based on the associated products’ relationship to the products in the shopping cart
or on the page.

The associated segments will be used to validate that a visitor is in an associated
segment before displaying content from a particular campaign schedule. The
campaign schedule segment is intersected with the segment conditions in a
rule-based posting. That is, the visitor must fall into both the segment(s) associated
with the campaign schedule as well as the segment(s) specified in the rule
condition.

For rule-based runtime actions, see the Runtime Action column in Table 6-7.

Note: When an advertisement is displayed on a corporate site
(recommend by the runtime engine), the embedded URL may link
to a restricted specialty store in Oracle iStore. If a user does not
have access privilege to the specialty store, then a warning message
appears. This is because the specialty store information for the
content is defined when the content is created and not at runtime
when the advertisement is displayed.

To avoid this scenario, you can use a manual selection strategy and
select advertisements on specialty stores that provide unrestricted
access to all users.

6.6.11 Extending Web Marketing

Web Marketing provides you the flexibility to create your own custom conditions
and strategies. It also allows you to create your own pages, sites, and styles. This
can be done in the Administration tab of Oracle Marketing. After creating these
custom conditions, strategies, page, style, and sites, you need to implement them to
use them effectively. For more information on creating and implementing these, see
the Oracle Marketing Implementation Guide.

6.7 Creating and Managing Web Marketing Content
The following procedures are explained in this section:

»  Section 6.7.1, "Creating Web Advertisements"
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= Section 6.7.2, "Creating Web Offers"

= Section 6.7.3, "Creating Products Media"

= Section 6.7.4, "Managing Universal Postings"

= Section 6.7.5, "Managing Rule-Based Postings"

= Section 6.7.6, "Managing Placements"

6.7.1 Creating Web Advertisements

Use the following procedures to create Web ads:
= Section 6.7.1.1, "Creating a Campaign Schedule of Type Internet Advertisement"
= Section 6.7.1.2, "Creating Content"

6.7.1.1 Creating a Campaign Schedule of Type Internet Advertisement
Use this procedure to create Campaign Schedule of type Internet Advertisement.

Prerequisites
An active campaign must exist

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Click the Names link of the campaign for which you want to create a schedule
and navigate to Execution > Campaign Schedule.

Click Create.

From the Setup Type drop-down list, select Internet Advertisement.
Enter a Name and other required details for the Campaign Schedule.
Click Create.

Click Request Approval to change the status to Active.

® N o a » @

In the Preview Approval page, select the User Status to Active and click
Confirm.
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Note: This procedure does not list all the steps to create a
campaign schedule. The fields that are specific to Web ads only are
mentioned. For information on creating a campaign schedule, see
Section 6.4, "Creating a Campaign Schedule".

6.7.1.2 Creating Content

Use this procedure to create content for a campaign schedule of type Internet
Advertisement.

Prerequisites

An active campaign and an associated campaign schedule of type Internet
Advertisement

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Select the campaign, click the Name link of the campaign schedule, and click
the Content side navigation link.

Click Create.
Select a Type and Subtype and enter a Description.

If the Type you have chosen is Web Image, enter the details in the Image and
Click Through Destination regions.

If the Type you have chosen is Web Text, enter the Display Text, select a
Language for the display, and enter the details in the Click Through Destination
region.

Select the Track check box to log the interactions.
Click Create.

To disassociate content from a campaign schedule, click its Remove check box
in the Content page and click Update.

6.7.1.3 Creating Web Advertisement Click-Through Destinations

Use this procedure to create click-through destinations for a Web ad.
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Prerequisite
A Campaign must exist

Steps

1.

© N o a k w

10.

11.

12.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the Names link of the campaign for which you want to create a schedule
and navigate to Execution > Campaign Schedule.

Click Create.

From the Setup Type drop-down list, select Internet Advertisement.
Enter a Name and other required details for the Campaign Schedule.
Click Create.

Click the Content side navigation link and click Create.

In the Type drop-down choose one of the following:

= Web Image: Displays an image to the user. The user clicks the image and is
routed to the destination page defined.

= Web Text: Display text to the user. The user click the text and is routed to
the destination page defined.

Select a suitable Subtype.

If the Type you have chosen is Web Image, click the Search icon and select an
image. If using an image that has not yet been uploaded, select Upload new
image.

If the Type you have chosen is Web Text, enter the Display Text and select a
Language for the display.

In the Click-Through Destination section enter an action for the CTD.

= Based on the action selected, the application will populate available
parameters.

= For example, if the action “Go to iStore Shopping Cart” is selected, the
application will populate, and next you will be prompted to select a
specialty store.

= You will not be able to preview the web advertisement in a web storefront
until you are in a runtime environment.
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13. Click Create.

14. To preview the CTD, click the Description link for the content in the Content
page and click Preview.

A Preview window opens displaying either the image or text selected for the
Web advertisement.

6.7.2 Creating Web Offers

Use the following procedures to create Web offers.

= Section 6.7.2.1, "Creating a Campaign Schedule of Type Internet Promotion"
= Section 6.7.2.2, "Associating Offers to a Campaign Schedule"

= Section 6.7.2.3, "Creating Web Offer Click-Through Destinations"

6.7.2.1 Creating a Campaign Schedule of Type Internet Promotion
Use this procedure to create a campaign schedule of type Internet Promotion.

Note: This procedure does not list all the steps to create a
campaign schedule. The fields that are specific only to Web offers
are mentioned. For information on creating a campaign schedule,
see Section 6.4, "Creating a Campaign Schedule"

Prerequisites
An active campaign must exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Click the Names link of the campaign for which you want to create a schedule
and navigate to Execution > Campaign Schedule.

Click Create.
From the Setup Type drop-down list, select Internet Promotion.
Enter a Name and other required details for the campaign schedule.

Click Create.

o o & W
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7. Click Request Approval to change the status to Active.

8. In the Preview Approval page, select the User Status to Active and click
Confirm.

6.7.2.2 Associating Offers to a Campaign Schedule

Use this procedure to associate offers to a campaign schedule.

Prerequisites
Active campaign schedule of type Internet Promotion must exist

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Select the campaign, click the Name link of the campaign schedule, and click
the Offers side navigation link.

3. Click the Search icon and select an offer from the list of values.

4. Click Update.

6.7.2.3 Creating Web Offer Click-Through Destinations

Use this procedure to create click-through destinations for Web Offers.

Prerequisite
= An offer exists

»  The offer is “Request only”
s The offer has a discount level of “line”

»  The profile AMS: Item Validation Organization and IBE: Item Validation
Organization are set to the same Master Inventory Organizations.

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns > Offer, and click the Content side navigation link.

2. C(Click Create.
3. In the Type drop-down choose one of the following:
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= Web Image: Displays an image to the user. The user clicks the image and is
routed to the destination page defined.

s Web Text: Display text to the user. The user click the text and is routed to
the destination page defined.

4. In the Subtype drop-down choose a Subtype. For example, if you chose Web
Image as the Type, the Subtype could be full banner or half banner.

5. In the Description text box, enter a short description for the content.

6. Click the Search icon and select an image. To use an image that has not been yet
loaded, click Upload New Image.

7. In the Click-Through Destination region, select the action “Go to Shopping Cart
page in iStore with an item.”

8. Select a Specialty Store, Section, and product or item.
9. Click Create.

10. To preview the CTD, navigate to the Content Details page and click the
Description link of the content.

11. Click Preview.

A Preview window opens displaying either the Web image or Web text selected
for the Web offer.

6.7.3 Creating Products Media

Multimedia components are used to enhance the presentation of products to Oracle
iStore visitors. Examples of multimedia files could be a picture of a certain size,
audio of a certain length, an animation sequence, or text. Oracle iStore supports
logical groupings of several multimedia components that can then be rendered
based on the specialty store and language combination. See Oracle iStore
documentation for details.

6.7.3.1 Creating Product Relationships
See Section 9.1.10, "Creating Product Relationships".

6.7.3.2 Associating a Template with an Oracle iStore Bin
Use this procedure to associate a template with an Oracle iStore Bin.
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Prerequisites

Check if IBE: Use Web Placement profile is set to Yes. Refer Oracle Marketing
Implementation Guide for details.

Steps

1. Log on to Oracle iStore as an Administrator and navigate to the Advanced tab.
Click the Template Manager horizontal navigation link.

Search for the templates containing the word “bin”. A list of bins is returned.
Select the bin to update.

Click Add Source File.

Enter the source name as amsWebPlacement.jsp.

Select a store and language.

Click Apply.

© N o a » 0 D

6.7.4 Managing Universal Postings

A Web posting is an object used to define the personalized content that is
dynamically selected and displayed in a placement at runtime. The content
returned by the posting to the visitor at runtime is dependent on the content type
and the merchandising strategy selected.

Use the following procedures to create and manage universal postings.
= Section 6.7.4.1, "Entering Universal Posting Details"

= Section 6.7.4.2, "Entering Strategy Details"

6.7.4.1 Entering Universal Posting Details
Use this procedure to enter details for a universal posting.

Prerequisites
None

Steps
1. Log into Oracle Marketing with the appropriate responsibility, click the
Execution link, and navigate to Execution > Web Posting.

2. C(lick Create.
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Select Universal as the Posting Type, enter the basic details for the posting, and
complete the Contents Displayed and Merchandising Strategy regions.

Click Create.

To modify the details for a posting, select it in the Web Postings page, make the
necessary changes in the Posting Details page, and click Update.

You can modify the status, the number of items returned by the posting, the
parameters of the merchandising strategy, and the priority of the content.

To change the status from Active to Inactive, ensure that the posting is
unassigned from the placements that are currently using it.

To delete a posting, select its Remove check box in the Web Postings page and
click Update.

6.7.4.2 Entering Strategy Details

Use this procedure to enter strategy details for a universal posting.

Prerequisites
An existing universal posting

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, click the
Execution link, and navigate to Execution > Web Posting.

Select the universal posting and click the Strategy Details side navigation link.
The options displayed are dependent on the selected Strategy Type.

Click the Strategy Details side navigation link. The options displayed are
dependent on the selected Strategy type.

»  If the selected strategy is Product Relationship:

*

Select the shopping context and the type of relation for the product in
the shopping cart or page. For example, select Cross-Sell as shopping
context and page as Products on Page.

*  Select a value from the Filter Contents list of values, to filter the
products to be displayed.

See Section 6.6.6.2, "Predefined Relationships" for details.

»  If the strategy is Oracle Personalization:
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*  Complete the Contents Displayed, Display Priority, and Default
Content regions and click Update.

*  Click Advanced Options and Product Purchase History, Context, and
Base Data regions.

*  Click Apply.

*  Click Back to navigate back to the Posting Strategy page and click
Update.

s If the strategy is Custom Selection:
*  Select a product strategy that is created in Administration tab.
= If the strategy is Manual Selection:
*  Click Add Contents.
*  Select the content in the Product Selector page.
*  Click Done.
4. Select a display priority for the posting.

= Select None to not have a display priority; the contents will be displayed in
the order they were added.

s Select Random to randomly display the contents, each time the page is
refreshed.

= Select Prioritize Display Numerically to rank the attributes associated to the
content type of the Posting;:
*  For Content Type Product Recommendation, the content is displayed in

ascending or descending order of the list price.

*  For Content Type Web Advertisement, the content is displayed in
ascending or descending order of the campaign priority, start date, or
end date.

For Content Type Web Offer, the content is displayed in ascending or
descending order of the offer start and end date.

5. Select the default content and click Update.

If no criteria is met to return the items, then the default content is displayed to
the visitor.
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6.7.5 Managing Rule-Based Postings

Use the following procedures to create a Rule-based posting;:

Section 6.7.5.1, "Entering Rule-based Posting Details"
Section 6.7.5.2, "Entering Rules Details"

Section 6.7.5.3, "Entering Strategy Details"

Section 6.7.5.4, "Entering Conditions Details"

Section 6.7.5.5, "Using the Associated Placements Page"

6.7.5.1 Entering Rule-based Posting Details

Use this procedure to create a new rule-based posting.

Prerequisites
Content is created

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, click the
Execution link, and navigate to Execution > Web Posting.

Click Create.

Select Rule Based as the Posting Type, enter the basic details for the posting and
and complete the Contents Displayed region.

Click Create.

To modify the details for a posting, select the posting in the Web Postings page,
make the necessary changes in the Rule-Based Posting Details page, and click
Update.

You can modify the status and the number of items returned by the posting.

To change the status from Active to Inactive, ensure that the posting is
unassigned from the placements that are currently using it.

To delete a posting, select its Remove check box in the Web Postings page and
click Update.
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6.7.5.2 Entering Rules Details

The rule priority is used by the eMerchandising engine at runtime to prioritize the
targeting rules of a posting. Use this procedure to define rules for rule-based
postings.

Prerequisites
A rule-based posting is created

Steps

1. Log into Oracle Marketing with the appropriate responsibility, click the
Execution link, and navigate to Execution > Web Posting.

Select the rule-based posting and click the Rules side navigation link.
Select a default content for the posting in the Default Content region.

Click Create.

o » w0 Db

Enter the name, description, and priority for the rule and select a strategy type.

Rule priority must be a value between 0 and 99. Rules within a posting must
each have a unique priority.

6. Click Create.

7. To update the details for a rule, click its link in the Rules page, make the
necessary changes in the Rule Details page, and click Update.

6.7.5.3 Entering Strategy Details

Use this procedure to enter strategy details for a rule-based posting.

Prerequisites
A rule-based posting with a rule exists

Steps

1. Log into Oracle Marketing with the appropriate responsibility, click the
Execution link, and navigate to Execution > Web Posting.

2. Select the rule-based posting and click the Rules side navigation link.

3. Click the Name link for the rule and click the Strategy Details side navigation
link.

4. The options displayed are dependent on the selected Strategy type.
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If the selected strategy is Product Relationship:

*

Select the shopping context and the type of relation for the product in
the shopping cart or page. For example, select Cross-Sell as shopping
context and page as Products on Page.

Select a value from the Filter Contents list of values, to filter the
products to be displayed.

See Section 6.6.6.2, "Predefined Relationships" for details.

If the strategy is Oracle Personalization:

*

Complete the Contents Displayed, Display Priority, and Default
Content regions and click Update.

Click Advanced Options and Product Purchase History, Context, and
Base Data regions.

*  Click Apply.

Click Back to navigate back to the Posting Strategy page and click
Update.

If the strategy is Custom Selection:

*  Select a product strategy that is created in the Administration tab.
If the strategy is Manual Selection:

*  (Click Add Contents.

*  Select the content in the Product Selector page.

*  (Click Done.

5. Select a display priority for the posting.

Select None to not have a display priority; the contents will be displayed in
the order they were added.

Select Random to randomly display the contents, each time the page is
refreshed.

Select Prioritize Display numerically to rank the attributes associated to the
content type of the Posting;:

*  For Content Type Product Recommendation, the content is displayed in
ascending or descending order of the list price.
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For Content Type Web Advertisement, the content is displayed in

ascending or descending order of the campaign priority, start date, or

end date.

For Content Type Web Offer, the content is displayed in ascending or

descending order of the offer start and end date.

6. Click Update.

6.7.5.4 Entering Conditions Details

A rule may contain a combination of different condition types. The rule is executed
only if all the conditions are true; in other words, all the conditions of a rule are
linked with a logical AND operator.

Use this procedure to enter conditions for a rule-based posting.

Table 6-8 lists the fields used to define and describe the targeting rule conditions.

Table 6-8 Targeting Rules Conditions

Condition

Function

Visitor Status

Checks if the visitor is:

= Anonymous

»  Registered without Purchase History
= Registered with Purchase History

This allows you to use different merchandising strategies to
anonymous or registered user or to offer a special offer to a
visitor who registered to the store but has not bought anything

yet.

Shopping Cart Total

This condition allows you to compare the total amount of the
active shopping cart to a value specified in the default currency
(as defined in the Administration screen). This allows you to
define rules, such as, “If visitor’s shopping cart amount is
greater than $1,000 display the high-end product line
advertisements.”

Segments and Lists

This condition allows you to select a set of segments and lists as
defined in the Audience tab of Oracle Marketing. Lists are a
combination of segments, workbooks and other lists. At
runtime, the eMerchandising engine checks if the visitor is part
of at least one of the selected segments or lists. This allows you
to define rules, such as, “If the visitor is part of the 18-25
year-old or 26-35 year-old segment, then recommend the
following list of products.”
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Table 6-8 Targeting Rules Conditions

Condition Function

Custom Conditions Web Marketing allows you to implement your own custom

conditions. You can create Java classes and register them in the
Oracle Marketing Administration tab, which will make the
custom conditions available in the conditions list of a targeting
rule.

Prerequisites
A rule-based posting with a rule exists

Steps

1. Log into Oracle Marketing with the appropriate responsibility, click the
Execution link, and navigate to Execution > Web Posting.

2. Select the rule-based posting and click the Rules side navigation link.

3. Click the Name link for the rule and click the Conditions side navigation link.

4. Complete the Visitor Status Condition, Shopping Cart Total Condition,
Segments and Lists Condition, and Custom Conditions (if defined) regions.

5. Click Update.

6.7.5.5 Using the Associated Placements Page
Use this procedure to display all the places a posting is being displayed.

Prerequisites
A posting exists and is assigned to placements

Steps

1. Log into Oracle Marketing with the appropriate responsibility, click the
Execution link, and navigate to Execution > Web Posting.

2. Select a posting and click the Associated Placements side navigation link.
The Associated Placement page appears listing all the placements the posting is
associated with.

3. Select the required placement and edit its details.

4. Click Update.
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5.
6.

Click the browser’s Back button to return to the Associated Placements page.

To disassociate a placement, select its Remove check box and click Update.

6.7.6 Managing Placements

Use the following procedures to manage placements:

Section 6.7.6.1, "Creating a Placement for Oracle iStore"
Section 6.7.6.2, "Creating a Placement for Sites other than Oracle iStore"

Section 6.7.6.3, "Associating a Posting to a Placement"

6.7.6.1 Creating a Placement for Oracle iStore
Use this procedure to create a placement for Oracle iStore.

Prerequisites
An existing site, page, style, and location

Steps

1.

N o a &

Log into Oracle Marketing with the appropriate responsibility, click the
Execution link, and navigate to Execution > Web Placement.

Click Create.

Enter a name and description for the placement and select the Status as
Inactive.

The placement can be made Active when it is associated to a posting.
In the Position region, select the site as iStore. The page will refresh.
Select the Page, Location, Specialty Store, and Tab.

Click Create.

To delete a placement, click its Remove check box in the Web Placement page
and click Update.

You cannot remove a placement that is Active and associated with a posting.

6.7.6.2 Creating a Placement for Sites other than Oracle iStore
Use this procedure to create a placement for a site other than Oracle iStore.

6-84 Oracle Marketing User Guide



Creating and Managing Web Marketing Content

Prerequisites
A site, page, style, and location exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, click the
Execution link, and navigate to Execution > Web Placement.

2. C(lick Create.

3. Enter a name and description for the placement and select the Status as
Inactive.

4. In the Position region, select a site other than iStore. The page will refresh.
5. Select the page and location and click Create.
6. Click ViewAPI Call Details link.

Example: The API that is to be embedded in an HTML may look something as
given below:

<!-- BEGIN Web Placements Tag -->

<script language="JavaScript"
src="http://www.yourHostname.com:port_number/OA_
HTML/amsWebPlacementLink.jsp?site='MYAFFILIATE' &page='HOME'&location="'TOP' ">

</script>

<noscript>

</noscript>

<!-- END Web Placements Tag -->

7. Copy the API call details and paste in affiliates.
8. Call the html page from the browser to post the placement.
9. Click Update.

6.7.6.3 Associating a Posting to a Placement
Use the following procedure to associate a posting to a placement.

Prerequisites
An existing site, page, style, and location
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Steps

1.

Log into Oracle Marketing with the appropriate responsibility, click the
Execution link, and navigate to Execution > Web Placement.

Click the Name link for a placement and change its status to Active in the Web
Placement Details page.

In the Posting region, click the Search icon and select the posting from the list of
values.

Select a style for the placement and click Update.

6.8 Troubleshooting Web Marketing

Some of the issues that you may face when using the Web Marketing functionality

are:

My postings are not displayed

My posting of content type Web Advertisement is not displayed

My posting of content type Web Offer is not displayed

My posting with content type Product Recommendation is not displayed
My Rule-based posting is not displayed

My posting with Strategy type Product Relationship is not displayed
My Posting does not display the image

My Posting are not displayed in iStore

My Offers are not displayed

My Web Placement is not displayed

My placement is not using the new stylesheet I have defined

The image is not appearing in the affiliate site

My placement on Oracle iStore is not displayed

My placement on Oracle Partner Portal is not displayed

My postings are not displayed

Check if all the mandatory steps in the implementation guide for Oracle
Marketing are complete.

6-86 Oracle Marketing User Guide



Troubleshooting Web Marketing

If you are implementing iStore, check if all the necessary steps given in the
Oracle Marketing Implementation guide are complete and the JSP is associated
to bin.

If postings are not displayed on Oracle iStore, make sure the profile IBE: Use
Web Placements is set to Yes at the application level for Oracle iStore and
bounce the apache.

Make sure that the status of the posting is “Active”.

My posting of content type Web Advertisement is not displayed

Check the Campaign and Campaign Schedule start and end dates.
Check if the Campaign and Campaign Schedule status is Active.

Check if the content is attached to the Campaign Schedule. Click the preview
button to see the attached image.

My posting of content type Web Offer is not displayed

Check if the Posting is active.

Check if the offer is active.

Check the posting start and end date.
Check if the request only flag is selected.

Check if QP: Source System Code is set to Oracle Marketing at the
application level.

My posting with content type Product Recommendation is not displayed

Make sure the appropriate style sheet is chosen and the image or text for the
style sheet exists. For example, a product thumbnail style sheet may be selected
but the thumbnail image may not be defined for the product.

My Rule-based posting is not displayed

If the posting has a segment attached to the condition, run 'AMS: Refresh party
market segments' concurrent program.

Check if all the all the conditions are met, otherwise, the posting will not be
displayed. For example, a user may be registered without a purchase history
but may not be part of the attached list.
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My posting with Strategy type Product Relationship is not displayed

s Check if the relationship exists in Oracle iStore. For example, if the
recommendation on the page is for Cross sell, cross-sell products must be
defined for the page and the correct filter must be chosen.

My Posting does not display the image

s Check if the image is uploaded. You can upload the image in the content
definition screen.

My Posting are not displayed in iStore
s Check if all the necessary steps given in the Oracle Marketing Implementation
guide are complete and the JSP is associated to bin.

= Make sure the profile IBE: Use Web Placements is set to Yes at the application
level for Oracle iStore and bounce the apache.

= For a posting with strategy type Product Relationship is the not displayed,
check if the relationship exists in Oracle iStore. For example, if the
recommendation on the page is for cross-sell, cross-sell products must be
defined for the page and the correct filter must be chosen.

= Make sure the products that are recommended are part of the minisite.

»  If section filtering is defined, make sure the product is part of the section also.

My Offers are not displayed
= Make sure the profile: QP: Source System Code is set to Oracle Marketing at the
Application level.

My Web Placement is not displayed
= Make sure the status is Active.
»  If the call is from an HTML or JSP application, make sure the site, page, and

location parameters that are passed match the definition parameters of the
placement.

s Itis possible that the Placement runtime engine is picking up a different
placement than the one you are interested in because the site, page, and location
parameters may not be apt for that placement.

My placement is not using the new stylesheet | have defined
»  Copy the newly defined stylesheet to the OA_HTML directory.
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s If the Placement is for a shopping cart page on Oracle iStore, the location must
be either "TOP' or ' BOTTOM'. No other location works for this page.

The image is not appearing in the affiliate site

= Make sure the profile AMS: Server URL is set correctly. The format is
http:/ /hostname:portnumber.

My placement on Oracle iStore is not displayed

= Make sure that the jsp, amsWebPlacement.jsp is associated to the appropriate
bin. Also, make sure that in the templates detailed design page, “All” is selected
from the Specialty drop-down list.

My placement on Oracle Partner Portal is not displayed
= Make sure that the profile value PV:Enabling Web Marketing is set to Yes.

General Tips:
Make sure the following concurrent programs are run successfully:

= AMS Web Execution: Campaign Items Refresh Program
= AMS Web Execution: Refresh Offer Parties and Products
= AMS Web Execution: Specialty Store Items Refresh Program

= AMS: Refresh party market segments (for segment condition only)
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Working with and Executing Events

An event is a marketing activity, such as a trade show, seminar, webinar or product
launch. This chapter describes the events functionality in Oracle Marketing.

Topics in this chapter include:
s Section 7.1, "Events Overview"
»  Section 7.2, "Creating and Managing Events"

»  Section 7.3, "Creating and Managing Event Schedules"

Working with and Executing Events  7-1



Events Overview

7.1 Events Overview

Marketers often participate in trade shows, conduct seminars, and create Web
events to generate leads. These types of events are the key means for you to educate
potential customers about a product or service and to build a brand recognition.
Oracle Marketing provides comprehensive functionality to manage key marketing
events.

An event can be a seminar, a class, a product demonstration, or any other activity
that is location specific. You can create an event as a stand-alone activity or as part
of a campaign. Using Events, a marketer can:

» Track event information. This includes information about the event’s
deliverables, budgets, registration, speakers, and directions

= Manage open and restricted registration using rules and lists

»  Facilitate registration (from Oracle TeleSales, Oracle Marketing, and external
sources)

= Integrate with call centers to distribute information and to facilitate registration

= Send event deliverables to enrollees that includes descriptions, directions,
maps, and cover letters using Oracle Marketing.

Topics in this section include:
s Section 7.1.1, "The Events Process Flow"

s Section 7.1.2, "One Off Events"

7.1.1 The Events Process Flow

Figure 7-1 depicts a high-level process flow of working with events in Oracle
Marketing. Each process has a list of tasks to be performed. They are not depicted in
any particular order. You can organize them based on the business practices
followed in your organization.
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Figure 7-1 Events Process Flow
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Planning an Event

Planning an event begins when you decide the purpose for your event - to
showcase your product or service to existing or potential customers, for a social or
charitable cause, and so on. You start by creating an event in Oracle Marketing.
Next, you decide whether this event must be part of a larger marketing activity
which may include other events, campaigns, and programs. If so, you will include
this event as part of a program.
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It is important that the event is addressed to the right set of people who will be
interested in your products or services. Therefore, the next step will be to identify
the segment you will address during this event.

Every event can carry a special message that will convey the substance of the
product, service, or the event itself. Additionally, you may want to specify the
budget required for this event, and request for approval.

It is not enough if you only plan and organize an event. It must be well promoted so
that your intended audience is made aware of the upcoming event, and prepare to
attend it. You can promote an event by sending out event invitations through e-mail
or direct mail print campaign schedules.

Executing an Event

Thus far, the event has been planned and promoted. Next, you must create
individual event schedules to address the requirements in all the places where it is
going to be held. If the event is to be held in San Francisco, Paris, and London, three
event schedules must be created.

The venue for the event must be booked, and all the necessary arrangements must
be made to host the event.

The agenda for the events must be planned, and a communication must be sent out
inviting people to register for the event.

You must also plan for event cancellation, or a date change. Fulfillment Rules can be
set up to communicate to the registrants or invitees to handle such occurrences.

Tracking an Event

You can track the event either during its execution or after it is complete. During the
event execution, you may view the rosters to see how many people registered. You
can also use the Event Dashboard to view the registrants based on their industry,
job, or country.

You can also view the costs that were incurred for this event, and also revenues
generated. Using Metrics, you can assess the effectiveness of the event schedule.

7.1.2 One Off Events

One-off events are events which will not be repeated at regular intervals. For
example, a CEO breakfast could be considered a one-off event. It is not truly part of
a marketing campaign, but can stand alone or be tied to a program so as to capture
costs.
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7.2 Creating and Managing Events

An event holds the general description of itself and provides the structure for
reporting costs and dispersing budgets to individual sessions of the event. If your
company is planning to train the sales force in different cities on your new product
line, for example, then the event holds information about the course content and the
budgets for the individual sessions to be held in the different cities.

Procedures in this section include:

Section 7.2.1, "Creating an Event"

Section 7.2.2, "Associating Segments to an Event"

Section 7.2.3, "Associating Products with an Event"

Section 7.2.4, "Associating Metrics with an Event"

Section 7.2.5, "Associating Costs and Revenues with an Event"

Section 7.2.6, "Specifying a Budget for the Event"

Section 7.2.7, "Defining a Message for the Event"

Section 7.2.8, "Specifying the Geography for the Events"

Section 7.2.9, "Associating a Category with an Event"

Section 7.2.10, "Promoting an Event by Associating it with a Campaign"

Section 7.2.11, "Publishing Notes for an Event"

7.2.1 Creating an Event

Use the following procedure to create an event.

Prerequisites

None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Event > Events.

2. Click Create.

3. Select the type of event to create using the setup type drop-down list.
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Selecting a type determines which side navigation links are available. These
types are set up by your administrator.

4. Enter a unique source code.

Optionally, you can leave the source code field blank and the system will
generate a unique code after the creation of the event.

5. Enter a name for the event according to naming conventions for your
organization, if any.

6. Enter the start date and end date, duration, and description of the event.
7. To indicate the kind of event, select its type from the Type drop-down list.
8. Select applicable check boxes:

= Global - indicates that the event will be global. The global source code is
used for reporting.

s Confidential - restricts access and view to this event to the team associated
with the event till the event is in the Active status. Other teams will not be
able to view the event.

= Pass Attendees as Leads - lead records are created for every person who
attends the event

»  Pass Registrants as Leads - lead records are created for every person who
registered for the event

9. To indicate the importance of the event, select a priority from the Priority
drop-down list.

10. Click Create.

11. Complete information for the items on the side navigation.

Note: You may update the currency field at any time during the
theme approval process. The currency field becomes read-only
after budget approval.

12. To copy an event, click Copy in the Events page, enter the necessary details in
the Copy - Event page, and click Copy.

7-6 Oracle Marketing User Guide



Creating and Managing Events

7.2.2 Associating Segments to an Event

A segment can be defined as a selection criteria that will be used to generate the
target groups for an event schedule. For example, a segment could be defined as a
condition to obtain residents living in the state of California. If this segment is
associated with a target group, then the number of records satisfying the segment
criteria at the time of generating the target group will be considered as part of the
target list entries.

The target group is generated only at the Event Schedule level. The entries
generated are also not validated against the segment associated with an event.
Associating a segment with an event is only for information purposes.

Use the following procedure to associate segments to the event.

Prerequisite
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Events.

Click the hyperlink of the event name to associate a segment to.
Navigate to the Segment side navigation link.
Select a segment using the search icon, and select the Include box.

Click Update.
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When the target group for this event is generated, this segment will also be
included.

7.2.3 Associating Products with an Event

If you are organizing an event to promote a product or service, use the following
procedure to associate a product or service with it. Associating a product to an
event can be used for reporting. For example, to report the number of events which
promoted a specific product.

Prerequisite
None
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Steps

1.
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Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Events.

Click the hyperlink of the event name to associate a product to.
Navigate to the Products side navigation link.

Select a product family using the search icon.

To exclude a product specifically from an event, select the Exclude box.

To specify that a product family is the primary category for this event, select the
Primary Category box.

Click Update.

7.2.4 Associating Metrics with an Event

Use the following procedure to associate an existing metric with an event.

Prerequisites
The required metric must be set up by the System Administrator.

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Events.

Click the hyperlink of the event name to associate a metric to.
Navigate to the Metrics side navigation link.

All the metrics associated with the event are displayed. The metrics template
functionality allows the setup of metrics at an object or custom setup level.

Within the Create New region of the Metrics page, click the Search icon to
display a list of available Metrics and select a metric from the list.

Enter the Forecast and Actual values in their respective columns.
Optionally, select a Transaction Date and enter a Description.

The Transaction Date is a reference for you. It is not used within the metrics
logic.

Click Create.
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The selected Metrics is now associated with the event and will appear in the
Metrics region.

Click Refresh.
The newly associated metric values are displayed as metrics for the event.

To disassociate a metric from the event, select its Remove check box and click
Update.

7.2.5 Associating Costs and Revenues with an Event

Use the following procedure to associate existing costs and revenues metrics with
an event.

Prerequisites
The required Cost or Revenue metric should be set up by the System Administrator.

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Events.

Click the hyperlink of the event name to associate costs and revenues metrics
to.

Navigate to the Costs and Revenues side navigation link.

All the costs and revenues metrics associated with the event are displayed. The
metrics template functionality allows the setup of metrics at an object or custom
setup level.

Click the Search icon within the Create New region of the Costs and Revenues
Details page and select a Cost or Revenue Metric from the list.

Select the currency and enter the forecast and actual values for the cost or
revenue.

Select a transaction date and enter a description.

The transaction date is a reference for you. It is not used within the metrics
logic.

Click Create.

The selected cost or revenue metric is now associated with the event and will be
displayed in the relevant Costs or Revenues region.

Working with and Executing Events  7-9



Creating and Managing Events

8. Click Refresh to view the Summary or Rollup metrics of the newly associated
cost or revenue metric.

9. To disassociate a cost or revenue metric from the event, click its Remove check
box and click Update.

7.2.6 Specifying a Budget for the Event

The budget amount you specify here may be for the overall event. Using this
information, the initial estimate can be communicated to the approvers during the
approval process.

Use the following procedure to specify a budget for the event.

Prerequisite
None

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Events.

Click the hyperlink of the event name to specify a budget.
Navigate to the Budget side navigation link.

Enter the amount in the Initial Estimated Budget field.
Click Update.

a0 DN

7.2.7 Defining a Message for the Event

A message conveys the essence of the event, product or service. For example, the
message "Unbreakable" is used for Oracle database products.

For more information on messages, and how to work with messages, see
Section 13.3, "Overview of Messages".

7.2.8 Specifying the Geography for the Events

An event can be held at different locations. You create individual event schedules to
specify details such as the venue, the speakers, and so on.

Use the following procedure to specify the geographies where your events will be
held.
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Prerequisite
None

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Events.

Click the hyperlink of the event name to specify the geography.
Navigate to the Geography side navigation link.
Select a geography level from the Level drop-down list.

For example, if an event is held in several places within the same country, then
you might choose City as the level. If it is being held in several countries, then
you would choose Country.

Select a value for the level that you have chosen using the search icon.

Click Update.

7.2.9 Associating a Category with an Event

Events can belong to different categories. You can associate a category with an
event and use it for reporting purposes.

Use the following procedure to associate a category with an event.

Prerequisites
Categories must be set up by the System Administrator.

Steps

1.
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Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Events.

Click the hyperlink of the event name to associate a category with.
Navigate to the Category side navigation link.

Click the search icon and select a category.

Click Update.

The category is associated with the event.
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7.2.10 Promoting an Event by Associating it with a Campaign

Events can be promoted by associating them with a campaign. Use the following
procedure to associate the event with an existing campaign. You can also create a
new campaign and associate the event from the Create Campaign page.

When attempting to link a campaign to an event, only campaigns of type “Event
Promotion” are displayed in the LOV. If a campaign is created through an event, it
automatically creates a campaign of type "Event Promotion".

Prerequisites
An existing campaign and an existing event.

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Events.

2. Click the hyperlink of the event name to associate a campaign.

3. Use the Campaign Name list of values (LOV) to select the campaign to associate
with the event. You can also create a new campaign.

4. Click Update.

See Also
To create a campaign, see Section 6.2, "Creating a Campaign".

7.2.11 Publishing Notes for an Event

Events can have publishable notes. For Events, notes of type "venue information,"
for example, give information about the execution of an event schedule related to
the venue. This could include comments made by the event managers for other
venue users to keep in mind. The venue information notes are available to all venue
users.

Use the following procedure to publish notes.

Prerequisites
None
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Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Events.

Click the hyperlink of the event name to publish notes for.

Navigate to the Publishable Notes side navigation link.

From the note Type drop-down list, select the type of note to publish.
Enter the note text.

Click Create.
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The publishable note is created.

7. Optionally, you can view a history of publishable notes from the Note History
region.

7.3 Creating and Managing Event Schedules

Event Schedules set up the actual delivery of the event. They determine when and
where an event is going to take place, what the methodology is, and how the
responses will be captured.

Using Event Schedules functionality, you can:

»  Create event agendas with multiple tracks and multiple sessions
= Create track and session details

Procedures in this section include:

»  Section 7.3.1, "Creating an Event Schedule"

= Section 7.3.2, "Specifying the Invitation List for an Event Schedule"
= Section 7.3.3, "Setting Up Event Registrations"

= Section 7.3.4, "Registering Participants for an Event"

»  Section 7.3.5, "Creating Event Agenda Tracks and Sessions"

= Section 7.3.6, "Entering Event Coordinators and Other Resources"
= Section 7.3.7, "Specifying Deliverables for the Event"

= Section 7.3.8, "Defining Fulfillment Rules"

= Section 7.3.9, "Creating Venues"
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Section 7.3.10, "Viewing the Roster"
Section 7.3.11, "Viewing the Dashboard"

7.3.1 Creating an Event Schedule

An event schedule tracks individually occurring events. It also records participation
and enrollment. Use this procedure to create an event schedule.

Prerequisites
An existing event

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Event Schedules.

Click Create.
Select a setup type from the Setup Type drop-down list.

The custom setup is created by the administrator and determines the type of
information to track with an event schedule

Enter the name of the event schedule you are creating, and select the name of an
associated event.

Enter a unique source code.

This is an optional entry. If you do not define a source code, the application
generates one upon the creation of the event schedule.

Enter the start and end dates for the event execution.

Enter the duration of the event, and select the venue where the event is to be
held.

If the person responsible for this event is other than yourself, enter that person’s
name in the Owner field.

Enter the budget currency.

Note: You may update the currency field at any time during the
theme approval process. The currency field becomes uneditable
after budget approval.
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10. Make entries in other fields, as desired.

11. Select applicable check boxes:

Global - indicates that the event will be global. The global source code is
used for reporting purposes.

Confidential - restricts access to this event schedule to a particular team till
the event schedule is in the Active status.

Registration Required - specifies if registrations must be taken for this event
schedule.

Invite Only - only people on the invite list associated to the event schedule
will be able to register.

Payment Required - specifies if this is a paid event schedule.

Pass Attendees as Leads - lead records are created for every person who
attends the event. If this option is selected at the Event level, it is
automatically selected at the Event Schedule level too.

Pass Registrants as Leads - lead records are created for every person who
registered for the event. If this option is selected at the Event level, it is
automatically selected at the Event Schedule level too.

12. Click Create.

13. To modify event details, make the necessary changes in the Event Details page
and click Update.

7.3.2 Specifying the Invitation List for an Event Schedule

Use this procedure to specify the list of people to invite to an event schedule.

Note: Persons who are not on the invitation list for an “invite
only” event cannot register for the event.

Prerequisites
A list of invitees

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Event Schedules.
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Click the hyperlink of the event schedule name to specify the invitation list.
Navigate to the Invite List side navigation link.
Enter a name for the invite list.

From the Source Type drop-down list, select the source type from which the
entries must be selected.

Select a Generation Type from the drop-down list.

From the Selection region:

a. Select a source type (List, Employee List, or a Segment).

b. Select a list using the search icon.

Add other source types and lists, as required.

Click Create.

The invite list is created, and the list is associated with the invite list.
Click Generate Invite List.

The list is generated and is in the Draft status. To make the list Active, you must
run the Workflow Background Process concurrent program with Item Type as
AMS: List Generation. For more details, see the Oracle Marketing Implementation
Guide.

7.3.3 Setting Up Event Registrations

Use this procedure to specify registration details for an event schedule. This
includes determining enrollment numbers and pricing.

Prerequisites
An existing event schedule

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Event Schedules.

2. Click the hyperlink of the event schedule name to display the Event Schedules -
Details page.

3. Navigate to the Registration Setup side navigation link.

4. Enter the enrollment start and end dates.
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These dates specify when the registration will open for this event. Registrations
can only take place between the enrollment start and end dates.

5. Enter the minimum required registrants and the Attain Minimum By date, as
appropriate.

This data is for informational purposes only.
6. In the Events region, enter the credit type and credits, as appropriate.

Use these fields when the organization awards credits for attendance. This data
is for informational purposes only.

7. In the Inventory region, select an action type and the inventory number.
8. Click Update.
An Event Pricing table appears.

9. Select the event pricing information for the products in the table provided, and
enter the necessary details.

10. Click Update.

Note: When the event registration is setup, the event can be
associated to an existing inventory item or a new inventory item
can be created. This is through the select/create option for
inventory.

7.3.4 Registering Participants for an Event

The event registration functionality enables marketing and sales users to search for
events through a simple search that returns results of events in which a user can
register. By default, the Search Results overview screen contains the most recent
events for which users can be registered.

Use this functionality to register external attendees for an event and to support
employees in registering themselves for an event. Managers can register
themselves, as well as their direct reports, as desired. If an employee does not have
access to Oracle Marketing, this tab is also accessible within other applications, such
as Oracle Sales Online, for enrollment in events.

Event registration allows the registration of all parties within the database. In
addition, events can be classified as “Invite Only.” In the case of Invite Only events,
only users on the invite list are allowed to register for the event.
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Use the following procedure to register for an event.

Prerequisites
An existing event schedule with valid registration dates

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Registrations.

Enter the search criteria for the event schedule that you want to register.
Click Search.

The search retrieves records of those event schedules which are active and
whose end date and event registration end date are greater than present date
and whose registration required flag is set to Yes.

To search for people whom you want to register for the event, click the
hyperlink of the schedule name corresponding to the event.

You can also click the Register hyperlink in the last column of the search results
table.

Enter search information using any of the search criteria.

A list of people falling under the defined search criteria appears.

Select the Register box for all persons on the list that you want to register.
Click Submit.

The selected persons are registered for the event.

7.3.5 Creating Event Agenda Tracks and Sessions

The event agenda broadly describes the activities that will take place during the
execution of an event. The event agenda contains details about the tracks and
sessions within the event.

If an event has multiple activities happening at the same time, you can split up the
event agenda into separate tracks and sessions. Use this procedure to create event
agenda tracks and sessions.

Prerequisites
An existing schedule
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Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Event Schedules.

2. Click the hyperlink of the event schedule name to create tracks and sessions for
an event.

3. Navigate to the Event Agenda side navigation link.
Tracks and Sessions for this event, if any, are displayed track-wise.
4. To change the view to Day View, select and click Switch Views.
Tracks and Sessions for this event, if any, are displayed day-wise.
5. To create a track:
a. Click Create Track.
b. Enter the Track Name, Description, and Coordinator.
c. Click Create.
The Sessions handled by the Coordinator appear.
6. To create a session for this track:
a. Click Create Session.
b. Complete the required fields.
c. Click Create.
A Resources table appears.
d. Enter the details for the resources for the session.

e. Click Update.

7.3.6 Entering Event Coordinators and Other Resources

Event coordinators and resources act as hosts during the event. They participate as
as speakers, technical personnel, marketing personnel, support executives, and so
on.

Use this procedure to enter coordinators and other resources for the event.

Prerequisites
An existing event
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Steps

1.
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Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Event Schedules.

Click the hyperlink of the event schedule name to enter event coordinators and
resources.

Navigate to the Resource side navigation link.

Select the resource type (role) to associate with the event.
Enter the name of the resource.

Select a Status.

Enter a Start and End date

Click Update.

7.3.7 Specifying Deliverables for the Event

Deliverables are takeaways given to participants during an event. Use this feature
to only specify the deliverables for an event. You must manually fulfill them at the
event. For more information on deliverables, and how to work with deliverables in
Oracle Marketing, see Section 13.1, "Overview of Deliverables".

Use the following procedure to associate deliverables you require for your event.

7.3.8 Defining Fulfiliment Rules

Using the following fulfillment templates, registered users can be notified.

Invitation: E-mails are sent to all members in the Invite List.
Registration Confirmation: E-mails are sent confirming a registration.
Registration Cancellation: E-mails are sent cancelling a registration.

Wait List Confirmation: E-mails are sent that a wait listed registrant is
confirmed.

Venue Change: E-mails are sent intimating a change in the event venue.

Event Date Change: E-mails are sent intimating a change in the date of the
event.

Event Cancellation: E-mails are sent intimating the cancellation of an event.
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Some default notifications are set up using the Administration tab. You do have the
ability to override the content associated with each of these actions using the
functionality located within the Events tab. All changes made here, however, effect
only the specific schedule with which you are working.

Use the following procedure to define the fulfillment rules for this event.

Prerequisites
None

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Event Schedules.

2. Click the hyperlink of the event schedule name to define the fulfillment rules.
3. Navigate to the Fulfillment Rules side navigation link.

The General rules, if defined, are displayed. Event managers can choose to
overwrite these setup rules.

4. From the Object Rules region:
a. Select an action using the drop-down list.
b. Enter a Subject for the e-mail.

c. Select a Cover Letter using the search icon.

e

Optionally, to preview the letter, click the icon from the Preview column.
e. Click Update.

The fulfillment rule for the object is saved. If there is a corresponding
general rule for the same action, the object rule overrides it.

7.3.9 Creating Venues

A venue is the physical location where the event will be executed. It could be a
Hotel, Convention Center, and so on. Information for the venue address, capacity,
and venue contacts can be provided for the venue. Each venue can have various
rooms and rates associated to it.

Venue Room
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Multiple rooms can be created for each venue. When a session is created, the rooms
associated with the venue are available for selection at the session level. This is
mainly used for planning purposes.

Venue Rates

Use this functionality to indicate the quoted rates so that event planners can use the
information to gauge their forecasted costs. The rates entered here are for reference

only and can be used only as a gauge to estimate costs. The actual cost of the venue
may vary based on season, customer, type of event, and additional services.

Use the following procedure to create a venue.

Prerequisites
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Venue.

Click Create.
Enter a name for the venue.

Select the venue type and rating, using the drop-down lists.
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Click the appropriate check boxes to indicate whether the event venue is
internal and active.

o

Enter a brief description of the venue and the venue address.

7. Enter any planning information, and additional information which will be
useful to others.

8. Click Create.

9. Click the Venue Room side navigation link.

10. Enter the details of the rooms at the venue, and click Update.
11. Click the Venue Rates side navigation link.

12. Enter the details of other infrastructure at the venue, such as laptops, and click
Update.

13. Optionally, you can view associated events for an existing venue by clicking the
Associated Events side navigation link.
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14. Click the Notes History icon for a schedule in the Venue - Associated Events

page to view any notes associated with it.

These notes are tied to the execution of the event, and could be information for
event planners about any additional details about the venue.

7.3.10 Viewing the Roster

The event roster provides a real-time view of the status of registrations at a event
schedule level.

The event registration roster contains information regarding the customers who
have registered for the event. In addition to the registrants” information, the roster
also indicates the channel of registration, the status of the registrations, and
information regarding the attendance.

Use the following procedure to view the roster for an event.

Prerequisites

None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Event Schedules.

2. Click the hyperlink of the event schedule name to view the roster.

3. Navigate to the Roster side navigation link.

4. In the Venue Registration Details region, you can view at a glance the venue,
event capacity, and the registration details for the event.

5. In the Roster region, select the registration status (Cancelled, Registered, and
Waitlisted) from the View drop-down list, and click Search.
The Search results display the registration details for the people based on the
registration status that you chose.

6. To modify the registration status for a person, select the status from the
Registration Status drop-down list.

7. To modify the registration method for a person, select the status from the
Registration Method drop-down list.

8. Click Update.
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9. To download this list, click the icon next to the Update button.

7.3.11 Viewing the Dashboard

The events dashboard provides a graphical representation on the event roster and
segregates the registrants by registration source, industry, country and job title.

Use the following procedure to view the dashboard for an event.

Prerequisites
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Events > Event Schedules.

2. Click the hyperlink of the event schedule name to view the roster.
3. Navigate to the Dashboard side navigation link.

The Event Schedule Details - Dashboard Details page displays the registration
details graphically by Source, Country, Industry, and Job.
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Using the Campaign Workbench

A campaign schedule is the execution vehicle for a marketing activity and can be
created and managed from the Campaign Workbench.

Sections in this chapter include:

= Section 8.1, "Understanding the Campaign Workbench"

»  Section 8.2, "Creating a Campaign Schedule"

= Section 8.3, "Understanding and Creating Web Schedules"
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8.1 Understanding the Campaign Workbench

The Campaign Workbench is a tool designed for marketing that enables you to
specify minimum required Campaign Schedule attributes and quickly create and
execute campaign schedules. It also comes with a range of tools that allow
pre-campaign analysis to empower you to plan better. The Campaign Workbench
will also allow sales managers to quickly plan, create, and execute sales
promotional activities.

Topics in this section include:

= Section 8.1.1, "An Overview of the Campaign Workbench"

= Section 8.1.2, "The Campaign Dashboard"

= Section 8.1.3, "Understanding and Using Schedule Gantt Charts"
= Section 8.1.4, "Understanding Schedule Templates"

= Section 8.1.5, "Understanding Schedule Purposes"

= Section 8.1.6, "Understanding Campaign Schedules"

= Section 8.1.7, "Understanding Repeating Schedules"

= Section 8.1.8, "Using Target Groups"

= Section 8.1.9, "Understanding and Using Fatigue Rules"

= Section 8.1.10, "Understanding and Using Offering"

= Section 8.1.11, "Using Marketing Collateral"

= Section 8.1.12, "Using Collaboration"

= Section 8.1.13, "Associating Costs, Revenues, and Metrics"

= Section 8.1.14, "Associating Notes to a Campaign Schedule"

= Section 8.1.15, "Understanding and Using Schedule Operational Reports"

8.1.1 An Overview of the Campaign Workbench

The Campaign Workbench functionality of Oracle Marketing is designed to help
marketers and sales users to quickly create, execute, track, and analyze marketing
schedules.

Creating schedules with a specific purpose in mind helps you stay consistent with
your organization’s marketing goals. You can run your schedules using different
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channels of execution. For example, for the purpose of retaining your customers,
you may launch e-mail schedules making offers and discounts on your products.

The various operational reports and charts available in the Campaign Workbench
help you review and analyze your current marketing activities. You can plan your
future marketing initiatives better to ensure that the largest number of potential
customers is targeted and the effectiveness of your marketing activities is
maximized.

The tasks that you can perform from the Campaign Workbench include:

Performing precampaign analysis that will help you decide on what campaign
schedules to plan for, create, and execute to optimize campaign effectiveness.

Planning and executing marketing activities for a specific purpose and within a
specified time frame. For details about Schedule Purposes, see Section 8.1.5.

Associating products or offers with activities.

Creating a target group (audience) for a campaign schedule. Campaign
Schedule purpose may dictate the segmentation rules for the creation of the
target group.

Creating and Maintaining collateral for use with marketing activities.
Tracking costs, revenues, and metrics for marketing activities.

Generating real-time operational reports on marketing activities. See
Section 8.1.15, "Understanding and Using Schedule Operational Reports" to
know more about reports that can be generated in the Campaign Workbench.

The tasks that sales users can perform from the Campaign Workbench include:

Identifying and building sales promotional activities within specified time lines
to cross sell/up sell products or to retain customers.

Associating products and offers with sales campaigns.

Associating proposal templates and collateral content for use by sales reps for
customer communication.

Generating and tracking leads.

8.1.2 The Campaign Dashboard

The Campaign Dashboard is the home page for the Campaign Workbench and
enables you to perform precampaign analysis and acts as an entry point for the
process of planning, creating, and executing Campaign Schedules.
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Table 8-1 provides brief descriptions of the bins, charts, shortcuts, and links on the

Campaign Dashboard.

Table 8-1 Elements of the Campaign Dashboard

Ul Element

Type

Description

Campaign Effectiveness

Bin

To review key campaign performance
metrics at a glance. The two seeded views
available are:

s Top Performing Campaigns

= Bottom Performing Campaigns

My Recent Schedules

Bin

Lists the campaign schedules that you own
and have been recently updated

Active Schedules by Channel

Chart

Provides a visual representation of the
percentage of schedules executed via each
channel
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Table 8-1 Elements of the Campaign Dashboard

Ul Element

Type

Description

Shortcuts

Bin

Contains links that you can click to
navigate to perform specific marketing and
administrative functions. The links in the
Schedule Details section include:

Schedules List - To search and view the
list of schedules

Campaign Hierarchy - to view the
campaigns and the associated
campaign schedules as a hierarchy

Schedules Gantt Chart - To review the
time lines for campaign schedules

Create Schedule - To create a campaign
schedule

Reports Dashboard - To generate and
view reports for tracking across
campaign schedules

Audience Workbench - To navigate to
the Audience Dashboard to create and
manage lists

Schedule Templates - For
administrators to perform the
Schedule Templates maintenance
function

Placements - For administrators to
perform the placement maintenance
function

Note:

Campaign schedules created using the Campaign tab of the

application will also be seen in the My Recent Lists, Schedules List,
the expanded Campaign Hierarchy view, and the Schedules Gantt
Chart. However, you cannot access these schedules from the
Campaign Workbench. Refer Oracle Marketing Implementation Guide
for details on implementing the two different campaign schedule

creation functionality.
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8.1.3 Understanding and Using Schedule Gantt Charts

With a number of campaign schedules being executed simultaneously, marketing
and sales managers need to review schedule time lines, analyze their effectiveness,
and determine what activities to plan and execute in the future.

To make the analysis meaningful, you can choose to view schedules based on
specific attributes. For example, schedules using the same channel, targeting the
same segment, or promoting the same product. You can also choose different time
scales for the chart: Day, Week, Month, or Quarter.

Examples

To determine if the same segment is being targeted with many offers in the same
period, select the date range and the segment name as the search criteria for the
Gantt chart. From the time lines of the displayed schedules, you can determine if
there is a time overlap for the same target audience.

To determine if multiple e-mail messages are being targeted to the same segment for
the same product, select the date range, the e-mail channel, and the product. From
the time lines of the displayed schedules, you can determine if there is a time
overlap for the same channel and product combination.

Figure 8-1 displays a sample Gantt chart.

Figure 8—1 A Sample Gantt Chart

Results

Expand All | Collapse All

Schedule Name Start Date  End Date  Status Reports 2_|g?14reh Mar Apr May Junm Jul
¥ Initiatives

Corp Gov 2004 - Initial E-mail Blast 20-Mar-2004 01-Apr-2004 Active & e

Corp Gov 2004 - C Lev Print 01-Apr-2004 05-Apr-2004 Active & 1 w

Corp Gov 2004 - Repeating Email 01-Feb-2004 31-May-2004 New & p———

Corp Gov 2004 - Channel 01-Apr-2004 01-Now-2004 New & e

E:;’rp Gov 2004 Sales to Fin Install Base - NA 01-Mar-2004 30-Apr-2004 New & Pre—

Corp Gov 2004 - Netcast 01-Jan-2004 15-Jan-2004 New g e

Corp Gov 2004(NA) - Initial E-mail Blast 23-Feb-2004 23-Feb-2004 New

a_ &
I.

Corp Gov 2004(SA4) - Initial Email 01-Feb-2004 31-May-2004 New
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8.1.3.1 Viewing a Gantt Chart

Use the following procedure to view Gantt charts.

Prerequisites
A set of campaign schedules must exist

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

Click the Schedules Gantt Chart link in the Shortcuts bin and select the start and
end dates to indicate the period for the review.

If necessary, select a specific campaign and/or a specific schedule status.
Optionally, click the Show more Search Options link and select required details.
Click Go to view the Gantt chart.

8.1.4 Understanding Schedule Templates

Schedule setup can be quickly and easily performed as each schedule is based on a
Schedule Template. A Schedule Template provides a prebuilt framework that
includes predefined values and specification for commonly used schedule
attributes. These include:

Channel - Each Schedule Template is created for one marketing execution
channel such as email, print, fax, or Web.

Schedule Purpose - Each Schedule Template is associated with one or more
schedule purposes. For a Campaign Schedule, you may choose one of these
purposes. Seeded purposes include: cross sell, up sell, customer retention,
customer acquisition, and lead maturation. For more information, see
Section 8.1.5, "Understanding Schedule Purposes".

List Template - Each purpose associated with a Schedule Template can be tied
with a default List Template. Based on the purpose selected for schedule setup,
this default List Template can be used to create the target group for the
schedule, or you may choose some other List Template for target group
specification.

Outbound Collateral - The Schedule Template defaults the marketing execution
channel for a schedule, and each marketing execution channel is associated
with specific cover letter types to facilitate outbound collateral creation.
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= Approval Needs - The Schedule Template also dictates whether the schedule
needs approval. Campaign schedules created based on seeded schedule
templates do need approval.

Administrators can create custom schedule templates based on Activity Type and
channel to suit specific business needs. Refer Oracle Marketing Implementation Guide
for information on creating custom schedule templates.

8.1.5 Understanding Schedule Purposes

For schedule planning purposes, you can align activities (and associated schedule
purposes) with the overall marketing objectives. For example, if the goal is to
increase marketing effectiveness, and cross sell is the primary way to achieve this,
then the schedule purpose would be "Cross Sell".

Marketers have the option of choosing from the following seeded purposes:
s Cross Sell - When you want to direct marketing activities at existing customers

s Up Sell - When you want to target customers who have bought a related
product

s Customer Acquisition - When you want to spread your customer base
= Customer Retention - When you want to build customer loyalty
s Lead Maturation - When you want to initiate schedules to improve lead quality

To help you create suitable target groups for your schedules, administrators can
create list templates and include segmentation rules to support these purposes.
When you select a purpose for a campaign schedule, the associated list template
becomes available.

Administrators can also create custom purposes to meet your specific needs. For
example, marketing activities, such as advertisements or Web schedules may be
setup to build brand awareness or surveys can be created to measure customer
satisfaction. Because advertisement schedules do not target specific target groups,
no list template is required. However, to target customers for customer satisfaction
surveys, the list template needs to extract a list of customers based on their service
and support history. Refer Oracle Marketing Implementation Guide for details on
creating custom purposes.

8.1.6 Understanding Campaign Schedules

A Campaign Schedule is the delivery tool for a marketing campaign. After
precampaign and preschedule analysis and planning, marketers create campaign
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schedules, each with a specific purpose and using a specific channel. Figure 8-2
shows a typical campaign schedule flow.

A campaign schedule’s tasks flow logically as follows:
1. Performing precampaign analysis and schedule planning.
2. Creating a campaign schedule, that includes:
1. Selecting a template for a specific marketing execution channel
Selecting a purpose
Selecting the parent campaign
Associating products and/or offers to the schedule
Associating a target group
Associating outbound collateral
Associating collaboration content

Updating tracking setup

© ® N o a M 0 Db

Adding notes, if desired
3. Submitting the schedule for approval.

Figure 8-2 The Campaign Schedule Process

1 2 3
Pre campaign analysis and Create Campaign Schedule Submit for approval
schedule planning
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In the process of creation and execution, a campaign schedule can be in different
transition states as depicted in Figure 8-3.
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Figure 8-3 A Campaign Schedule’s Status Transitions
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When approval is needed, the transition states for a campaign schedule include:

New - Upon creation

Pending approval - When the marketer has manually submitted the schedule
for approval. A notification is sent to the approving authority requesting the
approval

Rejected - When the approving authority rejects the schedule. The schedule can
then go back to the New status and be considered for approval again

Active - After approval, from the Launch on Date and thereafter, until End on
Date

Completed - You may set the schedule status to Completed when the End on
Date is reached

Closed - You can set the status as Closed on the End on Date specified or after

When approval is not needed, the transition states for a schedule include:

New - When first created
Available - A New schedule passes to the Available status
Active - From the Launch on Date and thereafter

Completed - You may set the schedule status to Completed when the End on
Date is reached

Closed - You can set the status as Closed on the End on Date specified or after

When you create a campaign schedule, you must specify the basic attributes, such
as Schedule Name, Schedule Template, Parent Campaign, and Launch on Date.
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Optionally, you may specify the Source Code, End on Date, Objective, and
Marketing Medium when applicable. If you do not specify the Source Code, the
system will generate one as it is a unique index into marketing activities.

Based on the channel of execution of a campaign schedule, you must define
additional attributes as needed. For example, for an e-mail or direct mail print
schedule, you must specify a target group, while for advertising or Web schedules, a
target group is not necessary.

8.1.7 Understanding Repeating Schedules

At times, for specific reasons, marketers need to plan campaign schedules whose
execution will repeat over a period of time. The following examples demonstrate
the need for repeating schedules:

= A repeating Up Sell schedule may need to run every quarter over the next two
years to target new customers who buy or upgrade to Oracle 10G.

= A company may need to send its newsletter to its customers on the 1st of every
month until subscriptions last.

= A company may need to send e-mail reminders for the renewal of subscription
to newsletters for all the customers whose subscription is ending two months
from today.

Schedules may repeat endlessly, such as in the send newsletter example, or may end
after a specified time period, as in the Up Sell 10G example above. Schedules may
target the same target group or target new segment members only. You need to
define the time range, the target audience, and the repeating frequency when you
set up repeating campaign schedules. For a sample business user flow, see

Section 3.1, "Sending Monthly Newsletters to a Set of Customers".

8.1.8 Using Target Groups

You can define target groups (audience) for your campaign schedules and preview
the list entries generated in the Target Group subtab.

You can create target groups using one of two ways:

= Use a List Template - You can either use the default list template or select a
different one from the available list. Additionally, you can modify the selection
filters and reorder them before generating the target group. For example, after
specifying a product as a selection criterion, you may also want to specify
additional conditions based on customer demographics.
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= Use an existing List or Segment - When you use an existing list to create a target
group, you can access the suppression, deduplication, selection, and chart
options for the list and make required changes. Segments being dynamic, when
you select one to base your target group on, it is generated when the schedule
executes and the resulting list contains the target group for the schedule. You
can change segment definitions in the Segment horizontal tab of the Audience
tab. See Section 4.4, "Creating and Managing Segments" for more information.

8.1.9 Understanding and Using Fatigue Rules

Use the following sections to understand the various concepts associated with
fatigue rules and to perform related procedures.

= Section 8.1.9.1, "Overview of Fatigue Rules"
= Section 8.1.9.2, "Tracking Fatigue for a Campaign Schedule"
= Section 8.1.9.3, "Previewing Schedule-Level Fatigue"

= Section 8.1.9.4, "Overriding Fatigue Rules"

8.1.9.1 Overview of Fatigue Rules

Fatigue rules prevent marketers from over contacting their customer or prospects
base. These rules enable you to carefully target customers so that they are more
receptive to the marketing promotions and messages.

The business benefits derived from using fatigue rules include:

= Promote Brand Awareness - If promotions are strategically timed, customers are
not overexposed to noise. Therefore, when they are contacted they are likely to
be more receptive.

= Support marketing strategy decisions - Helps enforce marketing rules dictating
customer contact limits.

= Maximize Marketing Dollar Effectiveness - By strategically contacting
customers, every marketing dollar spent receives (in theory) a better response
rate, therefore improving effectivity.

= Improve collaboration for the enterprise - Enables you to setup enterprise wide
rules. For example, telesales, direct mail, and e-mail (all communication
channels having the potential to fatigue the consumer) - by centralizing the
rules, you can prevent all channels from over-contacting the consumer.
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Understanding Fatigue Rules and Time Periods

A fatigue rule defines maximum permissible contacts within a specified time
period. For example, "Do not contact customers more than two times per month by
any channel." The defined time period adheres to a rolling period.

Rolling Period Example

An e-mail schedule is set to execute on February 13th -- Amy is on the target list of
customers to be contacted. The fatigue rule specifies, "Do not contact customers
more than two times per month by any channel."

On 13th February (when the schedule executes) it determines how many times Amy
has been contacted in the last one month.

= Contact count for Amy in the last 30 days:
s E-mail was sent to Amy on Jan 15 - one contact was counted.
= Another e-mail was sent to Amy on Jan 21 - the count became two.

= Asof Feb 13, Amy had already reached her threshold of "two contacts per
month." Therefore, she is fatigued and cannot be contacted.

However, if the schedule executed on Feb 14th, the total number of contacts within
the last 30 days would have been 1. The contact on Jan 15th would have been rolled
out from the past 30-day period starting Feb 14th.

Fatigue rule time periods are defined as follows:
Week =7 days

Month = 30 days

Quarter = 90 days

Year = 365 days

Fatigue rules can be global or channel specific.

Global Fatigue Rules

Using this type of rule (threshold) you can set an absolute limit on the number of
contacts by any channel for a given time period. For example, do not contact any
customer more than 4 times per month by any channel. If exclusively setting
channel-specific limits, global rules can be null.
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Marketing Channel-Specific Fatigue Rules

Within the limits set globally, you can also establish specific rules (thresholds) for
each outbound channel - direct mail (print), email, fax, and telemarketing (phone)
For example, of the 4 total contacts allowed per month, do not contact customer by
phone more than 2 times per month.

Depending on how the rules are setup, both global and channel rules can be
applicable. For example, a global rule may be 'Do not contact customer more than
once a week' and an e-mail channel rule may be 'Do not contact customers more
than 2 times a month by e-mail'.

Schedule Level Previews

You can use preview fatigue to determine whether an optimum number of
customers are available for targeting. In a given target group, preview provides
information about the total number of customers available to market and the total
number of fatigued customer for a date range.

Customers can belong to the target groups of multiple schedules and may be
contacted too often. Therefore, they could be fatigued on a particular date. You can
use the projected counts to adjust your schedule start date to optimize your
targeting need.

Schedule Level previews contain the following information:
= Total Size - The number of people in the target group eligible for targeting
s Target Date - The date for which fatigue status is being previewed

»  Projected Available to Market - The total members in a target group not
fatigued and available to be contacted on the target date

= Projected Fatigued - The total number of members in a target group who are
fatigued and will not be contacted on the target date

The Preview functionality uses the historical fatigue counts tracked to date for each
member of the target group against each date in a given date range. The set of
currently queued schedules are looked up, assuming that all approved, available, or
active schedules planned between the time of Preview and the previewed date will
be executed.

The fatigue projection is done for 14 days. The preview date range depends on the
schedule start date:

= When the schedule start date is a future date, the preview date range is between
(schedule start date -7) to (schedule start date + 7).
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= When the schedule start date is the current date, the preview date range is
between the current date and current date + 14.

You can drill down on Projected Fatigued Count to view the list of schedules that
are fatiguing people and how many people each schedule can potentially fatigue.
Access to schedules are controlled by team security settings at the schedule level.
Confidential schedules will be displayed only if you have access to them.

Example to Demonstrate How Preview Works

A Schedule A is set up and previewed on June 1, and is to be activated on June 5.
The Schedule contains Irvin as a member. On June 1, by Irvin's rolling period, Irvin
has a running count of three contacts. But by June 5, by Irvin's rolling period, Irvin
will have a running count of two contacts. So, two contacts is the number Preview
will leverage for the June 5 schedule activation preview.

Two additional schedules are already approved and planned for execution on June
3, both of which include Irvin as a member. Therefore Irvin's fatigue count on June 5
is projected at four contacts. Since the global limit per week is three contacts by any
channel, Irvin will be considered fatigued and removed from the Preview function
for Schedule A.

The preview displayed in Figure 8—4 shows that the Projected Fatigue figures for the
dates between March 24 and March 26 are high. Using this information, as a
marketer, you can decide to wait until Mar 27 to launch your schedule, when you
will have more customers to target.

Figure 8—4 A Sample Fatigue Preview
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The Fatigue Rule Override Option

when launching a campaign schedule, you can choose to override fatigue rules
based on two key requirements:

= Not all communication is fatiguing - such as purchase confirmation e-mail,
Event registration e-mail, and communications by request of the customer, such
as opted in subscriptions to newsletters, offers, product information should not
count towards fatigue thresholds.

= Not all communications are optional - For example, for communications that
are part of a service contract or contract renewal notices, product recalls,
important product launches, or churn risk, members should not be removed
from the target group.

Note: For all sales activities, that is, for all campaign schedules
where the channel is Direct Sales, fatigue rules are automatically
overridden.

8.1.9.2 Tracking Fatigue for a Campaign Schedule

When the system executes a campaign schedule, customers who have already been
contacted the number of times specified by the fatigue rules are considered
fatigued. These members are removed, and not contacted via the schedule channel
for that particular initiative.

To track the number of times each customer is contacted via the different channels
in a given time period, the system will track each contact for a given customer.

Customers who have not exceeded their fatigue thresholds will be contacted as part
of the schedule’s target group. Upon schedule execution, the customer's contact
count should be incremented, for the date of the schedule, for the channel of the
schedule.

Figure 8-5 demonstrates how fatigue rules work when a campaign schedule is
executed. The system looks up the fatigue counts for all the target group entries,
which are eligible to be contacted, for a given activation date, then applies the
fatigue rules that have been set up, and removes the fatigued customers from the
contact list. The campaign schedule is executed for the non-fatigued customers, and
the contact count is incremented and recorded.
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Figure 8-5 Fatigue Rules Execution
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8.1.9.3 Previewing Schedule-Level Fatigue
Use the following procedure to preview fatigue.

Prerequisites
= A direct marketing campaign schedule must exist

= A target group, which has been generated and is in the "Available’ status,
should have been associated with the campaign schedule

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

3. In the Options region of the Target Accounts subtab, click Preview Fatigue.

A table and chart are displayed in the Preview Fatigue page, displaying fatigue
details.

8.1.9.4 Overriding Fatigue Rules

Use the following procedure to override the fatigue rules that have been set up by
your administrator.

Prerequisites
A direct marketing campaign schedule must exist
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Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

3. In the Options region of the Target Accounts subtab, deselect the Fatigue Rules
Enabled check box and click Save.

Viewing Fatigue Reports

The Fatigue Rule tool also tracks customer fatigue levels and reports on fatigued
customers. See "Target History Reports" for details of fatigue reporting.

8.1.10 Understanding and Using Offering

The Offering functionality enables you to associate Products, Product Categories, or
Offers that you want to promote with a campaign schedule. Product categories
available to campaign schedules are those defined in the Single Product Catalog.
You can associate only those product categories, products that roll up to the product
categories, and products that have been associated to the parent campaign in the
Single Product Catalogue. You can also associate offers that have been associated to
the parent campaign. The offers associated at the schedule level should either be
associated with the product categories, with the products associated at the schedule
level, or should be independent of any product (for example, 10% off invoice).
Additionally, you can associate offers of type Request Offers to a campaign
schedule. Request Offers are those that are requested by a customer. For example,
customers may request a telesales executive for discounts based on coupons they
hold.

The selected product or offer may also play a role in defining the segmentation
parameters. For example, if a campaign schedule is being planned for marketing
electronic toys, the segmentation condition may be high-income parents with kids.

For sales schedules, products, and product categories associated with them are
recorded as Lead Lines.

8.1.11 Using Marketing Collateral

When you create E-mail, Fax, Print, or Advertisement campaign schedules, you
may want to include electronic marketing collateral, such as product data sheets,
white papers, promotional flyers, newsletters, cover letters, invitations, and so on.
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Such collateral are outbound and must reach the customer. For example, if you are
organizing a press conference to launch a product, you may want to send out
invitations. Alternatively, you may include the product datasheet to go out as an
attachment in the e-mail.

Cover letters for the different direct marketing channels (e-mail, fax, and print) and
other outbound collateral are stored and managed in Oracle Content Manager
(OCM). To maintain security for content, you need to have access to the OCM
folders to be able to create content items. Refer the Oracle Content Manager User
Guide for more information on folder security.

While many versions of a collateral may exist in the OCM repository, only one
version can be live. When the content associated with a schedule is fulfilled, the live
version of the content is used.

For Direct Marketing Print campaign schedules, cover letters can be either in
Portable Document Format (PDF) or Rich Text Format (RTF) formats. Refer the
Oracle Content Manager User Guide for more information on collateral creation and
maintenance.

For Web schedules, the execution content is the content for Web Ads, Web Offers, or
Product Recommendations. See Section 8.3, "Understanding and Creating Web
Schedules" for details.

8.1.12 Using Collaboration

Collaboration content is material associated to a campaign schedule. Collaboration
content is not outbound - that is, not sent out to customers. It includes content,
scripts, or proposal templates, and is meant to be used by sales and external teams
involved in the activity. For example, you may need to associate sales kits
containing proposal templates, competition analysis, scripts, and so on. Additional
collaboration content like competitive information, sales plans, and so on can also
be included. Refer the Oracle Proposals User Guide for more information.

Collaboration content is governed by the same security considerations that are
defined for the campaign schedule. Once content is associated to a marketing object,
all users who have access to the marketing object have access to the associated
content.

8.1.13 Associating Costs, Revenues, and Metrics

To analyze the effectiveness of marketing activities, marketing managers need
metrics tracked at individual campaign schedule levels and across campaigns. Costs
and revenue details are captured and tracked for return on investment (ROI)
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calculations. Other seeded metrics also tracked and reported for the different
campaign schedules. For specific business needs, the marketing administrator can
define additional metrics.

This section contains the following topics:

s Section 8.1.13.1, "Metrics Overview"

= Section 8.1.13.2, "Metric Categories"

s Section 8.1.13.3, "Metric Hierarchies"

= Section 8.1.13.4, "Metric Calculation Types"
»  Section 8.1.13.5, "Metric Templates"

s Section 8.1.13.6, "Metrics Refresh Process"
s Section 8.1.13.7, "Seeded Metrics"

s Section 8.1.13.8, "User-Defined Metrics"

8.1.13.1 Metrics Overview

Metrics are measurements for tracking the effectiveness of marketing activities.
Metrics can be associated with each of the following marketing objects:

= Programs

= Campaigns

= Campaign Schedules
= Events

= Event Schedules

s One-Off Events

s Deliverables

Metrics include both forecast and actual values. These values are either manually
input or automatically calculated by the Oracle Marketing application.

Metrics can also be used to initiate Campaign Triggers. For example, a Responses
Count metric that attains a desired value could be used to trigger a follow-up
Campaign Schedule to a larger audience.

Three categories of metrics are available for the Campaign Workbench: general
metrics, costs, and revenues. General metrics include the number of responses to a
campaign and the number of registrants for an event. Cost metrics are used to track
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expenses and revenue metrics are used to track the income associated with
marketing activities.

A number of commonly used marketing metrics are included with the deployment
of the Oracle Marketing application. If new metrics need to be defined for your
organization, the Marketing Administrator must create and set up these additional
metrics. For more information on creating and setting up metrics, see the Oracle
Marketing Implementation Guide.

8.1.13.2 Metric Categories

Metrics can be grouped into logical categories. For example, all metrics used to
track expenses for marketing activities are grouped into the Cost category. Several
metric categories, including Cost, Revenue, Response, and Other are included with
the deployment of the Oracle Marketing application. Your Marketing Administrator
can create additional metric categories as you increase number of metrics you are
tracking. Refer to the Oracle Marketing Implementation Guide for more information
about metric categories.

8.1.13.3 Metric Hierarchies
Metrics are organized into two hierarchies:

= A Summary Hierarchy within a marketing object

= A Rollup Hierarchy between marketing objects

Summary Hierarchy

Within a single marketing object, metrics of similar categories (Cost, Revenue,
Response, and so on) are organized into Summary Hierarchies.

Rollup Hierarchy

The Rollup Hierarchy enables metrics from lower level marketing objects (such as
Campaign Schedules and Event Schedules) to be rolled up to parent objects
(Campaigns and Events) and grandparent objects (Programs).

Figure 8-6 shows the typical structure for a Summary and Rollup Metric hierarchy.
Various individual costs are summarized at the schedule level and also roll up to
the campaign level.
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Figure 8-6 Example to Demonstrate Summary and Rollup Metrics
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8.1.13.4 Metric Calculation Types

The metric calculation type determines the way in which forecast and actual values
for a metric are entered into the system. For different business requirements,
marketers need different calculation types:

Function

These receive their actual values from a custom PL/SQL function or stored
procedure. This function or procedure contains logic for calculating the actual value
based on information within the Oracle E-Business Suite. Function metrics are
associated with the marketing objects at the lowest level in the hierarchy, such as
campaign schedules and event schedules. You can enter them as values directly or
they can be calculated by the system. For example, number of responses to the
schedule may be input manually and the actual total postage cost for a schedule
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may be calculated by multiplying the actual unit cost with the target group number.
The forecast values for function metrics are entered manually into the system.

Formula

To calculate the effectiveness of marketing objects based on composite values,
administrators can define formulas using relevant metrics and operators. For
example, you can set up a formula as Response Rate = Number of
Responses/Target Group Size. If the Number of Responses is 10 and the Target
Group size is 100, then Response Rate = 10/100 or .1. Seeded formula metrics are
available to measure effectiveness of each stage of the marketing cycle.

Summary

Summary metrics receive both forecast and actual values from lower level metrics

in the summary hierarchy. Summary metrics may have subordinate metrics of any
type (summary, manual, rollup or function) within the same metric category (Cost,
Revenue, Response, and so on).

Summary metrics are automatically associated with a marketing object when any
subordinate metric is associated. For example, a Total Direct Cost summary metric
is available for Campaign Schedules. If you associate Postage Cost with a particular
campaign schedule, Total Direct Cost will also be associated with the object, since
Postage Cost is a subordinate metric of Total Direct Cost.

Roll up

These metrics receive both forecast and actual values from lower levels in the
marketing object hierarchy and provide comprehensive metrics to evaluate
marketing effectiveness. Manual, function, and formula metrics within a lower level
object (example, Campaign Schedule) can be linked to a rollup metric in a higher
level object (example, Campaign). In addition, all child metrics of a rollup metric
must be in the same metric category (Cost, Revenue, Response, and so on).

In contrast to summary metric values, which are calculated within the same
marketing object, rollup metric values are calculated across marketing objects.

Manual
For these, both forecast and actual metric values are entered manually.

8.1.13.5 Metric Templates

Metric templates help marketing administrators to standardize the metrics to be
associated with a campaign schedule. For example, an administrator may define a

Using the Campaign Workbench 8-23



Understanding the Campaign Workbench

metric template that automatically associates costs that are specific to the
telemarketing activities of a call center. Each type of campaign schedule and
marketing object has an associated metric template.

When a campaign schedule is created, for ease of use, all the metrics associated with
the schedule type are enabled via the associated template. You only need to enter
the metric values. If necessary, you can also create and associate additional cost,
revenue, or other metrics with a schedule.

Metric templates can be associated with a marketing object (campaign, campaign
schedule, event, and so on) or a custom set up. When you create a marketing object
with a particular custom set up, the metrics available for that particular object will
include the metrics included in the metric templates associated with that custom set
up and those included in the metric templates associated with that particular
marketing object type.

For example, let us assume that you are creating a campaign ‘live it up” with the
custom setup "ABC’. Prior to creating this campaign, you created a metric template
"AA’ with metrics Al, A2, and A3, and associated it with the custom setup "ABC’.
You had also created another template ‘BB” with metrics B1, B2, and B3, and
associated it with the marketing object of type ‘Campaign’. The campaign ‘live it
up’ will include the metrics Al, A2, and A3 from metrics template "AA’, which is
associated with the custom setup "ABC’, and B1, B2, and B3 from the metrics
template ‘BB’, which is associated with the marketing object of type "Campaign’.

8.1.13.6 Metrics Refresh Process

The metrics refresh process runs on a periodic basis defined by the Marketing
Administrator. For example, the process could be set up to run each night at
midnight.

During the metrics refresh process, the following actions occur:

= Actual values for all function metrics are refreshed based on information from
the Oracle E-Business Suite. For example, the actual value of the seeded
function metric for Responses Count is refreshed based on the total number of
campaign response records within the Interaction History table for each
campaign source code.

»  Forecast and actual values for all summary metrics are refreshed based on their
subordinate metrics in the summary hierarchies.

»  Forecast and actual values for all rollup metrics are refreshed based on their
child metrics in the rollup hierarchies.
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s If the optional “Update History” parameter is enabled, the previous period's
metric values are copied to the Metrics History table to allow for historical
analysis.

To set up or change the frequency of the metrics refresh process, refer to the Oracle
Marketing Implementation Guide.

8.1.13.7 Seeded Metrics

A number of commonly used marketing metrics, such as Total Cost, Total Revenue,
Responses Count, and Event Registrants are included with the deployment of the
Oracle Marketing application. Refer to the Oracle Marketing Implementation Guide for
a complete list of seeded metrics.

8.1.13.8 User-Defined Metrics

In addition to the seeded metrics, user-defined metrics can be used for measuring
marketing objects. Refer to the Oracle Marketing Implementation Guide for details on
defining user-defined Metrics.

Example

The following scenario demonstrates the various metrics concepts in Oracle
Marketing.

Your organization, ‘Just For You’, plans to introduce a new line in clothing for the
coming fall season. Its marketing team wants to run a campaign (Fall In Place) and
send an information brochure by a direct mail campaign schedule (Fall Lines Print
Campaign Schedule) to all the customers who bought clothing from "Just For You’
last fall.

As the marketing manager, you want the overall costs and individual cost
components for the campaign tracked. To do so, you need to track costs at the
Campaign level and the campaign schedule level.

Your Administrator will create:

= Rolled Up Direct Cost and Rolled Up Indirect Cost as roll up metrics and Fall In
Place Campaign Total Cost as the summary metric

s Fall Lines Print Schedule Cost as a summary metric at the campaign schedule
level

= Fall Lines Print Schedule Postage Costs as a manual metric (this will be
summarized to Fall Lines Print Schedule Cost at the campaign schedule level
and will roll up to the Rolled Up Direct Cost at the campaign level)
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s Fall Lines Print Schedule Envelope Costs as a manual metric (this will be
summarized to Fall Lines Print Schedule Cost at the campaign schedule level
and will roll up to the Rolled Up Direct Cost at the campaign level)

You need to perform the following activities:
1. Create the Fall In Place Campaign
2. Create the Fall Lines Print Campaign Schedule

3. Associate Fall In Place Campaign Total Cost as a summary metric with the
campaign

4. Associate the manual metric, Fall Lines Print Schedule Postage Costs to the Fall
Lines Print Campaign Schedule

5. Associate the manual metric, Fall Lines Print Schedule Envelope Costs to the
Fall Lines Print Campaign Schedule

The costs are then captured as follows:

s The summarized Fall Lines Print Schedule Postage Costs will be rolled up to
Fall In Place Campaign Total Cost

s The summarized Fall Lines Print Schedule Envelope Costs will be rolled up to
Fall In Place Campaign Total Cost

8.1.14 Associating Notes to a Campaign Schedule

A note is descriptive information that you can record and reference later, such as
directions, special instructions, or reminders. Just as notes can be associated to other
marketing objects, you can associate them to a campaign schedule too. See

Section 14.1, "Overview of Notes" and Section 14.2, "Creating Notes" for more
information on notes and how they can be associated to a marketing object.

8.1.15 Understanding and Using Schedule Operational Reports

The Operational Reports available in the Campaign Workbench help you track
marketing activities, analyze their effectiveness, and plan future campaigns.

Tracking Across Campaigns

For tracking across campaigns, the Campaign Dashboard contains reports that help
you assess campaign performance and perform precampaign analysis when
planning new marketing initiatives. See Section 8.1.2, "The Campaign Dashboard"
for a description of these reports.
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Tracking Individual Campaign Schedules

To help you analyze the effectiveness of each campaign schedule, campaign
schedule specific reports display the following;:

s Performance metrics across the enterprise, beginning with response rates all the
way to revenue realization

s Target Group tracking or Fatigue Rule information, including Target Size and
Target Group Contacted

s Channel specific information, including details of the outbound content sent
» Information on repeat execution, if it is a repeating schedule
s Click Through Destination Analysis

The sections displayed in a report depend on the channel of execution for the
schedule. For example, for an e-mail schedule, Click Through Destination Analysis
is displayed.

Channel Specific Tracking and Reporting
For reviewing channel effectiveness, you can view channel specific reports that
display the following;:

s For e-mail, print, and fax campaign schedules, outbound collateral sent to
customers, including version sent. You can drill down and view individual
content items or preview a specific version

s E-mail details for e-mail schedules, including click-through destination analysis
- destination and click-through details, such as number of clicks and number of
unique clicks - fulfillment statistics, response statistics, and scripting reports

= All the leads generated from Sales schedules
»  For the Web channel, see Section 8.3.6, "Understanding Web Reports".

Tracking Repeating Schedules

For repeating schedules, details of target groups and fatigue rules applications are
tracked and reported for each iteration of the schedule. You can drill down to view
channel-based information.

Target History Reports

You can use the Schedule Targeting History and Channel Targeting History reports
to view fatigue history. These reports will help you examine targeting performance
by direct marketing channels.
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Schedule Targeting History

This report displays fatigue details by campaign schedules executed for all direct
marketing channels. For the schedules in a date range or for a campaign, you can
compare the target group sizes with the number of members contacted, fatigued,
and suppressed. You can sort the report to view the schedules with the largest
contact rates and largest removal rates.You can restrict the search criterion to view
schedules for one particular channel only. You can drill down to view fatigue details
for each schedule. For repeating schedules, the Repeating icon is enabled and you
can drill down by date, week, or month to view fatigue details for each schedule
iteration.

The Fatigue Rate displayed is calculated as follows:
(Total Contacted /Total Fatigued + Total Contacted)*100

When you drill down using the Total Fatigued link for a schedule, details of the
schedules that took away contacts from this schedule are displayed

The total displayed for each column in the report is the grand total for all schedules
or all channels. The totals provide a global view of all fatigue data for the specified
criteria.

Access to schedules is controlled by team security. The report will display schedules
that you have read access to. Confidential schedules will not be displayed unless
you have access to them.

Channel Targeting History

This report displays fatigue history by channels. For a specified date range or
campaign, schedule fatigue details are summarized and displayed by channels. You
can drill down to view fatigue details for each channel by date, week, or month.

Using the View History icon, you can view fatigue details for a specific channel, for
a specified date range as displayed in Figure 8-7.
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Figure 8-7 A Sample Channel Execution History Report

Channel Execution History: Telemarketing

Display Channel Execution by IDE“Q - Co |

10-DEC-2003 818
27-FEB-2004 2808
29-FEB-2004 12

04-MAR-2004 838

Date Target Group Size Comtrol Group Size Total Fatigued Fatigue Rate(%) Total Suppressed Total Deduplicated Total Contacted
0 408 100 0 an 0
0 1310 44 0 162 1336
0 12 100 0 0 0
0 376 81 0 378 24
0 a a 0 0 2

08-MAR-2004 2

Use the following procedures to view the different operational reports.
»  Section 8.1.15.1, "Viewing a Schedule or Channel Specific Fatigue Report"
= Section 8.1.15.2, "Viewing Campaign Schedule Specific Reports"

8.1.15.1 Viewing a Schedule or Channel Specific Fatigue Report

You can choose to view the fatigue history for a specific period and/or for a specific
campaign. You must enter at least one search criteria to view the report.

Use the following procedure to view a schedule or channel specific fatigue report.

Prerequisites
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. On the Campaign Dashboard, click the Reports Dashboard shortcut link.

3. On the Reports Dashboard, click the Target History link in the Marketing
Initiatives Report region.

4. To view the report for a specific period, select the start and end dates for the
period.

5. To view the report for the schedules of a specific campaign, click the Search icon
and select a campaign.

You can choose to view the report for a specific period for a campaign.
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6. To view the report only for a specific channel, select it from the drop-down list.
By default, the report is displayed for all the channels.

7. To view the fatigue history across schedules, select Schedule from the View the
Report Results by drop-down list and to view the fatigue history across
channels, select Channel.

8. Click Go to view the report and Reset to clear the search fields.

8.1.15.2 Viewing Campaign Schedule Specific Reports

You can view campaign schedule specific reports using different navigation.

Use the following procedure to view the report for a specific campaign schedule.

Prerequisites
Campaign schedule must exist and tracking metrics must be defined

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. On the Campaign Dashboard, do one of the following:
a. Click the Schedules List link and click the Reports icon for the schedule.

b. Click the Campaign Hierarchy link, expand the campaign to display a list of
its schedules, and click the Reports icon for the schedule whose reports you
want to view.

c. Select a campaign schedule by clicking its name in the Schedules list or My
recent schedules bin and click Reports in the schedule details page.

3. To view a Web Script report, click the Web Script Report icon in the
Click-Through Destination Analysis region.

4. For e-mail, fax, and print schedules, click the Current Live Version link in the
Outbound Content Sent region to view the version history of the outbound
collateral.

8.2 Creating a Campaign Schedule

You can create campaign schedules for various channels. Schedule templates are
seeded for the different channels. Based on the channel, you must define different
attributes for the schedule and different subtabs become available for you to do so.
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Table 8-2 mentions the unique attributes for campaign schedules for a specific
channel and the attributes that are not applicable to a channel.

Table 8—-2 Attributes of Campaign Schedule Types

Campaign Schedule Subtabs Not
Type Unique Attributes Applicable
Email You can create and associate cover -

letters in the Collateral subtab.

By including Click-Through
Destinations (CTDs) in cover letters,
you can associate Web Scripts.

Fax You can create and associate cover -
letters in the Collateral subtab.

Print You can create and associate cover -
letters in the Collateral subtab.

Sales You can associate proposal templates | Collateral
and associated content items in the
Collaboration subtab.

Telemarketing You can associate scripts in the -
Collaboration subtab.

Advertisement You must select the specific channel Collateral, Target
that you want to use for the Accounts

advertisement, such as Newspapers,
Billboards, Banner Ads, Motion
Pictures, and so on.

Web Ad, Web Offer, Web | See Section 8.3, "Understanding and | -
Product Recommendation | Creating Web Schedules”

Use the following procedures to create marketing campaign schedules of Email,
Fax, Print, Sales, Telemarketing, or Advertisement type.

= Section 8.2.1, "Entering Basic Campaign Schedule Details"
= Section 8.2.2, "Associating a Product or Offer"

= Section 8.2.3, "Creating and Associating Cover Letters to Direct Marketing
Schedules"

= Section 8.2.4, "Creating and Associating Target Groups"

= Section 8.2.5, "Creating and Associating Collateral Content for Telemarketing
Schedules"
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Section 8.2.6, "Creating and Associating Collaboration Content"
Section 8.2.7, "Associating Costs, Revenues, and Metrics for Tracking"
Section 8.2.8, "Creating a Note"

Section 8.2.9, "Entering Additional Information”

8.2.1 Entering Basic Campaign Schedule Details

Use the following procedure to enter the basic details for a new campaign schedule.

Prerequisites
A campaign must exist

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

Click the Create Schedule link in the Shortcuts bin. You can also click the
Schedules List link in the Shortcuts bin and click Create in the Schedules List

page.
Based on the channel you want to use for the campaign schedule, select a
template in the Create Schedule page.

Enter the other relevant information for the schedule.

For a schedule of type Advertisement, you must select a Channel (Newspaper,
Motion Picture, Banner Ads, and so on).

If the schedule must repeat, click the Repeating Option icon, select the
frequency for the repeat, complete the repeating option details, and click Done.

If flexfields have been defined for the campaign schedule object, enter the
information in them.

The information is then available in the Additional Information subtab of the
schedule.

Click Continue.

When you have entered all the details for a campaign schedule in the respective
subtabs, click Submit For Approval to initiate the approval process.
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10.

E-mail, fax, or print schedules cannot be submitted for approval if no approved
cover letter exists. If a cover letter is available but has a version that is in
progress, the schedule will execute with the 'live' version of the cover letter.

Click Apply in the Schedule Details page to save all the details and return to the
Campaign Dashboard (or any starting point from where schedule creation was
initiated).

To update the details of campaign schedule, click the Schedules List shortcut
link on the Campaign Dashboard, navigate to the necessary subtabs, make the
changes, and click Save.

If you do not have the necessary access permissions for the schedule, a
read-only view of the details is displayed.

8.2.2 Associating a Product or Offer

Use the following procedure to associate a product or offer with a campaign
schedule.

Prerequisites

A campaign schedule must exist

Products must be associated to the campaign to which the campaign schedule is
associated

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

In the Offering subtab of the Schedule Details page, click Add Another Row.

Click the Search icons of the Category and/or Product fields in the Products
region and select the category and product that you want to associate with the
campaign schedule.

Similarly, select any offer that you want to associate from the Offers region and
click Save.

To disassociate a product category, product, or offer from the schedule, click the
Remove icon of the corresponding row and click Apply.
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8.2.3 Creating and Associating Cover Letters to Direct Marketing Schedules

You can associate a collateral or cover letter content item to a campaign schedule.
Based on the content type you choose, different attributes are available for the
content item.

Use the following procedures to create and associate cover letters to e-mail, fax, or
print campaign schedules.

8.2.3.1 Creating and Associating Cover Letters to E-mail or Fax Schedules

Use the following procedure to create and associate cover letters to e-mail or fax
campaign schedules.

Prerequisites
A campaign schedule must exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List shortcut link and select the campaign schedule from the
Schedules List page.

The details to be entered in the Schedule Details page displayed differs based
on the cover letter content type. The content types available depends on the
campaign schedule’s channel.

3. In the Collateral sub tab of the Schedule Details page, select a content type and
click Search to select an already existing cover letter or Create to create a new
one.

4. If you clicked Create, enter or modify the required details in the General region.

5. In the Email Details region, enter the Sender, Reply-to, and Subject fields. You
can select an attribute from the drop-down list and click < to include the merge
field in the Subject.

6. Search and select the Content Block and Image information in the Header
region. The content depends on how the header has been setup.

7. Inthe Body region, enter the text for the e-mail and fax body.

8. You can enter the content for the e-mail in an HTML format. If the e-mail is for
non-html clients, you can choose to display the e-mail content in text format by
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10.

11.

12.

13.

14.
15.

16.
17.

clicking Edit Text Version. The content created for Fax groups will display the
content in HTML format.

If the content type has any query associated with it, you can embed the query
tags into the e-mail body individually by selecting it and clicking <, or all at
once by clicking <<.

To insert a Click-through Destination (CTD):

1. Enter the text for the link in the Body region, select it, and click the CTD
icon in the toolbar.

2. In the Click-Through Details page, select the attribute for which you want
to define a CTD and specify the action details in the Define Click-Through
Action region.

3. To validate the CTD action, click Preview. Click Back to return to the
Schedule Details page.

4. Click Apply.

Search and select the Content Block and Image information in the Footer
region. To add another content block, click Add Another Row and select a
content block from the list of values.

To add an attachment from the Oracle Content Manager (OCM) repository, click
the Search icon in the Attachments region and select the attachment. To add
another attachment, click Add Another Row and select another attachment.

To upload an attachment from your desktop, browse a location, select the
attachment, and click Add Attachment in the Upload Attachments region.
Similarly, add more attachments, if necessary.

Click Apply.

You can now preview the cover letter and send a test mail or fax. Enter the
mailing address in the Send Test field and click Send Test.

Click Submit to submit the cover letter for approval.

To download recipient information for the target group members, click
Generate. Click the link that appears next to the Generate button to download
the .csv file with the recipient information.

The generation of the .csv file containing the recipient information for the
members of the target group takes place in the background. After the download
is complete, a link appears, which you can use to download the .csv file. This
file can be used with other external programs to create labels.
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8.2.3.2 Creating and Associating Collateral to a Direct Mail Print Schedule

Use the following procedure to create and associate cover letters to print campaign
schedules.

Prerequisites
A direct mail print campaign schedule must exist

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List shortcut link and select the campaign schedule from the
Schedules List page.

The details to be entered in the Schedule Details page displayed differs based
on the cover letter content type. The content types available depends on the
campaign schedule’s channel.

In the Collateral sub tab of the Schedule Details page, select a content type and
click Search and select from the list of values containing already existing cover
letters.

In the Cover Letter Details page, click Create to create a new cover letter.
Browse and select a .pdf or .rtf file.

To add an attachment from the Oracle Content Manager (OCM) repository, click
the Search icon in the Attachments region and select the attachment. To add
another attachment, click Add Another Row and select another attachment.

Because of security considerations for the content stored in the OCM repository,
you must have the necessary folder permissions to access the content. For more
details on folders and their security, refer the Oracle Content Manager User Guide.

To upload an attachment from your desktop, browse a location, select the
attachment, and click Add Attachment in the Upload Attachments region.
Similarly, add more attachments, if necessary.

To disassociate a file or attachment from the campaign schedule, click the Delete
icon of the corresponding row.

Click Apply.

You can now preview the cover letter by clicking its link, and run a test print by
selecting a printer from the Print To drop-down list and clicking Send Test.
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For details on how to setup printers, refer Oracle Marketing Implementation Guide.
10. Click Submit to submit the cover letter for approval.
11. To update the cover letter, click its Update (pencil) icon and click Save.

12. To disassociate a cover letter from a campaign schedule, click its Remove Cover
Letter icon and click Save.

13. To download recipient information for the target group members, click
Generate. Click the link that appears next to the Generate button to download
the .csv file with the recipient information.

The generation of the .csv file containing the recipient information for the
members of the target group takes place in the background. After the download
is complete, a link appears, which you can use to download the .csv file. This
file can be used with other external programs to create labels.

8.2.4 Creating and Associating Target Groups

Target groups are generated in the Full Refresh mode - that is, using the selection
criteria, deduplication rules, and suppression options, the list is recreated as if for
the first time.

Indirect marketing schedules, such as of type Advertising, are not targeted at a
specific audience and therefore target group creation functionality is not applicable
to them.

Use the following procedures to create a target group for a campaign schedule.

8.2.4.1 Creating a Target Group Using a List Template

Use the following procedure to create a target group using a list template. When
you use list templates to create a target group, you are using the natural language
query method for specifying the target group selection criteria.

Prerequisites
The campaign schedule must exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Click the Schedules List link in the Shortcuts bin and click the Schedule Name
link of the schedule for which you want to create a target group.
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You can also create a target group when you create a new campaign schedule.
You should have entered the basic details and clicked Continue. See
Section 8.2.1, "Entering Basic Campaign Schedule Details" for more information.

3. In the Target Accounts subtab in the Schedule Details page, select List Template
from the Generate Using drop-down list and using the Search icon, select the
list template you want to use.

The query criteria associated with the list template is displayed in the Selections
region.

4. If necessary, click Modify Selections and change the selection criteria and click
Recalculate to recalculate the Projected Running Total.

5. In the Options region, click the Search icon and select a deduplication rule from
the list of values.

The deduplication rule will not only eliminate duplicates within the list but will
also be used in suppressing the records from being targeted.

6. To override the fatigue rules that have been setup, deselect the Fatigue Rules
Enabled check box. You can click Preview Fatigue to view the projected
fatigued and projected available counts before deciding to override or retain the
fatigue rules.

If fatigue rules have been specified by the administrator.
7. Click Save.

8. To generate the target group, click Generate Target Group and select when you
want the target group generated - immediately or later. If you choose to
generate the target group later, indicate the date and time when you want it to
be generated.

9. Click Preview Entries to view the details of the members of the target group.
10. Click View Details to navigate to the Update List page.

You can export a list or split it from this page. For the procedures, see
Section 4.3.5.2, "Exporting a List" and Section 4.3.5.2, "Exporting a List".

11. To view the list entries for a schedule, click the Schedules List link on the
Campaign Dashboard and click the View Entries icon of the appropriate row.
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8.2.4.2 Creating a Target Group Using the Advanced Option

Use the following procedure to create target groups based on other lists, segments,
Discoverer workbooks, list imports, or SQL. You can also create your own SQL
condition.

Prerequisites
s The campaign schedule must exist

»  Fatigue rules and deduplication rules should have been specified by the
administrator

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

You can also create a target group when you create a new campaign schedule.
You should have entered the basic details and clicked Continue. See
Section 8.2.1, "Entering Basic Campaign Schedule Details" for more information.

3. In the Target Accounts subtab in the Schedule Details page, select Advanced
Option from the Generate Using drop-down list and using the Search icon,
select the Audience you want to use.

4. Select the element you want to base your target group on from the Add Type
drop-down list and click Go.

5. Select the list, import list, segment, workbook, or custom SQL from the list of
values and click Apply. Similarly add more groups, if necessary. To create your
own SQL, click Create Custom SQL and complete the details in the Create
Custom SQL page.

Remember that the Action in the first row must be Include. The % Requested
must be null for Intersect and Exclude actions.

6. To reorder the list sources, click Reorder, select the list source whose order you
want to change, and use the up or down arrow to move the list source.

7. Click Recalculate to recalculate the Running Totals.

8. C(Click Save.
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9. To generate the target group, click Generate Target Group and select when you
want the target group generated - immediately or later. If you choose to
generate the target group later, indicate the date and time when you want it to
be generated.

10. Click View Details to navigate to the Update List page.

You can export a list or split it from this page. For the procedures, see
Section 4.3.5.2, "Exporting a List" and Section 4.3.5.4, "Splitting a List".

8.2.5 Creating and Associating Collateral Content for Telemarketing Schedules

You can associate existing content items from the library or create new content
items that will be used by telemarketing executives to run campaigns.

Use the following procedure to create and associate collateral to a telemarketing
campaign schedule.

Prerequisites
A campaign schedule must exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

3. In the Collateral subtab of the Schedule Details page:
= To upload local content:
1. Click Quick Upload.

2. Click the Search icon and select the location where you want the content to
be stored.

3. Click Add Another Row, select the content type (File or Image), browse and
select the file or image you want to create, and click Submit to submit the
content for approval. Click Save For Later for work in progress items.

= To select a content item from the Oracle Content Manager repository:

1. Click Add Another Row.
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2. Select a Content Type and using the Name Search icon, select a content item
from the list of values and click Save.

3. To disassociate a content item, click the Delete icon of the corresponding
row.

= To create a content item of a specific content type:
1. Select the Content Type and click Create.

You must have the required access permissions to the OCM folders to be
able to create content items. Refer Oracle Content Manager User Guide for
more details.

2. Enter a name and description for the content item and browse and select an
attachment. If the content item you are creating is of the content type Image,
specify its attributes in the Attributes region.

3. Click Submit to submit the content for approval.
4. Click Save.
5. Similarly, you can create and associate more content items.

Note: Content can be associated to a product - a typical association would be a
product datasheet or whitepaper. If the product is associated to the schedule,
then the collaboration search for content flags the content as 'recommended
content'. See Section 8.2.2, "Associating a Product or Offer" for information on
how to associate a product to a schedule.

6. To disassociate a content item, click the Remove icon of the corresponding row
and click Apply.

8.2.6 Creating and Associating Collaboration Content

Collaboration content is material associated to a campaign schedule and is usually
not outbound (that is, not sent out to customers).

For a sales schedule, you can associate the content items that are associated to a
proposal template, such as product data sheet, pricing information, and so on.

Use the following procedure to associate collaboration content to a campaign
schedule.

Prerequisites
A campaign schedule must exist
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Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

3. In the Collaboration subtab of the Schedule Details page:

= To add content from the Oracle Content Manager repository, proposal
templates, or Scripts:

1. Click Add Another Row.

Select the Type (Content, Proposal, or Scripts) for the content item.
Click the Search icon and select a content item from the list of values.
Click Save.

Click Preview to view the associated content or proposal template.

o o ~ w N

Click the corresponding Remove icon to disassociate a content item, script,
or proposal template from the campaign schedule.

= To upload local content:
1. Click Quick Upload.

2. Click the Search icon and select the location where you want the content to
be stored.

3. Click Add Another Row, select the content type (File or Image), browse and
select the file or image you want to create, and click Submit to submit the
content for approval.

= To create content item of a specific content type:
1. Select the Content Type and click Create.

2. Enter a name and description for the content item and browse and select an
attachment. If the content item you are creating is of the content type Image,
specify its attributes in the Attributes region.

3. Click Submit to submit the content for approval.
4. Click Save.

5. Similarly, you can create and associate more content items.
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6. To disassociate a content item, click the Remove icon of the corresponding row
and click Apply.

8.2.7 Associating Costs, Revenues, and Metrics for Tracking

The Views available to you for associating tracking metrics to a campaign schedule
include Costs, Revenues, or Metrics. For each of these, you have the Details or the
Hierarchy view.

Use the following procedure to view or associate costs, revenues, or metrics to a
campaign schedule.

Prerequisites
= A campaign schedule must exist

»  The costs, revenues, and metrics that you want to add should have been set up
by your administrator

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

3. To add a cost, revenue, or metric:

1. Depending on what you want to add, select Costs, Revenues, or Metrics
from the View drop-down list and click Go.

2. Click Add Costs (or Add Revenues or Add Metrics), select the costs,
revenues, or metrics that you want to associate with the campaign schedule,
and click Add.

3. The costs, revenues, or metrics that you added will be displayed in the list
on the Schedule Details page.

4. Add the necessary details and click Save. The Transaction Date and
Transaction Details are for your reference only.

5. To disassociate a cost, revenue, or metric from the campaign schedule,
expand the group to which it belongs by clicking the + symbol and click the
Delete icon.
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4. To view the Costs, Revenues, or Metrics:

1. Select the Costs, Revenues, or Metrics view, select Hierarchy or Details from
the drop-down list based on what you want to view, and click Go.

2, In the View Personalization region, select a personalized view, if necessary,
and click Go.

3. Click the Expand All link to be able to view the details of all the sub groups
of Costs, Revenues, or Metrics.

4. Click the Focus icon for a group to exclusively view or update its Cost,
Revenue, or Metric details.

8.2.8 Creating a Note

You can use notes to store any additional information for a campaign schedule.

Use the following procedure to create a note and associate it to a campaign
schedule.

Prerequisites
A campaign schedule must exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

3. In the Notes subtab, click Create.

4. In the Add Note page, select a Note type and Visibility, enter the note text and
click Apply.

5. In the Schedule Details page, click the Show link of a note to view its details.
Click the Hide link to hide the details again.

6. Click Save.

7. You can modify the Note Type and Visibility for a note. To do so, navigate to the
Notes sub tab of a campaign schedule, select the required Note Type or
Visibility from the drop-down lists and click Save.
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8.2.9 Entering Additional Information

You can use the Additional Information subtab to enter optional information and
information for any user-defined flex fields for a campaign schedule.

Use the following procedure to enter additional information for a campaign
schedule.

Prerequisites
A campaign schedule must exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

3. In the Additional Information subtab, enter or modify the necessary
information and click Save.

8.3 Understanding and Creating Web Schedules
Topics in this section include:
= Section 8.3.1, "Overview of Web Marketing"
= Section 8.3.2, "Creating and Using Placements"
= Section 8.3.3, "Understanding Web Schedule Types"
= Section 8.3.4, "Creating a Web Ad or Web Offer"
= Section 8.3.5, "Creating a Web Dynamic Recommendation”

= Section 8.3.6, "Understanding Web Reports"

8.3.1 Overview of Web Marketing

Along with other traditional marketing channels such as e-mail, Fax, direct mail,
and advertisements, marketers today want to leverage Internet capabilities for
marketing activities. The business benefits of Web marketing include direct, quick,
and personalized interaction with customers, real-time message transfer, targeting
highly specific market segments, and selling directly and immediately.
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Using the Web Marketing functionality, you can create Web schedules to cross sell,
up sell, or make "buy this also" recommendations on the Web. When a Web
schedule executes, the resulting content is rendered on placements (physical
locations) on applications such as Oracle iStore, iSupport, Partner Portal, or other
custom Web sites.

You can include images and text as content to be rendered on the Web. Content is
created and managed in Oracle Content Manager so that they are maintained and
version controlled centrally. Oracle Marketing integrates with Oracle Content
Manager to give you access to published or live content that you want to send to a
specific location on a Web site.

See Section 8.1.13, "Associating Costs, Revenues, and Metrics" and Section 8.1.10,
"Understanding and Using Offering" for information on general Metrics and reports
associated with campaign schedules.

Table 8-3 describes the various objects associated with Web marketing.

Table 8-3 Web Marketing Entities

Entity Description
Web Schedule A Web schedule is a campaign schedule that executes over the
Web channel.

There are three types of Web schedules:

s Web Ad - A schedule, when executed, renders content
(image and text) on the Web. You would use a Web Ad to
promote a product.

s Web Offer - A schedule, when executed, renders content
(image and text) with associated offers on the Web. You
would use a Web Offer for offers like price promotions.

s Web Dynamic Recommendation - A schedule that renders
recommended product(s) based on marketer-defined
context. You would use a Web Dynamic Recommendation
for promoting the accessories of whatever product the
online visitor happens to be viewing.

= For each type of Web schedule, you need to define a
specific set of parameters in the Schedule Details page.
See Section 8.3.3, "Understanding Web Schedule Types"
for more details.

Product A product or product category can be associated with a Web
Ad or Web Offer.
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Table 8-3 (Cont.) Web Marketing Entities

Entity

Description

Offer

An offer represents some pricing discounts for a product or a
set of products. For example, 20% off on a product. It is
defined independently in Oracle Marketing or Oracle Trade
Management. More than one offer can be associated with a
Web Offer schedule.

Application

Applications are either Oracle applications that are accessed as
Web sites (for example Oracle iStore), or a label given to a
specific custom site.

Supported applications include Oracle iStore, Oracle iSupport,
and Oracle Partner Portal. Labels can be created for custom
non-Oracle application driven sites.

Web Placement

A Web placement is a defined area in a Web site that will
display the content that results when a Web schedule is
executed. When you create a Web Placement, you are creating
a logical representation that points to the physical location
where the content will be displayed on the Web.

See Section 8.3.2, "Creating and Using Placements” for more
details.

Content Types and
Content Items

Content types define the type of content that can be displayed
in a given Placement. Each content type can have one or more
Style Sheet associated with it. Each Placement can be
associated with one or more content types. When Placement X
is chosen for a schedule, only content items that are of Content
Types defined for Placement X can be used for Placement X.

Content items are specific instances of content types.

Style Sheet

A Style Sheet defines how the content type is actually
displayed in a Placement.

Rules

Rules define the context, relationships, and conditions based
on which a product or product set gets recommended.

Rules are associated only with Web Dynamic
Recommendation schedules.

Target Group

When set, the target group for a given web schedule limits the
execution of this Web schedule to online visitors that belong to
the specific target group. If not set, the schedule applies to all
online visitors.

Click-Through
Destinations (CTD)

CTDs defines what happens when the content item or content
item component associated with it is clicked. An example of a
CTD is "Go to url: www.oracle.com".
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Table 8-3 (Cont.) Web Marketing Entities

Entity

Description

Web Script Web Scripts are created using Oracle Scripting and can be used

to present questions and get responses from online visitors, as
in a survey for example. Web Scripts are used through the
Click-Through Destination "Go to Web Script".

The workflow for Web marketing from the Campaign Workbench is as follows:

1. Create a placement.

2. Create a Web schedule.

1.
2

N o a &

Specify the basic attributes for the Web schedule.

Associate the product, offer, or relationship for the Web schedule. Your
selection will depend on whether you are creating a Web Ad, Web offer, or
Web Product Recommendation. See Section 8.3.3, "Understanding Web
Schedule Types" for more information.

In the Target Group tab, associate a target group for the Web schedule, if
desired.

In the Web Planner subtab, associate a Placement to the Web schedule.
Specify a title for the Placement, if desired.
Select a content item for the Placement.

Submit the Web schedule for approval. When approved, the Web schedule
will execute on the specified launch date and for the specified duration.

Note: If new content items have been created for use in a Web
schedule, they must be approved in Oracle Content Manager before
the Web schedule can be approved.

8.3.2 Creating and Using Placements

Topics in this section include:

s Section 8.3.2.1, "Overview of Web Placements"

»  Section 8.3.2.2, "Creating a Web Placement”
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8.3.2.1 Overview of Web Placements

A placement is a defined area in a Web site that will display the content that results
when a Web schedule is executed. Web placements are usually created once by the
marketing administrator and shared across all marketers. This means that you need
not create a Web placement every time you create a Web schedule. In fact, marketers
should never have to create Web placements, but should have a number of them to
select from when creating a Web schedule.

A Web placement will normally have many Web schedules associated to it. This
means that any of these Web schedules can potentially run and render content in
the Web placement at any given time. However, only one Web schedule can actually
run in a placement at any given time. You can set up which schedule gets picked up
as follows:

= Random - the default method, where the system selects a schedule randomly
for display.

s Ordered - where the order of execution defines the schedule to be displayed. A
Website manager can manually change this priority for a schedule and can also
indicate if a specific schedule must always execute first or last.

A newly created placement is in the Inactive status. You can change the status to
Active at any given time without having to go through an approval process. You
can change it back to Inactive if there are no active schedules associated with it.

What Web site and location in that site a Web placement actually represents is
defined using the fields in the Target region. What fields need to be defined
depends on the Application or web site targeted. For Oracle Store-based
applications, iStore, iSupport and Partner Portal, the fields are: Site, Section, Page,
Location. For iSupport only (non-Oracle Store-based) and custom Web sites, only
Page and Location need to be defined.

Oracle Content Manager (OCM) Content Types are used to define ‘'what” and OCM
Style Sheets will be used to define "how” content will be rendered on a placement. A
placement can have multiple content types associated with it and you can select a
specific style sheet for each content type. The content types seeded in the
application include:

= Web Advertisement
= Web Dynamic Recommendation

You can also define the default content (and style sheet) that will be rendered in a
placement when a Web schedule does not return any content.
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For a given Web placement, you can view all the schedules associated to it.
However, only schedules that are approved can actually run in the placement. If the
Auto-Publish attribute of the placement is set, schedules selected will be
automatically rendered anytime after approval. If the Auto-Publish attribute is not
set, the Website manager must manually update the placement to run an approved
schedule.

8.3.2.2 Creating a Web Placement

Placements are the physical locations on a Web site where campaign schedules
render content.

Use the following procedure to create a placement.

Prerequisites
Fatigue rules definitions must exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. On the Campaign Dashboard, click the Placements link in the Administration
bin.

3. Click Create Placement.
4. Enter a name and description for the placement.

5. Select the Auto Publish check box for new, approved schedules to be
automatically published in the placement.

6. Change the status to Active for the placement to be available immediately and
select a Selection Method.

You can change the status of a placement at any time. When you change it to the
Inactive status, ensure that no Active schedule is associated with it.

If you select the Selection Method to be Ordered, selection of which schedule to
run will be based on the Priority number for that schedule in that placement,
with the highest priority schedule (lowest number) that fits all the criteria (like
target group requirements) being the one selected.

7. Select the target location details in the Target region and the content types to be
associated with the placement in the Content region. To preview the content,
click the Preview icon.
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Two active placements cannot have the same values for Application, Page,
location, site, and section.

Placements that are to be used for Web Dynamic Recommendation schedules
need to have the seeded content type for Web Dynamic Recommendation
selected as one of their content types. Placements that do not have this as one of
their content types will not show up in the placement list in Web Dynamic
Recommendation schedules.

Placements that are to be used for Web Ad and Web Offer schedules need to
have at least one content type that belongs to the content type group for Web
defined.

8. Select a default content that must be rendered if the associated schedules do not
return any content and click Apply.

9. To view the list of schedules associated with a placement or to remove the
association of a schedule with a placement, click its Update icon on the Web
Placements page and scroll down to the Schedules region.

Only approved schedules will actually run in the associated placement.

10. To update the details of a placement, click its Update icon in the Web
Placements page, make the necessary changes, and click Apply.

11. To delete a placement, click its Remove icon in the Web Placements page.

A placement can be deleted only if it has no active schedules associated with it.

8.3.3 Understanding Web Schedule Types

You can create three types of Web schedules: Web Ads, Web Offers, and Web
Dynamic Recommendations from the Campaign Workbench.

Web Ad Schedule

A Web ad is a schedule the execution of which results in one or more content
(typically image or text) being displayed on a Web page. You can use Web ads to
improve product brand or company awareness or to alert customers of new
products or deals. You can choose to target the Web ad at specific customers or
target all the visitors to the Web site.

Figure 8-8 depicts the process flow of campaign schedules of type Web Ad or Web
Offer. The tasks in a Web ad or Web offer flow logically as follows:

1. Performing precampaign analysis and schedule planning.
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2. Creating a Web ad or offer, that includes:
1. Selecting an appropriate template.
Selecting a purpose.
Selecting the parent campaign.
Associating products and/or offers to the schedule.
Optionally, associating a target group.
Associating placement and selecting content items for it.

Defining CTD for the content items.

©® N o g » 0 b

Adding notes, if desired.

Figure 8-8 A Web Ad or Web Offer Process Flow
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A sample scenario

Vision Enterprises, which produces computer hardware, plans to launch its new
sleek monitors. To promote the new product, its marketing manager will create a
Web Advertising schedule that will advertise the product on Vision iStore’s Home

page.

Web Offer Schedule

A Web offer schedule is similar to a Web ad, but with an offer associated with the
content it renders. You can create Web offers to make marketing offers to customers.
For example, buy a product and get an associated product free. You can choose to
target the Web ad at specific customers or target all the visitors to the Web site.
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A sample scenario

Vision Enterprises, which produces computer hardware, plans to launch its new
sleek monitors. To promote the new product, its marketing manager will create a
Web Offer schedule that will display an offer on Vision iStore’s Home page - a 10%
discount on the price for those customers who purchase the product in the first one
month of the launch.

Web Dynamic Recommendation Schedule

A Web product recommendation schedule results in a product or set of products to
be recommended, and the associated product image (not an ad) that is pulled from
iStore's media object library.

Figure 8-9 depicts the process flow for a campaign schedule of type Web Dynamic
Recommendation. The tasks in a Web Dynamic Recommendation flow logically as
follows:

1. Performing precampaign analysis and schedule planning.

2. Creating a Web Dynamic Recommendation, that includes:
1. Selecting the appropriate template.

Selecting the parent campaign.

Selecting the Recommendation type.

Defining rules.

Optionally, associating a target group.

Associating placement.

N o a 0 Dbd

Adding notes, if desired.
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Figure 8-9 A Web Dynamic Recommendation Process Flow
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Product recommendations are made based on a set of defined rules. These rules are
defined on the basis of a Recommendation Type from the Offering subtab. Each
recommendation type has its own definitions. Oracle Marketing comes with two
seeded recommendation types:

Understanding Product Relationship Recommendation Type

For product recommendations to be based on how products are related, select
Relationship as the Recommendation Type. For example, if Product A must exist
before Product B can be utilized, create a recommendation for Product A based on
the 'Prerequisite’ relationship to an audience that is showing interest in Product B.
Oracle Marketing ships with a number of seeded relationships.

Understanding Oracle Personalization Recommendation Type

In order to remain highly effective in the fast-paced Web marketing field and to
keep the best customers coming back to your Web site, you must deploy
personalized and just-in-time messages to your customers. You need to capture
customers’ real-time interactions, analyze those interactions, and provide real-time
recommendations based on current and past browse behavior. For example, you
may want to define a product recommendation based on the products already in a
customer’s shopping cart.

In the Oracle E-Business Suite, customer data is captured and tracked by the Oracle
Personalization module. To create product recommendations based on this data,
you need to select Oracle Personalization as the Recommendation Type when you
are creating a Product Recommendation Web schedule.
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8.3.3.1 Understanding Oracle Personalization

When the recommendation type is Oracle Personalization, the following are the
parameters that users can define settings for and a brief explanation of each:

s Filter

s Include Product Previously Bought (Unchecked by default) - When
checked, products that have been previously bought by the visitor can still
get recommended by OP

» Context

m  Best Context Available (Default) - Context used for recommendation will be
products in shopping cart if available. If none, then product on page
browsed. If none, then only the customer identity will be used. Note that
customer identity is also used as part of context for ‘products on page
browsed' or 'products in shopping cart'.

= Products in shopping cart - Context used for recommendation will be
products currently in the shopping cart and the customer identity

= Products on page browsed - Context used for recommendation will be
products on page being browsed and the customer identity

»  Customer identity only - Context used for recommendation will be the
visitor himself, without regard for what product he is looking at or put in
his shopping cart

= Base Data - The recommendation model is generated using all historical orders
and select historical navigational data. What the selections for 'Base Data’
determine is if the visitor's particular session information and/or historical
information should be a factor in making the recommendation.

= Both Current Session and History (Default) - Basically use all the data
available

= Current session only - Only current session data will be used with the
recommendation model

= History only - Only the customer's historical data will be used with the
recommendation model; current session data is ignored

Sample Use Cases for Changing OP Parameters

While the default settings will be sufficient for most scenarios, the user may want to
modify some of these settings based on their marketing objectives. Some sample use
cases where settings are modified follow:
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Products Sold are Consumable

Products can be one-time purchases (usually durable goods, CDs, software with
specific versions) or consumable with repeat purchases. If products tend to be
repeat purchases, then the following should be set:

»  Filter - Check check box for 'Include Product Previously Bought'

This does not mean that previously bought products "WILL" be recommended -
it just means that they are not out of contention.

‘Impulse’ Buy

Analogous to check-out counters at the supermarket, additional products can be
displayed that have a high possibility of being bought, regardless of what the
person is buying right now. The following should be set:

= Placement is a location in the Shopping Cart page
s Context - Customer Identity Only
= Base Data - History Only

Cross-sell and Up-sell Based on Products Being Browsed

The intent here is that whatever it is that the visitor is browsing, always cross-sell or
up-sell him the things that he is most likely to buy together with the product
browsed. In this case, the following should be set:

= Placement is either a location in the Product Detail page or in the Shopping Cart
page
= Context - Products on Page Browsed or Products in Shopping Cart

= Base Data - Both Current Session and History or History Only

8.3.4 Creating a Web Ad or Web Offer

You can place a Web Ad or Offer in placements defined for a Web site, such as
Oracle iStore by creating a campaign schedule of type Web Ad or Web Offer.

Use the following procedures to create a Web Ad or Web Offer campaign schedule.
8.3.4.1 Entering Basic Details

Use the following procedure to enter the basic details for a new Web Ad or Web
Offer.

8-56 Oracle Marketing User Guide



Understanding and Creating Web Schedules

Prerequisites
= A campaign must exist

= A placement must exist

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. C(lick the Create Schedule link in the Shortcuts bin. You can also click the
Schedules List link in the Shortcuts bin and click Create in the Schedules List

page.
3. Based on the campaign schedule you want to create, select Web Ad or Web
Offer template in the Create Schedule page.

4. Enter the other relevant information for the schedule.
5. Click Continue.

6. Inthe Additional Info subtab, enter or modify the required information and
click Save.

7. When you have entered all the details for a campaign schedule, in the
respective subtabs, click Submit For Approval to initiate the approval process.

8. Click Apply in the Schedule Details page to save all the details and return to the
Campaign Dashboard.

8.3.4.2 Associating a Product or Offer

Use the following procedure to associate a product or product category with a Web
Ad and an offer with a Web Offer.

Prerequisites
A Web Ad or Web Offer schedule should exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.
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3. In the Offering subtab of the Schedule Details page, click Add Another Row.

4. Click the Search icons of the Category and/or Product fields in the Products
region and select the category and product that you want to associate with the
Web Ad or Web Offer. Click Save.

5. For a Web Offer, click the Search icons of the Offer field in the Products region
and select the offer that you want to associate with the Web Offer. Click Save.

6. To disassociate a product category, product, or offer from the schedule, click the
Remove icon of the corresponding row and click Apply.

8.3.4.3 Associating a Web Ad or Web Offer to a Placement

A placement is a specific location on a Web site where a Web Ad or Offer will be
hosted. A Web Ad or Offer is associated to a placement in the Web Planner subtab
of the schedule Details page.

Use the following procedure to associate a Web Ad or Offer to a placement.

Prerequisites
A Web Ad or Web Offer schedule should exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

3. Click the Web Planner subtab.

Creating New Content Items from Within the Web Planner Subtab

1. If you are creating a compound content item, you can add subitems from
the library in the Attributes subtab.

a. Select an attribute and click Add.
b. Click the Search icon and select a content item from the list of values.
Only approved content items are listed.

c. To use the Live version of the content item, select the Use Live check box.
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To quickly create a content item, click Quick Create, enter the necessary
details, and click Apply.

More content items can be similarly added.

To present the content in different formats, you can use the Renditions
subtab.

Click the Add Another Row icon, browse, and select a file.

To set a rendition as the default, select a row and click Set as Default
Rendition.

To associate the content with existing E-Business Objects, you can use the
Associations subtab.

Select an association type and click Add.

Click the Search icon and select the object for association from the list of
values.

For example, you can associate a product from Inventory Products to the
content item. The content item will be available when the product is
associated with the Web Ad schedule.

To enter general information for the content item, enter the necessary
details in the Meta Information subtab.

If you do not enter the Availability date, the content item is available as
soon as approved.

Text entered in the Keyword field will be used to search for the content item
in the Library.

To publish the content item to a category, you can use the Categories
subtab. Select the Publish to Category check box of the categories to which
you want to publish the content item.

Click Save For Later to save the content or click Submit to submit it for
approval.

The content item is saved in the central Oracle Content Manager (OCM)
repository. If you have the approver privileges, the status of the content
item changes to "Approved’ immediately. When the content item is
approved, it is available for selection from the Web Planner subtab.

To preview the content before submitting it for approval, click Preview.

You must save the content item before you can preview it.
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For more details on content items, refer Oracle Content Manager User Guide.

4. To associate content, click Add Another Row in the Web Planner subtab of the
Schedule Details page.

5. Specify the application type of the target Web site and select a placement.
6. Enter a Title if desired.

The title will appear when this schedule runs. For example, you might want the
title "Designed Specifically for the Internet"” for a Web Ad for a database
product.

7. Using the Search icon, find and select the content item to use for the placement.
8. Click the Click-Thru Details icon to define a click-through destination (CTD).

9. In the Click-Through Details page, select the attribute for which you want to
define a CTD and specify the action details in the Define Click-Through Action
region.

If you have not associated a product to the Web Ad in the Offering subtab, the
actions related to products, such as Go To Shopping Cart or Go To Item Details,
will not be available.

10. To preview the CTD, click Preview. Click Back to return to the Schedule Details
page.
11. Click Apply.

8.3.4.4 Creating and Associating a Target Group

You may want to target specific audience for a Web Ad or Web Offer. You can
associate a specific audience using the Target Accounts subtab of the Schedule
Details page. If you do not define a target group, the schedule is meant for all the
visitors to the Web site.

Target groups are generated in the Full Refresh mode - that is using the selection
criteria, deduplication rules, and suppression options, the list is recreated as if for
the first time.

See Section 8.2.4, "Creating and Associating Target Groups" for procedures to create
target groups for a campaign schedule.
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8.3.4.5 Associating Costs, Revenues, and Metrics for Tracking

The Views available to you for associating tracking metrics to a campaign schedule
include Costs, Revenues, or Metrics. For each of these, you have the Details or the
Hierarchy view.

See Section 8.2.7, "Associating Costs, Revenues, and Metrics for Tracking" for the
procedure to view or associate costs, revenues, or metrics to a campaign schedule.

8.3.4.6 Creating a Note

See Section 8.2.8, "Creating a Note" for the procedure for creating and associating a
note to a campaign schedule.

8.3.5 Creating a Web Dynamic Recommendation

You can make product recommendations based on product relationships or
personalized for customers based on customer data captured by Oracle
Personalization.

Use the following procedures to create a Web Dynamic Recommendation campaign
schedule.

8.3.5.1 Entering Basic Details

Use the following procedure to enter the basic details for a new Web Dynamic
Recommendation.

Prerequisites
= A campaign must exist

= A placement must exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. C(lick the Create Schedule link in the Shortcuts bin. You can also click the
Schedules List link in the Shortcuts bin and click Create in the Schedules List

page.
3. Select the Web Dynamic Recommendation template in the Create Schedule
page.

4. Enter the other relevant information for the schedule and click Continue.
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5. Inthe Additional Info subtab, enter or modify the required information and
click Save.

6. When you have entered all the details for a campaign schedule, in the
respective subtabs, click Submit For Approval to initiate the approval process.

7. Click Apply in the Schedule Details page to save all the details and return to the
Campaign Dashboard.

8.3.5.2 Entering Offering Details

Use the following procedure to select a Recommendation Type and enter associated
information.

Prerequisites
A Web Dynamic Recommendation campaign schedule must exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

3. In the Offering subtab of the Schedule Details page, select a Recommendation
Type.

4. If you have selected Product Relationship as the Recommendation Type, enter
the rule details for the relationship. If you select the Context type as Specified
Product, select a Context to indicate the product. Click Save.

For Recommendation type of Product Relationship, you can specify a product
relationship based on either the products on page, products in shopping cart, or
a specified product. The product relationships available are pulled from the
Oracle iStore inventory and typically include cross-sell to, up-sell of,
prerequisite of, accessories of, and so on. You can define more than one
relationship rule if desired, although one rule per schedule would be the
recommended usage.

5. If you have selected Oracle Personalization as the Recommendation Type,
complete the Product Purchase History, Context, and Base Data regions and
click Save.
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For Recommendation type of Oracle Personalization, the default settings should
suffice for most cases and you should not need to change parameters for it.
However, there may be some instances where you might want to set some of
these parameters. Please see Section 8.3.3.1, "Understanding Oracle
Personalization" for more details on Oracle Personalization settings.

8.3.5.3 Associating a Web Dynamic Recommendation to a Placement

A Web Dynamic Recommendation is rendered on a specified placement. Use the
Web Planner subtab of the Schedule Details page to associate a Web Dynamic
Recommendation to a placement.

Use the following procedure to associate a Web Dynamic Recommendation to a
placement.

Prerequisites
A Web Dynamic Recommendation must exist

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

2. Select the campaign schedule from the My Recent Schedules bin or click the
Schedules List link in the Shortcuts bin and select the campaign schedule from
the Schedules List page.

3. Click Add Another Row in the Web Planner subtab of the Schedule Details
page.

4. Select the Application where the recommendation will be rendered from the
drop-down list and using the Search icon, select a placement.

5. If desired, enter a Title and increase the maximum recommendations for this
placement.

6. Similarly, You can associate the Web Dynamic Recommendation to other
applications and placements

7. Click Save.

8. To disassociate a placement from a Web Dynamic Recommendation schedule,
click its Remove icon and click Save.
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8.3.5.4 Creating and Associating Target Groups

You may want to target specific audience for a Web Product Recommendation. If
you do not define a target group, the schedule is meant for all the visitors to the
Web site.

You can associate a specific audience using the Target Accounts subtab of the
Schedule Details page.

Target groups are generated in the Full Refresh mode - that is using the selection
criteria, deduplication rules, and suppression options, the list is recreated as if for
the first time.

See Section 8.2.4, "Creating and Associating Target Groups" for procedures to create
a target group for a campaign schedule.

8.3.5.5 Associating Costs, Revenues, and Metrics for Tracking

The Views available to you for associating tracking metrics to a campaign schedule
include Costs, Revenues, or Metrics. For each of these, you have the Details or the
Hierarchy view.

See Section 8.2.7, "Associating Costs, Revenues, and Metrics for Tracking" for the
procedure to view or associate costs, revenues, or metrics to a campaign schedule.

8.3.5.6 Creating a Note

See Section 8.2.8, "Creating a Note" for the procedure for creating and associating a
note to a campaign schedule.

8.3.6 Understanding Web Reports

All the Web schedules come with reports, which include web statistics broken down
by placement and by the relevant attribute given the Web schedule type (for
example, Web ad reports have statistics by product and product category).
However, while the rows may be different, the columns are similar.

Table 84 gives the columns in the channel-specific portion of web reports, and
what they mean.
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Table 8—4 Channel Web Reports

Column

Description

# Impressions Served -
Total

Number of times the content item associated to a Placement in
the Schedule was served up. Since there is only one content
item per Placement, this is the same as the number of times the
Schedule executed.

# Impressions Served -
Anonymous

Number of times the content item associated to a Placement in
the Schedule was served up to an anonymous visitor.

# Impressions Served -
Identified

Number of times the content item associated to a Placement in
the Schedule was served up to an identifiable visitor.

# Click-Thrus - Total

Number of times the content served is actually clicked.

# Click-Thrus -
Anonymous (1)

Number of times the content served is actually clicked by an
anonymous visitor.

# Click-Thrus - Identified

Number of times the content served is actually clicked by an
identifiable visitor.

# Click-Thrus - Unique (2)

Number of Click-Thrus identified and deduped. For example,
a logged in user who clicks the same link twice in the same
browser session will have only one click counted.

# of Responses - Identified

®)

Number of Click-Thrus Identified and deduped by Customer
ID. For example, a logged in user who clicks on the same link
twice in two different sessions will have only one click
counted.

Click-Thru Ratio -

Number of Impressions Served Anonymous versus the

Anonymous Number of Click-Thrus Anonymous.
Click-Thru Ratio - Number of Impressions Served Identified versus Number of
Identified Click-Thrus Identified.

Table 8-5 depicts a sample scenario with recommendations served to an
anonymous visitor. Bold and italicized items indicate the link clicked by the user.
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Table 8-5 Recommendations Served to an Anonymous Visitor

Anonymous Visitor

Anonymous Visitor

Anonymous Visitor

Please Try... Please Try...
Product A Image Product A Image
Product A Text Product A Text
Product B Image Product B Image
Product B Text Product B Text

Please Try...

Product A Image
Product A Text

Product B Image
Product B Text

Table 8-6 depicts a sample scenario with a recommendations served to an identified

customer. Bold and italicized items indicate the link clicked by the user.

Table 8-6 Recommendations Served to Customer X

Customer X Customer X Customer X
Please Try... Please Try... Please Try...
Product A Image Product A Image Product A Image
Product A Text Product A Text Product A Text
Product B Image Product B Image Product B Image
Product B Text Product B Text Product B Text

Table 8-7 gives the count of recommendations served.

Table 8-7 Counts in the Report

Metric

Totals

Product A | Product B

# Impressions Served - Total

# Impressions Served - Anonymous

# Impressions Served - Identified

# Click-Thrus - Total

# Click-Thrus - Anonymous (1)

# Click-Thrus - Identified

# Click-Thrus - Unique (2)

# of Responses - Identified (3)

= IN | W N W W[

6 6
3 3
3 3
4 1
2 0
2 1
1 1
1 1

Click-Thru Ratio - Anonymous

2/3

2/3 0/3
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Table 8-7 Counts in the Report
Metric Totals | Product A | Product B

Click-Thru Ratio - Identified 3/3 2/3 1/3

There is also the Click-Thru Destination Analysis table that is part of Web Ad and
Web Offer reports. This table includes destination and click-through details, such as
number of clicks and number of unique clicks - and access to scripting reports as
well. Note that these scripting reports are at the click-through destination level.
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9

Working with Products and Price Lists

The Products tab in Oracle Marketing allows marketing personnel to easily access
all product-related information and attributes required to better target, define, and
manage marketing initiatives. This includes managing products and their price lists,
tracking competitor products, and maintaining trade deals.

Topics in this chapter include:
= Section 9.1, "Managing Products"

= Section 9.2, "Managing Price Lists"
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9.1 Managing Products

The Products tab provides you with the ability to create new products and review
and maintain existing products. A product is considered anything you manufacture
or trade, including physical items you can stock in inventory. A product is not
necessarily physical; it can also be a service, or a combination of physical items and
services. A grouping of products is often referred to as a product bundle.

Using the Products tab, you can easily access all product-related information and
attributes required to better target, define, and manage marketing initiatives. It also
provides a consolidated view of all marketing-related product information and the
key Enterprise Resource Planning (ERP) decision-making variables from inventory,
purchasing, sales and customer relationship management modules.

Note: Oracle Marketing supports access to the basic features of
Oracle Inventory. Depending on your business practices, your
organization may require further parameters to be set up in Oracle
Inventory before the manufacturing and shipping of a product or
bundle. See the Oracle Inventory User’s Guide and the Oracle
Marketing Implementation Guide for more information.

Topics in this section include:

= Section 9.1.1, "Understanding Inventory Attribute Templates"
= Section 9.1.2, "Seeded Inventory Attribute Templates"

= Section 9.1.3, "Single Product Catalog"

= Section 9.1.4, "Creating a Product”

= Section 9.1.5, "Modifying Inventory Options"

= Section 9.1.6, "Assigning a Product to a Category”

= Section 9.1.7, "Assigning a Product to an Organization”

= Section 9.1.8, "Associating a Product to Price Lists"

= Section 9.1.9, "Creating an Offer for a Product"

= Section 9.1.10, "Creating Product Relationships"

= Section 9.1.11, "Creating a Collateral Relationship with another Product"

= Section 9.1.12, "Creating Product Revisions"
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= Section 9.1.13, "Specifying Products for a Product Bundle"
= Section 9.1.14, "Creating a Competitor Product"

= Section 9.1.15, "Associating Product Contents"

9.1.1 Understanding Inventory Attribute Templates

Oracle Marketing provides default inventory attribute templates based on whether
you are defining a product or a service. The template can be overridden by selecting
or deselecting the desired product attributes. For each product attribute grouping,
you can specify whether a check box defaults to being checked or unchecked and
whether the default can be overridden or not. You can define the list of product
attributes for each responsibility and you can also specify if the product attributes
are editable in the product options page. This feature allows you to isolate product
attributes and limit their access to the appropriate users in accordance with
business and integration requirements.

In addition, this flexibility allows you to display only relevant product attributes
and quickly create a product ensuring that the requisite attributes are available.

For more information on setting up the templates, see the Oracle Marketing
Implementation Guide.

9.1.2 Seeded Inventory Attribute Templates

Oracle Marketing comes with seeded product and service templates for inventory
attributes. The following tables give you the details of the seeded templates. You
can customize them to suit your organization’s requirements.

s Table 9-1, "Product Template Inventory Attributes"
»  Table 9-2, "Service Template Inventory Attributes”
Table 9-1 describes the inventory attributes that are specified in the seeded product
template.
Table 9-1 Product Template Inventory Attributes
Section Check Box/LOV Description

Inventory

Inventory Item Specifies whether to stock and transact this item in
Oracle Inventory. If you turn this option on, the
item is automatically assigned to the default
category set for the Inventory functionality.
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Table 9-1 Product Template Inventory Attributes

Section

Check Box/LOV

Description

Stockable

Specifies whether the product or bundle is
available for inventory stocking. Selecting this
option enables you to select the Transactable
check box.

Transactable

Specifies whether to allow inventory transactions.
You can set this attribute only when you turn on
the Stockable option. This attribute is optionally
set by the Item Status code.

Note: Oracle Order Management uses this along
with stockable and returnable to determine which
authorized returned items can be physically
received into inventory.

Revision Control

Specifies whether to track inventory balances by
revision. If you turn this option on, you must
specify an existing revision number for issues and
receipts.

Note: You cannot change revision control when
an item has quantity on hand. If Revision Control
is controlled at the Master Item level, the check for
on-hand quantity is against the sum of on-hand
quantities in all child organizations.

Bill of
Material

BOM Item Type

Specifies the bill of materials type of item.
Standard is the default BOM Item Type.

BOM Allowed

Specifies whether to allow the creation of a bill of
materials for the item.

Pick Components

Specifies whether all shippable components
should be picked.

This option is not selected in the seeded template.

Costing
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Table 9-1 Product Template Inventory Attributes

Section

Check Box/LOV

Description

Cost Enabled

Specifies whether to report, value, and account for
any item costs. For example, you might disable
costing for reference items, or for invoice only
(non-stock) items that you never ship and never
hold in inventory.

This is an item defining attribute. If you turn this
option on, the item is automatically assigned to
the default category set for the Oracle Cost
Management functional area.

Note: Organizations using average costing always
maintain their own item costs, regardless of the
control level set for the Costing Enabled attribute.

Physical
Attributes

Collateral Item

Specifies whether the item is marketing collateral.

Electronic Format

Specifies whether the item is in electronic format.

Downloadable

Specifies whether the item can be downloaded.

OM Indivisible

Specifies whether the item can be ordered in
fractions.

Product Weight

Specifies the unit of measure of the unit weight.

The product weight must be specified for
individual products.

Unit Weight

Specifies the weight of the product.

The unit weight must be specified for individual
products.

Order
Management

Customer Orderable

Specifies whether an item is orderable by external
customers. You can initially define an item with
Customer Orderable selected and Customer
Orders Enabled de-selected. This means prices can
be defined for the item, but no orders can be
placed for it.

Customer Order
Enabled

Specifies whether an item is currently customer
orderable.
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Table 9-1 Product Template Inventory Attributes

Section

Check Box/LOV

Description

Internal Orderable

Specifies whether to allow the item to be ordered
on an internal requisition.

Internal Order
Enabled

Specifies whether you can currently order the item
internally.

Shippable

Specifies whether to ship an item to a customer.
Shippable items are released by Oracle Shipping
Execution’s Pick Release program, creating
confirmable shipping lines, and are printed on the
pick slip. A warning is issued if you change the
value of this attribute when open sales order lines
exist.

This attribute must be turned off if the BOM Item
Type attribute is set to Planning.

Returnable

Specifies whether to allow customers to return an
item.

Activation Required

Turn this attribute on if customer is required to
activate the Product; this option is generally used
for communication products.

Assemble to Order

Select this if the item is generally built for sales
order demand.

OE Transactable

Indicates whether demand and shipment
transactions for this item are tracked in Inventory.

Invoiceable

Invoiceable

Specifies whether the item can be included on an
Oracle Receivables invoice.

Invoiced Enabled

Specifies whether to activate an item for invoicing
in Oracle Receivables. If Invoiceable Item is
turned on, you can temporarily exclude from
invoicing by leaving Invoice Enabled turned off.

If you turn this option on, the item appears in the
Invoice Entry item list of values in Oracle
Receivables. If you turn this feature off, the item
does not appear in the list of values and Auto
Invoice rejects the item.

Service

Serviceable Product

Specifies whether the item is serviceable or not.
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Table 9-1 Product Template Inventory Attributes

Section Check Box/LOV Description
Defect Tracking Specifies whether defects related to the item
should be tracked.
Billing Type Specifies the billing type for the customer.
Web
Orderable on Web Specifies whether this item can be orderable on
Oracle iStore.
Back Orderable Specifies whether this item can be back-ordered
on Oracle iStore.
Web Status Specifies whether the item is to be published to a

Web store.

Table 9-2 describes the inventory attributes that are specified in the seeded service

template.

Table 9-2 Service Template Inventory Attributes

Section

Check Box/LOV

Description

Bill of Material

Note: This section only appears in the Service
template for items for which the contract type is
“warranty.”

BOM Item Type

Specifies the bill of materials type of item.

BOM Allowed

Specifies whether to allow the creation of a bill of
materials for the item.

Pick Components

Specifies whether all shippable components
should be picked.

Costing
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Table 9-2 Service Template Inventory Attributes

Section Check Box/LOV Description
Cost Enabled Specifies whether to report, value, and account for
any item costs. For example, you might disable
costing for reference items, or for invoice only
(non-stock) items that you never ship and never
hold in inventory.
This is an item defining attribute. If you turn this
option on, the item is automatically assigned to
the default category set for the Oracle Cost
Management functional area.
Note: Organizations using average costing always
maintain their own item costs, regardless of the
control level set for the Costing Enabled attribute.
Physical
Attributes
Collateral Item Specifies whether the item is marketing collateral.
Electronic Format | Specifies whether the item is in electronic format.
Downloadable Specifies whether the item can be downloaded.
OM Indivisible Specifies whether the item can be ordered in
fractions.
Product Weight Specifies the unit of measure of the unit weight.
Unit Weight Specifies the weight of the product.
Order
Management
Customer Specifies whether an item is orderable by external
Orderable customers. You can initially define an item with

Customer Orderable selected and Customer
Orders Enabled de-selected. This means prices can
be defined for the item, but no orders can be
placed for it.

Customer Order
Enabled

Specifies whether an item is currently customer
orderable.

Internal Orderable

Specifies whether to allow the item to be ordered
on an internal requisition.

Internal Order
Enabled

Specifies whether you can currently order the item
internally.
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Table 9-2 Service Template Inventory Attributes

Section

Check Box/LOV

Description

Activation
Required

Turn this attribute on if customer is required to
activate the Product; this option is generally used
for communication products.

Assemble to Order

Select this if the item is generally built for sales
order demand.

OE Transactable

Indicates whether demand and shipment
transactions for this item are tracked in Inventory.

Invoiceable

Invoiceable

Specifies whether the item can be included on an
Oracle Receivables invoice.

Invoice Enabled

Indicate whether to activate an item for invoicing
in Oracle Receivables. If Invoiceable Item is
turned on, you can temporarily exclude from
invoicing by leaving Invoice Enabled turned off.

If you turn this option on, the item appears in the
Invoice Entry item list of values in Oracle
Receivables. If you turn this feature off, the item
does not appear in the list of values and Auto
Invoice rejects the item.

Service

Defect Tracking

Specifies whether defects related to the item
should be tracked.

Contract Item Type

Indicates the contract item type.

Web

Orderable on Web

Specifies whether this item can be orderable on
Oracle iStore.

Web Status

Specifies whether the item is to be published to a
Web store.

9.1.3 Single Product Catalog

In release 11.5.10, Oracle Marketing uses Oracle Product Lifecycle Management
(PLM) for product cataloging and management. The concept of using the hierarchy
provides an efficient and re-usable catalog and product management system.
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Using catalog categories, you build a structured hierarchy that contains
characteristics (such as attributes and functions). These characteristics are inherited
throughout the hierarchy. For example, you can create a catalog category Phone.
This category can have children Mobile Phone and Land Line. All children will
inherit the characteristics defined for the parent phone.

Catalogs

A collection of categories that are setup in a hierarchical format. When building
your product catalog (and associated hierarchy), the first thing to do is create the
catalog structure.

Categories

Using PLM, you can create categories and sub-categories. Sub-categories can only
be added under categories with no product associated to it. Products can only be
associated to leaf level categories.

9.1.4 Creating a Product

Use the following procedure to create a product or a service product.

Prerequisites

An understanding of the organization’s inventory practices and inventory
numbering conventions

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

2. Click Create.
3. Select a setup type using the drop-down list.

The setup type indicates the template that you want to use for this product or
service product. It determines which side navigation items will be available for
this record. See the Oracle Marketing Implementation Guide for information on
creating custom setup types.

4, Select either the Product or Service option buttons.

Choose Product to create a physical product, and Service to create a service
product. Depending on which type of product you select, the system displays a
corresponding set of attributes on the following attribute definition pages.
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5. Enter a name for the product or service.

6. Enter a product number for the product or service, following your
organization’s guidelines for creating inventory numbers.

This field is a key flex field that validates the product number entered. If you
enter an invalid value, you will be directed to a page that lists the appropriate
values. For more detailed information, refer the Oracle Inventory User’s Guide.

7. Enter the name of the owner of the product.
Use the search icon to view the available owners’ names.

8. Your Master Organization is displayed. The value is the default value that is set
for the AMS: Item Validation Master Organization profile option. See the Oracle
Inventory User’s Guide for more information on master organizations.

9. Select the Product Type from the drop-down list.
10. Select a unit of measure using the search icon.
11. Enter a product description.
12. If you are creating a product of type Service:
a. Click Go to select a Coverage Template.
This specifies the coverage template type for a warranty.
b. Enter a value in the Duration Value field.
This value specifies the unit of time for the service.
c. Enter a value in the Duration Period field.
This value specifies the current duration for the service.
13. Click Apply.

The Product Detail page appears displaying flexfields, if any. You can add
details for these fields.

14. To update product details, navigate to the Product Details page, make the
necessary changes, and click Apply.

9.1.5 Modifying Inventory Options

Use this procedure to modify an existing product or service’s inventory options.
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Prerequisites

You can modify inventory options only for products created within Oracle
Marketing.

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

Click the hyperlink of the product name to modify its inventory options.
Navigate to Planning > Inventory Options side navigation link.

Fill in the Product Weight and Unit Weight fields.

o » w0 Db

Select or deselect the desired inventory option check boxes.

For details about these options, see Section 9.1.2, "Seeded Inventory Attribute
Templates".

6. Click Apply.
7. Optionally, click Revert for the original settings.

9.1.6 Assigning a Product to a Category

This feature supports you in assigning your products to a category. You must
define categories to group items that share similar characteristics.

You need to define categories to create different category grouping schemes.
Category sets group your categories into functional areas, such as inventory, cost,
purchasing, order entry, and so on.

With this functionality, you can define multiple segment structures for the Item
Category flexfield. The categories assigned to a category set must have the same
flexfield structure as the set itself. You can define an unlimited number of categories
in a category set.

By default, every product you create are added to the following category sets:
= Purchasing
s Inventory Items

Use the following procedure to define category assignments for an existing product.

Prerequisites
= An existing product
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The Load Inventory Category concurrent program must have been run during
implementation.

Steps

1.

N o a » o Db

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

Click the hyperlink of the product name to assign it to a category.
Navigate to Planning > Category side navigation link.

Select a category set from the drop-down list.

Select a description using the search icon.

Repeat the above steps until you have entered all desired categories.

Click Apply.

9.1.7 Assigning a Product to an Organization

An organization may have several inventory organizations with one master
organization. You can assign the inventory organization and its unit of measure.

Use the following procedure to define organization assignments for an existing
product.

Prerequisites
An existing product

Steps

1.

N o g » 0 Db

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

Click the hyperlink of the product name to assign it to an organization.
Navigate to Planning > Organization Assignments side navigation link.
Select an organization using the search icon.

Select a unit of measurement using the search icon.

Repeat steps 3 and 4 until you have entered all desired organizations.

Click Apply.
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9.1.8 Associating a Product to Price Lists

A product may be part of one or more price lists. Use this procedure to add a
product to price lists.

Prerequisites
An existing product and price list

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

2. Click the hyperlink of the product name to associate with a price list.
3. Navigate to Planning > Price List side navigation link.
4. Add the product to one or more price lists. To select a price list:
a. From the Name column, click the search icon to select the price list.
The Status and Currency fields will be populated later.
b. Enter the price.
c. Click the search icon to select a Unit of Measure (UOM).

UOM is the unit in which the quantity of an item is expressed. UOMs are
established and defined in Oracle Inventory.

d. Click the search icon to select a Static Formula.

Prior to order entry, you execute a concurrent process which calculates the
list price based on a static formula.

e. Click the search icon to select a Dynamic Formula.

When you enter an order, the pricing engine uses the dynamic formula to
calculate the list price.

f. Enter the start date when the price becomes effective.
g. Optionally, enter an end date.

5. Click Apply.
The Status and Currency fields are displayed.

6. Optionally, you can also create a price list for this product.

See Section 9.2.1, "Creating a Price List" for details.

9-14 Oracle Marketing User Guide



Managing Products

9.1.9 Creating an Offer for a Product

An offer is an incentive designed to entice someone to purchase your product or
service. If the offer is a discount, it is applied to the price list that the customer is
eligible for. For example, if the price for a product is $10, and the discount offer is
20%, then the customer has to pay $8.

To create an offer, see Section 10.2.1, "Creating an Offer".

9.1.10 Creating Product Relationships

You can build a relationship between two products. The relationship type could
vary from Prerequisite to Complimentary.

For example, if the product is a CD Player, you may want to give a complimentary
CD free. On the other hand, a mobile charger is optional with a mobile handset.

To build a relationship between products, complete the following steps.

Prerequisites
Two existing products

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

2. Click the hyperlink of the product name to build a product relationship.
3. Navigate to Planning > Related Products side navigation link.

4. From the Product Name column, select the desired product using the search
icon.

5. From the Relationship Type drop-down, select the relationship type.

6. Click the Reciprocal check box for activating the relationship on both products.
Conversely, if you only want a one-way relationship, do not check this box.

7. Click Apply.

9.1.11 Creating a Collateral Relationship with another Product

Collateral is another kind of relationship between two products. For example, a user
manual for a television set is a collateral. In this case, both the user manual and the
television set must be part of the inventory.
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Use the following procedure to create a collateral relationship with another
product.

Prerequisites
Two existing products

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

2. Click the hyperlink of the product name to create a collateral relationship.

3. Navigate to Planning > Collateral side navigation link.

4. From the Product Name column, select the desired product using the search
icon.

5. From the Relationship Type drop-down, select the Collateral relationship type.

6. Click the Reciprocal check box for the Collateral relationship to be activated on
both products. This means Product A and Product B are collaterals for each
other. Conversely, if you only want a one-way relationship, do not check this
box.

7. Click Apply.

9.1.12 Creating Product Revisions

A product revision is a new, amended, improved, or up-to-date version of an
existing product. Oracle Marketing supports iterations of the same product. Each
time you work on a revision, you are always working from the most current
products. Use the Revisions functionality to build a history for each revision you
make on the given product.

Note: The effective date of the revision must be a date after the
current date in order for the system to accept your update.

Use the following procedure to add details to the product revision history.

Prerequisites
None
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Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

2. Click the hyperlink of the product name to enter product revisions.
3. Navigate to Planning > Revisions side navigation link.
Revision A is seeded. You can remove or modify it, if required.
4. Enter the name and description for the revision.
5. Enter an effective date for the revision.

6. Click Apply.

9.1.13 Specifying Products for a Product Bundle

The bundling feature supports the creation of a product bundle by combining
products with other products and services.

Note: Set the BOM allowed flag for this product bundle to “Y”, as
the system stores the bundling specification you define in the Bill of
Material.

Use the following procedure to specify which products this product bundle will
contain.

Prerequisites
The products you wish to bundle must already exist in inventory.

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

Click the hyperlink of the product name to create a product bundle.
Navigate to Planning > Bundling side navigation link.
In the Item Sequence column, enter a number.

Select a product using the Search icon.

o o &~ w N

Enter the item quantity.
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This indicates the number of items to include in the bundle.
7. Repeat steps 3 to 6 until you list all products for inclusion.

8. Click Apply.

9.1.14 Creating a Competitor Product

A product from another company with solutions for the same domain as your
product is a competitor product. You can create, view and update competitor
product information from either the Product Tab (Competitor Product cue card) or
from the Competitor Products tab.

Use the following procedure to create a new competitor product.

Prerequisites

»  The product for which you are creating competitive information must exist in
inventory

s The competitor name must exist in the party table

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

Click the hyperlink of the product name to create a competitor product.
Navigate to Planning > Competitor Product side navigation link.

Enter the name of the competing product.

Enter the product code for the competing product, if available.

Select the name of the competing vendor using the Search icon.

Enter the competitor’s URL, if available.

® N o g » @ Db

Enter the Start and End Dates for the product.
The competitor product is disabled after the end date specified here.
9. Click Apply.

9.1.15 Associating Product Contents

When a Product is created, documents like datasheets, whitepapers, analyst reports,
and so on for the product or service are available. Such content can be associated to
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the product upon creation. When this content is associated to a product, the content
is displayed as recommended content for schedules that have the product attached.

Prerequisites
Content items must exist in the library

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Products.

2. Click the hyperlink of the product name to associate content items.
3. Navigate to Planning > Product Content side navigation link.

= To upload content from your desktop:

a. Click Quick Upload.

b. Click the Search icon and select the location where you want the content to
be stored.

c. Click Add Another Row, select the content type (File or Image), browse
and select the file or image you want to create, and click Submit to submit
the content for approval. Click Save For Later for work in progress items.

= To select a content item from the library (Oracle Content Manager
repository):

a. Click Add Another Row.

b. Select a Content Type and using the Name Search icon, select a content item
from the list of values and click Save.

c. To disassociate a content item, click the Delete icon of the corresponding
row.

= To create a content item of a specific content type:
a. Select the Content Type and click Create.

You must have the required access permissions to the OCM folders to be
able to create content items. Refer Oracle Content Manager User Guide for
more details.

b. Enter a name and description for the content item and browse and select an
attachment. If the content item you are creating is of the content type
Image, specify its attributes in the Attributes region.
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4,
5.

c. Click Submit to submit the content for approval.
Similarly, you can create and associate more content items, and click Apply.

Optionally, click Revert for the original settings.

9.2 Managing Price Lists

You can create price lists and associate them with products. Based on various
factors, you might create different price lists for the same product. For example, as a
marketer, you may want to create an exclusive price list for your premium
customers, and a different price list for other customers in the region you operate

m.

Topics in this section include:

Section 9.2.1, "Creating a Price List"
Section 9.2.2, "Defining the Market Eligibility for a Price List"

9.2.1 Creating a Price List

Use the following procedure to create a price list.

Prerequisites

None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Price Lists.

2. Click Create.

3. Select a setup type using the drop-down list.
The setup type indicates the template that you want to use for this price list. It
determines which side navigation items will be available for this record. See the
Oracle Marketing Implementation Guide for information on creating custom setup
types.

4. Enter the details for the price list.

5. Click Create.

The Products region is displayed. You can now add products to this price list.
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10.
11.
12.

13.

14.

15.

From the Level column, select the product’s level using the drop-down list.

Using the search icon, select the product number that you want to add to this
price list.

The name of the corresponding product is displayed in the Product Name field.
Select a unit of measurement for the product using the search icon.

Enter the price at which this product must be sold.

Repeat steps 5 to 8 to add other products to this price list.

Click Update.

Click Request Approval.

A theme approval is required for the price list to become active.

To modify the details for a price list, click the price list link in the Price Lists
page, make the necessary changes in the Price List Details page, and click
Update.

In the Products region, click the Details icon to view the Price Line details for a
product.

To view the details of a price list, click its View Price List icon in the Price Lists
page. Click the Download to CSV file icon to save the details in a .csv file.

9.2.2 Defining the Market Eligibility for a Price List

The market eligibility is a qualifier that the price list is applicable to. You must
specify the market context and context attribute while defining the market
eligibility for a price list. Market context is set up in Oracle Advanced Pricing. There
are seeded market contexts, and you can create your own too.

Examples of Market Context and Context Attributes:

Order (Market Context) and Order Type (Context Attribute)
Customer (Market Context) and Customer Bill To (Context Attribute)

Use the following procedure to define the market eligibility for a price list.

Prerequisites

An existing price list

Oracle Advanced Pricing must be installed

Working with Products and Price Lists 9-21



Managing Price Lists

Steps

1. FI:,Aog into Oracle Marketing with the appropriate responsibility, and navigate to
Product > Price Lists.

2. Click the hyperlink of the price list to define its market eligibility.

3. Navigate to the Market Eligibility side navigation link.

4. From the Market Context drop-down list, select the context in which this price
list will be applicable.

5. Using the Search icon, select a context attribute.
The context attribute is based on the market context chosen in the earlier step.

6. Enter the other details for the market context.

7. Click Update.
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Working with Offers

Offers are used to encourage customers to purchase a product or service. Offers
reach customers when the products they are associated with are promoted through
campaign or event schedules.

Sections in this chapter include:
m  Section 10.1, "Offers Overview"

= Section 10.2, "Creating and Managing Offers"
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10.1 Offers Overview

An offer is an incentive designed to entice customers to purchase your product or
service and so maximize on your return on investments. It can take several different
forms depending on who your target audience is and what you want the offer to
accomplish.

You can create offers as stand alone objects or attach them to Campaigns or
Products. Offers come in many different varieties which are used for specific
promotion types. You may include a free product when another product is
purchased or offer discounts off purchase prices. Some examples of offers include:

Buy a Children’s Combo Meal and receive a cartoon character figurine
Buy 2 get 1 free

Purchase a DVD player and receive a free DVD

Today Only! 25% Off Original Price

Buy $100 worth of items and receive 20% off the entire order

Some of the basic attributes and associations that you can define for an offer
include:

Associate an offer type for it, which will define the attributes that must
specified for the offer.

Define the target customer at whom the offer is directed. For example, you may
want to define an offer for a specific segment of people such as for the residents
of California.

Specify the duration for the offer. This can be based on different qualifiers -
Order Dates, Ship Dates, or Performance Dates (Offer performance is based on
the rules that a customer must comply with to be eligible for the offer -
example, customers will be paid a bonus based on the quantities of a product
they sell).

Associate a budget from where the funds for the offer will be sourced. If this
budget has a market eligibility criteria defined, it must match the customer
defined for the offer. For example, if a budget is created for funding the
marketing activities for California, an offer can source funds from it only if its
target customers belong to lists or segments containing the residents of
California.

Define the discount level to be Line to make the offer for each individual item in
product category, Group of Lines to make the offer for the total invoice amount
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for the products of a category, or Order to make the offer for the total amount of
an order (containing items of different product categories). For example, for a
category, to offer a 5% discount on Product A and 10% on Product B, select the
Line discount level.

= Specify Committed Amount as the amount that you want to commit to meet the
offer expenses. You can also set this amount to be the maximum amount for the
offer. If the maximum is not set, then, based on the performance of the offer, you
can exceed the committed amount.

= Set the Confidential flag to restrict access to the offer to yourself and your team
members. You can allow access to other teams and users by adding them to the
offer object. See Section 12.2, "Adding Security to a Marketing Object” for more
information.

s Define an offer to be reusable to make it available across the schedules
associated with a campaign.

= Define the details of the offer as Discount Rules. Discount rules enable you to
enter discount information for individual products and product lines in the
offer. For an offer, you can select the discount level, and discount tier based on
how you want to offer discounts.

= Define advanced options for the offer to facilitate product pricing. See Oracle
Advanced Pricing User Guide for product pricing information.

= Associate text or image with the offer that will be rendered as content for a Web
Offer Schedule. See Section 8.3, "Understanding and Creating Web Schedules"
and Section 6.6, "Understanding Web Marketing" for information on Web
schedules.

10.1.1 Offer Types

The different forms that offers can take are reflected in the different offer types that
are seeded in the application. Offers may be from Business to Business (B2B) or
Business to Customer (B2C).

Off-invoice Offer

This is also known as On-invoice offer. In an Off-invoice offer, discount is offered on
the invoice amount when customers purchase the specified quantity of a product.
Customers will be eligible for the discount only if they buy the specified number of
units of the specified product. For example, Buy 100 units of Product A and get 10%
off on the purchase price.

Working with Offers  10-3



Offers Overview

The discounts and quantities can be tiered. For example,
= Buy 100 units of the product and get 5% discount
= Buy 101-200 units of the product and get 10% discount

= Buy 201 or more units of the product and get 15% discount

Order Value Offer

In an Order Value offer, discount is offered on the entire order value, irrespective of
the products that a customer purchases. The customer may purchase different
products; the discount is offered on the total value (order amount) of these
products.

The discounts can be tiered. For example:
= Spend $100 to $499 and get 10% off on the total purchase price
= Spend $500 or more and get 20% off on the total purchase price

Promotional Goods Offer

A Promotional Goods offer includes an additional product or service with the
purchase of a specified product. When customers purchase certain goods or
services, they are eligible for one of the following:

= To receive additional goods or services at no extra charge. For example,
purchase a Computer and get a free Printer.

= To receive a percentage off on additional goods or services. For example,
purchase a Refrigerator and get 50% discount on a Food Processor.

This offer type can be either on a recurring basis or non-recurring basis.

Assume that you have created Promotional Goods offer whereby the customers will
get 1 unit of Product B absolutely free if they purchase 10 units of Product A. In this
case:

»  If the offer is on a non-recurring basis, then a customer who purchases 20 units
of Product A, will get 1 unit of Product B.

»  If the offer is on a recurring basis, then a customer who purchases 20 units of
Product A, will get 2 units of Product B.

Terms Upgrade Offer

In a Terms Upgrade offer, discount is offered on costs that are associated with a
purchase; the discount is related to the purchase. For example:
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= Purchase $100 worth of items and receive free shipping.
s Purchase a car and receive four free service sessions for the car.

For information on the following offer types, refer the Oracle Trade Management User
Guide.

»  Accrual Offer

»  Net Accrual Offer
s Lump sum Offer
= Volume Offer

» Trade Deal

= Scan Data Offer

10.1.2 Sourcing Off-Invoice Offers from Budgets

When Off-invoice offers (including Off-invoice, Order value, Promotional goods,
and Terms upgrade offers) are applied, certain discounts are given and the amount
that the customers need to pay is reduced. When you source Off-invoice offers from
a budget and execute the offers, the utilized and paid columns in the budget get
updated simultaneously.

For example, the selling price of a product is $100. You create an off-invoice offer to
give 10% discount on the product, and you source the offer from a budget. The
committed amount for the offer is $10,000. A customer places an order for 10 units
of the product. Because the discount offered is 10%, the customer has to pay only
$900 instead of $1000. In this case, the amount the utilized and paid columns in the
budget both simultaneously get updated to $100.

Total Committed Utilized Earned Paid
5,00,000 10,000 100 100 100

For the details of how the following offers are sourced from budgets, refer the Oracle
Trade Management User Guide.

s Accrual Offers
s Lump sum Offer

m  Scan Data Offer
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Volume Accrual Offer

10.2 Creating and Managing Offers

Procedures in this section include:

Section 10.2.1, "Creating an Offer"

Section 10.2.2, "Setting Advanced Offer Options"
Section 10.2.3, "Associating Offers with a Campaign"
Section 10.2.4, "Creating Offer Budgets"

10.2.1 Creating an Offer

Offers come in many different varieties. You can create offers from the Offers subtab
of the Product tab or the Campaign tab. Both pages use the same functionality.

Use the following procedure to enter the basic details for an offer.

Prerequisites
None

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, click the
Campaign or Products link, and navigate to Campaign > Offers (or Products >
Offers).

Click Create.
Select a setup type for the desired type of offer.

Enter information for all required fields. Optionally, enter information for the
other fields listed.

A product can be added to an offer only when you create or update an offer.
Click Create.

In the Offer details page, enter offer details including qualifiers and discount
rules, as required.

Click Update.

To update the details of an offer, edit the required fields in the Offer details page
and click Update.
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10.2.2 Setting Advanced Offer Options

Advanced Options are used to precisely control pricing modifiers in Oracle
Advanced Pricing. Refer Oracle Advanced Pricing User Guide for more information.

Prerequisites
An existing offer

Steps

1.
2
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Navigate to the Offer Details page.

Select the Advanced Options side navigation link. The Offer Name, Start, and
End Dates are displayed.

Select a phase.

Select the Print on Invoice option, if appropriate.
Select one of the Incompatible Group, if appropriate.
Select a Bucket.

Set the Level of Precedence, if appropriate.

Click Update to save your changes.

10.2.3 Associating Offers with a Campaign

Use this procedure to associate one or more existing offers with a campaign.

Prerequisites
None

Steps

1.

a » Db

Log into Oracle Marketing with the appropriate responsibility, click the
Campaign link, and navigate to Campaign > Campaign.

Click the campaign’s Name link and navigate to the Offers side navigation link.
Click the Search icon and select an offer.

Click Update.

To view the details of the offer, click the Offer Name link.
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6. If a particular offer should take precedence over the rest of the offers associated
with the campaign, select the Primary Flag check box.

10.2.4 Creating Offer Budgets

Securing funding for the cost of the Offer is accomplished on the Budgets item of
the side navigation.

Prerequisites
An existing offer

Steps
1. Log into Oracle Marketing with the appropriate responsibility, click the

Campaign or Products link, and navigate to Campaign > Offers (or Products >
Offers).

2. Navigate to the Budget side navigation link.

3. Enter an Estimated Budget for the Offer and click Update. A Confirmation
message will be displayed.

4. To request funding from a Budget, click Create Request and perform the
following:

a. Select a Source Type, either Budget or Person. If you request funds from a
Person, that person will select a budget during their response to the request
notification.

b. The source code for the selected source along with the source’s owner are
filled in.

c. Information about the recipient is displayed in the Budget Recipient region.
d. Enter a date and requested amount.

e. Enter a Holding Owner if the funding source is derived from a partner or a
vendor.

f. Select Initial Sourcing as the Transfer Reason.
Enter a Justification for the request.
Click Create.

The information entered will be summarized and displayed on the Budget
page.

10-8 Oracle Marketing User Guide



11

Working with Budgets

Marketing activities need to be funded. In Oracle Marketing, the different objects
associated with marketing activities have an approved budget amount assigned to
them.

Sections in this chapter include:

Section 11.1, "Overview of Budgets"

Section 11.2, "Budget Planning"

Section 11.3, "Budget Execution"

Section 11.4, "Budget Tracking"

Section 11.5, "Creating and Managing Budgets"

Working with Budgets 11-1



Overview of Budgets

11.1 Overview of Budgets

Budgets in Oracle Marketing are the funding source for a variety of objects. These
objects, such as campaigns and events, may require other approvals before a
funding request may be made. Budgets may exist in a hierarchical structure, a root
budget supplying funds to child budgets, allowing you to view and control costs.
Budget checkbooks have columns for: Total (original amount), Holdback, Planned,
Committed, Balance (Total — Holdback — Committed), Utilized and Balance, giving
you a clear view of utilized and available funds. Oracle Marketing’s budgeting
functions are grouped in the following categories:

= Budget Planning
= Budget Execution
= Budget Tracking

= Budget Administration - Refer Oracle Marketing Implementation Guide for
information on administering budgets.

11.2 Budget Planning

Budget planning includes defining Fixed and Accrual budgets, the market
eligibility of customers, and the product eligibility for a product or product family.

Fixed Budget

A fixed budget is a pool of money, with value > zero, decided up front to fund sales,
marketing, and partnering activities. Fixed budgets can be defined for different
customer and product attributes.

Multiple marketing objects request money from fixed budgets including campaigns,
campaign schedules, events, event schedules, and so on.

Here is an example of how a campaign updates the budget:

A fixed budget is set up for all sales and marketing activities for customers in the
United States for $500,000. A campaign is created for $10,000. When it becomes
active, the budget has the following balances:

Total Committed Utilized Paid
500,000 10,000 0 0
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This is an advertising campaign, and a marketing manager contacts an advertising
agency. The agency runs the ads for the company and charges the company $8,000.
The marketing manager enters this $8,000 as an actual cost for the campaign. The
budget balances become:

Total Committed Utilized Paid
500,000 10,000 8,000 8,000

For more details about different budgets, refer Oracle Trade Management User Guide.

Market Eligibility
Market eligibility defines what customers or customer groups the budget is
targeting. For a fixed budget, market eligibility serves two purposes:

s Classification

= Validation - to validate that a campaign or event schedule matches that of the
budget category.

Eligibility for a fixed budget can be defined for the following;:
s Individual customers

Individual customers are eligible whether they are sold-to, bill-to, or ship-to
customers. These are customer “accounts” in Oracle’s Trading Architecture
Community (TCA).

= Buying Groups

Buying Groups are organizations formed when companies group themselves
together to leverage on higher purchase volume achieved as a group.

s Lists

Lists are groupings of customers or customer contacts created based on
user-specified criteria. You can specify the criteria using Oracle Discoverer
workbooks or queries and save the result as a static list.

= Segments

Segments are also groupings of customers or customer contacts. Like lists, they
are also created based on user-specified criteria via Discoverer workbooks or

Working with Budgets 11-3



Budget Execution

writing queries. However, segments are dynamic in that every time you
generate the segment, based on the query criteria, the result is generated afresh.

s Territories

Territories are yet another way to group customers together, based on their
location and other attributes. They are created in the Oracle E-Business Suite
Territory Management module.

Product Eligibility

Product eligibility defines what product or product families or groups the budget is
targeting. For a fixed budget, product eligibility mainly serves the purpose of
classification.

11.3 Budget Execution
Topics in this section include:
= Section 11.3.1, "Budget Request"
= Section 11.3.2, "Budget Transfer"

= Section 11.3.3, "Budget Reconciliation"

11.3.1 Budget Request

A budget request is a request to withdraw money from a budget and it comes
through marketing objects such as campaigns, schedules, or deliverables. A budget
request may also be submitted by sales representatives who want to give an offer to
customers or by the owner of another budget. Requests generally need to be
approved before money actually gets transferred. Approval rules can be configured
to route different requests to different approvers.

A budget may provide funding for multiple marketing activities, and vice versa; an
activity such as a campaign can receive funds from multiple budgets.

11.3.2 Budget Transfer

While a request is asking for money from another budget, a transfer is moving
money to another budget. In any case, all movements of money in and out of any
given budget are tracked to provide full audit control.

For example, a “New Product Introduction” fund may not need as much money as
originally forecasted because the new product was not performing well. As a
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budget user, you can then transfer money out of it into other budgets so that the
money can be spent elsewhere.

11.3.3 Budget Reconciliation

Reconciliation is a way to return unutilized money at the end of a marketing
activity. Previously committed, but unutilized funds, is adjusted by transferring
them from being committed to becoming available again. You can use this
functionality when a marketing activity has completed or when the activity has
been cancelled.

You can reconcile a budget only if a campaign’s end date has been reached and its
status is 'Completed’ or if the campaign has no end date and its status is
‘Completed’. You can drill down all reconciliations to view their details. You can
also set the reconciliation to be performed automatically by a concurrent process by
defining a grace period for it.

11.4 Budget Tracking

Topics in this section include:
= Section 11.4.1, "Budget Buckets"
= Section 11.4.2, "Budget Roll-Up View"

11.4.1 Budget Buckets

The following table describes the multiple buckets used to track different Budget
amounts.

Table 11-1 Budget Buckets

Column Meaning

Total Total budget amount

Transferred In Amount transferred into the budget. This is added to the
Total.

Transferred Out Amount transferred out to another budget. This is subtracted
from the Total.

Holdback Amount held in reserve.

Available Total — Holdback

Planned Total amount of not yet approved budget requests.
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Table 11-1 Budget Buckets

Column Meaning

Committed Total amount of all approved budget requests.
Balance Available - Committed

Utilized Amount that has been utilized.

Paid Amount that has been paid.

11.4.2 Budget Roll-Up View

The budget rollup view shows the total funds in a budget, including the sum of all
its child budgets. For example, if there is a budget hierarchy where there are 3
levels, each level with one node, like USA, Western Region, and California, then the
roll-up view of USA will be the numbers for USA+Western Region+California.

So if the California budget has committed $10,000, the Western Region budget on its
own has committed $5,000, the USA budget on its own has committed $3,000, then
the roll-up view for the USA budget’s committed funds is $10,000 + $5,000 + $3,000
= $18,000.

The Roll-up view of the Western Region budget’s committed funds is $10,000 +
$5,000 = $15,000.

The Roll-up view of the California budget’s committed funds is $10,000.

A budget self view means that it will only show the transactions/activities that the
budget itself directly funds. In the above example, the budget self view for the
California budget’s committed is the same as its roll-up view (that is, it equals
$10,000). The budget self view for the Western Region budget’s committed is $5,000.
The budget self view for the USA budget’s committed is $3,000.

Users in a budget hierarchy can see real-time, roll-up views based on their user
profile currency. For example, a manager in Canada may see the roll-up view in
Canadian Dollars. The budget’s parent may be owned by a US manager who may
prefer to see the roll-up view in USD.

11.5 Creating and Managing Budgets

Use the Budget tab to set up funding for campaigns, offers, events, and deliverables.
To draw funds from an existing budget, use the Budget item on the side navigation
in the individual campaign, event, offer, or deliverable.

Procedures in this section include:
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s Section 11.5.1, "Creating a Fixed Budget"

= Section 11.5.2, "Updating Market Eligibility for Fixed Budgets"
»  Section 11.5.3, "Updating Products for Fixed Budgets"

= Section 11.5.4, "Creating Budget Requests from a Budget"
= Section 11.5.5, "Creating Budget Transfers from an Object"
= Section 11.5.6, "Creating Budget Transfers from a Budget"
= Section 11.5.7, "Viewing Budget Utilized"

= Section 11.5.8, "Reconciling a Budget"

= Section 11.5.9, "Viewing the Budget Checkbook"

»  Section 11.5.10, "Viewing the Customer Checkbook"

= Section 11.5.11, "Viewing Budget Rollup"

= Section 11.5.12, "Adding a Budget Threshold"

»  Section 11.5.13, "Activating a Budget"

11.5.1 Creating a Fixed Budget
A fixed budget has a budget amount specified at the time of creation and activation.
= It can fund marketing activities such as campaigns, events, and deliverables
= Its budget amount can change by transfers and requests
= Itis active until a user manually closes it, even after the end date is reached

Use the following procedure to create a fixed budget.

Prerequisites
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budgets.

2. C(Click Create.

3. Select the Setup Type as Fixed and enter a name for the budget.
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10.

11.
12.
13.

The Setup Type for a budget determines what attributes are displayed as side
navigation links and whether the budget is a fixed budget or a fully accrued
budget.

Enter a Number or allow system to generate it.
The number is used by the system to uniquely identify the budget.
Select a business unit.

Business units are organizations set up in Oracle Human Resources with Type =
Business Unit. It is used here mainly for classification purposes. It can also
affect the approval rule built for the budget.

To associate the budget to a parent budget, select a parent budget.
The association will establish a budget hierarchy.
Select a budget category.

Budget categories are set up in Administration and can be used to classify the
budget. An approval rule defined for a budget may use budget category as one
of its criteria.

Enter budget amount, currency, and Holdback amount.

The budget amount is the money set aside for this fixed budget. Holdback
amount is the amount which you would like to reserve and not allocate down
to lower levels. A budget owner may choose to release the holdback amount at
any time.

Verify the owner. By default the user entering the budget details will be its
owner. The owner of a budget has the update access to it.

Enter start and end periods and the start and end dates.

Start and end periods are set up to map to GL calendars and if selected, will
limit the start and end dates.

Enter description for the budget and click Create.
To delete a budget, navigate to its Budget Details page and click Delete.

To copy a budget, navigate its Budget Details page and click Copy. Select the
source budget from which to copy, enter the other details and click Copy.

To create a budget with similar details as an existing budget, you can copy the
existing one and update the new budget with the necessary changes.

11-8 Oracle Marketing User Guide



Creating and Managing Budgets

14. To update a budget, navigate its Budget Details page, make the necessary

changes, and click Update.

11.5.2 Updating Market Eligibility for Fixed Budgets
Use the following procedure to update market eligibility for fixed budgets.

Prerequisites
A draft fixed budget exists

Steps

1. FI:,Aog into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budgets.

2. Select the budget and navigate to Market Eligibility.

3. Select the Eligibility Context and the Eligibility Name.

4. Click Update.

11.5.3 Updating Products for Fixed Budgets

Use the following procedure to update products for a fixed budget.

Prerequisites
A draft fixed budget exists

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budgets.

Select the budget and navigate to Products.
Select a product category, a product, or a combination of both.

For example, you may select a particular category but choose to exclude some
products within that category.

The different meaningful combinations are:

s Include Categories Only. For example, include a particular category called
“Household Supplies” which contains multiple household supplies
products within it.
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s Include Categories and Products. For example, include a particular
category called “Household Supplies” which contains multiple household
supplies products within it, plus a product called “Industrial Cleaning
Solution” which does not fall into the “Household Supplies” category but is
a product that you want to associate to the budget.

s Include Categories, Include/Exclude Products. For example, include a
particular category called “Household Supplies” but exclude a product
within the category called “Discontinued Washing Detergent.”

s Include Some Categories, Exclude Some Categories. For example, include a
bigger category called “New Products” but exclude a smaller category
called “Household Supplies.”

s Include Some Categories, Exclude Some Categories, Include Products. For
example, include a bigger category called “New Products” but exclude a
smaller category called “Household Supplies”, and in addition include a
particular product called “Discontinued Washing Detergent.”

s Include Some Categories, Exclude Some Categories, Exclude Products. For
example, include a bigger category called “New Products” but exclude a
smaller category called “Household Supplies”, and in addition exclude a
particular product called “New Industrial Washing Detergent.”

= Include Products Only. For example, simply include a product called “New
Industrial Washing Detergent.”

11.5.4 Creating Budget Requests from a Budget

Use the following procedure to create a budget request from a budget.

Prerequisites
Access to the Budget Request page

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budget Transfers.

Click Create Request.

In the Budget Request page, complete the Source, Recipient, and Request
Details regions.

Click Create.
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11.5.5 Creating Budget Transfers from an Object

Use the following procedure to create a budget transfer from a marketing object.

Prerequisites

Access to the Budget Transfer page

Both the granting and the receiving budgets are active

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, click the link for
the object, select the object, and navigate to the Budgets side navigation link.

Click Create Transfer.

In the Budget Transfer page, complete the Source, Recipient, and Request
Details regions.

Click Create.

11.5.6 Creating Budget Transfers from a Budget

Use the following procedure to create a budget transfer request from one budget to
another.

Prerequisites

Access to the Budget Transfer page

Both the granting and the receiving budgets are active

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budget Transfers.

Click Create Request.

In the Budget Request page, complete the Source, Recipient, and Request
Details regions.

Click Create.
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11.5.7 Viewing Budget Utilized

For marketing purposes, the Budget Utilized column contains all the costs posted to
the budget from marketing objects such as Campaigns and Events.

Use the following procedure to view utilized budgets.

Prerequisites
Access to view the budget

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budgets.

2. Drill down into Budget Utilized by clicking the number in the Utilized column.
3. The following data is displayed:

= Activity Type: The available values are Campaign, Offer.

= Activity Code: Either the code of a campaign or an offer.

s Component Type: Campaign Schedule, or Offers which source from
Campaign.

s  Component Code: Schedule source code, or Offer Code.

= Document Customer: The customer specified on the document (that is, an
order or simply an adjustment). This is only populated if Activity Type =
Offer.

s Document Type: Order. This is only populated if Activity Type = Offer.

s Document Number: Order number. This is only populated if Activity Type
= Offer.

s Document Date: Order date. This is only populated if Activity Type = Offer.

= Adjustment Utilization Type: This can be Utilized, Accrual or Adjustment.
It is Utilized for off invoice discounted amounts as well as costs from
campaigns/events posted to the budget. It is Accrual for accrual offer
amounts.

= Adjustment Type: This is only populated if Utilization Type = Adjustment.
= Adjustment date: Date that the adjustment updates the budget.
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s  Utilization Amount in Different Currencies — Transaction Currency: This is
the currency from an order transaction.

s Utilization Amount in Different Currencies — Budget Self Currency: This is
the currency which the budget is created in.

11.5.8 Reconciling a Budget

Reconciliation is a way to return the unutilized money at the end of a marketing
activity. Budget reconciliation performs the following tasks:

» It adjusts previously committed, but unutilized funds, transferring them from
the Committed column to the Available column (“Reconcile Un-Utilized”)

» It adjusts previously utilized, but unpaid funds, thus adjusting the Utilized
column accordingly and transferring it from the Committed column to the
Available column (“Reconcile Un-Utilized and Un-Paid Earnings”). This option
is not currently applicable for marketing purpose.

The Reconcile button will appear after the marketing activity’s end date and when
its status is Completed or Closed, or if the activity has no end date specified, its
status is Completed or Closed.

Use the following procedure to reconcile a budget.

Note: The steps below use a Campaign as the example, but
reconciliation can be performed for Events and Deliverables as
well.

Prerequisites
Access to the Budget page of an object such as a campaign

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Select a campaign and click the Budget side navigation link.

3. The Reconciliation section at the bottom of the page appears if one of the
following is true:

= End date of the campaign is past.
»  Offer status = Completed or Closed
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4. Select a reconciliation option. The option “Un-Utilized” is applicable for
marketing while the other, “Un-Utilized and Un-Paid Earnings” is not.

Un-Utilized:
s Un-Utilized amount = (Committed — Utilized).

= During reconciliation, the budget’s committed amount will be reduced and
its available amount will be increased accordingly. For example, an offer has
committed = $10K, utilized = $8K. This kind of reconciliation will decrease
the committed from $10K to $8K and increase the budget available by $2K.

5. Click Reconcile.

11.5.9 Viewing the Budget Checkbook

The budget checkbook summarizes the main budget buckets.

Use the following procedure to view a budget checkbook.

Prerequisites
Access to the Budget

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budgets.

2. Select a budget and navigate to the Checkbook side navigation link.
The Budget Position and Utilization information is displayed.

You can drill down Total in the Budget Position region and the different
utilization parameter amounts to view the budget details.

11.5.10 Viewing the Customer Checkbook

The customer checkbook summarizes the main budget buckets by customer. You
can get to a customer checkbook by viewing the ‘Customer Budget View.” A profile
option determines if you can view all the customers’ budget views or simply those
customers who belong to the budget you own. For more information, refer Oracle
Trade Management Implementation Guide.

Use the following procedure to view the customer checkbook.
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Prerequisites
Access to the Budget

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budgets.

2. C(Click Customer Budget View and select a View.
3. Search for the customer whose checkbook you want to view.
Some of the data displayed is as follows:
»  Total after Holdback - Total amount of the budget minus holdback amount
= Planned - Total amount of not yet approved budget requests
s Committed - Total amount of all approved budget requests

= Recalculated Committed - The amount of commitment calculated based on
actual utilization. If re-calculated committed is implemented, the amount
here displays the real committed funds

m Balance - Total after Holdback minus Committed

11.5.11 Viewing Budget Rollup

Use the following procedure to view a budget rollup.

Prerequisites
Access to the Budget.

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budgets.

2. Change View from Self View to Rollup View. The screen will refresh with rollup
numbers.

11.5.12 Adding a Budget Threshold

Use the following procedure to add an existing budget threshold rule to an existing
budget.
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Prerequisites
Access to the budget

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budgets.

Drill down into a budget by clicking its name.
Search for and select the threshold rule set up under Administration.

Click Update.

11.5.13 Activating a Budget

After all the necessary information has been entered, a user can initiate the
activation of a budget.

Use the following procedure to activate a budget.

Prerequisites
Access to the Budget

Steps

1.

a k& ® N

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Budget > Budgets.

Drill down into the budget by clicking its name.
Click Request Approval.

Review the displayed approval details.

Click Confirm.
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Working with Teams and Approvals

This chapter discusses how you can control access to and initiate approvals for your
marketing objects.

Sections in this chapter include:
s Section 12.1, "Overview of Teams"
= Section 12.2, "Adding Security to a Marketing Object"

= Section 12.3, "Approvals Overview"
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12.1 Overview of Teams

Marketing teams associated with marketing objects (Campaigns, Events,
Deliverables, and so on) represent users or a group of users with access privileges to
these objects. Once a team is added to an object, team members gain access to the
marketing object. This access can be restricted by using the edit metrics function. If
a team does not have the Edit Metrics privilege, its members will be unable to view
the associated Budgets, Costs and Revenues, or Metrics navigation links for this
object. Marketing team members can have full access (read /write) either with or
without the Edit Metrics (Budgets, Costs and Revenues, and Metrics) privilege for
the marketing object. By default, the owner of a marketing object has full access
(with the option to Edit Metrics) to the marketing object.

When you create a marketing object, you can define it to be confidential to restrict
access to the object to the owner and associated team members. You can choose to
provide limited read access to initiatives, including higher-level programs, to
non-team members by marking those initiatives as not confidential. This enables
rollup access to programs. However, when the status of a confidential program or
campaign changes to Active, access to it is the same as for any non-confidential
program or campaign.

To manually add other teams and users to a specific marketing object, navigate to
the Team navigation link associated with the object. To add users to a marketing
object, you should either be the owner of a marketing object or a member of its
marketing team.

When you add a user to a marketing object (only the object owner and super users
can add team members to an object), the user immediately has access to the
marketing object. However, if you add a Team to a marketing object, then you need
to run the AMS - Team Access Refresh concurrent program to refresh the access
privilege for users within the Team. For additional information about the
concurrent program, refer to the Oracle Marketing Implementation Guide.

12.2 Adding Security to a Marketing Object

The following procedures demonstrate how you can make a campaign confidential
and associate teams or individual users to a campaign. You can perform similar
procedures for other marketing objects, such as programs or events.

12.2.1 Setting the Confidential Flag

You can set a campaign as confidential to restrict access to non-team members. A
confidential object will not be visible to users outside the object’s team.
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Use the following procedure to make a campaign confidential.

Prerequisites
An existing campaign

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Click the campaign’s Name link.
3. Select the Confidential check box and click Update.

You can also make the campaign confidential when you are creating the
campaign. For details, see Section 6.2.1, "Entering Basic Campaign Details".

Until the campaign becomes Active, access to the campaign is restricted to the
owner and associated team members only.

12.2.2 Adding a Team or User to a Marketing Object

You can add an individual user or a team of users to a campaign (or other
marketing objects) to allow them access to it.

Use the following procedure to add a user or team to a campaign. Similarly, you can
add a user or team to other marketing objects.

Prerequisites
An existing campaign

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

The navigation is dependent on the object to which you are adding a user or
team.

2. Click the campaign’s Name link and navigate to the Team side navigation link.
3. Select Team or User from the User/Role drop-down list

4. Click the Search icon and select a user or team from the list of values.
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5. Select the Edit Metrics check box to allow the user or team to view the
associated Budgets, Costs and Revenues, or Metrics for the campaign.

6. Click Update.

When you add a team or a user, the Date Added information is displayed.
Additionally, when you add a user, if Phone and Email details are available,
they are also displayed.

Similarly, you can add more users or teams to the campaign.

7. To disassociate a user or team from a campaign, select its Remove check box
and click Update.

12.3 Approvals Overview

Approvals are needed for most objects created in Oracle Marketing (campaigns,
campaign schedules, events, event schedules, one-off events, offers, and
deliverables). Objects are approved according to your organization’s business rules
and approval processes. The administrator sets up the different types of approvals
needed for an object as part of the custom setup for the object. For example, the
custom setup for a campaign schedule may define that only the budget allocated
must be approved. Refer Oracle Marketing Implementation Guide for more
information on setting up approval rules.

There are, primarily, two types of approvals, theme approval and budget approval.

Theme Approval

Theme approval is also referred to as concept approval. You may plan a marketing
event or campaign around an idea. For example, during the Christmas season, a
clothing manufacturer may plan fashion shows in major cities. Once the idea is
conceived, it must be approved. In our example, this means that the theme/concept
of having a set of fashion shows is approved. At this stage, you may provide only
brief details of the campaign and the costs to be incurred.

Budget Approval

Once the theme has been approved, you will build a detailed plan, also including
all the costs involved. For example, the clothing manufacturer in our example will
create event schedules with details such as the location for the show in each city, the
dates for the events, cost and revenue details that must be tracked, and so on.

Once you have planned and entered schedule details, you will request funds
(budget line requests) to execute these schedules. The budget lines requested must
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be approved by an approver based on the approval rules setup. After the budget
lines are approved, the object itself must be approved based on the approval rules
setup. Depending on the approval, the object’s status will go to Active or Rejected.

If the object moves into the ‘Rejected” status, after modifying its details, you may
once again request approval for it.

Approval Requests

If an object needs approval, the Request Approval button is displayed on the object
details page. You can initiate approvals for the object using the Request Approval
button. Once you have submitted an object for approval, the Request Approval
button is rendered as a View Approval button on the details page, which you can
use to view the approval status. When the authorized person confirms the approval,
the status of the object will move to "Active’.

There may be times when you need to bypass the approval process for an object.
The object will then go from the ‘New’ status to the ‘Active’ status directly. If you
choose to waive approval for specific marketing activities, you can request your
administrator to create a custom setup with the theme approval and budget
approval waivers defined. However, you must click the Request Approval button
on the details page. In the Preview Approval page, notice that the Approval Rule
displays ‘No Approval Required’. Select the Active option and the appropriate User
Status in the Request Status region, and click the Submit button for the object status
to change to "Active’.

Other than the owner, only those users who have the Edit Metrics access can
request approval for an object. An owner is automatically assigned the Edit Metrics
access for an object.

Previewing Approvals

When you click the Request Approvals button, you are taken to the Preview
Approvals page. If you are the approver, you can view the different details of the
object, such as about its request status and budget sources before you confirm the
approval. You can also select the status of the object after it has been approved - do
you want the object to be "Active’ or "Available’.

Viewing Approvals

As the owner of an object awaiting approval, you can view the status of the
approval before using the object for marketing activities. Clicking on the View
Approvals button will navigate you to the View Approvals page, where you can
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view the last approval process initiated for the object. You can view the approval
until the object is approved and moves to the "Active’ status.

For budget lines (the method in which the money / expense associated with an
object is approved) approval, you can view the line level details by clicking the
Details icon in the Budget Sources region. A user who does not belong to your team
must have the Edit Metrics privilege to view these details.

Approvals Rule Search

Approval rules are built on a set of criteria. Approval rule search allows
administrators to search for approval rules based on search criteria.

Approval Notes

As approvers approve objects in an approval hierarchy, they can maintain notes.
These notes are visible to users with Edit Metrics access to the objects. However, the
notes are not direct communication between approver and requestor or between the
approvers within a hierarchy. You can access these notes from the View Approval
Details page. The note could contain information such as any condition for the
approval, the reason for the rejection, and so on.

Approval Process

After creating an object (for example, a campaign), you may need to submit the
object for various types of approval (depending on the object approval
requirements specified by your application administrator in Custom Setup).

All approvals in Oracle Marketing happen through the AMS Marketing Workflow
process. The logical flow for approvals is as follows:

1.  When you create an object that needs approval, a Request Approval button is
displayed. Approvals are initiated when this button is clicked. Users who do
not have Edit Metrics privileges will not be able to view the Request Approval
button.

2. Clicking the Request Approval button takes you to the Preview Approvals
page. This page contains details of the approval type (Theme or Budget),
request status, budget sources, and approver details. You can modify the
request status for the object and select the appropriate user status for the system
status that you have selected. Note that your administrator can set user-friendly
user statuses corresponding to a system status. For example, you may want the
system status ‘Cancelled’ to have the user status "Not Available’. System
statuses are used internally by the system and the corresponding user statuses
are displayed when you view the object details.
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Once the request status is selected, you can click the Confirm button. This
initiates the approval process. The status returned upon approval is the request
status you selected.

The object then changes status to "Pending Approval” based on the approval
initiated. A notification goes to the approver defined in the approval rule. If
there is no approval rule defined, the notification for approval goes to the
default marketing approver.

When the object is pending approval, the View Approval button is displayed on
the object detail page. Clicking it takes you to the View Approval Details page
that provides information about the status of the approval and the approver
with whom the approval is pending.

Depending on whether the object is approved or not, the object’s status will go
to "Active’ or 'Rejected’. If rejected, you can modify the details of the object as
necessary and request for a fresh approval. Once the status of an object is
"Active’, to change it to any other status, you must update it manually. The
View Approval button is no longer available.

For objects not requiring approvals, you need to click the Request Approval
button in the object details page, change the system status to Active, select the
corresponding user status, and click the Submit button. The status of the object
changes to "Active’.
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Working with Deliverables and Messages

When you create marketing objects, you can associate collateral with them that
must reach the customer when marketing activities (campaign and event schedules)
are executed. This chapter discusses deliverables and messages that you can plan
and associate with different marketing objects.

Sections in this chapter include:

Section 13.1, "Overview of Deliverables"

Section 13.2, "Creating a Deliverable"

Section 13.3, "Overview of Messages"

Section 13.4, "Creating a Message"

Section 13.5, "Associating a Product or Product Family to a Message"

Section 13.6, "Associating a Message to a Marketing Object"
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13.1 Overview of Deliverables

Deliverables are marketing collateral that you can distribute to customers across
multiple channels. A deliverable in Oracle Marketing is a physical or electronic
collateral, which you can associate with a campaign or an event. Examples can
include a brochure for an event, a promotional campaign advertisement, a data
sheet for a product launch campaign, or special offers for promoting brand loyalty.

The content associated to electronic deliverables is stored in Oracle Content
Manager (OCM). The OCM content is available to be used in marketing cover
letters. For more information, refer the Oracle Content Manager User Guide and Oracle
Content Manager Implementation Guide.

Some of the attributes that you can set for a deliverable include:

= Define its storage and fulfillment. Physical deliverables may be stocked
manually or as inventory items. Examples include brochures, CDs, or gifts to
promote a product during campaigns or events. Electronic deliverables are
stored on Oracle Marketing and fulfilled as attachments or cover letter content.
Electronic files include Web content, e-mail blocks, and mailing scripts to
support your campaigns and events.

= Set the Confidential flag to ensure that only you and your team can access it
until such time as you include other teams and users to allow them access.
When a deliverable’s status changes to Final Loaded, the Confidential check
box is automatically unchecked and the deliverable is now accessible to all
users.

= Mark and associate it as a kit. For example, you may want to include a product
data sheet and a discount coupon in a kit that will be a given to all the attendees
of an event.

= Attach some text, a file, or a URL to it. For example, you may want to attach a
product data sheet as a file to a deliverable.

A deliverable may have a theme associated with it. For example, a product
promotion campaign may need large, colored posters to be attached to magazines.
The theme must be approved before posters can be created and used as deliverables
for the campaign.

A deliverable may or may not need funds. When it needs funds, you can associate a
budget to it and the budget must be approved. For example, you may need funds to
contract out brochure creation to a third party vendor, whereas an electronic
product data sheet may not need funds. If a deliverable does not need budget
approval, an administrator can disable budget approval in the custom setup.
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Once a deliverable gets both budget and theme approvals (budget is approved first
and then the theme is approved), its status changes to Final Loaded and is available
for fulfillment across campaigns and events. See Section 12.3, "Approvals
Overview" for information about the Approval process.

After the end date, you can set a deliverable’s status to Expired so that it is no
longer used. However, it can still be accessed. When a deliverable is no longer
needed, you can archive it. An archived deliverable cannot be accessed or used. You
can also cancel a deliverable any time in its life cycle. A canceled deliverable too,
cannot be accessed or used. Campaigns or events which use the archived or
canceled deliverables are notified of the status change.

13.2 Creating a Deliverable

Use the following procedures to perform activities related to creating and storing
deliverables.

= Section 13.2.1, "Entering Basic Deliverable Details"

= Section 13.2.2, "Defining the Inventory Options for a Deliverable"

ms  Section 13.2.3, "Creating a Kit"

= Section 13.2.4, "Associating a Budget to a Deliverable"

= Section 13.2.5, "Adding Associated E-Mail Electronic Files to a Deliverable"

13.2.1 Entering Basic Deliverable Details

Use the following procedure to enter the basic details when you create a
deliverable.

Prerequisites
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Deliverable > Deliverable.

2. Click Create.
3. Select a Setup Type from the drop-down list.
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10.

11.
12.

13.
14.

The setup type defines the attributes for a deliverable that become enabled and
the options that the system will display. A given setup type may also block a
budget or costs option for electronic mediums that do not require budgeting.

Enter a unique name and version for the deliverable.

Select a language, category, and sub category from the respective drop-down
lists.

The categories displayed in the list depend on the setup type you selected
earlier and the sub categories displayed are those associated with the category
you selected. Categories are used for reporting.

Select a delivery medium by clicking the appropriate radio button.

Physical items are stocked manually or stored as inventory items. Electronic
items are stored in Oracle Marketing and fulfilled through cover letter
associations.

Enter the Start Period and End Period for the deliverable.
These indicate the planned dates for the deliverable.

When you have entered the Start Period and End Period dates, based on them,
the Available From and Available To dates are automatically displayed.

These dates are primarily for execution purposes. Active objects are available in
other applications even if the end dates have passed.

Enter the Due Date for this deliverable.

This date is just for your information and is the date by when the deliverable
must be ready. The date must be on or before the Available From date.

Select a country and currency.

Enter the name of the owner or click the Search icon and select from the list of
resources displayed.

Select the Kit check box to include this deliverable in a kit.

Select the Confidential check box to disallow viewing or editing of the
deliverable.

Until the deliverable becomes active, it can be viewed or edited only by the
members of your team. Once active, the deliverable becomes available to all.

Enter a description of the deliverable.

Click Create.
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15.

16.

To update the details for a deliverable, select it in the Deliverables page, make
the necessary changes and click Update.

When you update the details, you can view the Status and the Last Updated
date for the deliverable. If you want to cancel the deliverable, you can select
Cancelled from the Status drop-down list.

To download the deliverables list from the Deliverables page, click the
Download to CSV File icon, navigate to the required folder, and save the file.

13.2.2 Defining the Inventory Options for a Deliverable

Use the following procedure to define inventory options for a deliverable.

Prerequisites
An existing deliverable

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Deliverable > Deliverable.

Select a deliverable from the list on the Deliverables page.
Click the Inventory Options side navigation link.

If the deliverable is a Physical item, the options include Stock Manually and
Inventory Item. If the deliverable is an electronic item, its Document Number is
displayed and you have the option of adding it as an inventory item.

For a physical deliverable, select one of the following options:

a. Stock Manually and enter the Quantity you wish to stock.

b. Inventory Item and select the Part Number from the list of values.

For an electronic deliverable that you are defining as an inventory item, either:
a. Select a Part Number from the list of values, or

b. Select Create New from the inventory Item drop-down list and enter a new
Part Number and click Update.

Click Update.
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13.2.3 Creating a Kit

You can bundle a set of physical and inventoried items or a set of electronic
deliverables and attachments to create a kit of related collateral for a given
promotion. You can use a deliverable as a component in multiple kits, as long as an
item is not a kit itself.

Note: Do not mix delivery mediums in the same kit. For example,
if a deliverable assigned as a kit is a manually stocked item, all the
deliverables that you want to include in the kit must also be
manually stocked items.

Use this procedure to associate a number of deliverables into a kit. The kit itself
must be created as a deliverable first before adding other deliverables to it.

Prerequisites
An existing deliverable

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Deliverable > Deliverable.

Select a deliverable from the list on the Deliverables page.
Select the Kit? check box to enable the kit option.
Click Update.

Select Deliverable Kit from the side navigation.

o a & 0 N

Select the deliverables that must be part of the kit:
a. Select the name of a deliverable from the Name list of values.

When the deliverable is referenced, the entire kit is fulfilled. The kit is not
stored in Oracle Inventory. It is stored as a marketing object in Oracle
Marketing.

b. Click Update.
c. Repeat this procedure for each deliverable that you want in the kit.

7. Click Update.
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For physical, inventoried kit items, if the kit is created and one component of the kit
is not in stock, any orders for the kit will be back ordered via Order Management
and the kit will not be sent until all the items are available. However, an order for
individual kit components can be placed, instead of for the entire kit.

13.2.4 Associating a Budget to a Deliverable

Use the following procedures to enter an initial estimated budget to your
deliverable and to create a budget request.

Prerequisites
An existing deliverable

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Deliverable > Deliverable.

Select a deliverable from the list on the Deliverables page.
Select the Budget side navigation link.

Enter the initial estimated budget amount and click Update.
Click Create Request.

o o ~ w N

Enter the necessary details in the Budget Source and Request Details sections.
The budget recipient information is displayed.
7. Click Create.

13.2.5 Adding Associated E-Mail Electronic Files to a Deliverable

You specify the content of an electronic deliverable for an e-mail body in the E-mail
Content side navigation link for the deliverable. Use this to store corporate
positioning statements, feature lists, benefits, or standard offering statements which
can be used in multiple e-mails.

Note: The E-mail Content side navigation link can be seen only if
the deliverable is created with custom setup of Activity Type “E-
mail.”

There are two types of electronic files available for deliverables:
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Electronic

E-mail

Use the following procedures to add e-mail attachments to your deliverable.

Prerequisites
A deliverable of Activity Type E-mail must exist

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Deliverable > Deliverable.

Select a deliverable from the list on the Deliverables page.
Select the Email Content side navigation link.
From the E-mail Content screen, select a delivery type of HTML or text.

You can select the content for the e-mail from a URL or file. This populates the
e-mail body with a set of text you can modify. You can enter html or text
content, or images. Note that the images must be http images. Embedding static
local images is not supported.

You can also import an existing e-mail block. This populates the e-mail body
with a set of text you can modify. You can also enter text directly in the e-mail
body. Only the body of the e-mail is specified. The sender, return to, subject line,
and greeting text of the e-mail is customized at the e-mail blast level. The target
group and relevant offers are specified at the e-mail blast level as well.

You can preview the e-mail content by clicking Preview before activating the
e-mail for campaign usage.

E-mail content can be referenced in one or more e-mail schedules so the content
need not be created per e-mail blast.

Click Update.

13.3 Overview of Messages

A message can be defined as the overall theme or communication that forms a basis
for the execution channels. The message associated to a marketing object is not
executed automatically.

Messages are used to distinguish and position a product and are defined at the
program or campaign levels. Examples of messages include corporate and offering
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slogans, positioning statements, key branding marketing strategies, and so on. An
example would be "Know More, Do More, Spend Less With Oracle Applications".

When you create a message, it is set to Active by default and is available to be
associated with a campaign or event. When you no longer want a message to be
used, deselect the Active check box.

13.4 Creating a Message

Use the following procedure to create a message for use with marketing objects.

Prerequisites
None

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Deliverable > Messages.

Click Create.

Enter the message name and select a type.

Enter the Date Effective From and Date Effective To dates.
If necessary, change the message owner and country.
Enter a description of the message.

Click Create.

© N o a » 0 D

To update the details of a message, click its link in the Messages page, make the
necessary changes in the Message Details page, and click Update.

9. To download the messages list from the Messages page, click the Download to
CSV File icon in the Messages page and save the file in the required folder on
your PC.

13.5 Associating a Product or Product Family to a Message

Use the following procedure to associate a message with a product or product
family.

Prerequisites
An existing message
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Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Deliverable > Messages.

Select the desired message by clicking its link in the Messages page.
Click the Products side navigation link.

Click the Search icon in the Product Family section and select a product
category from the list of values. If you want to associate the message to a
product, select a product in the Products section.

Select Exclude and Primary Category check boxes to set specific reporting
preferences.

Click Update.

You can associate the message to multiple product families or products.

13.6 Associating a Message to a Marketing Object

Use the following procedure to associate a message with a marketing object.

Prerequisites
None

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

The navigation will differ based on the marketing object you are associating the
message with.

Select a campaign by clicking its link and navigate to the Messages side
navigation link.

Select a Message Type.
Using the Search icon, select a message.

Click Update.
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Working with Common Components

This chapter discusses the components that are used by different objects of Oracle
Marketing, such as Notes, Tasks, Attachments, and Contact Points. It also discusses
the Marketing Calendar and User Profile functionality of Oracle Marketing.

Sections in this chapter include:

Section 14.1, "Overview of Notes"

Section 14.2, "Creating Notes"

Section 14.3, "About Attachments"

Section 14.4, "Associating Attachments to Marketing Objects"
Section 14.5, "About Tasks"

Section 14.6, "Creating a Task"

Section 14.7, "About Contact Points"

Section 14.8, "Creating a Contact Point"
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14.1 Overview of Notes

You may need to record information about various marketing activities, such as
creating campaigns, events, lists, schedules, and so on. You can do so using the
Notes functionality available across the applications in the Oracle E-Business Suite.
A note is descriptive information that you can record and reference later, such as
directions, special instructions, or reminders. In Oracle Marketing, you can associate
notes to most objects: programs, campaigns, events, schedules, deliverables, and so
on. When you attach a note to an object, it becomes a part of that object.

The following are the key features of notes:

= Notes can be categorized based on business requirements. For example, your
administrator may define Approvals, Date Change, and General Information as
note types

= Notes are displayed with their type (based on business requirements), text,
author, and creation date

= You can capture large amounts of text data, up to 32 Kilobytes

= Notes can be private (only you can access it) or public (other users can read
from or write to it)

= You can search for a note based on its type, entering Related To information, or
selecting a match option

= You can attach text, files, or URLSs to a note

For more information on notes, refer Oracle CRM Application Foundation User Guide.

14.2 Creating Notes

The following procedure will help you create a note and add it to a campaign. You
can similarly add a note to other marketing objects. The navigation to the Notes
summary page is dependent on the object you are adding the note to.

Use this procedure to create and add a note to a campaign.

Prerequisites
An existing campaign

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.
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2. (Click the campaign’s Name link and navigate to the Notes side navigation link.
3. Click Create.
4. Select the note Type and Status.

Select Private as the status if you do not want other users to access the note and
select Public if you intend to share the note.

5. In the Note text box, enter note details. You can enter a maximum of 2000
characters.

6. Click More if you need to enter large amounts of text.

The Note Details (More) page is displayed where you can enter up to 32K of
text.

7. Enter the note information and click Save.

8. Click Create to save the note or click Create and Create Another to save the
current note and begin the creation of another note.

14.3 About Attachments

Attachments are documents, URLs, or text that can be associated with marketing
objects. The typical use of attachments is for sharing and storing information about
marketing activities. For example, you can attach a presentation for an event or the
hyperlink for your organization’s Web site. When attachments have been uploaded
to a marketing object, they can be accessed and downloaded by all the team
members associated with the marketing activity.

14.4 Associating Attachments to Marketing Objects

The following procedure will help you create and associate an attachment to a
campaign. Similarly you can associate attachments to other marketing objects. The
navigation to the Create Attachment page is dependent on the object you are
associating the attachment with.

Use this procedure to create and associate an attachment to a campaign.

Prerequisites
An existing campaign

Working with Common Components 14-3



About Tasks

Steps

1.

10.

11.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

Click the campaign’s Name link and navigate to the Attachments side
navigation.

Click Create.
Enter a Description for the Attachment.

The description is used to identify the attachment and appears as a hyperlink in
the Campaign Details page.

To add a file as an attachment, click the Search icon, select a file in the
Attachment Selector page, and click Submit.

To add some text as an attachment, select the Text radio button and enter the
text for the attachment. The text can be up to 2000 characters.

To add a URL as an attachment, select the URL radio button and enter the
complete URL.

Note: The URL should begin with "http://’.
Click Create.
You can associate multiple attachments with a campaign.

To modify attachment details, click the corresponding Description link, make
the necessary changes in the Attachment Details page, and click Update.

For Attachments of type File, you can modify the file directly, and upload the
modified file. This will overwrite the previous version.

To remove an attachment, select its corresponding Remove check box in the
Campaign Details page and click Update.

To preview or download an attachment, click its corresponding Attachment link
in the Campaign Details page.

14.5 About Tasks

A task is a unit of work for any marketing activity. A task may be a follow-up
action, a reminder, or a daily work assignment. Tasks are usually scheduled events
and have defined start and end dates. For example, a support manager of a
company may create a task for a telemarketing executive stating, “Please call back
customer by 9:00am tomorrow.”

14-4 Oracle Marketing User Guide



Creating a Task

A task may include information relating to actions such as resources, appointments,
references, dates, contacts, recurrences, and events. You must assign a task to an
individual or object.

For more information on tasks, refer Oracle CRM Application Foundation User Guide.

14.6 Creating a Task

You can associate tasks to a campaign, event, their schedules, and other marketing
objects. The following procedure will help you create and associate a task to a
campaign. Similarly, you can create and associate tasks for other marketing objects.
The navigation to the Tasks page is dependent on the object you are associating the
task with.

Use this procedure to create and associate a task to a campaign.

Prerequisites
An existing campaign

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Click the Name link of the desired campaign and navigate to the Tasks side
navigation link.

Click Create.
Select the task type, enter the subject, and enter a description for the task.

Select a priority, status, and category for the task.

o o & v

If you wish to associate this task with a parent task, click Go and select a task
from the list of values.

7. Select the Private check box if you do not wish the task to be accessible to all
and the Notify check box for notifications to be sent to the owner and assignees
when you change the details of a task.

8. Select a time zone and enter the Planned, Scheduled, and Actual dates, as
appropriate in the Dates region.

9. Enter owner and assignee details in the Assignee region.

10. Enter customer and references details. These help in tracking a task.
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11. Click Create to save the task or click Create and Create Another to save the
current task and begin the creation of another task.

14.7 About Contact Points

Whenever you create a marketing object, you can define contact points that other
applications can direct customers to for further information. For example, if you
specify your Web site name as the contact point, customers visiting related sites can
be directed to visit it for marketing related information. You can also associate
Inbound and Outbound scripts as contact points. The outbound communication
about contact points such as URLs is a manual process and the information is stored
here for information purposes. See Section 6.5.2, "Associating Scripts to a Campaign
Schedule" for more details.

14.8 Creating a Contact Point

You can associate contact points to a campaign, event, and their schedules. The
following procedure will help you create and associate a contact point to a
marketing object. The navigation to the Contact Point page is dependent on the
object you are associating the contact point with.

Use this procedure to create and associate a contact point to a campaign. Similarly
you can create and associate contact points with other objects.

Prerequisites
An existing campaign

Steps

1. Log into Oracle Marketing with the appropriate responsibility, navigate to
Campaign > Campaigns, and click the Name link of the desired campaign.

2. Select the Contact Point side navigation link.

3. Select a contact point type and enter its name. If you have selected Inbound
Script or Outbound Script as the contact point type, click the Search icon and
select a script from the Script Selector.

You can search for a script using a Search Keyword in the Script Selector.
4. Click Update. You can add multiple contact points to a campaign.

5. Toremove a contact point, select its Remove check box and click Update.
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Working with Data Mining

This chapter discusses the data mining functionality in Oracle Marketing.
Sections in this chapter include:

= Section 15.1, "Overview of Data Mining"

= Section 15.2, "Understanding and Building Predictive Models"

= Section 15.3, "Evaluating Model Build Results"

= Section 15.4, "Improving Model Results"

»  Section 15.5, "Building a Model"

= Section 15.6, "Understanding Scoring Runs Generation"
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15.1 Overview of Data Mining

Data Mining is a process used to discover strong, meaningful patterns and
relationships in large amounts of data. These patterns and relationships are used to
more accurately predict and analyze the behavior of customers and prospects.

For example, you can use the Oracle Data Mining functionality within Oracle
Marketing to predict customer behavior for a variety of purposes, such as
identifying which customers are most likely to:

Respond to your marketing campaign
End their relationship with your organization
Purchase a particular product

Be profitable to you

Effective data mining enables you to make better business decisions. You can more
effectively apply your marketing budget by targeting only the strongest prospects,
thereby driving up margin.

The data mining process consists of the following general steps and concepts:

1.

Building a model

A model is a set of rules that can be used to predict the value of a specific
customer attribute based on the known values of other attributes.

Building a model involves using data mining algorithms to create a set of rules
based on the training data it is supplied. The training data is historical
information about existing customers. This information consists of the known
values for customer attributes such as direct mail responder, income, age,
gender, and so on.

Oracle Marketing provides seeded model types (three response, one
loyalty/retention, one product affinity, and one customer profitability models)
to help automate the data mining process. Custom model types that predict any
customer behavior can also be implemented.

Evaluating model results

Three reports are generated automatically when a model is built: Lift Chart,
Performance Matrix, and Attribute Importance. By evaluating this information,
you can determine the accuracy of the model and make adjustments to the
training data that will improve the performance and predictive power of the
model.
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Scoring a target population

The process of scoring is also referred to as executing a scoring run. During a
scoring run, a model is used to predict the future behavior of a target
population. The score assigned to each customer record in the target population
indicates the likelihood that this customer will exhibit a particular behavior. For
example, customer A may be scored with a 90% probability of responding to a
particular e-mail campaign.

Viewing the scoring run results and generating a list

The scoring run results are presented as a continuous range of 10 deciles. Each
decile has an associated percentage range (for example, 80-89.99%). The
percentage indicates the likelihood that the customers within a particular range
will exhibit the target behavior.

From the scoring run results page, you can generate lists of customer records.
The breakdown into deciles allows you to narrow your target population and
select only the customers who exhibit the desired behavior.

To deal with any inherent budget or cost constraints while planning your
marketing activities, you can use the optimal targeting analysis feature in
Oracle Marketing. Based on the results of the optimal targeting analysis, you
can select the criteria for generating a list (for example, you may want to limit
the number of targets to within a budget amount).

Each of the steps above is described in more detail in the following sections.

15.2 Understanding and Building Predictive Models

The process of building a model consists of the following steps:

1.

2
3.

Creating the model by selecting a
= Model type

n  Target

Selecting the training data
Building (training) the model

The target comprises a target field and a data source. The data source is implied
through the model type and target field association.
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15.2.1 About Model Types

Oracle Marketing models are predictive models used to predict future customer
behavior. They are built using the Naive Bayes algorithm, which can predict binary
or multi-class outcomes. Currently in Oracle Marketing, this algorithm is used to
predict the binary outcomes of a target field.

For example, you might want to predict which customers are likely to respond to a
direct marketing campaign. The possible values for the target field would be yes or
no.

The following model types are seeded in the application and are designed to
automate the model building process.

= Response models
s E-mail
s Direct Mail
s Telemarketing
= Loyalty/Retention model
= Product Affinity model
s Customer Profitability model
s Custom model

A description of each model type is provided in the following table.

Table 15-1 Model Types

Model Type Description

Response Use these three model types (e-mail, telemarketing, and direct
mail campaigns) to predict which customers and prospects are
most likely to respond to the corresponding marketing activity.

Loyalty/Retention Use this model to predict which customers are likely to end
their relationship with your organization.

Product Affinity model | Use this model to predict the likelihood of a customer
purchasing a particular product or products from a particular
product category. This model analyses a customer’s past
purchasing patterns for a product or product category and
predicts the customer’s affinity for a product or product
category. After building this model for a specific product or
product category, you can score a list to determine the product
affinity.
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Table 15-1 Model Types

Model Type

Description

Customer Profitability
model

Use this model to score customers and prospects with unknown
profitability to determine which ones are likely to be profitable.
The Customer Profitability model will identify and score a
single customer record to predict the customer’s profitability.
For Organization Profitability model, you can score a list of
organization contacts and predict their likelihood of being
profitable.

Custom

Use this model to predict any type of customer behavior within
the Oracle customer model (TCA) or a user-defined data
source. The target behavior must be based on a data attribute
that is binary (yes or no) in nature.

Sample Business Scenarios

The following scenarios are examples where you can use predictive modeling to
help you generate lists whose members are most likely to exhibit the desired
behavior. Sections later in the chapter describe the different functionality and tasks
mentioned in the scenarios in detail.

= You find that the number of responses to your campaigns for specific products
are decreasing. You will create a Product Affinity model, train it using a list of
customers who have bought the product in the past, build the model, and test
its effectiveness. You can then score a list of new customers or prospects and
predict the probability of their purchasing the product.

= You have budgetary restrictions and would like to generate an optimal list of
customers to target. After building and scoring your model, you will perform
an Optimal Targeting Analysis. For this, you will update the cost and revenue
data, generate and view the Optimal Targeting chart, enter budget constraints,
and generate the optimal list you should target in a campaign schedule.

15.2.2 About Data Sources and Targets

When creating a model, you must select a data source and a target. A data source
consists of a flexible set of customer attributes that are evaluated by the data mining
engine. The data mining engine determines which attribute values correlate with
the target behavior (yes or no).

A target field is a column in the data source that represents the customer behavior
you are trying to predict. Selecting the target while creating a model automatically
selects the target field. For example, your System Administrator might define a
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target called Home Ownership that is mapped to a column in a specific
user-defined data source with the name Own Rent Flag.

Oracle Marketing currently supports binary outcomes for the target field. As such,
the possible value for a target field must either be binary or must be mapped to a
binary outcome. For example, if the value for a field can be an income, and you are
interested in high income households, then values equal to or exceeding $100,000
could be mapped to 1 (yes), and values under $100,000 could be mapped to 0 (no).

User-defined data sources and target fields can be set up by your System
Administrator. System Administrators should also know the attributes present in

these data sources.

Oracle Marketing provides two seeded data sources for each model type: TCA
Persons for B2C models and TCA Organization Contacts for B2B models. Both of
these data sources are associated with customer data from the Oracle customer
model (TCA). Refer the Oracle Marketing Implementation Guide for a complete list of
attributes included in the seeded data sources.

The following table lists the seeded targets and data sources provided by Oracle
Marketing for the different model types. For Custom model types, your System
Administrator must define the associated target fields and data sources. They can
also create additional data sources and targets for the out-of-the-box models.

Table 15-2 Seeded Target Fields and Data Sources

Model Type

Data Source

Targets

Direct Mail Response

Organization Contacts

B2B: Direct Mail Responders

Persons

B2C: Direct Mail Responders

E-Mail Response

Organization Contacts

B2B: E-Mail Responders

Persons B2C: E-Mail Responders
Telemarketing Organization Contacts B2B: Telemarketing Responders
Response Persons B2C: Telemarketing Responders
Loyalty /Retention Organization Contacts B2B: Loyalty /Retention

Persons B2C: Loyalty/Retention
Product Affinity Organization Contacts B2B: Product Affinity

Persons B2C: Product Affinity
Customer Profitability | TCA Organization Contacts B2B: Customer Profitability

TCA Persons

B2C: Customer Profitability
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Table 15-2 Seeded Target Fields and Data Sources

Model Type Data Source Targets

Custom None. Must be set up by your System Administrator.

15.2.3 About Training Data

In data mining, a model requires a data set from which to learn and build the
model. The data set is referred to as the training data and the process of learning is
referred to as training the model.

Training data consists of organizations contacts or individuals that you select. It
should consist of members:

= Whose characteristics closely resemble the target population that will be scored
with the model

= Whose behavior and responses are known

The more similar the training data is to the target population, the greater the
predictive power of the model. For example, to conduct a telemarketing campaign
for consumers, you would train the model using data that consists of consumers
targeted by a similar telemarketing campaign in the past, and whose response to the
campaign is known.

Note: If historical information from a similar campaign is not
available, you must create and execute a test campaign before you
can build a model.

15.2.4 About Building a Model

As mentioned above, model building is the process of training the model using a
data set that you have selected. The data set consists of both positive and negative
values (responses, affinity, or profitability). During model building, the data set is
divided into two parts: input data (70% of the training data set) and holdout or test
data (30% of the training data set). The test data is to used to validate the discovered
relationship and patterns for determining the effectiveness of the model.

Both positive and negative values are split in the 70:30 ratio. Which means once
split, the input data will contain 70% of the positives and 70% of the negatives and
the test data will contain 30% of the positives and 30% of the negatives. This ensures
that the input and the test data reflect the positives and negatives proportion in the
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data set. The training data should have adequate number of positive and negative
values to successfully build a model.

For more information on the test data and how it is used, see Section 15.3,
"Evaluating Model Build Results".

The data mining engine uses the input data to discover relationships and patterns to
build a set of rules. Depending upon the target field and data source selected, the
application may examine the following:

»  For a seeded data source, more than 150 customer attributes comprise the
Oracle customer model (TCA). Refer the Oracle Marketing Implementation Guide
for a complete list of attributes.

= A variety of customer attributes that contain customer information from a
user-defined data source.

The attributes examined can include demographic information such as age, gender,
and income. Historical data can include information such as the number of times a
customer has been contacted, number of past purchases, and the number of service
requests they have opened. It can also include data collected using your Customer
Relationship Management (CRM) applications, or data that you have purchased
from outside vendors and imported into the database.

Different types of models are trained on different subsets of attributes depending
upon the target audience. Here are some examples.

= Aresponse model targeting organization contacts through a telemarketing
campaign may examine data such as the number of employees in the
organization, annual revenue, and business transaction history. A response
model for a telemarketing campaign targeting individuals might instead
examine detailed personal information such as age, household income, and
personal transaction history.

= A loyalty/retention model will examine the attributes of customers who have
and have not placed an order with your organization in the last three months.

= A customer profitability model will examine the financial attributes, role, and
department of customers and whether a customer is a decision maker.

= A product affinity model will analyze a customer’s past purchasing pattern for
products or product categories to be able to predict the customer’s affinity for
the product or product category.
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15.2.5 About Model Statuses

The status of a model indicates its state. The current status of a model determines
whether or not you can use it for a build or a scoring run, modify it, copy it, or

change its status.

The table below provides a description of each status, what the status can be reset
to, what fields you can modify, and whether or not you can copy the model.

Table 15-3 Model Status
What you can
Status Meaning Can be reset to | modify What you can copy
Draft All new models have this | Archived All fields. Create an identical
status initially. (manually) model with a
different name and
status of Draft.
Scheduled Model is scheduled to be | Draft by All fields. Create an identical
built. cancelling the model with a
build. different name and
status of Draft.
Building The application is in the Draft by Training data is Create an identical
process of building the cancelling the locked. model with a
model. build. different name and
status of Draft.
Failed An error occurred while Archived View the modellog, | Create an identical
building or previewing (manually) make the necessary model with a
the model. changes. Preview or different name and
rebuild the model. status of Draft.
Invalid The model was Archived Rebuild the model. Create an identical
successfully built (status (manually) model with a

was Available), but cannot
be used for scoring
because changes were
made to the training data.

See Invalid below for
more information.

different name and
status of Draft.

Working with Data Mining 15-9




Understanding and Building Predictive Models

Table 15-3 Model Status

What you can

automatically deletes the
source data for the model.

Status Meaning Can be reset to | modify What you can copy
Previewing The training data has been | Cannot be reset. | All fields. Create an identical
submitted for previewing. model with a
If successful, the status is different name and
changed to Draft. If the status of Draft.
preview fails, the status is
changed to Failed.
A request to build the
model during this state
terminates the preview.
Scoring A scoring run is taking Available by Target population Create an identical
place. cancelling the data is locked. model with a
scoring run. different name and
status of Draft.
Available Model is built and Archived All fields. Create an identical
available for a scoring run. | (manually) model with a
When rebuilding a model, different name and
- status of Draft.
the results of the previous
build are purged.
Expired The model expires at the Cannot be reset. | Cannot be modified. | Create an identical
end of the date you enter model with a
in the Expiration Date different name and
field. status of Draft.
Archived Archived models only Cannot be reset. | Cannot be modified. | Create an identical
appear in the All Models model with a
list. different name and
The application status of Draft.

Invalid

As stated in Table 15-3, a status of Invalid means that the model was successfully
built, but that some change occurred after the build that has caused the status to

change. The changes that can result in a status of Invalid are:

= A column in the data source is disabled or enabled for data mining.

s The training data selections are changed. For example:

— Campaign schedule selections are changed for a Response model
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- Workbooks, lists, or segment selections are changed for a
Loyalty /Retention model

- Attributes or workbook filters for training data sources are changed
- Selection methods or record counts are changed

= When the status of a model is Invalid, it cannot be used for a scoring run. You
can rebuild the model, and if the build is successful, the status will change to
Available. You can then use it for a scoring run.

15.3 Evaluating Model Build Results

The accuracy of a model is determined by evaluating the results of the model build.
The evaluation is performed by applying the set of rules created during the model
build to the test data (30% of the total data made up of 30% of the positives and 30%
of negatives).

Because the actual value of the target field for the test data is known, the predicted
and actual values are compared to determine the effectiveness of the model.

One report and two charts are created during the evaluation. Table 15—4 describes
what you can use each for.

Table 15-4 Model Reports

Report or Chart Use

Lift Chart A graphical representation of the benefits of using the model
over contacting your target population at random.

Performance Matrix Provides statistical insight into the accuracy of the model build.

Report

Attribute Importance Displays the predictive power of the customer attributes in

Chart determining the target value.

Based upon the information in these reports, you can make modifications to your
data that will improve the predictive power of your model. See Section 15.4,
"Improving Model Results".

15.3.1 About the Lift Chart

The Lift Chart illustrates the benefit of using the predictive model to intelligently
select a portion of your target population as opposed to targeting the entire
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population at random. Targeting only the strong prospects allows you to reduce
marketing costs and improve your return on investment.

The x axis, Percent Targeted, is the total target population. The y axis, Percent of
Records, is the population exhibiting the target behavior. For a Response model, this
indicates the percentage of positive responders. For a Loyalty /Retention model, this
indicates the percentage of customers who have not placed an order within the last
three months. For a Customer Profitability model, this indicates the percentage of
profitable customers. For a Product affinity model, this indicates percentage of
purchasers for a selected product or product category.

Figure 15-1 A Sample Lift Chart

Name : Sample Iodel Last Build Date/Time : 2004-Jan-12, 0446 AN
Type : Loyalty/Fetention Elapsed Build Time : 0 Days, 0 Hours, 14 Idinutes

Audience : Perzon DataZource
Lift
Chart

The Lift Chart represents the benefits of using the predictive model over targeting custarmers at randorn.
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In the graph in Figure 15-1, the A and B lines represent the percentage of the total
population (x axis) that you must target to reach the desired percentage of
responders, purchasers, defectors, or profitable customers (y axis).
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The curved line (B) is the lift. It indicates the advantage the model provides over
targeting prospects at random. The more the line curves to the upper left hand
corner of the graph, the more benefit you will achieve with the model.

Reading different points along the lines indicates what percentage of the total
population you must target to meet your goal. In the Lift Chart in Figure 15-1, let us
assume that our target population consists of 100,000 customers (x axis) and the
total responders equal 5,000 (y axis). The intersection labeled 1 indicates that
randomly contacting 50% (50,000) of your target population might yield a positive
response rate of 50% (2,500). The intersection labeled 2 indicates that by using the
predictive model, you can selectively target just 50% (50,000) of the population with
the possibility of a 97% (4,850) response rate.

This outcome demonstrates the increase in campaign return on investment that may
be achieved using predictive modeling.

You can also view a table reporting the lift chart details below the chart and can also
download the data to a .csv file.

15.3.2 About the Performance Matrix Report

The Performance Matrix report (also referred to as a Confusion Matrix) provides
statistical insight into the accuracy of the model. It displays information in two
formats: as record counts, and as percentages. It rates the predictions made by the
model against what actually occurred within the holdout sample of the training
data.
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Figure 15-2 A Sample Performance Matrix Report

Name : Sample Model Last Build Date/Time : 2004-Tan-12, 0446 AN
Type : Loyaltyw/Fetention Elapsed Build Time : 0 Daysz, 0 Hours, 14 hfinutes

Audience : Person DataZource

Counts
The overall Accuracy Rate for the Model is 87.38 % (otal % of correct predictions).
The overall Error Rate for the Model is 12,62 % {total % of incorrect predictions).
Defectors Non Defectors Total
Predicted Correctly 11 79 90
Predicted Incorrectly 9 4 13
Total 20 83 103
Percentages
Defectors Non Defectors
Predicted Correctly 55.00 % 9518 %
Predicted Incorrectly 45.00 % 482%

As shown in Figure 15-2, the Counts table displays the number of correct and
incorrect predictions the model made. For example, out of 90 responders, the model
predicted 79 non defectors correctly and 4 incorrectly.

The Percentages table shows the overall accuracy rate of the model in percentage
numbers. For example, the percentage of responders predicted correctly is 79/90 or
95.18%.

15.3.3 About the Attribute Importance Chart

The Attribute Importance chart displays the importance of the attributes in
determining the target field value. It allows you to see which customer attributes
have the most significant effect on the predictive capability of a model.

Attribute importance information can be displayed in three formats: as a pie chart,
vertical bar chart, or a horizontal bar chart. Each slice of the pie chart is labeled with
a percent; the total of the slices equals 100%. The bar charts indicate a numerical
value for each attribute on the Y-axis. In the chart legends, the attributes are
displayed in descending order of importance.
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Figure 15-3 A Sample Attribute Importance Chart
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By default, only the top 10 attributes are displayed. You have the option of
displaying additional or fewer attributes by entering a value in the Number of
Attributes field.

15.4 Improving Model Results

After evaluating the model results, you can manipulate your training data in a
number of ways to improve the predictive power of your model. You can:

Increase the Size of the Training Data Set

Larger sets of training data tend to produce more accurate results. While there is no
minimum size, the training data set should include thousands if not tens of
thousands of customers, prospects, or both for the best results.
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Improve the Quality of Customer Data

If your data is missing many of the attributes, the models will still work, but will
not be as accurate. Consider using other application products as these will
automatically fill in the required customer data. For a list of attributes used in
models, refer Oracle Marketing Implementation Guide.

Focus on Characteristics

Choose a training data with characteristics that are as close as possible to the target
population. The more similar the two populations, the better the predictive model.

Split the Target Population

Split the target population and build multiple specialized models. The more
precisely you target your audience, the more precise your model will be. For
example, a shoe retailer may wish to build a separate model for marketing to males
and females because the two markets behave very differently. Another approach
this retailer might take would be to build a separate model for different age groups:
children, adults, and seniors.

15.5 Building a Model

This section provides step-by-step instructions on model building. Follow the
procedures listed in the sections below to build a model.

15.5.1 Creating the Model

Use the following procedure to create a model.

Prerequisites
None

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Analytics > Models.

2. Click Create.
3. Enter a Name, select the model Type, and select a Target for the model.

The targets available are dependent on the model type you select.

15-16 Oracle Marketing User Guide



Building a Model

If you want your model to be available only for a specified period, select an
Expiration Date.

If necessary, change the Owner and enter a brief description for the model.
Click Create.

To update a model, navigate to the Model Details page, make the necessary
changes, and click Update.

Next you will select the training data for your model. The training data can reside
in the Oracle TCA or a user-defined data source. Proceed to do one of the following;:

Section 15.5.2, "Selecting Training Data For Response Models Using Seeded
Data Sources"

Section 15.5.3, "Selecting Training Data for Loyalty /Retention Models Using
Seeded Data Sources"

Section 15.5.4, "Selecting the Training Data for a Customer Profitability Model
Using Seeded Data Sources"

Section 15.5.5, "Selecting the Training Data for a Product Affinity Model Using
Seeded Data Sources"

Section 15.5.6, "Selecting the Training Data for Custom Models Using Seeded or
User-Defined Data Sources"

15.5.2 Selecting Training Data For Response Models Using Seeded Data Sources

Follow this procedure to select the training data for response models that will use
an Oracle Marketing seeded data source. Your data source is seeded if it is listed as
TCA Persons or TCA Organization Contacts.

Prerequisites

The basic information for the model must be set up. See Section 15.5.1,
"Creating the Model".

You must know the name of the campaign and the campaign schedule that
contains the historical data that will be used to train your model.

The population targeted by the historical campaign must have trackable
similarities to the population you will target with your new campaign.

The campaign must include both, responders and non-responders.
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Steps

1.

Log into Oracle Marketing with the appropriate responsibility, navigate to
Analytics > Models, and select the Response model for which you want to train
data.

Click the Training Data side navigation link.
Select a campaign and a campaign schedule in the Selection region.

To restrict the size of the training data, choose a Selection Method and/or
specify minimum and maximum Record Count numbers.

For example, to select records starting from the top down until some maximum
number is reached, select Top Down and enter a value in the Maximum field.

The system applies the Selection Method criteria before the Record Count
criteria. If a conflict occurs, the Record Count criteria takes precedence.

Click Update.

Click Preview to preview the record count, number of positive responses, and
the percent of positive responses.

During the preview, the model status changes to Previewing and when the
preview is complete, the model status changes to Draft.

Click Monitor Preview to view the progress of the training. If you find the green
line moving downwards from a point, that is the point of failure of the training.

Once you are satisfied with the training data, you are ready to schedule a build.
Proceed to Section 15.5.7, "Scheduling a Build for a Model".

15.5.3 Selecting Training Data for Loyalty/Retention Models Using Seeded Data

Sources

Follow this procedure to select the training data for loyalty /retention models that
will use an Oracle Marketing seeded data source. Your data source is seeded if it is
listed as TCA Persons or TCA Organization Contacts.

Prerequisites

The basic information for the loyalty /response model must be set up. See
Section 15.5.1, "Creating the Model"

The source for the training data must exist

The training data must:
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s Include customers who have and who have not placed an order within the
last three months

= Beas similar as possible to your target population

s Include demographic, transaction history, and account status information

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, navigate to
Analytics > Models, and select the Loyalty /Retention model for which you
want to train data.

Click the Training Data side navigation link.

Select the training data sources in the Selection region.

The operations for the data sources can be:

s Include: Include all the customer records in this source.

= Exclude: Exclude all the customer records in this source from the previous
sources.

= Intersect: Use only the customer records common to this source and the
previous sources.

When using multiple training data sources, for the first data source selected, the
Order must be 1 and Operation must be Include.

To restrict the size of the training data, choose a Selection Method and/or
specify minimum and maximum Record Count numbers.

For example, to select records starting from the top down until some maximum
number is reached, select Top Down and enter a value in the Maximum field.

The system applies the Selection Method criteria before the Record Count
criteria. If a conflict occurs, the Record Count criteria takes precedence.

Click Update.

Click Preview to preview the record count, number of positive responses, and
the percent of positive responses.

During the preview, the model status changes to Previewing and when the
preview is complete, the model status changes to Draft.

Click Monitor Preview to view the progress of the training. If you find the green
line moving downwards from a point, that is the point of failure of the training.
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Once you are satisfied with the training data, you are ready to schedule a build.
Proceed to Section 15.5.7, "Scheduling a Build for a Model".

Note: The application looks at each list and performs the include,
exclude, and intersect operations in the order specified. For
example, you specify three sources numbered 1, 2 and 3, with no
size restrictions.

1. The application includes all of the records in source 1 in the
training data set. We will call this the current training data.

2. It then compares the current training data with source 2. If the
operation is exclude, the data is modified to consist of the records
unique to source 1 only. This set of records is now the current
training data.

3. Finally, the application compares the current training data with
source 3. If the operation is intersect, it modifies the data to consist
of only the records that are common to both sets (in other words,
the results from step 2 and source 3.)

15.5.4 Selecting the Training Data for a Customer Profitability Model Using Seeded

Data Sources

Follow this procedure to select the training data for customer profitability models
that will use an Oracle Marketing seeded data source. Your data source is seeded if
it is listed as TCA Persons or TCA Organization Contacts.

Prerequisites

The basic information for the Customer Profitability model must be set up. See
Section 15.5.1, "Creating the Model"

The source for the training data must exist

The training data must:

Include customers who have and who have not placed an order within the
last three months

Be as similar as possible to your target population

Include demographic, transaction history, and account status information
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Steps

1.

Log into Oracle Marketing with the appropriate responsibility, navigate to
Analytics > Models, and select the Customer Profitability model for which you
want to train data.

Click the Training Data side navigation link.

Select the training data sources in the Selection region.

The operations for the data sources can be:

= Include: Include all the customer records in this source.

= Exclude: Exclude all the customer records in this source from the previous
sources.

= Intersect: Use only the customer records common to this source and the
previous sources.

When using multiple training data sources, for the first data source selected, the
Order must be 1 and Operation must be Include.

To restrict the size of the training data, choose a Selection Method and/or
specify minimum and maximum Record Count numbers.

For example, to select records starting from the top down until some maximum
number is reached, select Top Down and enter a value in the Maximum field.

The system applies the Selection Method criteria before the Record Count
criteria. If a conflict occurs, the Record Count criteria takes precedence.

Click Update.

Click Preview to preview the record count, number of positive responses, and
the percent of positive responses.

During the preview, the model status changes to Previewing and when the
preview is complete, the model status changes to Draft.

Click Monitor Preview to view the progress of the training. If you find the
green line moving downwards from a point, that is the point of failure of the
training.

Once you are satisfied with the training data, you are ready to schedule a build.
Proceed to Section 15.5.7, "Scheduling a Build for a Model".
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15.5.5 Selecting the Training Data for a Product Affinity Model Using Seeded Data
Sources

Follow this procedure to select the training data for customer profitability models
that will use an Oracle Marketing seeded data source. Your data source is seeded if
it is listed as TCA Persons or TCA Organization Contacts.

Prerequisites

s The basic information for the Product Affinity model must be set up. See
Section 15.5.1, "Creating the Model"

= The source for the training data must exist
s Target product categories and products must exist
s The training data must:

= Include customers who have and who have not placed an order within the
last three months

= Be as similar as possible to your target population

= Include demographic, transaction history, and account status information

Steps

1. Log into Oracle Marketing with the appropriate responsibility, navigate to
Analytics > Models, and select the Product Affinity model for which you want
to train data.

2. Click the Training Data side navigation link.
3. Select the product categories and the products in the Target Products region.
4. Select the training data sources in the Selection region.

The operations for the data sources can be:

= Include: Include all the customer records in this source.

= Exclude: Exclude all the customer records in this source from the previous
sources.

= Intersect: Use only the customer records common to this source and the
previous sources.

When using multiple training data sources, for the first data source selected, the
Order must be 1 and Operation must be Include.
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To restrict the size of the training data, choose a Selection Method and/or
specify minimum and maximum Record Count numbers.

For example, to select records starting from the top down until some maximum
number is reached, select Top Down and enter a value in the Maximum field.

The system applies the Selection Method criteria before the Record Count
criteria. If a conflict occurs, the Record Count criteria takes precedence.

Click Update.

Click Preview to preview the record count, number of positive responses, and
the percent of positive responses.

During the preview, the model status changes to Previewing and when the
preview is complete, the model status changes to Draft.

Click Monitor Preview to view the progress of the training. If you find the
green line moving downwards from a point, that is the point of failure of the
training.

To disassociate a product category or target source, click its Remove check box
and click Update.

Once you are satisfied with the training data, you are ready to schedule a build.
Proceed to Section 15.5.7, "Scheduling a Build for a Model".

15.5.6 Selecting the Training Data for Custom Models Using Seeded or User-Defined

Data Sources

To select training data for a custom model from the Oracle customer model (TCA)
or a user-defined data source, follow the steps below.

Prerequisites

The basic information for the custom model must be set up. See Section 15.5.1,
"Creating the Model"

The source for the training data must exist

The training data must be as similar as possible to your target population

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, navigate to
Analytics > Models, and select the custom model for which you want to train
data.
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Click the Training Data side navigation link.
Select the selection filters in the Attributes and/or Workbook regions.

To restrict the size of the training data, choose a Selection Method and/or
specify minimum and maximum Record Count numbers.

For example, to select records starting from the top down until some maximum
number is reached, select Top Down and enter a value in the Maximum field.

The system applies the Selection Method criteria before the Record Count
criteria. If a conflict occurs, the Record Count criteria takes precedence.

Click Update.

Click Preview to preview the record count, number of positive responses, and
the percent of positive responses.

During the preview, the model status changes to Previewing and when the
preview is complete, the model status changes to Draft.

Click Monitor Preview to view the progress of the training. If you find the
green line moving downwards from a point, that is the point of failure of the
training.

Once you are satisfied with the training data, you are ready to schedule a build.
Proceed to Section 15.5.7, "Scheduling a Build for a Model".

15.5.7 Scheduling a Build for a Model

Use the following procedure to schedule a build for your model.

Prerequisites

For all model types, the model must exist and the training data set must be
specified, including any restrictions on the training data size.

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, navigate to
Analytics > Models, and select the model for which you want to schedule a
build.

Click the Build side navigation link.

If you want to schedule the build immediately, select Generate immediately.
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If you want to schedule the build for a convenient date and time, select
Generate at a future time and select the required date, time, and time zone for it.

Note: Model building may impact system performance. Therefore,
consider scheduling builds for off-peak hours.

Click Update.

To cancel a build, navigate to Schedule Model Build page, and click Cancel
Build.

You can check the status field for the model to ascertain when the model building is
complete. If the build was successful, the status changes to Available.

You are now ready to view the reports generated during the model build. Proceed
to Section 15.3, "Evaluating Model Build Results".

You can associate attachments, notes, and tasks to a model and add users and teams
to allow them access to the model. See Chapter 14, "Working with Common
Components" and Section 12.2, "Adding Security to a Marketing Object" for
information on making these associations.

15.5.8 Viewing Build Results

Use the following procedure to view the build results for your model.

Prerequisites

The model must exist

The training data set must be specified, including any restrictions on the
training data size

Model should have been built and in Available status

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, navigate to
Analytics > Models, and select the model for which you want to view build
results.

Navigate to Results > Lift Chart to view the benefits of using the predictive
model over targeting customers at random. The information is displayed both,
as a lift chart and a table.
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3. Navigate to Results > Performance Matrix to view the predictive model’s
accuracy in making predictions.

4. Navigate to Results > Attribute Importance and select the chart type and
number of attributes you want to view in the chart. The chart helps you
measure the customer attributes that have the highest predictive power.

15.6 Understanding Scoring Runs Generation

Scoring is the process of using a model to predict the future behavior of a specific
population based on the attribute values of individual customer records. The score
assigned to a customer or prospect indicates the likelihood that they will exhibit the
desired behavior.

Because of budget, resource, or other constraints, you may need to restrict the size
of the list you are scoring and specify a minimum and a maximum size for it. You
may also choose to score the target population immediately or specify a date and
time when the scoring should execute.

After scoring, the target population is divided into ten continuous segments called
deciles. Each decile represents a certain number of customers, prospects, or both.
The sum of the record counts in each decile equals the total target population. The
deciles are ordered from the highest to the lowest probability of displaying the
target behavior. Therefore, the customer records in decile 1 are the most likely to
exhibit the behavior you are interested in.

Based on this information, you can select the groups with the highest probability of
exhibiting a target behavior and generate a list. The list can then be used for
marketing activities such as executing an e-mail campaign. Campaign execution
closes the loop of using a predictive model to score a target population and generate
a list of customers or prospects that are most likely to exhibit the target behavior.

You can also perform an Optimal Targeting analysis and then generate an optimal
list of people to target for your marketing activities. See Section 15.6.1 for the details
of Optimal Targeting analysis.

Once you have generated a list, you can access it from Audience Workbench. To
view the actual names on the list and other related details, click the Entries link.

For more information about lists, see Section 4.3, "Creating and Managing Lists" and
Section 8.1.8, "Using Target Groups".

An example of the scoring run results for a Response model is shown in Table 15-5
below. Table 15-6, provides a description of each column in the scoring run results
table.
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Table 15-5 Scoring Run Results

Propensity to Percent of Positive | Include
Decile Respond* Number of Records | Values in List
1 90-100% 1560 26.54 X
2 80-89.99% 183 3.11 X
3 70-79.99% 87 1.48 X
4 60-69.99% 48 .82 X
5 50-59.99% 45 77
6 40-49.99% 78 1.33
7 30-39.99% 231 3.93
8 20-29.99% 183 3.11
9 10-19.99% 261 444
10 0-9.99% 3,201 54.47

* Propensity to Respond is displayed for Response model types. For Loyalty /Retention
models, this column is labeled Propensity to Defect; for Customer Profitability model it is
labeled Profitability; for Product Affinity model it is labeled Propensity to Purchase; for

Custom models it is labeled Propensity for Positive Target Values.

The following table describes each of the columns on a scoring run report.

Table 15-6 Scoring Run Report

Column

Description

Decile

Each number represents a group of customers, prospects or
both. The deciles are ordered by the probability of response,
from the highest to the lowest. The first decile represents group
members with a 90-100% likelihood of exhibiting the target
behavior; the second decile includes those who are 80-89.99%

likely to respond to your campaign; and so on.

Working with Data Mining 15-27



Understanding Scoring Runs Generation

Table 15-6 Scoring Run Report

Column

Description

Propensity to Respond
(Response models)

Propensity to Defect
(Loyalty /Retention
models)

Propensity to Purchase
(Product Affinity model)

Propensity to be
Profitable (Customer
Profitability model)

Propensity for Positive
Target Values
(Custom models)

The probability that persons or organization contacts (customer
records) in the decile will exhibit the target behavior. Select the
deciles with the highest predicted probabilities for your list.

For a Loyalty /Retention model, the percentages represent how
likely the members of each decile are to defect to a competitor.

For a Product Affinity model, the percentages represent the
likelihood that members will purchase the specified product.

For a Customer Profitability model, the percentages represent
how profitable to you the customers will be.

Number of Records

The number of records in the decile.

Percent of Positive
Values

A percentage representation of the number of records in the
decile to the total number of records.

Include in List

This column contains a check box for each decile. The check
boxes allow you to select the customer records in a particular
decile and include them in a list.

You can associate attachments, notes, and tasks to a scoring run and add users and
teams to allow them access to the scoring run. See Chapter 14, "Working with
Common Components" and Section 12.2, "Adding Security to a Marketing Object"
for information on making these associations.

15.6.1 Optimal Targeting Analysis

If you have costs or budget constraints for your marketing activities, the build
results from a model may not be adequate for arriving at an optimal target list. You
can use the Optimal Targeting Analysis functionality and perform an analysis of the
costs, revenues, and scored response probabilities of the population for a test
campaign and derive the expected gross profit per customer. The result of this
analysis is presented as an Optimal Targeting Chart.

The X-axis of the Optimal Targeting Chart represents the total target population and
the Y-axis represents the expected Return On Investment (ROI) or Profits for the

campaign. The highest Y-axis value on the chart determines the optimal number of
customers to target. In Figure 154, it is seen that the optimal percent of customers
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to target is about 14%. You can modify the costs, margins per order, and costs per
customer details and arrive at optimal ROI and profits.

Figure 15-4 A Sample Optimal Targeting Return On Investment Chart
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The optimal number of customers to target is 26 out of 147.

You can perform optimal targeting analysis for scored response probabilities of
Response and Product Affinity models where targeted customers will place orders
and you can easily identify the costs and revenues per customer. However, for
Loyalty /Retention and Customer Profitability models, customers do not place
orders and so identifying the costs and revenues per customer for optimal targeting
analysis is not possible. The purposes of these models is to identify the profitable
customers or arrive at marketing strategies to build up and retain customers. For
example, in a call center, telemarketing executives may be instructed to assign
higher priority to calls from profitable customers.

Once the optimal targeting chart is generated, you can generate an optimal list to
target for a campaign schedule. An optimal list may be associated with campaign
schedules in the Draft or Active statuses. You can restrict the size of the optimal list
to within a budget amount or to the top x% of targets.

If a campaign schedule already has a target group defined, the entries in the optimal
list generated are added to the target group. If no target group has been defined for
a campaign schedule, a new target group is created with the entries of the optimal
list.
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15.6.2 Generating a Scoring Run

The scoring process looks at the data mining attribute values for each member
(customer record) of the target population. It then scores each record based on how
likely that member is to exhibit the target behavior. The application then divides the
population into 10 groups called deciles based on the score given to the record.

As part of the scoring process, costs and revenues for a customer can also be
analyzed to arrive at optimal targeting data.

When the scoring is complete, you can generate a list by selecting the deciles
(customer records) with a high likelihood of exhibiting the target behavior or by
using the results of an optimal targeting analysis. The list would then be targeted in
a future marketing campaign.

Use the following procedures to generate a scoring run.
= Section 15.6.2.1, "Creating a Scoring Run"

»  Section 15.6.2.2, "Selecting Target Population When Using a Seeded Data
Source"

= Section 15.6.2.3, "Selecting a Target Population When Using a User-Defined
Data Source”

= Section 15.6.2.4, "Scheduling a Scoring Run"

= Section 15.6.2.5, "Viewing Scoring Run Results"

= Section 15.6.2.6, "About Scoring Run Statuses"

= Section 15.6.2.7, "Generating a List Based on Decile Scores"

= Section 15.6.2.8, "Performing an Optimal Targeting Analysis and Generating an
Optimal List"

= Section 15.6.2.9, "Viewing Logs"

15.6.2.1 Creating a Scoring Run

Use the following procedure to create a scoring run.

Prerequisites
A model that has been built and is in the Available status

15-30 Oracle Marketing User Guide



Understanding Scoring Runs Generation

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, navigate to
Analytics > Models, and navigate to Analytics > Scoring Runs.

Click Create.
Complete the details on the page and click Create.

To modify the details for a scoring run, make the necessary changes in the
Scoring Run - Details/Create page and click Update.

To copy a scoring run, click Copy in the Scoring Runs page. In the Copy -
Scoring run page, complete the necessary details, select the components you
want copied, and click Copy.

To download the list of scoring runs to a .csv file, click the Download to CSV
file icon, click Save in the File Download dialog box, navigate to a relevant
folder, and save the .csv file.

15.6.2.2 Selecting Target Population When Using a Seeded Data Source

Your data source is seeded if it is listed as TCA Persons or TCA Organization
Contacts. Use the following procedure to select seeded data sources for scoring.

Prerequisites
A scoring run must be created for a model

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Analytics > Scoring Runs.

Select a run and navigate to the Selections side navigation link.
Select the data sources in the Selection region.

The operations for the data sources can be:

= Include: Include all the customer records in this source.

»  Exclude: Exclude all the customer records in this source from the previous
sources.

= Intersect: Use only the customer records common to this source and the
previous sources.
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When using multiple training data sources, for the first data source selected, the
Order must be 1 and Operation must be Include.

Note: The application looks at each list and performs the include,
exclude, and intersect operations in the order specified. For
example, you specify three sources numbered 1, 2 and 3, with no
size restrictions.

1. The application includes all of the records in source 1 in the
target population set. We will call this the current target population.

2. It then compares the current target population with source 2. If
the operation is exclude, the data is modified to consist of the
records unique to source 1 only. This set of records is now the
current target population.

3. Finally, the application compares the current target population
with source 3. If the operation is intersect, it modifies the data to
consist of only the records that are common to both sets (in other
words, the results from step 2 and source 3.)

4. To restrict the size of the scoring data, choose a Selection Method and/or
specify minimum and maximum Record Count numbers.

For example, to select records starting from the top down until some maximum
number is reached, select Top Down and enter a value in the Maximum field.

The system applies the Selection Method criteria before the Record Count
criteria. If a conflict occurs, the Record Count criteria takes precedence.

5. Click Update.
6. Click Preview to preview the data selection.

During the preview, the scoring run status changes to Previewing. When the
preview is complete, the scoring run status changes to Draft.

7. Click Monitor Preview to view the progress of the scoring run. This will help
you trouble shoot if the run fails. If you find the green line moving downwards
from a point, that is the point of failure of the scoring run.

8. To modify the scoring run details, make the necessary changes in the Scoring
Run Details - Selections page and click Update.
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9. To deselect a data source from the scoring run, select its Remove check box in
the Run Details - Selections page and click Update.

15.6.2.3 Selecting a Target Population When Using a User-Defined Data Source

For a user-defined data source, you can use a combination of attributes and
Discoverer Workbook filters to restrict the size of your target population. If no filters
are specified, the scoring run will select and score all of the records in the data
source.

Use the following procedure to select a target population from a user-defined data
source.

Prerequisites
A scoring run must be created

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Analytics > Scoring Runs.

2. Select a run and navigate to the Selections side navigation link.
3. Select the selection filters in the Attributes and/or Workbook regions.

4. To restrict the size of the training data, choose a Selection Method and/or
specify minimum and maximum Record Count numbers.

For example, to select records starting from the top down until some maximum
number is reached, select Top Down and enter a value in the Maximum field.

The system applies the Selection Method criteria before the Record Count
criteria. If a conflict occurs, the Record Count criteria takes precedence.

5. Click Update.
6. Click Preview to preview the selections.

During the preview, the scoring run status changes to Previewing. When the
preview is complete, the scoring run status changes to Draft.

7. Click Monitor Preview to view the progress of the scoring run. If you find the
green line moving downwards from a point, that is the point of failure of the
scoring run.

Once you are satisfied with the target population, you are ready to schedule a
scoring run. Proceed to Section 15.6.2.4, "Scheduling a Scoring Run".
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15.6.2.4 Scheduling a Scoring Run

Use the following procedure to schedule the scoring run.

Prerequisites
A scoring run for a model must exist

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Analytics > Scoring Runs.

2. Select the relevant run and navigate to the Score side navigation link.
3. If you want to schedule the run immediately, select Generate immediately.

4. If you want to schedule the run for a convenient date and time, select Generate
at a future time and select the required date, time, and time zone for it.

Note: Scoring runs may impact system performance. Therefore,
consider scheduling scoring for off-peak hours.

5. Click Update.

6. Click Monitor Scoring to view the progress of the scoring. If you find the green
line moving downwards from a point, that is the point of failure of the scoring.

7. To cancel a scoring run, navigate to Schedule Scoring Run page, and click
Cancel Scoring Run.

15.6.2.5 Viewing Scoring Run Results

Use the following procedure to view the results of a scoring run.

Prerequisites
The scoring run must be in the Completed status

For more information on scoring run statuses, see Section 15.6.2.6, "About Scoring
Run Statuses".

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Analytics > Scoring Runs.
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2. Select the relevant run and navigate to Results > Deciles side navigation link to
view the target population sorted into ten segments called deciles.

Each decile represents a portion of the target population and indicates the
likelihood that they will exhibit the target behavior.

3. Navigate to Results > Optimal Targeting to view the costs and revenues

information for a campaign and the optimal targeting chart.

If you are satisfied with your scoring run results, you can select which customer
records you would like to include in a list that will be targeted by a future
marketing campaign. To generate a list, see Section 15.6.2.7, "Generating a List
Based on Decile Scores" and Section 15.6.2.8, "Performing an Optimal Targeting
Analysis and Generating an Optimal List"

15.6.2.6 About Scoring Run Statuses

The table below describes the seeded statuses for scoring runs, and tells you:

s The meaning of each status

= What status the scoring run can be changed to

= What fields you can modify

= If you can copy scoring runs with that status

Table 15-7 Scoring Run Statuses

What you can

Status Meaning Can reset to modify What you can copy
Draft Initial status for all Archived All fields. Create an identical
scoring runs. (manually) scoring run with a
different name and
status of Draft.
Scheduled The scoring run is Draft by cancelling | All fields. Create an identical
scheduled. the scoring run. scoring run with a
different name and
status of Draft.
Running The application is in the Draft by cancelling | Data selections are Create an identical

process of scoring the
target population.

the scoring run.

locked.

scoring run with a
different name and
status of Draft.
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Table 15-7 Scoring Run Statuses

What you can

appear only in the All
Scoring Runs list.

The application
automatically deletes any
source data for the
scoring run.

locked.

Status Meaning Can reset to modify What you can copy

Invalid A scoring run that Archived All fields. All scoring run
completed successfully (manually) fields are locked
(status was Completed) and cannot be
has been invalidated. modified.

Failed An error occurred while | Archived All fields. All scoring run
generating or previewing | (manually) fields are locked
a scoring run. and cannot be
View the log, make the modified.
necessary changes, and
resubmit it for a run or
preview.

Previewing The run has been Scheduled by All fields. Create an identical
submitted for setting up a run scoring run with a
previewing. time. different name and

L status of Draft.
If the preview is:
- successful, the status
changes to Draft.
- unsuccessful, the status
changes to Failed.
A request to score will
terminate the preview
operation.

Completed The scoring run finished | Archived All fields. Create an identical

and was successful. (manually) scoring run with a
different name and
status of Draft.

Archived Archived scoring runs Cannot be reset. Data selections are | Create an identical

scoring run with a
different name and
status of Draft.

15.6.2.7 Generating a List Based on Decile Scores
Use the following procedure to use the deciles from the scoring run to generate a

list.
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Prerequisites
The scoring run must be in the Completed status

For more information on scoring run statuses, see Section 15.6.2.6, "About Scoring
Run Statuses".

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Analytics > Scoring Runs.

2. Select the relevant run and navigate to the Results > Deciles side navigation
link.

The target population sorted into ten segments called deciles. Each decile
represents a portion of the target population and indicates the likelihood that
they will exhibit the target behavior.

3. Select the deciles that you want to include in the list by clicking their Include in
List check boxes.

4. Enter a name for the list and click Generate List.

Note: To generate a list, the Workflow Background Process must
be running. See your System Administrator or refer to the Oracle
Marketing Implementation Guide for more information on the
Workflow Background Process.

5. To view the list, navigate to Audience > Audience Workbench and click the My
Lists Shortcut link.

15.6.2.8 Performing an Optimal Targeting Analysis and Generating an Optimal
List
Use the following procedure to use the deciles from the scoring run to generate a
list.

Prerequisites
The scoring run must be in the Completed status

For more information on scoring run statuses, see Section 15.6.2.6, "About Scoring
Run Statuses".
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Steps

1.

7.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Analytics > Scoring Runs.

Select the relevant run and navigate to the Results > Optimal Targeting side
navigation link.

Select a campaign and campaign schedule and if necessary, modify the details
in the Costs and Revenues region and click Update.

Select a chart type to view the Optimal Targeting chart, and compare the
expected ROI/Profit from random marketing and from targeted marketing.

In the Target List region, enter a name for the list and select a list generation
option.

You can use the suggested optimal targets or choose to restrict the targets to
within a specified budget or to the top x% of the targets.

Select a campaign schedule to associate the list with and click Generate List.

Only those campaign schedules whose target groups have been created using
the Advanced option of the audience workbench will be available for selection.
See Section 4.3, "Creating and Managing Lists" and Section 8.2.4, "Creating and
Associating Target Groups" for information on list and target group creation.

Note: To generate a list, the Workflow Background Process must
be running. See your System Administrator or refer to the Oracle
Marketing Implementation Guide for more information on the
Workflow Background Process.

To view the list, navigate to Audience > Audience Workbench and click the My
Lists Shortcut link.

15.6.2.9 Viewing Logs

For Data Mining, the log sequentially summarizes the back-end process occurs
during model builds and scoring runs. If your build or scoring run fails, you can
view the log to help determine the cause of the failure. Log entries are listed in
ascending order.
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Working with Home Page Bins, Reports,
and Charts

This chapter provides an overview of Marketing Intelligence available as bins,
reports, and charts on Oracle Marketing’s home page. It also describes how you
may personalize these bins, reports, and charts.

Topics in this section include:
= Section 16.1, "Marketing Intelligence Overview"

= Section 16.2, "Personalizing Home Page Bins, Reports, and Charts"
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16.1 Marketing Intelligence Overview

Marketing intelligence is displayed as bins, reports, and charts on the Home page of
Oracle Marketing, and provides summary information about key marketing
activities, along with links to recently accessed campaigns and events.

Security for Bins, Reports, and Charts
There are two types of Home Page Reports:

= Marketing Intelligence reports

= Leads Intelligence reports

Marketing Intelligence Security

Marketing Intelligence security utilizes the Oracle Marketing security Model.
Members of the Oracle Marketing Administration group can access all marketing
intelligence reports. Users who are not members of this group can view reports for
all the marketing objects they have access to (either directly or via a Team).

Leads Intelligence Security

Users who are managers or Administrators of sales group can view Leads
Intelligence reports. Such users can view data corresponding to their sales group.
For a list of marketing and leads intelligence reports, see Table A-13, "Home Page
Marketing Intelligence Reports" and Table A-14, "Home Page Leads Intelligence
Reports".

Most Recent Bins

Most Recent bins display links to recently accessed campaigns and events. The links
are generated automatically when you create or edit a campaign or event. The links
navigate you to the details page for the object type. Most Recent bins are available
for campaign and event objects.

Reporting Bins

Reporting bins display trend performance information for key marketing activities.
Some examples include campaign effectiveness, event effectiveness, and marketing
budgets. Each reporting bin contains links to more granular detailed reports.

Reports

Reports displayed directly on the Home page are drill-down reports linked from a
reporting bin, but with a configurable date range specified by the user. The date
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aggregate for the report is inherited from the calling bin. For example, when drilling
down on the month of September, all data for the drill down reports is about
September.

Charts

Charts display trend performance information for key marketing activities. They
illustrate information based on date ranges specified by the user.

In Oracle Marketing, charts render the top comparisons. For example, if you are
viewing a Campaigns by Leads chart and the number of rows to display is 10, then
the chart for Campaigns by Leads will show the Top 10 Campaigns by Leads.

Note: Home page reports can be used by Oracle 8i customers.
Oracle 97 customers should implement Oracle E-Business
Intelligence, and refer the Daily Business Intelligence User Guide for
information on the various reports and charts available.

16.2 Personalizing Home Page Bins, Reports, and Charts

Each bin, report, and chart has configurable parameters. These parameters are
either general or specific to the bin, report, or chart. For example, specific
parameters may relate only to budgets. These parameters are available only from
the Budget bins, reports, and charts.

Use the following procedures to personalize your Home page:

»  Section 16.2.1, "Specifying Home Page Bins, Reports, and Charts"
= Section 16.2.2, "Editing a Home Page Bin"

»  Section 16.2.3, "Editing a Home Page Report"

16.2.1 Specifying Home Page Bins, Reports, and Charts

Use this procedure to personalize the available bins, reports, and charts that are
displayed on your Home page.

Prerequisites
None

Working with Home Page Bins, Reports, and Charts 16-3



Personalizing Home Page Bins, Reports, and Charts

Steps

1.

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Home > Home.

Click the Personalize link. You may have to scroll to the right to view the link.
Select a 2 or 3 column layout.

In the Narrow Column (Left) region, select the bins you want to display from
the Available Bins shuttle. Use the CTRL key to select multiple bins.

Click the Move (>) icon to move the selected bins to the Displayed Bins shuttle.

Use the up and down arrows on the Displayed Bin shuttle to specify the display
order.

Scroll down to the Wide Column shuttle and repeat the previous 2 steps for
modules (charts and graphs).

If you selected 3-column layout, then scroll down to the Narrow Column
(Right) section of the page and select the bins for this column.

Click Update to complete the changes.

16.2.2 Editing a Home Page Bin

Use the following procedure to edit a home page bin.

Prerequisites
An existing home page bin

Steps

1.

N o g & 0 Db

Log into Oracle Marketing with the appropriate responsibility, and navigate to
Home > Home.

Click the Edit link in the bin header.

Click the Personalize side navigation link.
Enter a Favorite name.

Select your desired bin parameters.

Enter your desired bin attributes.

Click Save to complete the changes.
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16.2.3 Editing a Home Page Report

Reports displayed directly on the Home page are drill-down reports displayed from
a reporting bin, but with a configurable aggregate. Because Home Page reports are
not derived from a reporting bin, the aggregate must be configured. Similar
aggregates are available as they are in the bins.

Columns and rows to display on a report are configurable via the Edit link.

Drill-down reports do not allow for data aggregation selection. The aggregate is
inherited from the calling bin.

16.2.4 Editing Home Page Charts

Charts always represent the top comparison of components. For example in the
Campaigns by Leads chart, if the number of rows to display was set to 10, then the
chart renders with the top 10 Campaigns by Leads.

Rows to display in a chart are configurable via the Edit link.
You can perform the following edits:

s Edit link in header of chart

»  Specify the period

= Specify the number of data elements

= Select the chart type
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Common Procedures

This chapter gives procedures for the operations that are common to all objects in
Oracle Marketing. It also contains information about user profiles.

Topics in this section include:
= Section 17.1, "Searching for a Marketing Object"

= Section 17.2, "Personalizing Views in the Audience and Campaign
Workbenches"
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17.1 Searching for a Marketing Object

You can search for a marketing object using a saved search or performing a quick
search.

17.1.1 Using Saved Searches

Saved Searches are searches where the parameters are already provided. For
example, if you frequently search for a list of campaigns that were run during the
last year in the United States, then you would provide all the required parameters
for such a search, and save it. The next time you want to see the results, all you have
to do is run the saved search.

The following procedure will help you create a saved search for a campaign. You
can similarly create saved searches for other marketing objects. The navigation is
dependent on the object you are creating a saved search for.

Use this procedure to create a saved search for a list of campaigns run in the United
States during the year 2003.

Prerequisites
None

Steps
1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Inthe Saved Search region, click Personalize.

3. Use the Search Criteria region to specify the criteria for the search. To specify
the criteria for our example:

a. Click Modify Criteria.

b. Select Country, Start Date, End Date, and Type.

c. Click Update.

d. Select the following values for the respective attributes:

Country: United States

Start Date: January 1, 2003
End Date: December 31, 2003
Type: Campaigns
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4. Use the Filter Search by region to specify the scope of your search. Click the
appropriate option.

5. Use the Display Options region, select the columns that should be displayed in
the results.

a. From the Available Columns section, select Name, Country, Start Date, End
Date, and Type.

b. Click >.
The selected columns move to the Displayed Columns section.

c. Select the columns that should be sorted in the results, and also specify the
number of rows to be displayed per page.

6. Inthe Save Search As region, enter a name for this search.

a. To display this saved search as the default summary in the Campaigns
page, select the Use as Overview Page Default box.

b. Click Save.
The search criteria is saved.
OR

c. Click Save and Apply.

The search criteria is saved, and the results are displayed in the Campaigns
page.
7. To use a Saved Search:

a. From the Saved searches region, select a search from the drop-down list.

b. Click Search. The results of the search are displayed.

17.1.2 Using Quick Search

Using Quick Search, you can enter the name of the object you are searching for. The
following procedure will help you search for a campaign. You can similarly search
for other marketing objects. The navigation is dependent on the object you are
searching for.

Use the following procedure to search for Campaigns with the name starting with
C.
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Prerequisites
None

Steps

1. Log into Oracle Marketing with the appropriate responsibility, and navigate to
Campaign > Campaigns.

2. Select Campaigns from the Quick Find drop-down list.
3. Enter 'C%’ in the field next to Quick Find, and click Go.

"%’ is the wildcard. All campaigns whose name starts with C are listed.

17.2 Personalizing Views in the Audience and Campaign Workbenches

In the Audience and Campaign workbenches, you can modify what is displayed in
the summary, and how the information is displayed by personalizing the view. For
example, the Audience Workbench has the List Effectiveness View. You can
personalize this view by choosing different options. You can also create a view.

The Personalize feature provides the following options:

= General Properties: You can change the name of the view, specify the number
of rows to be displayed in a tabular summary, and provide a description for the
view.

s Column Properties: You can choose the columns to display in the tabular
summary, and the order in which they should appear.

= Sort Settings: You can choose three columns to sort on, and specify the sort
order.

= Search Query: You can specify the query based on which the summary is
displayed.

In the Campaign Workbench, The Last N Days view captures how many days in the
past we have to go to see if a Schedule was available at that time. The seeded
queries, My Schedules and All Schedules are shipped with a value of 30, indicating
that only those Schedules that had start date or end date within the LAST 30 DAYS
will be shown. When you define new personalization criteria, you should use this
field to limit searches. For Schedules with null end date, the parent Campaign’s end
date is considered as its end date.
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Use the following procedure to personalize the Campaign Effectiveness view. You
can similarly personalize other views in the Campaign and Audience Workbenches.
The navigation is dependent on what you choose to personalize.

Prerequisites
None

Steps

1.

10.

Log into Oracle Marketing with the appropriate responsibility, and access the
Campaign Dashboard.

In the Campaign Effectiveness region, click Personalize.

The existing views are listed.

Click Create View.

In the General Properties region, enter the name for the view, and other details.

In the Column Properties region, select the columns to display from the
Available Columns section.

Optionally, to change the name of the columns or to choose to display a total for
a column, click Advanced Settings.

In the Sort Settings region, select the columns that you want displayed as
sorted.

In the Search Query to Filter Data in Table region:
a. Select to display all records.
OR
b. Select the appropriate values to be displayed in the results.
Click Apply.

To display the results of this view, select the view name from the Campaign
Effectiveness drop-down.

Common Procedures 17-5



Personalizing Views in the Audience and Campaign Workbenches

17-6 Oracle Marketing User Guide



A

Home Page Bin, Report, and Chart
Reference

This appendix describes the bins, reports, and charts available to the Oracle
Marketing home page. Sections include:

= Section A.1, "Home Page Bins"
= Section A.2, "Home Page Reports"
= Section A.3, "Home Page Charts"
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A.1 Home Page Bins

This section presents a detailed listing of the components of the bins available in
Oracle Marketing. Bins are displayed on the Oracle Marketing home page. Prior to
displaying bin data, you must implement market intelligence, as described in the
Oracle Marketing Implementation Guide.

Table A-1 summarizes the available bins.

Table A-1 Home Page Bins

Name

Description

Related Section

Campaign Effectiveness

Summarizes the total number of leads and
lead amount created against campaigns
during the period

Section A.1.1,
"Campaign
Effectiveness Bin"

Completed Web Surveys

Summarizes the total number of leads
added, invalid and went into lead import
from the web response point of view during
the period. Also calculates the change since
the last period.

Section A.1.2,
"Completed Web
Surveys Bin"

Event Effectiveness

Summarizes the total number of
registrations, leads and lead amount created
against events during the period

Section A.1.3, "Event
Effectiveness Bin"

Lead Import Statistics

Summarizes the total number of leads
added, valid, invalid and new from import
point of view during the period. It also
calculates the change since the last period.

Section A.1.4, "Lead
Import Statistics Bin"

Lead to Opportunity (Key Metrics)

Summarizes the Key Performance Indicators

Section A.1.5, "Lead

like Lead Coverage and Lead to Opportunity | to Opportunity Bin
from Lead Intelligence and other modules. (Key Metrics)"

Lead Quality Summarizes total number of leads by quality | Section A.1.6, "Lead
(rank) during the period. Also calculates the | Quality Bin"

change since the last period.

Lead Sources

Summarizes total number of leads by source
of origin during the period. Also calculates
the change since the last period.

Section A.1.7, "Lead
Sources Bin"

Marketing Activities

Summarizes the number of active marketing
activities for a given period

Section A.1.8,
"Marketing Activities
Bin"
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Table A-1 Home Page Bins

Name Description Related Section

Marketing Budgets Summarizes the amount of budget Section A.1.9,
committed, utilized and balance for a given | "Marketing Budgets
period Bin"

Response to Lead (Key Metrics) Summarizes the Key Performance Indicators | Section A.1.10,
from Oracle Marketing and other modules "Response to Lead

Bin (Key Metrics)"

Responses Summarizes the total number of responses Section A.1.10,
added and converted during the period. "Response to Lead
Also calculates the change since the last Bin (Key Metrics)"
period.

When you view the Home page bins, you can set different parameters. Table A-2
provides a comprehensive list of these parameters and their descriptions. A subset
of these parameters will be applicable to each bin.

Table A-2 Home Page Bins Parameters

Parameter Name | Description

Region Lists all Regions defined by geographic area Region (geographic area
location 2). User may choose a region or “All” for all Regions. Default
is set to “All".

Country Lists all Countries defined in geographic area Country. User may
choose a Country or “All’ for all Countries. Default is set to “All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU".
User can choose a business unit or ‘All” for all business units. Default
is set to ‘All’.
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Table A-2 Home Page Bins Parameters

Parameter Name

Description

Aggregate By

Data can be aggregated by period. The default period is Quarter.

= Month - Aggregates by Month defined in GL Calendar associated
with the profile option “AMS Marketing Calendar’.

= Quarter - Aggregates by Quarter defined in GL Calendar
associated with the profile option “AMS Marketing Calendar’.

= Year - Aggregates by Fiscal Year defined in GL Calendar
associated with the profile option “AMS Marketing Calendar’.

= Incremental (Day, Week, Month, Quarter, Year)

Aggregated as follows:

= Day is 24 hours prior to Last Refresh Date/Time.

= Wkis 7 days prior to Last Refresh Date/Time (Rolling 7 Days).
=  Mithis from start of current month to Last Refresh Date/Time.

= Qtris from start of current fiscal quarter to Last Refresh

Date/Time.

= Yris current fiscal quarter plus previous 3 fiscal quarters (Rolling
4 Quarters).

Examples:

= Day 9-Nov-02 to 10-Nov-02
» Wk 4-Nov-02 to 10-Nov-02
= Mth 1-Nov-02 to 10-Nov-02
s Qtr 1-Sep-02 to 10-Nov-02
= Yr 1-Dec-01 to 10-Nov-02
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Table A-2 Home Page Bins Parameters

Parameter Name

Description

Fixed Calculation
Period

Data can be aggregated by period. Default is Quarter.

Examples:

Daily - Last 24 hours (Last refresh date)

Weekly - Start of week to current date, up to 7 days. Week begins
on a Sunday.

Monthly - Start of month, up to 30 days.
Quarterly - Start of current quarter, up to current date.

Yearly - Start of current fiscal year, up to current date.

Daily 9-Nov-02 to 10-Nov-02
Weekly 4-Nov-02 to 10-Nov-02
Monthly 1-Nov-02 to 10-Nov-02
Quarterly 1-Sep-02 to 10-Nov-02
Yearly 1-Jun-02 to 10-Nov-02

Scale by

Scale the amount columns by user choice. Available options:

Units
Hundreds
Thousands
Millions

A.1.1 Campaign Effectiveness Bin

This bin summarizes the total number of Leads and Lead Amounts created against
Campaigns during the period. This bin comprises all leads except dead leads.
Table A-3 describes the columns of the Campaign Effectiveness bin.
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Table A-3 Campaign Effectiveness Bin Columns

Column Name

Description

Period

Period is displayed based on the option chosen in parameter
‘Aggregate by’. The period displayed is hyper linked to the
following drill down reports:

= Campaigns by Leads and Opportunities
= Campaigns by Activity

= Campaigns by Budget Amount

= Campaign to Order

The reports inherit the Bin parameters and their values. However,
the user has the choice of changing the parameters on the report.

Lead

Total number of leads created against the campaigns during the
period, excluding dead leads.

Lead Amount

The sum of Lead amount of all leads created against the campaign
during the period.

A.1.2 Completed Web Surveys Bin

This bin summarizes the web responses information for the period. Table A—4
describes the columns of this bin.

Table A-4 Completed Web Surveys Columns

Column Name

Description

Added

The total number of completed web surveys for the time period.

Invalid

The number of completed web surveys that are invalid.

To Lead Import

The number of completed web surveys that were passed to the lead
import engine.

The period displayed is hyperlinked to the following drill down reports:

s Completed Web Surveys by Region

= Completed Web Surveys by Campaign

= Invalid Web Surveys by Reason
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A.1.3 Event Effectiveness Bin

This bin summarizes the total number of Registrations, Leads and Lead Amounts
created against Events during the period. This bin summarizes all leads except dead
leads. Table A-5 describes the columns of this bin.

Table A-5 Event Effectiveness Columns

Column Name Description

Period Period is displayed based on the option chosen in parameter
‘Aggregate by’. The period displayed is hyperlinked to the following
drill down reports:

= Events by Leads and Opportunities
= Events by Event type

= Events by Budget Amount

= Events by Registrants

The reports inherit the Bin parameters and their values. However, the
user has the choice of changing the parameters on the report.

Registration Total number of registrations created against the events during the
period.

Lead Total number of leads created against the events during the period,
excluding dead leads.

Lead Amount The sum of Lead amount of all leads created against the events during
the period.

A.1.4 Lead Import Statistics Bin

This bin summarizes the lead import statistics during the period. Table A—6
describes the columns of this bin.

Table A-6 Lead Import Statistics Columns

Column Name Description

Added The total number of valid, invalid and new leads.

Valid The number of successfully imported leads.

Invalid The number of lead import failures.

New The total number of leads added to the import interface engine during
the period.
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The period displayed is hyperlinked to the following drill down reports:

s Lead Import Statistics by Region

s Lead Import Statistics by Campaign

s Invalid Leads by Reason

A.1.5 Lead to Opportunity Bin (Key Metrics)

This bin summarizes the Key Performance Indicators from Lead Intelligence and
other modules. Table A-7 describes the columns of this bin.

Table A-7 Lead to Opportunity Columns

Column Name

Description

Key Metrics

Key Metrics:
= Leads Assigned
= Lead to Opportunity

Each key metric is a hyperlink to drilldown detail reports specific to
each key metric. Lead Assignment drill down to the following reports:

= Conversion Rates by Sales Group
= Campaign Conversion Rates

The reports inherit the Bin parameters and their values. However, the
user has the choice of changing the parameters on the report.

Value

s Lead Coverage

For this key metric, the value is calculated as the total amount of
open leads in the system with how many are currently being
worked on. This is a percentage.

OPEN = status of OPEN only
Formula: (assigned/lead open)*100
= Lead to Opportunity

For this key metric, the value is calculated by dividing the
number of leads that have been converted to opportunities by the
total amount of leads in the system. This is a percentage.

Total # of Leads = all lead statuses minus dead leads
Formula: Converted /Total # of leads * 100
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Table A-7 Lead to Opportunity Columns

Column Name Description

Change s This column is the percentage representation of the difference
between the current Lead Assignment value and the Lead
Assignment value from the previous time aggregate.

s This column is the percentage representation of the difference
between the current Lead to Opportunity value and the Lead to
Opportunity value from the previous time aggregate.

Status The Status column is common across all Key Metrics. The indicator
arrow images mean the following:

Green Up indicates data increasing over the comparison period and
that for this attribute, an increase is good.

Green Down indicates data decreasing over the comparison period
and that for this attribute, the decrease is good.

Red Up indicates data increasing over the comparison period and for
this attribute, an increase is bad.

Red down indicates data decreasing over the comparison period and
that for this attribute, a decrease is bad.

Status
Indicators - - - - -
From
Prev Green | Green | Red Red
Column Period Up Down | Up Down

Leads Assigned | Increase X - - -

Leads Assigned | Decrease | - - - X
Lead to Increase X - - -
Opportunity

Lead to Decrease | - - - X
Opportunity

A.1.6 Lead Quality Bin

This bin summarizes the total number of leads created per rank during the period.
Table A-8 describes the columns of this bin.
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Table A-8 Lead Quality Bin Columns

Column Name Description

First Defined Rank | The A, B, and C columns of this bin are defined at:
Administration, Marketing > Setup > Code Definition, Object Type
Rank.

Second Defined N/A

Rank

Third Defined N/A

Rank

Others These are leads belonging to ranks not shown in the first three
columns.

Total Total leads by all ranks during the period.

The period displayed is hyperlinked to the following drill down reports:
= Lead Quality by Region

= Lead Quality by Campaign

s Lead Quality by Status

A.1.7 Lead Sources Bin

This bin summarizes the total number of leads created per source during the period.
Table A-9 describes the columns of this bin.

Table A-9 Lead Sources Columns

Column Name Description

First Defined The A, B, and C columns of this bin are defined at:

Source Administration > Marketing > Setup > Code Definition, Object Type
Source.

Second Defined N/A

Source

Third Defined N/A

Source

Others Leads belonging sources not shown in the first three columns.

Total Total leads by all sources during the period.
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The period displayed is hyperlinked to the following drill down reports:

= Lead Source by Region

= Lead Source by Campaign

= Lead Source by Status

A.1.8 Marketing Activities Bin

This bin summarizes the number of active marketing activities for a given period.
Table A-10 describes the columns of this bin.

Table A-10 Marketing Activities Columns

Column Name

Description

Period

Period is displayed based on the option chosen in parameter
‘Aggregate by’.

Count

The number of active marketing activities at the start of the period.

Started

The number of marketing activities activated during the period.

Ended

The number of marketing activities that ended during the period.

Change

The change from previous value to current value. Formula: ((Current -
Previous) / Previous) * 100

A.1.9 Marketing Budgets Bin

This bin summarizes the amount of Budget committed, utilized and balance for a
given period. Note that only those budgets, which are active during the given time
period, are considered for calculating these figures. For example, a budget is active
for a period of 3 months starting from "01-Mar-2001" to '31-May-2001". This budget
is considered for calculating the total committed, utilized and balance amounts only
for months of March, April and May 2001. Table A-11 describes the columns of this

bin.
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Table A-11 Marketing Budgets Columns

Column Name

Description

Period

Period is displayed based on the option chosen in parameter
‘Aggregate by’. The period displayed is hyperlinked to the following
drill down reports:

= Budgets by Utilization

= Budgets by Activity

= Budgets by Campaign

= Budgets by Business Unit

The reports inherit the Bin parameters and their values. However, the
user has the choice of changing the parameters on the report.

Committed

The sum of all the budget commitments or approvals made during the
period.

Utilized

The sum of all the budgets utilization occurred during the period.
Budget utilization is recorded only the Actual costs are posted to
Budgets.

Balance

The sum of the balance of all the budgets which are active during the
period.

Note:

When budget facts are loaded, the program will consider

pre approval transactions. When pre approval transactions are
considered, there may be time periods for which there is no data.
The summarized data may not have information in the comparative
period and thus may not be able to display a positive or negative
value in the form of an arrow.
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A.1.10 Response to Lead Bin (Key Metrics)

This bin summarizes the Key Performance Indicators from Oracle Marketing and
other modules. Table A-12 describes the columns of this bin.

Table A-12 Response to Lead Columns

Column Name Description
Key Metrics Key Metrics:
» Leads

s ‘A’ Lead Ratio
s Cost per Lead
= Revenue per Lead

Each key metric is a hyperlink to drill-down detail reports specific to
each key metric. Currently Leads and ‘A’ Lead Ratio drill down to the
following reports and charts.

Reports:

= Campaign Cost and Revenue and ROI
= Event Cost and Revenue and ROI

= Campaign to Order

The reports do not inherit the bin parameters. However, the user has
the choice of changing the parameters on the report.

Chart:
s Leads and Cost Per Lead

Cost per Lead and Revenue per Lead drill down to the following
reports:

= Campaign Cost and Revenue
= Event Cost and Revenue

The reports inherit the Bin parameters and their values. However, the
user has the choice of changing the parameters on the report.
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Table A-12 Response to Lead Columns

Column Name

Description

Value

Leads Shows the total amount of all leads, except dead leads,
during the period.

'A’ Lead Ratio Shows the percentage of 'A’ (top) quality leads of
all leads during the period. (This is all leads except dead leads.)
The Value is calculated by dividing the number of all 'A" quality
leads during the period by the total number of leads.

Cost per Lead Shows the budgetary cost of generating all leads
during the period. The Value is calculated by dividing the budget
of all current Campaign and Events during the period by the total
number of leads. Equally allocated per “active” day.

Revenue per Lead shows the booked revenue ratio as a result of
all leads that were generated during the period. The Value is
calculated by dividing the booked revenue associated with all
leads during the period by the total number of leads.

Change

Leads: The Change is calculated by comparing the total number
of leads for the current period with the total number of leads for
the previous refresh period. E.g. if on October 1 there were 1,000
leads and on November 1 there were 1,200, to get the % Change,
take ((1,200 - 1,000)/1,000) * 100. The negative(-) or positive (+)
signs indicate if the change is up or down from the previous
period.

'A’ Lead Ratio: The Change is calculated by comparing the 'A’
quality lead ratio for the current period with the 'A’ quality lead
ratio for the previous refresh period.

Cost per Lead: The Change is calculated by comparing the cost
per lead ratio for the current period with the cost per lead ratio
for the previous refresh period.

Revenue per Lead: The Change is calculated by comparing the
revenue per lead for the current period with the revenue per lead
for the previous refresh period.
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Table A-12 Response to Lead Columns

Column Name Description
Status The Status column is common across all Key Metrics. The indicator
arrow images mean the following:
= Green Up - Indicates data increasing over the comparison period
and that for this attribute, an increase is good.
= Green Down - Indicates data decreasing over the comparison
period and that for this attribute, a decrease is good.
= Red Up - Indicates data increasing over the comparison period
and that for this attribute, an increase is bad.
= Red Down - Indicates data decreasing over the comparison
period and that for this attribute, a decrease is bad.
Status by
Column - - - - -
From
Prev Green | Green | Red Red
Column Period Up Down | Up Down
Leads Increase | X - - -
Leads Decrease | - - - X
A Leads Increase | X - - -
A Leads Decrease | - - - X
Cost/Lead Increase | - - X -
Cost/Lead Decrease | - X - -
Revenue/Lead Increase | X - - -
Revenue/Lead Decrease | - - - X

A.2 Home Page Reports

This section presents a detailed listing of the reports available in Oracle Marketing.
Reports are displayed on the Oracle Marketing home page. Prior to displaying
Report data, marketing intelligence must be implemented, as described in the Oracle
Marketing Implementation Guide.

Table A-13 lists the Marketing Intelligence reports that can be displayed on the
Oracle Marketing Home page:
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Table A-13 Home Page Marketing Intelligence Reports

Report Name

Description

Related Section

Budget Utilization (Budget by total
amount)

Summarizes budget utilization
information

Section A.2.1, "Budget
Utilization Report (Budget
by Total Amount)"

Budgets by Activity

Summarizes budget information per
activity

Section A.2.2, "Budgets by
Activity Report”

Budgets by Business Unit

Summarizes budget information per
business unit

Section A.2.3, "Budgets by
Business Unit Report"

Budgets by Campaign

Summarizes budget information per
campaign

Section A.2.4, "Budgets by
Campaign Report"

Campaign Cost and Revenue

Summarizes costs and revenues per
campaign

Section A.2.6, "Campaign
Cost and Revenue Report"

Campaign Cost, Revenue, and ROI

Summarizes costs, revenues, and return

Section A.2.7, "Campaign

on investments per campaign Cost, Revenue, and ROI
Report”
Campaign to Order Summarizes order information per Section A.2.8, "Campaign to
campaign Order Report"
Campaigns by Activity Summarizes campaign information per | Section A.2.9, "Campaigns
activity by Activity Report"
Activities by Campaign Summarizes activity information per Section A.2.10, "Activities by
campaign Campaign Report"
Marketing Activities Summarizes marketing activities Section A.2.11, "Marketing

information per activity

Activities Report"

Campaign Budget Amount by
Activity Type

Summarizes budget information per
Activity Type

Section A.2.12, "Campaign
Budget Amount by Activity
Type Report"

Campaigns by Leads and
Opportunities

Summarizes lead and opportunity
information per campaign

Section A.2.13, "Campaigns
by Leads and Opportunities
Report"

Event Cost and Revenue

Summarizes costs and revenues per
event

Section A.2.17, "Event Cost
and Revenue Report"

Event Cost, Revenue, and ROI

Summarizes costs, revenues, and return
on investments per event

Section A.2.18, "Event Cost,
Revenue and ROI Report”

Events by Budget Amount

Summarizes budget information per
event

Section A.2.19, "Events by
Budget Amount Report"
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Table A-13 Home Page Marketing Intelligence Reports

Report Name

Description

Related Section

Events by Event Type Summarizes budget and event Section A.2.20, "Events by
information per Event Type Event Type Report"

Events by Leads and Opportunities Summarizes lead and opportunity Section A.2.21, "Leads by
information per event Opportunity Report"

Events by Registrants Summarizes registration information Section A.2.22, "Events by
per event Registrants Report"

Responses by Activity Summarizes Interaction History Section A.2.37, "Responses
responses information by Activity by Activity Report"

Responses by Campaign Summarizes Interaction History Section A.2.38, "Responses

responses information by campaign

by Campaign Report"

Table A-14 lists the Leads Intelligence Reports that can be displayed on the Oracle
Marketing Home page:

Table A-14 Home Page Leads Intelligence Reports

Report Name

Description

Related Section

Campaign Conversion Rates

Summarizes lead conversion rate
information by campaign

Section A.2.5, "Campaign
Conversion Rate Report"

Conversion Rates by Sales Group

Summarizes lead conversion rate

Section A.2.16, "Conversion

information by sales group Rates by Sales Group
Report”
Invalid Leads by Reason Summarizes invalid leads by reason Section A.2.23, "Invalid
Leads by Reason Report"

Invalid Web Surveys by Reason

Summarizes invalid Web survey
information by reason

Section A.2.24, "Invalid Web
Surveys by Reason Report”

Lead Aging by Quality

Summarizes leads information based on
lead age by sales rank

Section A.2.25, "Lead Aging
by Quality Reports”

Lead Aging by Sales Group

Summarizes leads information based on
lead age by sales group

Section A.2.26, "Lead Aging
by Sales Group Report"

Lead Assignment and Conversion by

Sales Group

Summarizes lead assignment and
conversion information by sales group

Section A.2.27, "Lead
Assignment and Conversion
by Sales Group Reports"

Lead Import Statistics by Campaign

Summarizes lead import statistics by
campaign

Section A.2.28, "Lead Import
Statistics by Campaign
Report"
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Table A-14 Home Page Leads Intelligence Reports

Report Name

Description

Related Section

Lead Import Statistics by Region

Summarizes lead import statistics by
region

Section A.2.29, "Lead Import
Statistics by Region Report"

Lead Quality by Campaign

Summarizes leads by rank per

Section A.2.30, "Lead

campaign Quality by Campaign
Report"
Lead Quality by Region Summarizes leads by rank per region Section A.2.31, "Lead
Quality by Region Report"
Lead Quality by Status Summarizes leads by rank per status Section A.2.32, "Lead

Quality by Status Report"

Lead Sources by Campaign

Summarizes leads by source per

campaign

Section A.2.33, "Lead
Sources by Campaign
Report”

Lead Sources by Region

Summarizes leads by source per region

Section A.2.34, "Lead
Sources by Region Report"

Lead Sources by Status

Summarizes leads by source per status

Section A.2.35, "Lead
Sources by Status Report”

Lead Status by Campaign

Summarizes leads by status per
campaign

Section A.2.36, "Lead Status
by Campaign Report"
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Table A-15 lists and describes the parameters that can be set for Home page reports.

Table A-15 Home Page Reports Parameters

Parameter Name | Description Remarks

Region Lists all Regions defined by geographic area Region Applicable to all reports.
(geographic area location 2). User may choose a region or ‘All’
for all Regions. Default is set to “All’.

Country Lists all Countries defined in geographic area Country. User Applicable to all reports.

may choose a Country or “All’ for all Countries. Default is set

Business Unit

to “‘All’.
Lists all business units defined in HR Organizations with type | Not applicable to the
‘BU’". User can choose a business unit or “All” for all business following reports:
units. Default is set to “All’. «  Invalid Leads by
Reason
= Lead Import
Statistics by
Campaign
= Lead Import
Statistics by Region
s Lead Quality by
Campaign
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Table A-15 Home Page Reports Parameters

Parameter Name

Description

Remarks

Scale by

Scale the amount columns by user choice. Available options:

Units
Hundreds
Thousands
Millions

Applicable to all reports.

Fixed Calculation
Period

Data can be aggregated by period. Default is Quarter.
Daily - Last 24 hours (Last refresh date)

Weekly - Start of week to current date, up to 7 days. Week
begins on a Sunday.

Monthly - Start of month, up to 30 days.
Quarterly - Start of current quarter, up to current date.

Yearly - Start of current fiscal year, up to current date.

Examples:

Daily 9-Nov-02 to 10-Nov-02
Weekly 4-Nov-02 to 10-Nov-02

Applicable to the
following reports:

Campaign by
Conversion Rate

Campaign Cost and
Revenue

Conversion Rates
by Sales Groups

Event Cost and
Revenue

Lead Assignment
and Conversion by

= Monthly 1-Nov-02 to 10-Nov-02 Sales Group
= Quarterly 1-Sep-02 to 10-Nov-02
= Yearly 1-Jun-02 to 10-Nov-02
Period Data can be aggregated by period. Default is Current Quarter. | Applicable to the
For campaigns, lists of all fiscal years and all quarters are following reports:
available. s Campaign Cost,
For Events, lists of 4 fiscal years and 16 quarters are available. Revenue and RO
= Event Cost,
Revenue and ROI

A.2.1 Budget Utilization Report (Budget by Total Amount)

This report summarizes Budget utilization information. Table A-16 describes the
columns of this report.

Table A-16 Budget Utilization Columns

Column Name Description

Budget Name Budget name
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Table A-16 Budget Utilization Columns

Column Name

Description

Total This represent total budget minus holdback.

Planned Sum of planned amount. Planned amount is any amount for which
new campaigns or offers are in Waiting or Approval stage.

Committed Sum of committed amount. Committed amount is any amount for
campaigns with an Approval status.

Utilized Sum of the amount of total budget earned or used.

Balance Sum of the amount of funds available for further activity. Balance =
Budget — Committed

Paid Sum of paid amount. Paid amount is the total paid on the promotion,
amounts deducted on the face of the invoice, rendered checks and
submitted credit memos.

Category A category in which the budget falls.

A.2.2 Budgets by Activity Report

This report summarizes Budget information per Activity. Table A-17 describes the
columns of this report.

Table A-17 Budget by Activity Columns

Column Name

Description

Activity Activity name.

Number of The number of budgets currently opened for this Activity.

Budgets

Approved Budget | The total budget amount allocated to the Activity by approved budget
Amount lines

Awaiting The total budget amount is the combined total amount for Pending
Approval Budget | and Planned for the Activity.

Amount

A.2.3 Budgets by Business Unit Report

This report summarizes Budget information per Business Unit. Table A-18
describes the columns of this report.
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Table A-18 Budget by Business Unit Columns

Column Name

Description

Business Unit

Business Unit name.

Number of The number of budgets currently opened for this business unit.

Budgets

Total This represent total budget.

Planned Sum of planned amount. Planned amount is any amount for which
new campaigns or offers are in Waiting or Approval stage.

Committed Sum of committed amount. Committed amount is any amount for
campaigns with an Approval status.

Utilized Sum of the amount of total budget earned or used.

Paid Sum of paid amount. Paid amount is the total paid on the promotion,

amounts deducted on the face of the invoice, rendered checks and
submitted credit memos.

A.2.4 Budgets by Campaign Report

This report summarizes Budget information per Campaign. Table A-19 describes
the columns of this report.

Table A-19 Budgets by Campaign Column

Column Name

Description

Campaign Name

Campaign name.

Number of The number of budgets currently opened for this Campaign.

Budgets

Approved Budget | The total budget amount allocated to the Activity by approved budget
Amount lines.

Awaiting The total budget amount is the combined total amount for Pending
Approval Budget | and Planned for the Activity.

Amount

A.2.5 Campaign Conversion Rate Report

This report summarizes the rate of lead conversion to opportunities, quotes and
orders by sales group. Table A—20 describes the columns of this report.
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Table A-20 Campaign Conversion Rate Columns

Column Name

Description

Campaign Campaign Name.

Total Leads Sum of total leads during the period.

Open Leads Sum of open leads during the period.

% Converted The number of opportunities divided by total leads multiplied by 100.
Leads

Total Sum of total opportunities during the period.

Opportunities

Open Sum of open opportunities during the period.

Opportunities

Converted to

The number of quotes divided by total opportunities multiplied by

Quotes 100.
Total Quotes Sum of total quotes during the period.
Open Quotes Sum of open quotes during the period.

Converted to
Orders %

The number of orders divided by total quotes multiplied by 100.

A.2.6 Campaign Cost and Revenue Report

This report summarizes Costs and Revenues per Campaign. Table A-21 describes
the columns of this report.

Table A-21 Campaign Cost and Revenue Columns

Column Name Description
Campaign Campaign Name.
Total Cost Period-to-date cost which is the cumulative amount of the approved

budget for the period.

Total Revenue

Period-to-date revenue which is the cumulative amount of revenue
for the period. This is booked order in the CRM schema for actual
revenue.

Response Count

The sum of positive responses for the period.

Cost Per Response

Total approved budget amount for the campaigns for the activity
divided by the number of cumulative responses.
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Table A-21 Campaign Cost and Revenue Columns

Column Name

Description

Revenue Per

The sum of the revenue for that period divided by the number of

Response responses for that period.

Response Lead Total number of leads created against the campaigns during the
Count period. This excludes dead leads.

Cost per Lead The sum of Period-to-date cost divided by the sum of lead count.

Revenue per Lead

The sum of the revenue for that period divided by the sum of leads
for that period.

Order Count

The number of booked orders.

Cost per Order

The total booked order amount divided by the number of orders
booked.

Revenue per
Order

The sum of the revenue for that period divided by the sum of orders
for that period.

A.2.7 Campaign Cost, Revenue, and ROI Report

This report summarizes Costs, Revenues and Return on Investments per Campaign.
Table A-22 describes the columns of this report.

Table A-22 Campaign Cost, Revenue, ROl Columns

Column Name

Description

Campaign

Campaign name.

Actual Cost

Summarized schedule costs and its parent object’s costs.

Forecasted Cost

From Metrics value. Summarize schedule cost and the parent cost.

Cost Variance

((actual — forecast) / forecast) * 100

Actual Revenue

Booked order amount in Quoting/Order Capture.

Forecasted
Revenue

From Metrics value. Summarize schedule revenue and the parent
revenue.

Revenue Variance

((actual - forecast) / forecast) * 100

Actual ROI ((actual revenue - actual cost) / actual cost) * 100
Forecasted ROI ((forecast revenue - forecast cost) / forecast cost) * 100
ROI Variance ((actual - forecast) / forecast) * 100
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A.2.8 Campaign to Order Report

This report summarizes Order information per Campaign. Table A-23 describes the
columns of this report.

Table A-23 Campaign to Order Columns

Column Name

Description

Campaign Name

Campaign name.

Total Responses

Sum of responses, collected in Interaction History, based on the
aggregate.

Converted to
Leads

Sum of responses converted to a lead based on aggregate.

((open + closed leads) / total responses) * 100

Open Leads Total number of leads created against the campaigns which are open
during the period.
Close Leads Sum of Leads closed based on aggregate. All closed leads regardless

of qualified /unqualified.

Converted to
Orders

Sum of Leads converted to orders based on aggregate.

((total orders of all statuses) / (open + closed leads)) * 100

Orders Booked

The dollar amount of the sum of orders booked based on the
aggregate.

A.2.9 Campaigns by Activity Report

This report summarizes Campaign information per Activity. Table A—24 describes
the columns of this report.

Table A-24 Campaigns to Activity Columns

Column Name

Description

Activity Activity name.

Count This is the number of Campaigns associated to this activity during the
period.

Target Audience The total target audience for this Activity during the period.

Lead Total number of leads created against the campaigns during the

period, excluding dead leads.

Lead Amount

The sum of lead amount of all leads created against the campaigns
during the period.
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Table A-24 Campaigns to Activity Columns

Column Name

Description

Opportunities

Total number of opportunities created against the campaigns during
the period.

Opportunity
Amount

The sum of opportunity amount of all opportunities created against
the campaigns during the period.

A.2.10 Activities by Campaign Report

This report summarizes activities information per campaign. Table A-25 describes
the columns of this report.

Table A-25 Activities by Campaign Columns

Column Name

Description

Campaign

Campaign name.

Active Schedules
Count

The number of campaign schedules associated to this campaign
during the period.

Active Schedules
Total Cost

The total budget amount currently assigned to this campaign.

Target Audience

The number of target group entries (combination of List, Segment,
and Employee List) associated with this campaign.

Forecasted
Responses

The number of responses forecasted for the campaign.

Forecasted
Response Rate

(forecasted responses/targeted customers)*100.

A.2.11 Marketing Activities Report

This report summarizes marketing activities information per activity. Table A-26
describes the columns of this report.

Table A-26 Marketing Activities Report Columns

Column Name

Description

Activity

Activity name.

Number of
Campaigns

This is the number of campaigns associated to this activity during the
period.
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Table A-26 Marketing Activities Report Columns

Column Name

Description

Response Rate

Active Schedules | The number of campaign schedules associated to this activity during
Count the period
Active Schedules | The percentage increase or decrease in the number of active schedules
% Change as compared to the previous period.
((Current schedule count - previous schedule count)/previous
schedule count)*100
Active Schedules | The total budget amount currently assigned to this activity.
Total Cost
Target Audience The number of target group entries (combination of List, Segment,
Count and Employee List) associated with this Activity Type.
Target Audience % | The percentage increase or decrease in the number of target group
Change entries as compared to the previous period.
((Current target audience count - previous target audience
count)/previous target audience count)*100
Forecasted The number of responses forecasted for the activity.
Responses
Forecasted (forecasted responses/targeted customers)*100

A.2.12 Campaign Budget Amount by Activity Type Report

This report summarizes Budget information per Activity Type. Table A-27 describes
the columns of this report.

Table A-27 Campaigns by Budget Amount by Activity Type Columns

Column Name

Description

Campaign Name

Campaign name.

Activity Type

Activity Type name.

Activity

Activity name.

Business Unit

Business Unit name.

Approved Budget
Amount

The total budget amount allocated to the Activity by approved budget
lines.
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Table A-27 Campaigns by Budget Amount by Activity Type Columns

Column Name

Description

Awaiting
Approval Budget
Amount

The total budget amount is the combined total amount for Pending
and Planned for the Activity.

A.2.13 Campaigns by Leads and Opportunities Report

This report summarizes Lead and Opportunity information per Campaign.
Table A-28 describes the columns of this report.

Table A-28 Campaigns by Leads and Opportunities Columns

Column Name

Description

Campaign Name

Campaign name.

Targeted The total target audience for this Activity during the period.
Customers
Lead Total number of leads created against the campaigns during the

period, excluding dead leads.

Lead Amount

The sum of Lead amount of all leads created against the campaigns
during the period.

Opportunities Total number of opportunities created against the campaigns during
the period.

Opportunity The sum of opportunity amount of all opportunities created against

Amount the campaigns during the period.

A.2.14 Completed Web Surveys by Campaign Report

This report summarizes web surveys information by campaign. Table A-29
describes the columns of this report.

Table A-29 Completed Web Surveys Columns

Column Name

Description

Campaign Name of the campaign.
First Defined The A, B and C columns of this report are defined at:
Grade Administration > Marketing > Setup > Code Definition, Object Type:

Grade.
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Table A-29 Completed Web Surveys Columns

Column Name Description

Second Defined N/A

Grade

Third Defined N/A

Grade

Others Total of remaining grades during the period.
Total Total number of web surveys during the period.

A.2.15 Completed Web Surveys by Region Reports

This report summarizes web surveys information by region. Table A-30 describes
the columns of this report.

Table A-30 Completed Web Surveys Columns

Column Name Description

Region Name of the region.

First Defined The A, B and C columns of this report are defined at:

Grade Administration > Marketing > Setup > Code Definition, Object Type:
Grade.

Second Defined N/A

Grade

Third Defined N/A

Grade

Others Total of remaining web surveys during the period.

Total Total number of web surveys during the period.

A.2.16 Conversion Rates by Sales Group Report

This report summarizes rate of lead conversion to opportunities, quotes and orders
by sales group. Table A-31 describes the columns of this report.

Table A-31 Conversion Rates by Sales Group Columns

Column Name Description
Sales Group Name of the Sales Group.
Total Count Sum of total leads corresponds to that sales group during the period.
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Table A-31 Conversion Rates by Sales Group Columns

Column Name Description

Opportunities Total leads converted to opportunities during the period.

Quotes Total leads converted to Quotes during the period.

Lead to The number of opportunities divided by total leads multiplied by 100.

Opportunities %

Opportunities to The number of quotes divided by total opportunities multiplied by
Quotes % 100.

Quotes to Orders | The number of orders divided by total quotes multiplied by 100.
%
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A.2.17 Event Cost and Revenue Report

This report summarizes Costs and Revenues per event. Table A-32 describes the
columns of this report.

Table A-32 Event Cost and Revenue Report Columns

Column Name Description
Event Event Name
Total Cost Period-to-date cost which is the cumulative amount of the approved

budget for the period.

Total Revenue

Period-to-date revenue which is the cumulative amount of revenue
for the period. This is booked order in the CRM schema for actual
revenue.

Registration Count

The sum of registrations for the period.

Cost per
Registration

Total approved budget amount for the events for the activity divided
by the number of cumulative registrations.

Revenue per

The sum of the revenue for that period divided by the sum of

Registration registrations for that period.

Lead Count Total number of leads created against the campaigns during the
period, excluding dead leads.

Cost per Lead The sum of Period-to-date costs divided by the sum of Lead Count.

Revenue per Lead

The sum of the revenue for that period divided by the sum of leads
for that period.

Order Count

The number of booked orders.

Cost Per Order

The total booked order amount divided by the numbers of orders
booked.

Revenue per
Order

The sum of the revenue for that period divided by the sum of orders
for that period.

A.2.18 Event Cost, Revenue and ROl Report

This report summarizes Costs, Revenues and Return on Investments per Event.
Table A-33 describes the columns of this report.

Table A-33 Event Cost, Revenue and ROI Report Columns

Column Name

Description

Actual Cost

Summarized schedule costs and its parent object’s costs.
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Table A-33 Event Cost, Revenue and ROI Report Columns

Column Name Description

Forecasted Cost From Metrics value. Summarize schedule cost and the parent cost.
Cost Variance ((actual - forecast) / forecast) * 100

Actual Revenue Booked order amount in Oracle Quoting.

Forecasted From Metrics value. Summarize schedule revenue and the parent
Revenue revenue.

Revenue Variance | ((actual - forecast) / forecast) * 100

Actual ROI ((actual revenue - actual cost) / actual cost) * 100
Forecasted ROI ((forecast revenue - forecast cost) / forecast cost) * 100
ROI Variance ((actual - forecast) / forecast) * 100

A.2.19 Events by Budget Amount Report

This report summarizes Budget information per Event. Table A-34 describes the
columns of this report.

Table A-34 Events by Budget Amount Columns

Column Name Description

Event Event name.

Type Event Type name.
Business Unit Business Unit name.

Approved Budget | The total budget amount allocated to the Event by approved budget

Amount lines.

Awaiting The total budget amount is the combined total amount for Pending
Approval Budget | and Planned for the Event.

Amount
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A.2.20 Events by Event Type Report

This report summarizes Budget and Event information per Event Type. Table A-35
describes the columns of this report.

Table A-35 Events by Event Type Columns

Column Type Description

Event Type Event Type name.

Number of Events | The number of Events associated with this Event Type.

Approved Budget | The total budget amount allocated to the Event by approved budget
Amount lines.

Awaiting The total budget amount is the combined total amount for Pending
Approval Budget | and Planned for the Event.

Amount

Registrants The sum number of registrations for this event type for the period.
Attendees The sum number of attendees for this event type for the period.
Cancellations The sum number of cancellations for this event type for the period.

A.2.21 Leads by Opportunity Report

This report summarizes Leads and Opportunities information per Event.
Table A-36 describes the columns of this report.

Table A-36 Leads by Opportunity Columns

Column Name

Description

Event

Event name.

Leads

Total number of leads created against the campaigns during the
period, excluding dead leads.

Lead Amount

The sum of Lead amount of all leads created against the campaigns
during the period.

Opportunities Total number of opportunities created against the campaigns during
the period.

Opportunity The sum of opportunity amount of all opportunities created against

Amount the campaigns during the period.
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A.2.22 Events by Registrants Report

This report summarizes Registration information per Event. Table A-37 describes

the columns of this report.

Table A-37 Events by Registrants Columns

Column Name

Description

Event Name

Event name.

Registrants The sum number of registrations for this event type for the period.
Attendees The sum number of attendees for this event type for the period.
Cancellations The sum number of cancellations for this event type for the period.

A.2.23 Invalid Leads by Reason Report

This report summarizes invalid leads by reason. Table A-38 describes the columns

of this report.

Table A-38 Invalid Leads by Reason Columns

Column Name

Description

Reason

Reason for failure.

Invalid

Total leads which failed to import during the period.

A.2.24 Invalid Web Surveys by Reason Report

This report summarizes invalid web surveys by region. Table A-39 describes the
columns of this report.

Table A-39 Invalid Web Surveys by Reason Columns

Column Name

Description

Reason

Reason for failure.

Invalid

Total number of web surveys which failed to import.

A-34 Oracle Marketing User Guide




Home Page Reports

A.2.25 Lead Aging by Quality Reports

This report summarizes leads by aging by rank. Table A—40 describes the columns
of this report.

Table A-40 Leads Aging by Quality Reports Columns

Column Name Description
Rank Name of the Sales Rank
0-1 Leads generated from 0 to 1 day from the last refresh date.
2-3 Leads generated between 2 and 3 days from the last refresh date.
3-7 Leads generated between 3 and 7 days from the last refresh date.
8-14 Leads generated between 8 and 14 days from the last refresh date.
15-21 Leads generated between 15 and 21 days from the last refresh date.
22-28 Leads generated between 22 and 28 days from the last refresh date.
29-35 Leads generated between 29 and 35 days from the last refresh date.
36-42 Leads generated between 36 and 42 days from the last refresh date.
> 43 Leads generated 43 days and beyond from the last refresh date.
Total Total leads generated since the last refresh date.

Parameters

None

A.2.26 Lead Aging by Sales Group Report

This report summarizes leads by aging by sales group. Table A—41 describes the
columns of this report.

Table A-41 Leads Aging by Sales Group Columns

Column Name Description

Sales Group Name of the Sales Group.

0-1 Leads generated from 0 to 1 day from the last refresh date.

2-3 Leads generated between 2 and 3 days from the last refresh date.
3-7 Leads generated between 3 and 7 days from the last refresh date.
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Table A-41 Leads Aging by Sales Group Columns

Column Name Description
8-14 Leads generated between 8 and 14 days from the last refresh date.
15-21 Leads generated between 15 and 21 days from the last refresh date.
22-28 Leads generated between 22 and 28 days from the last refresh date.
29-35 Leads generated between 29 and 35 days from the last refresh date.
36-42 Leads generated between 36 and 42 days from the last refresh date.
> 43 Leads generated 43 days and beyond from the last refresh date.
Total Total leads generated since the last refresh date.

Parameters

None

A.2.27 Lead Assignment and Conversion by Sales Group Reports

This report summarizes lead assignment and conversion by sales group. Table A—42
describes the columns of this report.

Table A-42 Lead Assignment and Conversion by Sales Group Columns

Column Name

Description

Sales Group Name of the Sales Group.

Total Count Sum of total leads corresponds to that sales group during the period.

Changed Count Total number of assigned leads that are actually updated by sales rep
during the period.

Changed % The number of changed leads divided by assigned leads multiplied by
100.

Unchanged Count | Total leads that are assigned but not updated by sale rep during the
period.

Unchanged % The number of unchanged leads divided by assigned leads multiplied
by 100.

Open Leads Total leads in open status during the period.

Dead Leads Total leads in dead status during the period.

Converted to
Opportunities

Total leads converted to opportunities during the period.
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Table A-42 Lead Assignment and Conversion by Sales Group Columns

Column Name Description

Converted to The number of opportunities divided by total leads multiple by 100.
Opportunities %

A.2.28 Lead Import Statistics by Campaign Report

This report summarizes lead import statistics by campaign. Table A—43 describes
the columns of this report.

Table A-43 Lead Import Statistics by Campaign Columns

Column Name Description

Campaign Name of the campaign.

Added Total of valid, invalid and new leads.

Valid Total leads imported successfully during the period.
Invalid Total lead import failures during the period.

New Total Leads imported during the period.

A.2.29 Lead Import Statistics by Region Report

This report summarizes lead import statistics by region. Table A—44 describes the
columns of this report.

Table A-44 Lead Import Statistics by Region Columns

Column Name Description

Region Name of the Region.

Added Total of valid, invalid and new leads.

Valid Total leads imported successfully during the period.
Invalid Total lead import failures during the period.

New Total Leads imported during the period.

A.2.30 Lead Quality by Campaign Report

This report summarizes leads by rank by campaign. Table A-45 describes the
columns of this report.
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Table A-45 Lead Quality by Campaign Columns

Column Name Description

Campaign Name of the Campaign

First Defined Rank | The A, B and C columns of this report are defined at:
Administration > Marketing > Setup > Code Definition, Object Type
Rank.

Second Defined N/A

Rank

Third Defined N/A

Rank

Others The total of the leads in the remaining ranks.

Total Total leads by all ranks during the period.

A.2.31 Lead Quality by Region Report

This report summarizes leads by rank by region. Table A—46 describes the columns

of this report.
Table A-46 Lead Quality by Region Columns
Column Name Description
Region Name of the Region.
First Defined Rank | The A, B and C columns of this report are defined at:
Administration > Marketing > Setup > Code Definition, Object Type
Rank.
Second Defined N/A
Rank
Third Defined N/A
Rank
Others The total of the leads in the remaining ranks
Total Total leads by all ranks during the period.

A.2.32 Lead Quality by Status Report

This report summarizes leads by rank by status. Table A—47 describes the columns
of this report.
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Table A-47 Lead Quality by Status Columns

Column Name

Description

Status Name of the Status

Status Flag Flag to determine if the status is yes or no.

First Defined Rank | The A, B and C columns of this report are defined at:
Administration > Marketing > Setup > Code Definition, Object Type
Rank.

Second Defined N/A

Rank

Third Defined N/A

Rank

Others The total of the leads in the remaining ranks.

Total Total leads by all ranks during the period.

A.2.33 Lead Sources by Campaign Report

This report summarizes leads by source then by campaign. Table A—48 describes the
columns of this report.

Table A-48 Lead Sources by Campaign Columns

Column Name

Description

Campaign Name of the Campaign.

First Defined The A, B and C columns of this report are defined at:

Source Administration > Marketing > Setup > Code Definition, Object Type
Source.

Second Defined N/A

Source

Third Defined N/A

Source

Others The total of the leads from the remaining sources.

Total Total leads by all sources during the period.

A.2.34 Lead Sources by Region Report

This report summarizes leads by source by region. Table A-49 describes the
columns of this report.
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Table A-49 Lead Sources by Region Columns

Column Name Description

Region Name of the Region

First Defined The A, B and C columns of this report are defined at:

Source Administration > Marketing > Setup > Code Definition, Object Type
Source.

Second Defined N/A

Source

Third Defined N/A

Source

Others The total of the leads from the remaining sources.

Total Total leads by all sources during the period.

A.2.35 Lead Sources by Status Report

This report summarizes leads by source and then by status. Table A-50 describes
the columns of this report.

Table A-50 Lead Sources by Status Report Columns

Column Name

Description

Status Name of the Status.

Open Flag top determine if the status is yes or no.

First Defined The A, B and C columns of this report are defined at:

Source Administration > Marketing > Setup > Code Definition, Object Type
Rank.

Second Defined N/A

Source

Third Defined N/A

Source

Others The total of the leads from the remaining sources.

Total Total leads by all sources during the period.
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A.2.36 Lead Status by Campaign Report

This report summarizes leads by status then by campaign. Table A-51 describes the
columns of this report.

Table A-51 Lead Status by Campaign Report Columns

Column Name Description

Campaign Name of the Campaign.

First Defined The A, B and C columns of this report are defined at:

Status Administration > Marketing > Setup > Code Definition, Object Type
Status.

Second Defined N/A

Status

Third Defined N/A

Status

Others The total of the leads from the remaining statuses.

Total Total leads by all statuses during the period.

A.2.37 Responses by Activity Report

This report summarizes response information by activity. Table A-52 describes the
columns of this report.

Table A-52 Responses by Activity Columns

Column Name Description

Activity Activity Name.

Number of Total number of campaigns belonging to that activity during the
Campaigns period.

Target Audience

Total targeted audience for this activity during the period.

Responses Added

Total number of responses added for the activity during the period.

Responses Change

Change from previous to current for the number of responses during
the period.

Cost Per Response

Total approved budget amount for the campaigns for the activity
divided by the number of cumulative responses during the period.

Responses
Forecast

Total number of responses forecasted during the period.
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Table A-52 Responses by Activity Columns

Column Name

Description

Responses
Variance

((Actual - Forecast)/Actual) * 100

Conversion to
Lead Count

Total number of responses converted to leads during the period.

Conversion to
Lead Change

Change from previous to current for the number of responses
converted to leads during the period.

Cost Per Lead

Sum of period-to-date cost divided by total leads during the period.

A.2.38 Responses by Campaign Report

This report summarizes response information by campaign. Table A-53 describes
the columns of this report.

Table A-53 Responses by Campaign Columns

Column Name

Description

Campaign Campaign Name.
Target Audience Total targeted audience for this campaign during the period.
Responses Added | Total number of responses added for the campaign during the period.

Responses Change

Change from previous to current for the number of responses during
the period.

Cost Per Response

Total approved budget amount for the campaigns divided by the
number of cumulative responses during the period.

Responses Total number of responses forecasted during the period.
Forecast

Responses ((Actual - Forecast)/Actual) * 100

Variance

Conversion to
Lead Count

Total number of responses converted to leads during the period.

Conversion to
Lead Change

Change from previous to current for the number of responses
converted to leads during the period.

Cost Per Lead

Sum of period-to-date cost divided by total leads during the period.
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A.3 Home Page Charts

In order for the charts to display, your server must be configured as follows:

1.

To enable run-time image generation for charts on Unix, specify the X Server
used to generate dynamic images. This server does not have to be a dedicated
server for Applications; however, it does need to be accessible by the Apache
server that calls it. This is done through “xhost +“, or through a more secure
“xauth” Unix command. A Windows NT Machine running a Unix emulator like
Exceed may be used. Note: This step is not required if you are installing the JTF
framework on a Windows-based operating system (Windows NT or Windows
2000). To implement the Display Server identifier, update the <ORAHTTP_
TOP>/]Jserv/etc/jserv.properties with the following changes:

Add the following DISPLAY parameter immediately below the wrapper.bin
variable:

wrapper .env=DISPLAY=<xserver-hostname>:<xserver-displayport>

Replace <xserver-hostname> and <xserver-displayport> with the machine
name and port number where the X Server is running. For example,
wrapper .env=DISPLAY=myxserver .mycorp.com: 0.

This step is required if Apache Jserv is started in the Automatic mode. If Jserv is
started in Manual mode, then set the DISPLAY environment variable, either in
the script that starts the jserv or on the shell that (re)starts Apache. For example,

setenv DISPLAY <xserver-hostname>:<xserver-displayport>

Table A-54 contains a list of charts available for display on the Oracle
Marketing home page:

Table A-54 Home Page Charts

Chart Name Description Section Location
Budget Utilization by Business Unit | Summarizes the top ten budgets by business | Section A.3.1, "Budget
unit Utilization by Business

Unit Chart"

Budget Utilization by Category Summarizes the top ten budgets by category | Section A.3.2, "Budget
Utilization by Category
Chart"

Campaigns by Leads Summarizes the top ten campaigns by leads | Section A.3.3,
"Campaigns by Leads
Chart"
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Table A-54 Home Page Charts

Chart Name Description Section Location
Campaigns by Opportunity Summarizes the top ten campaigns by Section A.3.4,
opportunities "Campaign by
Opportunity Chart"
Events by Attendance Summarizes the top ten events by attendance | Section A.3.5, "Events
by Attendance Chart"
Events by Leads Summarizes the top ten events by leads Section A.3.6, "Events
by Leads Charts"
Events by Registration - Section A.3.7, "Events
by Registrations Chart"
Lead to Opportunity - Section A.3.8, "Lead to
Opportunity Chart"

The following table provides a list and description of the parameters that you can
set to view Home page charts. Table A-55 describes the parameters for Home Page
charts.

Table A-55 Home Page Charts Parameters

Parameter Name | Description

Region Lists all Regions defined by geographic area Region (geographic area
location 2). User may choose a region or “All” for all Regions. Default
is set to "All".

Country Lists all Countries defined in geographic area Country. User may
choose a Country or “All’ for all Countries. Default is set to “All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU".
User can choose a business unit or ‘All” for all business units. Default
is set to ‘All’.

A.3.1 Budget Utilization by Business Unit Chart

This chart summarizes the top ten Budgets by Business Unit. Table A-56 describes
the columns of this chart.

Table A-56 Budget Utilization by Business Unit Columns

Column Name Description

Budget Budget information.
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Table A-56 Budget Utilization by Business Unit Columns

Column Name

Description

Business Unit

Business Unit name.
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A.3.2 Budget Utilization by Category Chart

This chart summarizes the top ten Budgets by Category. Table A-57 describes the
columns of this chart.

Table A-57 Budget Utilization by Category Columns

Column Name Description
Budget Budget information.
Category Category name.

A.3.3 Campaigns by Leads Chart

This chart summarizes the top ten Campaigns by Leads. Table A-58 describes the
columns of this chart.

Table A-58 Campaigns by Leads Columns

Column Name Description
Campaign Campaign name.
Leads The number of leads to Campaign.

A.3.4 Campaign by Opportunity Chart

This chart summarizes the top ten Campaigns by Opportunities. Table A-59
describes the columns of this chart.

Table A-59 Campaign by Opportunity Columns

Column Name Description
Campaigns Campaign Name
Opportunities Opportunities

A.3.5 Events by Attendance Chart

This chart summarizes the top ten Events by Attendance. Table A—60 describes the
columns of this chart.
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Table A-60 Events by Attendance Columns

Column Name Description
Events Event name.
Attendance The number of attendees to the Event.

A.3.6 Events by Leads Charts

This chart summarizes the top ten Events by Leads. Table A-61 describes the
columns of this chart.

Table A-61 Events by Leads Columns

Column Name Description
Event Event name.
Leads The number of leads to Event.

A.3.7 Events by Registrations Chart

This chart summarizes the top ten Events by Registrations. Table A—62 describes the
columns of this chart.

Table A-62 Events by Registration Columns

Column Name Description
Event Event name.
Registration The number of registrations to the Event.

A.3.8 Lead to Opportunity Chart

This chart summarizes the number of leads to opportunities. Table A-63 describes
the columns of this chart.

Table A-63 Lead to Opportunity Columns

Column Name Description
Cost Per Lead N/A
Leads N/A
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This glossary provides brief descriptions of the key terms that are used in Oracle
Marketing.

Activity
Sub-level of Activity Type. For example, below activity type “Advertising,” one
would find “Advertising” and “e-Advertising.”

Activity Purpose

A meaningful objective to drive a marketing activity. All marketing activities
(campaign schedules) may be associated with an Activity Purpose. In some cases,
Activity Purpose may dictate Target Group selection.

Activity Template
See Schedule Template

Activity Type
The types of marketing activities that can be created and defined in Oracle
Marketing. For example,

s Advertising

»  Direct Marketing
= Events

s Publishing

= PR/AR

s Internal Communications
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Actuals

Seen on Cost Types and Metrics in Oracle Marketing and used to enter the actual
costs or actual metrics

Administration

A main tab in Oracle Marketing from where a variety of administrative functions
can be performed

Analytics

A group of tools used to predict desired customer behavior by analyzing customers’
response to a prior campaign

Approval Rule

Rules created in Oracle Marketing (and also in other parts of the Oracle E-Business
Suite), to control the routing and sequence of approval requests. This means users
do not manually have to select the correct approver, they simply submit for
approval.

Attachment

Electronic document that can be uploaded or linked to Oracle Marketing for later
download by other users

Attachment Type

When attachments are added at various levels within Oracle Marketing (for
example, Campaigns and Campaign Schedules), the attachment type must be
selected. Allowable values are:

= File: Any digitized file that is loaded into Oracle Marketing.
= URL: A URL that points to a file not actually loaded into Oracle Marketing.

Audience

An audience, in marketing terms, is a group of people who can be targeted for a
campaign or event. They meet a common criterion, and can be addressed for a
specific purpose.

Audience Dashboard

The home page of list managers from where they can create, manage, and analyze
the performance of lists



B2B

Business-to-Business

B2C

Business-to-Consumer

BIS

Business Intelligence System. A module in the Oracle E-Business Suite generally
used for reporting purposes

Budget

A pool of funds which are drawn upon to pay for campaigns, events, deliverables,
offers - essentially any marketing object requiring money. Can be fixed or accrued,
based on sales

Budget Adjustment Types

Types of adjustments, such as making available committed funds when a customer
fails to perform.

Budget Amount (also Initial Budget Amount)

Currency and value, that is set on the Budget side navigation of an Oracle
Marketing object, in the planning phase, as the object is being created.

Budget Source

Source of funds. It could be a budget or campaign in the case of schedules and also
a person in specific cases.

Budget Source Value
The amount being requested, or approved, from a Budget Source.

Budget Thresholds
Alerts that can be raised when a budget is being depleted too quickly or too slowly.

Business Rules

The rules and guidelines which govern how an organization uses an Oracle
product.
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Business Unit
A grouping of users within the application, defining the organizational structure.

Campaign
Campaign is a framework to plan and manage a marketing initiative. It is a
collection of marketing activities designed to support a goal.

Campaign Dashboard

The home page for Campaign Workbench users that helps them identify high and
low performing campaigns, view schedule GANTT charts, view their recent
schedules, and view and drill down a campaign hierarchy.

Campaign Schedule

A marketing activity that will be executed through a specific channel. These
executions may include direct marketing, advertising, direct sales, and events.

Categories
Method for grouping like marketing objects

CCM

Concurrent Manager. For example, approvals workflow requests are batched and
then handled by concurrent manager programs.

CDS
Core Data Set

Channel

Channel is the mode of delivery for a schedule. Examples could be a campaign
activity executed through the following channels: e-mail, fax, print, Web
advertisements, and banners.

COGS
Cost of Goods Sold



Collaboration

Collaboration content is material associated with a marketing activity but is not
outbound (that is, not sent out to customers). Sales and external teams involved in
the marketing activity use it.

Collateral

Collateral is the outbound, promotional message that customers receive. It could be
information about the product or marketing activity such as product data sheets,
white papers, promotional flyers, newsletters, cover letters, invitations, and so on.

Control Group

A group of list entries whose members are not contacted through a marketing
activity. A Control Group can be specified when a Target Group is being created.
Members of a Control Group are usually used to run test marketing activities and
the responses are compared with the responses from the target records that are
actually contacted, to determine the benefits of marketing to customers who meet
the list criteria.

Contact Group

A group of list entries whose members are actually contacted through a marketing
activity. A Contact Group is obtained by taking the count of associated lists or
segments for a target group, subtracting the number of Control Group records from
it, and adjusting for any suppression or duplicate records.

Contact Point

A touch point associated with a marketing object that other applications can direct
customers to for further information. Example: a person or Web site may be
contacted for more information about a product.

Content ltem

A specific instance of a content type. A merchant can create any number of content
items that belong to a content type. Example: Product is a content type, a laptop
computer is a content item.

Content Type

Content types define the structure of the content item through a set of attributes
that constitutes the meta-data to ensure content consistency.

Glossary-5



Glossary-6

In Web Marketing, the content type specifies the type of Web posting. These can be:
Product Recommendation, Web Ad, Web Offer.

Cost

Expenditure incurred by marketing and sales activities. Can be paid immediately, or
accrued and paid later.

Cost Type

A breakdown of pre-specified cost on each Oracle Marketing object. For example,
within a total budget value of $20,000, cost types may be allocated as $10,000 on
Mail List Buy and $10,000 on Production/Creative.

CRM

Customer Relationship Management

Custom Setups

Custom setups dictate how an organization will use marketing objects. They enable
an organization to use marketing objects to suit the organization’s needs through
customized, object specific Side Navigation menus.

Customer Master Record(s) (also known as Customer Master Files)

The actual records of customers, prospects, partners, vendors, and so on that are in
the Trading Community Architecture stored within the Oracle E-Business Suite.
These records are shared across all the modules in the suite.

csv
A comma delimited data file type

Data Mining

Data Mining is a process used to discover strong, meaningful patterns and
relationships in large amounts of data. These patterns and relationships are used to
more accurately predict and analyze the behavior of customers and prospects.

Data Sources
Field maps for external data sources



DBA

Database Administrator

Deciles

In data mining, after scoring a target population based on a model, the target
population is divided into ten continuous segments called deciles. The deciles are
ordered from the highest to the lowest probability of displaying the target behavior.
Therefore, the customer records in decile 1 are the most likely to exhibit the target
behavior.

Deduplication

To remove duplicate records from a list, the entries are compared based on the
deduplication rules specified in the Administration tab. Use of Word
Standardization improves the completeness of the deduplication process. (See Word
Standardization.)

Deliverables

Deliverables are marketing collateral that you can distribute to customers across
multiple channels. Each deliverable is a physical or electronic collateral, which you
can associate with a campaign or an event.

Discoverer
Oracle’s data query tool

Display Priority

A business attribute of the posting’s content type used to prioritize the
recommended content for display, based on business objectives. Example: prioritize
the recommended products based on price, and display the highest priced product.

DNC

Do Not Contact. A flag in marketing databases and lists indicating people who do
not wish to be contacted.

Web Marketing

A group of methodologies used to configure Web sites according to customer
preferences and anticipated interests.
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ERP

Enterprise Resource Planning

EUL

End User Layer. The EUL provides the mapping between the database attributes
and Oracle Discoverer.

Event

A planning tool to execute a marketing activity, such as a trade show, seminar,
webinar, or product launch.

Event Promotion

A specific type of Campaign that may be created in Oracle Marketing to promote an
Event. It will contain a Campaign Schedule, detailing the executions, and will be
linked to the Event.

Event Schedule

An event schedule is a marketing activity executed in one or more venues for an
audience.

Fatigue Rules

Rules that prevent marketing teams from over contacting their customer or
prospects base. Customers or prospects who have been contacted the specified
number of times are removed from the target group of a marketing activity.

Geography

A side navigation link in Oracle Marketing that allows users to define the
geographical area (country, region, sub region, state, and city) in which an Oracle
Marketing object will be executed.

GUI
Graphical User Interface

Import

A link in the Shortcuts bin of the Audience Dashboard, giving access to the List
Import functionality
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Initial Budget Amount
See Budget Amount

Interaction

Any interaction (or touch point) with a customer or prospect. For example, contacts
may be targeted, and they may respond, register, attend, and evaluate (dependent
upon the activity type). Interactions may later be qualified and rated, and may
become leads.

Interaction Import

A functionality in Oracle TeleSales that will allow interactions and/or new
customer/prospect records to be imported from pre-defined format flat files into
customer master records.

Intersect

A value used in List Build and Selection. Use this option to create a selection that
includes only the intersect (overlap) of two chosen lists.

iStore
An Oracle product designed for producing electronic commerce Web sites.

JSP

Java Server Page

JTF

Java Technical Foundation

Lead

A qualified sales opportunity that results from a marketing or sales activity.
Lists

A list is a group of customers or prospects that meet a specific user-defined criteria.
A list is always static.
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List Import

A function in which external data, such as a rented or purchased list, may be
permanently or temporarily added to an organization’s internal customer and
prospect data.

List Import Table

A database table where records imported from a rented or purchased list are stored.
Records may be added to TCA from the List Import Table.

List Templates

Consist of a set of query criteria and data filters and are used to create lists based on
associated Data Sources.

Locking Rules

Determine which fields of particular attributes of a marketing object are locked
from update once they are created.

LOV
List of Values

Mandatory Rules
Determine which fields belonging to a marketing object are required.

Marketing Mediums

Execution channels, such as radio, newspaper, television, or billboards through
which marketing campaigns are conducted.

Marketing Object
See Object.

Marketing Response

A contact made by a customer or a prospective customer with a vendor as a result
of some marketing activity initiated by the vendor.

Merchandising Strategy

An algorithm used to select personalized content items (including products, offers,
ads, product reviews) for display on a web site.



MES

Marketing Encyclopedia System, a module in the Oracle E-Business Suite

Messages

Messages are associated with a program or campaign and they are used to
distinguish and position a product.

Metrics

Metrics are measurements for forecasting and tracking the effectiveness of
marketing activities. You can associate cost, revenue, or other metrics with many
marketing objects.

MLS
Multi-lingual Support

MRP

Manufacturing Resource Planning, a module in the Oracle E-Business Suite

Multi Org

Used to describe the capabilities of the Oracle E-Business Suite in dealing with
multiple organizations/languages/currencies, and so on.

Natural Language Query

A template that enables the selection criteria for generating a list to be defined just
as you would think them in a natural language.

Note Type
Allows users to classify “Notes” created in Oracle Marketing by their type.

Object
Oracle Marketing uses the term “object” to refer to various building blocks used in
the application. These include:

s Programs
s Campaigns
= Campaign Schedules

s Events
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s Event Schedules
s One-Off Events
s Deliverables

s Products

s Offers
= Budgets
OC or OM

Order Capture or Order Management, a part of the Oracle E-Business Suite
allowing orders to be created and passed for fulfillment.

Offer

An offer is an incentive designed to entice customers to purchase a product or
service.

One-Off Event

An “event” type object in Oracle Marketing, used to define an event taking place
once, in one location only. This allows the user to create an event schedule, without
first having to create an event (or a Campaign) plus a schedule.

Opportunity

A sales opportunity, created in Oracle Field Sales, Oracle Telesales, and other sales
applications.

Oracle Advanced Outbound
A product used to preprocess marketing campaigns for Oracle TeleSales.

Organization
A company (or other logical grouping of contacts) in TCA

Owner

The name of the person within Oracle who owns or is responsible for the Oracle
Marketing object.



Page
A logical entity describing a JSP template or an HTML or OA page. In Web
Marketing, Page identifies a placement.

Personalize

A function that allows an Oracle Marketing user to personalize many screens, to
produce a listing of chosen columns only, and/or to select filtered or specific data
only.

PHP

Personal Home Page.

Placement

An object representing a location on a Web site for displaying content when a Web
schedule executes.

Web Posting

A web posting is an object that holds the content type, content selection, and
display strategy in Web Marketing. There are two types of web postings: universal
and rule-based.

Product

A main tab in Oracle Marketing, giving access to create and manage products,
product hierarchies, and product pricing in the Oracle E-Business Suite.

Product Family

A value in several pick lists, giving a choice of products. Messages, campaigns,
events, and deliverables may all be associated with specific product families.

Program

Program is an umbrella object used to combine different marketing objects such as
campaigns and events, under one entity. Costs, revenues, and metrics of the
program components are rolled up and reported at the program level.

Related Products

Related products are user-defined links between different products. You can
associate an unlimited number of product relations. Related products are used by
various Oracle applications. For example, a call center agent using Oracle TeleSales
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can use related products to identify cross-sell or up-sell opportunities and
prerequisites.

Response

A response can be any communication back from a customer or prospect. After
qualification, a response can become a lead. A response that cannot be qualified as a
lead can be further targeted with lead maturation programs.

ROI

Return on Investment.

Rollup Cost

A cost metric that is composed of, or calculated as a sum of, other cost metrics. A
rollup cost receives its values from lower level marketing object costs.

Rollup Metric

A metric that is composed of, or calculated as a sum of, other metrics. A rollup
metric receives its values from lower level marketing objects.

Rule

A set of conditional statements, merchandising strategy, and a rule priority. The
merchandising strategy is triggered if all conditional statements are true.

Rule-based Posting

A rule-based posting consists of several rules. Use it to apply different
merchandising strategies to different situations as described by the rules conditions.

Schedule Template

Includes information on what is needed to plan and execute a campaign. A specific
outbound channel and a specific schedule purpose are associated with a Schedule
Template.

Scripts

Scripts provide marketing managers with the ability to follow up on the campaigns
with a scripted flow of interactions (either through the Web or a call center). They
are used to establish an interactive, personalized conversation with customers.



Segment

Segments are customers that satisfy a specific set of business rules, or selection
criteria. Examples could be profitable or non-profitable customers. A segment is
dynamic.

SIC

Standard Industrial Classification.

Source Code

The unique code number assigned to each Campaign, Campaign Schedule, Event or
Event Schedule within Oracle Marketing. Source Codes are associated with all
interactions, and are used in Oracle Leads Management

SQL
Structured Query Language

Status

Seen in many places within Oracle Marketing, the Status field shows where the
campaign, event, schedule, deliverable is in the approvals process. Actual values
within the pick list vary dependent upon the object.

Style

Styles define the look and feel for content items that are displayed in a Web site
placement. Styles are associated with an XSL stylesheet that converts the XML
output of the eMerchandising engine into HTML.

Suppression Lists

List of entries used to automatically exclude them from a specific marketing activity.
Suppression filters are predefined and applied to all target lists to comply with
privacy policies when customers choose to opt out of campaigns and do not wish to
be targeted. User-defined filters can also be created and applied globally to all
campaigns or to specified campaigns.

Target Accounts

A target account for a campaign or event schedule is the set of people who will be
informed about an activity and invited to participate in it. They make up the
audience for the schedule.
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Targeting Conditions

Conditional statements used to target merchandising strategies to specific users.
Targeting conditions may be based on the type of visitor, shopping cart total
amount and belonging of a visitor to a segment or a list.

Trading Community Architecture (TCA)

The Oracle customer model (or schema), that serves as a single repository for all
data about organizations, customers, contacts, partners, vendors, and relationships.

Triggers

Triggers are used to activate a campaign schedule on a condition or date-based
monitor.

Teams

Marketing teams are associated with marketing objects (Campaigns, Events,
Deliverables, and so on) and represent users or a group of users with access
privileges to these objects. Marketing team members can have full access

(read /write) either with or without the ability to Edit Metrics (Budgets, Costs and
Revenues, and Metrics) for the marketing object

ul

User Interface

Universal Posting

The content that will be rendered as a Web Ad, Offer, or Product Recommendation
using the same merchandising strategy to all the online visitors; however, the
strategy may return different personalized content to different visitors.

UuoMm

Unit of Measure

URL

Universal Resource Locator

VAD
Value Added Distributor



Venue
A specific location that is generally associated with an event

Word Replacement Rules

Rules that govern the comparison of entries during list import to determine
whether a duplicate entry is being imported

Word Standardization (sometimes referred to as Word Replacement)

In order to successfully deduplicate a list, words such as street identifiers (Avenue
= Ave), first names (William = Bill), and States (California = CA) will be temporarily
standardized for the purposes of comparison. The use of Word Standardization
does not change the text of the actual records. Names of organizations may
similarly be temporarily standardized.

Workbook

A term used in Discoverer. A workbook represents selection criteria that will be
applied against records in the database.

Workflow

Oracle Workflow is a product used to track and relay approvals and notifications
according to business rules.

Worksheet

A spreadsheet of customers or prospects, or both, extracted from a database by
Oracle Discoverer.

YOY

Year over Year / Year on Year.
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associating product contents, 9-18
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bundle, 9-17
creating, 9-10
creating an offer for, 9-15
creating collateral relationships, 9-15
creating competitor product, 9-18
creating relationships, 9-15
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adding components to, 5-4
creating, 5-3
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overview, 5-2
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quick search, 17-3
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recipient information
generating, 8-37
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Request Approval button, 12-5
role, 2-2
See also users and responsibilities
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search
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security enhancements in Oracle
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shortcuts
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creating using advanced method, 8-39
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creating, 14-5
teams, 6-29,12-2
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trigger conditions, 6-7

metric to metric, 6-7

metric to value, 6-8

metric to Workbook, 6-8
triggers, 6-5

and metrics, 6-7

associating to a campaign, 6-13

benefits, 6-6

creating, 6-13

date based, 6-8

definition, 6-6

functional flow, 6-5

monitoring frequency, 6-9

notification, 6-9
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